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COPYRIGHT NOTICE

Legal

aonoN ySuidoy

The contents of this guide are Copyright © 2005 Koroush Ghazi, TweakGuides.com and protected under US,
Australian and International Copyright laws. No unauthorized reproduction, alteration or distribution of the
guide, in part or in whole, in any language, is permitted without explicit written consent from the author. All
Trademarks used in this publication are the property of their respective owners.

Informal

In general I won't be granting permission for anyone to reproduce or alter any part of this guide and/or host
it on their site. That includes translations of this guide — unfortunately I cannot be sure of the quality and
accuracy of any translations and hence I won't allow my works to be translated. I apologize to my non-
English readers and I hope you understand.

I have put a great deal of personal time and effort into creating this guide and I'm releasing it free of charge
so that the widest possible audience can benefit from its contents. I would appreciate that out of respect for
my efforts and the fact that I didn't write the guide to make a quick buck, people do not rip off my work or
host it on other sites. If I find, or am informed of illegal copies of my guide, I will make every effort to have
those copies removed — including but not limited to pursuing the matter with the site's domain owner, their
ISP, the site host, their IP Registrar and finally through a Court of Law. TweakGuides.com only produces
tweak guides — if I allow others to rip off my guides then my site loses all its traffic and I lose control over
my material, therefore I will take every step necessary at my own expense to prevent widespread
unauthorized distribution of my works.

If you enjoy my guides and want to support my site please report sites which violate my Copyright and
keep visiting TweakGuides.com for my original free tweak guides rather than supporting sites which rip off
other peoples’ work to generate advertising revenue and boost their traffic.

CREDITS

Aside from my personal experience and knowledge, this guide is the culmination of a great deal of research
and reading. As such I wish to credit all the sites and authors linked throughout this guide — there are far too
many to mention here, but without their work this guide would not have been possible. My thanks go out to
those sites for their contribution to the PC community. The same goes for all the software developers whose
excellent tools I link to in this guide, especially those who provide their software for free. I appreciate the
incredible time and effort it takes to develop and test a software package, then provide it absolutely free so
that PC users the world over can optimize and maintain their computers.

In particular I want to thank my readers who since my site began in April 2004 have provided incredible
support. From those who support TweakGuides.com by linking to my guides on websites and Internet
forums, to those who take the time to write to me — I really do appreciate all your feedback, support and
ideas. The only thing which motivates me to write my guides is the fact that I know there are people out
there who are willing to use them. I wish I could name all the individuals who have written to me and
provided valuable feedback, but once again there are literally thousands of you who have done so, and the
best I can do here is give you my heart-felt thanks. You know who you are and you know how grateful I am.
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INTRODUCTION

Hi there,

uonONPOIIUY

Windows XP is a popular, well-established operating system and is
currently the best operating system to use on a home PC. I first started using
Windows XP in late 2001, and although not perfect I've found it a stable,
fast, secure platform for desktop computing. In late 2002 I released my first
Windows XP Tweak Guide - WinXP Tweaking: From Reformat to Relax. It
became very popular, encouraging me to follow it up with my WinXP

Tweaking: From Relax to Righteous and my System Optimization Guide.
These guides are still in wide usage to this day.

However with the release of Windows XP Service Pack 2, and given the
many small changes XP has undergone over the last couple of years, the
time has come for an entirely new guide to replace my older offerings. One
which covers all the major XP tweaks and tips, yet takes them much further
by providing information on understanding and optimizing your entire
system all in one place: thus was born my Windows XP Tweaking Companion.
Furthermore, in response to requests from readers I've chosen to release this guide as a free downloadable
document. So while the guide is longer than any XP guide released to date, it should be easier to store, read,
print and search through for all the information you need when tweaking Windows XP.

As one of the major authors of tweak guides on the Internet, I'm often asked: "What's the point in tweaking
man? It's long, it's boring, and it doesn't do much anyway - why bother?" The implication is that tweaking is
either something poor people have to do because they can't afford decent hardware, or that it's just not
worth the hassle because it doesn't result in any real gains. Wrong on both counts. Tweaking isn't a magic
trick — it doesn't suddenly double your performance with a few magical changes. It's also not about messing
around with settings just for the heck of it, or to seem cool (since when was tweaking cool?). Tweaking is
about customizing software and hardware settings to suit your particular machine's configuration and tastes
perfectly. It's like performance tuning a car, or having a suit tailor-made for you.

Because no two computers are completely alike, Windows has a lot of "fat" built into it to accommodate
potential variations in the hardware, software and preferences of consumers who use it. So no matter how
fast or slow your hardware is, you can always customize and trim down Windows XP to suit your system
perfectly, resulting in better performance, greater ease of use and most importantly - increased stability.
Everything from reducing the time it takes to boot up your system to increasing your framerate in games, to
preventing mysterious crashes and errors - tweaking shows noticeable, sometimes dramatic results. Bottom
line: it's worth doing.

With that in mind, I proudly present the Windows XP Tweaking Companion. It's taken me a long time to
compile, so I truly hope it assists you in optimizing your PC. If you find the guide useful, please consider
providing feedback or making a donation at www.TweakGuides.com - this will allow me to work on
refining future versions of this guide and provide many other guides to better meet your needs.

Cheers,

Koroush

Koroush Ghazi ;
Owner/Author In honor of 2,500 years of Persian Culture
TweakGuides.com Knowledge without Judgment, Power without Injustice
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USING THIS GUIDE

This section covers some important things you should know before using this guide - please read through to
ensure you make the best use of this guide.

opmo sy, Sursn

B BASIC REQUIREMENTS

There are several important requirements you need to know before using this guide:

¢ You should have prepared backups of all your important information prior to undertaking any of the
changes detailed in this guide. Follow the instructions in the Backup & Recovery section.

¢ You should have your original Windows XP installation CD readily available — do not undertake the
tweaks in this guide if you don't have a Windows XP CD (e.g. if XP was pre-installed on your system
without an accompanying disk).

¢ You will need Administrator level access to Windows XP to make the majority of the changes in this
guide. See User Accounts under the Control Panel section for more details.

¢ You should be viewing Windows XP using Windows Classic Folders so that the references make sense
to you. See Folder Options under the Control Panel section for more details.

¢ You will need Internet access to use this guide, as there are references to online articles, guides and
resources which are essential to understanding and performing some of the major tweaks in this guide.

Unless you meet all of the requirements above, I do not recommend proceeding with the guide as you may
be unable to successfully undertake the tweaks in this guide, or may run into problems.

B DIFFERENT VERSIONS OF WINDOWS XP

The contents of this guide refer equally to both Windows XP Professional and Windows XP Home. Contrary
to popular belief, there is no performance difference between XP Pro and XP Home. The main differences are
that XP Pro has additional features related to setting up and managing networks. The actual differences are
spelt out in this Microsoft Article.

Furthermore, there are no content differences between the various versions of Windows XP which are sold.
That is, the OEM Edition, Academic Edition, and Upgrade Edition of Windows XP Home for example are all
identical in terms of performance and content to the Full Version of Windows XP Home. These editions are
simply the way Microsoft provides different price points for various markets. The actual difference between
these editions is that certain purchasing conditions are attached to them: the OEM (Original Equipment
Manufacturer) Edition can only be provided with the purchase of a new computer; the Upgrade Edition
requires that you own an earlier version of Windows to install it; and the Academic Edition requires that you
be a student or qualified educator to purchase it. However the tweaks and tips in this guide apply to all
these versions equally, as they all have exactly the same content as the Full Edition version.

The one exception is Windows XP 64-Bit Edition which is architecturally different to the mainstream
Windows XP which is a 32-Bit operating system. Some descriptions and recommendations in this guide will
be inappropriate for Windows XP 64-Bit Edition, however I cannot specify which.

B OTHER VERSIONS OF WINDOWS

This guide does not apply to other versions of Windows. For starters Windows95/98/SE/ME are all based on
a different architecture to Windows XP, so many of the descriptions of XP functionality in this guide (such as
Virtual Memory) are not technically correct for other versions of Windows. Windows 2000/Pro/NT/2003 are
based on the same architecture as Windows XP, so most of the general tips, descriptions and tools will apply
to those versions. However I cannot specify which do and do not work, so it is up to your judgment whether
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you want to experiment. I have only tested the tweaks and settings in this guide on Windows XP, and I
cannot provide recommendations for other Windows versions.

B REFORMAT & REINSTALL VS. EXISTING INSTALLATION OF XP

opmo sy, Sursn

This guide is designed to be used on either fresh or existing installations of Windows XP, and you will
definitely see performance improvements in either case. However I personally recommend that if possible

you take the time to start with a reformat of your hard drive and a fresh installation of Windows XP. You
will find that programs you have installed in the past, settings you have changed and hardware you have
added, removed or shifted around will have left an overwhelming amount of junk on your system which
may take some time to clean up. Some issues, such as major IRQ conflicts, can really only be resolved
through a reinstallation of Windows. Therefore a fresh install of XP guarantees the least amount of problems.

B READ AHEAD

I strongly suggest you always read ahead before undertaking any tweaking to see what is required at
various stages. It may turn out for example that you require a particular program which would be best
downloaded prior to starting the steps in the guide. Or you may need the latest drivers downloaded in
advance. Or you might have to change some hardware settings — or even shift around some hardware -
before starting a particular procedure. You must read ahead and familiarize yourself with the procedures in
this guide so that there are no surprises.

B WHY IS THE GUIDE SO LONG?

For those wondering why this guide is so long, particularly as other XP guides are only a few pages, the
reason is simple: I provide relatively detailed explanations and step-by-step procedures for general system
optimization which are often excluded from other Windows XP guides. Also, to provide maximum benefit
to as wide an audience as possible I couldn't assume a general level of existing computer knowledge; I
wanted to explain even the most basic settings and cover all areas of Windows and system optimization. I
want readers to understand how their system actually works, not just rely on me for recommendations. I
firmly believe in the old saying: "Give a man a fish and he will eat for a day; Teach a man to fish and he will eat for a
lifetime". This has resulted in a great deal of descriptive text which some people may label as "fluff". At the
end of the day I would rather that hardcore computer geeks found my guides too fluffy and simple than
have relatively inexperienced computer users left scratching their heads at a bunch of registry tweaks.

B SOFTWARE TO DOWNLOAD

Listed throughout this guide is a range of software which I recommend you download to enable you to carry
out the tweaks and procedures I provide in the guide. Download as much of this software as possible in
advance of tweaking. Note that at no point do I urge you to purchase any software. I am not paid or
sponsored by any software or hardware company and hence my recommendations are based only on two
criteria: functionality and price. Specifically it must be the best free software available to do the job for me to
recommend it. I have made a special effort to ensure that all of this software is both readily available and
more importantly that it is completely free to download. In a couple of cases the software may eventually
require paid registration, but in such cases the software retains sufficient functionality until the end of its
trial period — enough to complete the job for which I have recommended it. Of course if you do find any of
the software useful I encourage you to support the software's author and purchase it or donate to them.

B REFERENCES TO OTHER GUIDES, ARTICLES OR WEBSITES

For those of you hoping that this guide would be completely self-contained and cover every single Windows
and system optimization procedure from start to finish, I'm sorry to say that you will be disappointed. I tried
as hard as I possibly could to provide all the relevant information within the pages of this guide, without the
need to refer to other reference sources, but found it would take too long and triple the size of the guide.
BIOS Optimization guides, step-by-step Windows installation screenshots, full Service configuration
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descriptions, etc. have all been covered much more expertly by authors such as Adrian Wong and
BlackViper. At best I would only be rehashing their specialized work, at worst I would be plagiarizing it.
Therefore you will see many links throughout this guide to other recommended guides, articles and
websites which are necessary to supplement the information provided herein, and which also provide you
with an avenue for further investigation if you want to learn more about a particular topic. Rest assured that
the links provided are genuinely useful and informative, and that I have no affiliation with the referred

opmo sy, Sursn

links, nor do I gain financially in any way from referring you to particular sites.

B PICTURES AND DIAGRAMS

You may notice while going through this guide that there is a distinct lack of pictures, diagrams and
graphics. This has been done to reduce the size of this document, ensuring that the bandwidth on my
website is not blown out by the many users downloading this guide and to reduce the page count which
may deter some users from reading the guide - it's already quite long as it is without another 50 pages of
graphical padding.

B REPORTING PROBLEMS WITH THE GUIDE

While I have made every effort to ensure this guide is as accurate and detailed as it can be, I hope you
appreciate that I can't possibly have tested the information and recommendations in this guide on every
potential variation in PC hardware and software. Therefore I am relying on readers to tell me if there is
anything which needs fixing in the guide. If you have any issues with, or feedback on this guide - everything
from simple typographical and formatting errors through to factual errors, difficult to understand
descriptions, dead links, important omissions and any unusual results from applying the tweaks as
described, please provide your feedback by using this link: Email Me.

I stress that I can't provide detailed technical support to readers. I wish I could, but I just don't have the time
- I already spend over an hour each day answering my emails, so I hope you can appreciate that because of
the vast number of variables involved in troubleshooting PC problems, I can't give you personalized tech
support. The whole reason for writing this guide was to give each and every reader a thorough rundown on
all the steps necessary to optimize your system.

B YOUR RESPONSIBILITIES

The basic theme throughout this guide is that as long as you follow the procedures carefully and use
common sense when applying these tweaks and recommendations, you will remain problem-free. In all
respects the guide is safe to use if followed correctly. However for legal reasons, I cannot take any
responsibility for any damage or loss incurred through the use of this guide. I have been writing tweak
guides for over three years, and have had literally hundreds of thousands of satisfied readers worldwide. Be
that as it may, it is a condition of use for this guide that you agree to take full responsibility for your
actions. The guide provides you with the advice required to tweak your system correctly - how you
implement it is your choice. If you do not wish to take full responsibility for using this guide, and any
resulting impacts, then do not proceed any further — close the guide now and delete it from your system.
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BASsIC PC TERMINOLOGY

If you're not totally familiar with the various components of a modern PC, then this section will familiarize
you with the common terminology used throughout the guide and what each hardware component does in
layman's terms. If you are an experienced PC user you can skip this section.

BITS & BYTES

You will often see the terms Bits, Bytes, Kilobytes, Megabytes and Gigabytes (or their abbreviations) being
thrown around in guides such as this one. A Bit is the lowest form of computer information and can take the
value 0 or 1 (i.e. Off or On). All computer functionality is derived from the behavior of Bits - read more about
it in this Bytes Made Easy article. For our purposes, the conversion factors you need to know are:

8 Bits =1 Byte

1,024 Bytes = 1 Kilobyte (KB)

1,024 Kilobytes (KB) = 1 Megabyte (MB)
1,024 Megabytes (MB) = 1 Gigabyte (GB)

PC

A PC (Personal Computer), also often referred to as a System, Machine or Rig, is a collection of hardware
(electronic components) which function as a unified system through the use of software (programmed
instructions). This is similar to the way a human body has a range of organs, connective tissue and structures
designed to work together to achieve an outcome. Note that in this section I use the human body analogy to
describe PC hardware components, hopefully clarifying their functionality in more familiar terms.

CPU

The CPU (Central Processing Unit) is the single most important component of a PC. It is typically a thin
square chip which is seated firmly on your Motherboard, usually covered by a large metal heatsink and fan
to cool it. The CPU controls and co-ordinates the actions of the entire PC under instruction from software. It
has the role of determining which hardware component does what, assigning tasks and undertaking
complex calculations which are then fed through the various relevant components and back. In human body
terms, the CPU is the brain.

MOTHERBOARD

The Motherboard, also called the Mainboard, or Mobo for short, is the large thin rectangular plastic Printed
Circuit Board (PCB) into which a large range of electronic components are connected in a PC. The
motherboard provides a network of pathways (or Buses) for the CPU to communicate to the various
hardware components, and a range of ports for standard peripherals and devices to plug into the PC. The
main pathway for information flow in the motherboard is the Front Side Bus (FSB). In human body terms,
the motherboard is the nervous system and arterial system combined.

MEMORY

RAM (Random Access Memory), also called System RAM or just Memory, is the most common form of
memory hardware used by a PC. RAM usually comes in long thin 'sticks' of set sizes that plug into the
motherboard and through it provide a place for the CPU and other components to temporarily store
information. RAM only holds information while the PC is on; if a PC is rebooted or switched off, any
information in RAM is instantly cleared. Aside from System RAM, the graphics card usually has its own
RAM called Video RAM, and the CPU and other hardware often have small memory chips called Caches to
hold information temporarily. In all cases, memory is used to speed up data transfers because information
can be written to and read from memory much faster than any other form of storage (such as the Hard Drive
or CD ROM).

AZoourura, D J d1seg
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ROM (Read Only Memory) is a permanent form of memory, and works similar to RAM, however unlike
RAM it can only be read from and not written to under normal circumstances, and it will not clear when the
system is rebooted or switched off. ROM is primarily used to hold small amounts of important information,
such as the BIOS (Basic Input Output System) — the program which tells the computer how to function when
it is first switched on - stored on the ROM chip in the motherboard. Certain ROMs can be written to by use
of a process called Flashing, such as when the BIOS is flashed with a new version. In human body terms,
Memory is like our own memory with RAM being short term memory and ROM being long term memory.

HARD DRIVE

The Hard Drive is a large, semi-permanent storage area that acts like Memory, except it is slower and
typically far larger. The hard drive is a rectangular metallic box inside which is a stack of round platters and
a read/write head. The hard drive plugs into the motherboard's IDE (Integrated Drive Electronics)
Controller, SATA (Serial Advanced Technology Attachment) Controller or SCSI (Small Computer System
Interface) Controller depending on the drive type and the motherboard type. Whenever the PC requires
information, it must first be read from the hard drive, usually into RAM, from where it is then accessed by
the CPU and other devices. Data such as installed software will remain on the hard drive regardless of
whether the system is rebooted or switched off. Because the hard drive involves physical components, such
as the moving read/write head and a spinning disk, it cannot be as fast as RAM — which has no moving parts
- in providing information. Often a system may slow down or stutter while waiting for more information to
be loaded up or written to the hard drive. The amount of information on the hard drive itself usually has no
significant impact on its performance. In human body terms, the hard drive and the information it holds is
like an external library of books, or a notepad that can be read from and written to.

CD/DVD/CDRW/DVD-R DRIVE

Much like the Hard Drive, a CD, DVD, CDRW or DVD-R drive is a storage device that reads from and
sometimes writes information onto CDs or DVDs that permanently hold this information until overwritten
or deleted. Such drives usually come in plastic rectangular boxes with a loading slot or extendable tray in the
front. They usually plug into the motherboard's IDE Controller or SATA Controller depending on the drive
and motherboard type. Specifically, CD and DVD ROM drives can read information from CDs or CDs &
DVDs respectively, but cannot write anything onto them. CDRW and DVD-R drives can both read from and
write information to writeable CDs and CDs & DVDs respectively. All these drives are slower than a hard
drive in reading and writing information due to physical limitations once again and also the way in which
they are connected to the main system Bus. In human body terms, these drives are again much like an
external library and the CDs and DVDs themselves are books or notepads.

FLorPY DRIVE

Much like a Hard Drive or CD/DVD/CDRW/DVD-R Drive, a Floppy Drive stores information on a recording
medium, usually a thin plastic 3.5" Floppy Disk. The floppy drive comes in a rectangular plastic box with a
loading slot at the front and a large ejection button, and plugs into the floppy controller on the motherboard.
Floppy drives can read from and write information to floppy disks, but are incredibly slow compared to any
other form of drive, and also hold very little information (1.44MB) and hence are not commonly used
anymore. Most PCs retain a floppy drive for emergency use when Windows won't load up for example, or to
flash the BIOS. Again, in human body terms a floppy drive is like a library, with the floppy disks a
document or notepad for reading from and writing to.

GRAPHICS CARD

The Graphics Card, also called the Video Card, Graphics Adapter or VGA Adapter, is a miniature computer
of its own dedicated to graphics-related functions on the PC. It is a thin rectangular plastic PCB with a GPU
(Graphics Processing Unit) - similar to a CPU - and Video RAM (or VRAM) - similar to System RAM - as
well as Pipelines for transferring information internally, similar to the FSB. It plugs into the motherboard
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through the AGP (Accelerated Graphics Port) Port or a PCI (Peripheral Component Interconnect) slot, or
more recently a PCI-E (Peripheral Component Interconnect Express) slot. Most graphics cards have one or
more heatsinks on the GPU and the VRAM, and often have a fan on the GPU or covering the entire card. The
graphics card undertakes the majority of 2D and 3D graphics calculations and also sends information
directly to the Display Device, which is usually a monitor. Some motherboards have built-in graphics
functionality that works in much the same way as a graphics card, but is referred to as Onboard Graphics or
Integrated Graphics. PCs with such graphics functionality (if enabled) typically process graphics-related
information far less quickly than those with plug-in graphics cards. In human body terms, the graphics card
is like the portion of the Brain that relates to visual or artistic expression.

DISPLAY DEVICE

A Display Device, or more commonly referred to as the Monitor, is the device through which the PC's
information is displayed graphically. This graphical information comes from the graphics card, and a
display device must usually be plugged directly into the graphics card through the back of a PC to facilitate
this. While most computers still have a CRT (Cathode Ray Tube) monitor as their primary display device,
modern PCs can utilize Televisions, LCD displays and sometimes multiple types of displays at once to
output the graphics information.

Display devices have the ability to display graphics at various resolutions, typically expressed in number of
Pixels wide by number of Pixels high. A Pixel is the smallest component of graphics, and the higher the
resolution, the more pixels displayed on the display device and hence the clearer the image. At each
resolution a display device can also redraw the image a number of times per second, referred to as the
Refresh Rate. The higher the refresh rate the smoother your graphics will appear and the less flickering you
will experience. In human body terms the display device is like a pen and a piece of paper, or a canvas used
by a person to convey thoughts as images and text.

SOUND CARD

The Sound Card, also called the Audio Card or Audio Device, is a thin plastic PCB or sometimes an external
attachment that acts as a dedicated CPU for calculation of audio information. A sound card typically plugs
into the motherboard through a PCI slot, or in some cases as a peripheral, and usually has no heatsink or fan,
as it does not require the same level of cooling as other major components. Some motherboards have built-in
audio functionality that works in much the same way as a sound card, but is referred to as Onboard Audio
or Integrated Sound. PCs with such audio functionality typically (if enabled) process audio-related
information less quickly or less faithfully than those using plug-in sound cards. In human body terms, the
sound card is much like the portion of the Brain that relates to audio interpretation.

SPEAKERS OR HEADPHONES

A PC speaker system (or headphones) is designed to output the audio signals of the PC, which usually come
from the sound card, and hence they typically plugged directly into the sound card. Even if a PC has no
attached speakers/headphones all PCs have a small built-in speaker that provides important system status
information usually as beeps. In human body terms the speakers or headphones are like the voice of the PC.

PSU

The PSU (Power Supply Unit) is a square metal box, usually with a fan at the back, which is cabled to all the
major components of a PC, particularly the motherboard, and provides the power for the PC to function. The
power cord from the wall usually plugs straight into the back of the PSU directly, as it draws the appropriate
power and regulates the precise voltages that certain devices need to function correctly. The PSU usually has
a wattage rating which indicates the maximum power output of the PSU under load, with the more devices
connected to a PC the higher the wattage required to maintain ample smooth power to each and hence keep
the system stable under stress. In human body terms, the PSU is like the heart which pumps blood through
the arteries and organs.
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HEATSINKS AND FANS

A Heatsink is a square or rectangular solid metal object typically with a perfectly flat surface on one side,
and many long square 'spines' on the opposite surface. The role of a heatsink is to sit on top of a chip like the
CPU or GPU, or even RAM, and draw out the heat these components are producing through conduction.
This heat then travels along the length of the heatsink to the top of the individual metal spines where cooler
air and a large surface area help in accelerating the dissipation of the heat. Typically a fan is bolted on top of
the heatsink to aid in blowing more cool air over the heatsink's spines and hence dissipate the heat more
quickly. In some cases where just a heatsink is sufficient for the job, no fan is used — such as the heatsinks on
the motherboard or heatsinks placed onto VRAM.

Often Fans are placed inside and around a PC case by themselves to draw in cool air and blow out hot air
from the enclosed space around the hardware components on the motherboard. Given the way heatsinks
work, the air around components will heat up quickly as heatsink(s) radiate the heat drawn from hardware
components. Fans of varying sizes and speeds aid in cooling the air in the entire case.

Other forms of cooling such as refrigerator-like VapoChill units, Peltiers, Heatpipes and Watercooling blocks
can assist or replace heatsinks and fans in the role of cooling system components, but are less common due
to their cost and complexity. In human body terms these cooling devices are like the respiratory and
perspiration functions.

CASE

The PC case is a hardened structure, usually made of some form of thin but strong metal and/or plastic,
which encloses all the PC components and onto which the motherboard is firmly attached. The case usually
provides the basic framework required for affixing additional components such as hard drives, floppy drives
and the PSU. Quite often the case will also have a range of openings small and large to allow fans to draw
and expel air for better circulation. In human body terms the case is like the skeleton combined with the skin.

PERIPHERAL

A Peripheral generally refers to any external device attached to a PC, such as a mouse, keyboard, printer or
digital camera for example. The term "peripheral’ is used specifically to indicate that the device lies outside
the periphery of the PC case. The only thing peripherals have in common with each other is that they
provide additional input to the PC, and often capture some of the PC's output too. In human body terms
peripherals are like the eyes, ears, nose, hands and feet of the PC.

OPERATING SYSTEM AND SOFTWARE

The Operating System (or OS) such as Windows XP, is a vital piece of software — a compilation of
instructions that tell all the hardware components in a PC how to function to achieve particular outcomes.
This information is interpreted and coordinated by the CPU, but is not confined to CPU functionality. An OS
is a necessity on all modern PCs since without an overarching program to provide core functionality, all the
computer components would not be able to function as a single machine. Additional installed software is
like modular functionality which slots under the OS to perform specific functions or tasks, such as word
processing or gaming. In human body terms the Operating System/software is like a combination of our
basic education, instincts and emotions — the driver behind our behavior that tell us how to act.

Hopefully this information has helped you understand the roles of the various hardware components a little
better. Ultimately a PC is an incredibly complex machine and as such the simplifications in this section don't
do justice to the intricate and multi-faceted ways in which hardware and software components interact with
each other; they're just intended as brief introductions.
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SYSTEM INFORMATION TOOLS

To find out precisely what hardware is running on your PC, and what its various capabilities are, you
require a general System Information tool. System information is vital — for example you must know the
model and chipset type of your motherboard before you can upgrade your BIOS, or to install the correct
motherboard drivers. Or you may be asked to provide details of your PC's specifications so that a Technical
Support person can help you via email. Or you may simply be curious as to what exactly you paid for when
you bought that PC recently.

Fortunately there are many good free system information utilities to choose from, and a combination of
several of these will tell you everything you need to know about your system. These are listed below and I
recommend you download as many of these programs as possible:

WINDOWS SYSTEM INFORMATION TooOL

You can access the Windows System Information Tool by going to Start>Programs>Accessories>System
Tools>System Information, or go to Start>Run and type "msinfo32.exe" (without quotes) and hit Enter. Note
that for this utility to work, you will need to have the 'Help and Support' service enabled - see the Services
Utility section for more details.

The System Information Tool presents a range of basic information about your system. Unfortunately much
of it can be a little difficult to comprehend or may not be quite what you're looking for. Some of the more
useful pieces of information include the IRQ allocations under Hardware Resources>IRQs, the listing of your
hardware components by type under the Components section and a listing of all the system drivers loaded
up and their status under Software Environment>System Drivers.

In general the System Information Tool is best used by medium to advanced users who can comprehend the
interface and the information much easier than a beginning user. Its major advantage is that it is a free and
built-in utility that anyone can easily access in XP.

DEVICE MANAGER

You can access the Windows Device Manager under the Control Panel>System>Hardware tab, or by going
to Start>Run and typing "devmgmt.msc" (without quotes) and then press Enter. As a built-in Windows
utility you can gain a great deal of useful information from this tool. Your major devices are displayed under
various categories, and you can even choose to update individual device drivers or uninstall a device
altogether should you wish. The device manager has many roles and is covered in more detail under System
in the Control Panel section.

DIRECTX DIAGNOSTICS

You can access the DirectX Diagnostic Utility (DXDiag) by going to Start>Run and typing "dxdiag" (without
quotes) and pressing Enter. DXDiag is another built-in Windows Diagnostic/System Information tool that is
part of the DirectX API (See my ATI Catalyst Tweak Guide for more information on DirectX and APIs).
When DXDiag starts up you should cancel anything to do with WHQL (Windows Hardware Quality Labs)
certificate checking - WHQL certification is pretty much a waste of time in my opinion and not an indication

of a driver's stability or functionality (See Step 3 under the Driver Installation Order section for details).

The main tab of DXDiag - called System - shows basic information about your system such as CPU type and
speed, amount of physical RAM and the total pagefile (Virtual Memory) usage among other things. Under
the Display, Sound and Input tabs you can find more information about the particular hardware you are
running for these particular functions, and also conduct some basic tests to ensure they are working to their
full extent under DirectX. In particular you should ensure that all the DirectX Features listed are Enabled
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and that any Acceleration options are at maximum (slider to the far right). If you are experiencing problems
with your hardware you can try the DirectX troubleshooting procedures under the More Help tab.

The most useful function for DXDiag is its ability to create a text file with all your major system information,
including your main hardware specifications, driver files, and environmental settings. To generate this text
file click the 'Save All Information' button found at the bottom of the DXDiag screen. You will be prompted
to save this report somewhere, and the default of the Windows Desktop is just fine. This DXDiag.txt file can
now be attached to an email you can send to a Technical Support person, or its contents can be posted on an
online forum to allow others to help you with any problems you may be experiencing. Don't worry - it
doesn't contain any private information such as serial numbers or passwords.

EVEREST

You can download Everest Home Edition from the Lavalys Website. Once installed, run Everest and you
will find a very clear, easy-to-understand interface which lets you look at the various aspects of your system

such as your Display hardware, Storage hardware, Motherboard type and so forth.

In terms of depth of useful information, Everest is one of the best utilities you can get. For example if you
want to know your RAM's SPD settings (SPD is Serial Presence Detect - See RAM Overclocking under the
Overclocking section), simply go to Motherboard>SPD and you can see your RAM's current SPD timings,
RAM brand and even a link to your RAM manufacturer's website. If you're curious about your
motherboard's chipset type, to install the correct motherboard chipset drivers for example, go to
Motherboard>Chipset and you can see the chipset type and once again a link to the chipset manufacturer's
website. You can even run some memory-related benchmarks under the Benchmark section of Everest to test
your RAM. All in all I highly recommend Everest as a straightforward and information-packed system
information tool.

3DMARK 2005

You can download 3DMark 2005 from the Futuremark Website and you can read more about its main
functionality under the Benchmarking & Stress Testing section in this guide. 3DMark05 is primarily
designed as a graphics benchmarking utility, however it has a nice system information section that gives you
plenty of important info. Start 3DMark05 and on the main screen, click the 'Details..." button under the
System section. A browser screen will open with a vast array of information about your system. Everything

from your CPU's clock speed and L1 & L2 Cache sizes, to your hard drive's capacity and interface type.

SANDRA

You can download Sandra 2005 Lite from the SiSoftware Website. Once installed, run Sandra and you will
be presented with a wide selection of information and benchmarking modules to choose from. Note that
under the free version of Sandra, many of these modules are inactive, however the main ones that we
require retain sufficient functionality for our purposes.

For example, if you want to know more about your CPU, open the CPU & BIOS Information module. It will
display everything ranging from your CPU model to its current temperature. If you want to know more
about your motherboard, open the Mainboard Information module, and once it has read your system
settings, it will display the motherboard chipset type, and a variety of information related to your
motherboard and the types of devices on its various ports. Sandra has several very useful benchmarking and
stress testing features that are covered in full detail in the Benchmarking & Stress Testing section below.

CPU-Z

You can download CPU-Z from the CPU-Z Website. Run CPU-Z.exe and the CPU-Z Utility will provide you
with everything you need to know about your CPU, such as its precise speed, voltage, packaging type, cache
sizes etc. It will also tell you about your system's current FSB speed (See the Overclocking section) under the
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CPU tab, your full motherboard details under the Motherboard tab, and your RAM's complete details under
the Memory and SPD tabs. Note that for information to appear under the SPD tab you will have to first
select the slot(s) on the motherboard that your RAM stick(s) occupy, otherwise the box will be empty.

NERO INFOTOOL

You can download the Nero InfoTool Utility from the CD Speed Website. Run the InfoTool.exe file and you
can see a wealth of information about your selected CD/DVD drives, as well as your drive channels under
the Configuration tab, and even a quick snapshot of your main system components under the Hardware tab.
The main use for Nero InfoTool is to give you precise information about the capabilities of your CD/DVD
drives under the Drive tab, such as the types of media the drive(s) can read from and/or write to, and their
current firmware version for example.

In general I strongly recommend having several of these tools installed on your system, as you will need to
refer to system information often throughout the course of this guide. You must become familiar with the
full details of the hardware on your system if you want to successfully optimize and troubleshoot your PC
now and in the future.
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VIRUS CLEANING

Whether you're going to start with a clean install of Windows XP or you want to tweak an existing
installation, the first step in tweaking actually involves scanning all your current data for viruses and other
kinds of nasty intruders such as trojans and spyware. This must be done before you backup any data, and
before you do any reformatting/reinstallation or any tweaking. That way you can be sure that what you do
from this point onward will not all be wasted due to a virus messing up your system and making you go
through the whole process again. Do not skip this section.

B VIRUS SCANNERS

Viruses are small programs that load onto your computer without your permission and without your
knowledge of their actual function. They are called viruses because just like a human virus they can replicate
and cause damage, attaching themselves to normal programs and files and spreading to other host
computers. Viruses range from the mischievous to the truly harmful. Worms are a variation of viruses, with
the primary difference being that they generally do not attach to other programs. Virus scanners serve a
valuable role in finding these hidden viruses and worms and removing them from your system.

I personally use and recommend AVG Antivirus Free Edition to regularly scan for viruses. AVG is highly
effective, completely free and easy to use. There are a variety of other scanners out there, such as the popular
Norton Antivirus (Note: you can perform a free online Norton scan here), McAfee Virusscan and PC-cillin. I
strongly recommend getting a good antivirus package and using it often. A virus scanner forms the core of

your defense against PC nasties, and will pick up the bulk of viruses and worms which can cause strange
behavior on your system, damage your files and compromise your privacy.

There are many arguments about which virus scanner is 'the best', but any of the ones listed above should do
a suitable job. I have yet to see any experts agree on which single scanner is the most efficient one at
detecting and removing every virus and worm so don't hold your breath waiting. I used to use Norton
Antivirus but found that it basically took over my entire system and took a great deal of work in reining in
its intrusiveness, hence my recommendation that you use AVG. I firmly believe that there is no point
crippling your system just to protect it from viruses. The following is information on how to set up the
recommended AVG Antivirus Free Edition software for optimal performance and minimal intrusiveness in
Windows XP.

AVG ANTIVIRUS

After you download and install AVG Antivirus Free Edition, make sure you select the Update button on the
main screen and download all the latest updates for AVG from the Internet. AVG will update itself
automatically once these have been downloaded. From here you can configure your protection options by
clicking the 'Control Center' button on the main screen. I recommend that you do not have any of AVG's
background protection options enabled as these can conflict with games and applications, generally slow
down Windows XP by using memory and CPU resources as well as slowing down reads/writes to the hard
drive. To disable this functionality in AVG go into the AVG Control Center and do all of the following:

e Select the Scheduler box, and in the bottom of the screen click the 'Scheduled Tasks' button. Double-click
on each of the scheduled tasks listed and in the box that opens, untick all available options to disable
regularly scheduled scanning, updates etc.

e (Click once on the Shell Extension box in the Control Center, and on the bottom of the screen select the
Deactivate button to remove AVG from Windows context menus etc.

¢ Double-click on the Email Scanner box in the Control Center, and click the 'Disable Plugin' button.

e Double-click on the Resident Shield box in the Control Center and untick all the options under the
Properties tab to disable background scanning.
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The final step in removing all the background tasks is to disable the unnecessary AVG-related Services and
startup items. These take up a great deal of resources even after you have disabled much of the background
functionality in AVG itself. Remove the 'Avgcc' item (avgcc.exe) from your startup, and disable the 'AVG7
Alert Manager Server' service. Note however that you should set the 'AVG7 Update Service' to Manual for
AVG's Internet Update functionality to work, otherwise you will not be able to successfully update AVG.
See the Services Utility and Microsoft Configuration Utility sections for details on how to disable services
and startup items.

This may seem like a lot of trouble to go to, but as I have mentioned Virus scanners are notorious for causing
conflicts and slowdowns, and most people don't realize that their virus scanner may be the cause of long
startup times, as well as stuttering or crashes in games for example. AVG Antivirus is one of the less
intrusive virus scanners I have used — Norton Antivirus doesn't even give you the option of disabling many
of its resource-hogging background tasks.

Once all the background and system-intrusive features of AVG have been disabled, you must now manually
scan for viruses regularly. Make sure to update the virus definitions often (at least once a week), and run the
'‘Complete Test' in AVG once a week or more to ensure a clean system. See the General Security Tips section
just below for ways of preventing a virus infection without crippling your system.

B TROJAN SCANNERS

A Trojan, short for trojan horse, is a malicious program that is often installed on your system under the guise
of being another program. Trojans typically attempt to steal information from your system such as
passwords, or control certain aspects of your PC without your knowledge, all for the benefit of the
distributor of the trojan. A trojan scanner will find these trojans and remove them.

I personally use and recommend The Cleaner to scan for trojans. It is available to use as a free fully-
functional 30-day trial. Trojans differ from viruses, and many trojans are not detected by virus scanners, so
you need a dedicated trojan scanner as well. Use The Cleaner to start with, and during its trial period shop
around to find the trojan scanner that suits you best. The following is information on how to set up the
recommended The Cleaner trojan scanner for optimal performance in Windows XP.

THE CLEANER

After downloading and installing The Cleaner, every time you start the program when online it will
automatically check for updates. You should allow it to find and install any required updates. If you wish to
disable this functionality, click on the Options button on the main screen, and under the Update tab untick
the 'Check for updates at startup’ option. To manually find and download updates for The Cleaner instead,
go to the Cleaner Updates Page. Once updated, you should turn off The Cleaner's background functionality,
as once again this can take up resources, cause conflicts with games and applications and slow down
reads/writes to the hard drive. To do this, click the Options button on the main screen and under the General
tab untick the 'Run TCActive at startup' and 'Run TCMonitor at startup' options.

To ensure that The Cleaner has the most likelihood of finding trojans on your system, click the Options
button and under the Scanning tab make sure no file types are being ignored, and tick the 'Scan for hidden
executables' option. You can also tick the 'Scan inside archive files..." option, however I find that this blows
out the scanning time immensely for only a marginal increase in security, so it is not recommended. Finally,
click on the Options button and under the Schedules tab make sure there are no scheduled tasks. Note if the
‘Task Scheduler' service is disabled (See Services Utility section) then The Cleaner can't run scheduled tasks.

As with the AVG Antivirus recommendation above, I recommend checking for updates to The Cleaner at
least weekly and running a full manual scan of your system at least as often to ensure a trojan-free system.
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B SPYWARE/ADWARE SCANNERS

Spyware is similar to a trojan, in that it is software that is usually installed on your system purporting to
have different functionality, or as a component of a useful program. Just like a trojan it transmits information
about you, such as your passwords, Internet usage behavior etc. to the distributor of the spyware. Adware is
a form of spyware that is less malicious as it is mainly used to target online advertising, however again it is
installed without your permission. In either case this software serves no useful purpose and uses system
resources and bandwidth, and a spyware/adware scanner will find and remove them from your system.

I personally use and recommend Ad-aware SE Personal. It is very easy to use and available as a free fully
functional download with no trial limit. You may wish to use Spybot, another free utility that detects
spyware/adware. Note that the bulk of spyware/adware found by these scanners is not always malicious,
and typically consists of tracking Cookies — small files that keep information on your user preferences for a

particular site, or whether you've already voted in the online poll on a site for example. These have no real
impact on performance or security, contrary to popular hysteria. However some spyware, such as
keyloggers, are malicious and will compromise your security for things like online banking, so in general
you should find and remove all spyware and adware from your system - it has no useful purpose
whatsoever and has no place on your system. The following is information on how to set up the
recommended Ad-Aware SE Personal scanner for optimal performance in Windows XP.

AD-AWARE SE PERSONAL

After installing Ad-Aware SE Personal, make sure you update to the latest resource file by clicking the
WebUpdate tool icon - the small button with the picture of the Earth at the top right. Click the Connect
button and agree to download any updates found, and they will be downloaded and installed automatically.
Then install the free Ad-Aware TweakSE Plugin as well to allow access to additional Ad-Aware features.

Fortunately the free version of Ad-Aware SE Personal doesn't have any major system intrusive features or
services which need to be turned off, however to set it up for the most effective scanning performance follow
these steps. First click the Configuration Window icon (the icon with the small cog) then:

e Under the General Settings, put a cross against the Prompt to update outdated definitions' item (i.e.
click on the small green tick mark until it becomes a red cross).

e Under the Scanning Settings, make sure a green tick is against every available option (some are
unavailable in the free version - this is fine).

e Under the Default Settings click on the Read current settings from system' link and check to make sure
the homepage is what you expect it to be, otherwise change it.

e Under the Tweak Settings:

* Scanning Engine - place a green tick against 'Unload recognized processes & modules during
scan’, 'Obtain command line of scanned processes' and 'Scan registry for all users instead of
current user only'.

* (leaning Engine - place a green tick against all available options.

= Safety Settings - place a green tick against all available options.

* Log Files - place a green tick against all available options.

*  User Interface - place a red cross against all available options.

*  WebUpdate settings - place a red cross against all available options.

*  Misc Settings - place a red cross against all available options.

Click the Proceed button when done. Click Start to start a new full scan. Make sure you regularly update Ad-
Aware's reference file and also do a manual scan after any heavy Internet browsing, especially after visiting
unfamiliar or risky sites, and at least once a week.
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B BROWSER HIJACKERS

A certain category of malicious scripts attempt to alter certain aspects of your browser's behavior, such as the
default home page, the title bar of the window, additional toolbar icons etc. - all without your permission.
These scripts are typically called Browser Hijackers, and although the utilities listed above may detect and
remove some of them, there is a specific tool designed to detect and remove these called HijackThis. This
tool is slightly more advanced than the average virus scanner, and riskier to use, however it may be your last
hope if your browser is exhibiting undesirable behavior.

To use HijackThis, download the program and run it, then click the Scan button to begin a scan of your
system. When the scan is complete you will see a list of entries - don't panic, these are not all browser hijack
attempts. Many of these entries are related to legitimate modifications you may have made to your browser,
such as installing a messaging program or changing one of the browser's parameters using the tweaking
information in the Internet Explorer section of this guide. Some entries are required startup items you need
to run at Windows startup (See the Microsoft Configuration Utility section). In any case, it is recommended
that if you have any doubts about a particular entry that you refer to this HijackThis Tutorial to determine
what should be kept and what should be removed. You can click the 'Save Log' button at the bottom left and
save a text log that contains this list on your hard drive. You can post the contents of this log on an Internet
forum (using the instructions at TomCoyote), or attach it to an email to a tech support person.

If you just want to restore your browser to its default settings and don't care about losing any of your
customizations, then place a tick mark against every item on the list (left-click on the small box next to each
item), then click the 'Fix Checked' button. Note that HijackThis keeps a backup of your changes under the
Config>Backups section of the program, so if you need to undo these changes you can highlight a backup
and click the Restore button to return to the state you were in before HijackThis changed anything. You may
need to go through this guide and re-tweak your startup items and any customizations you may have lost.

To keep HijackThis updated, make sure you are online then click the Config button, click the 'Misc Tools'
button and use the small black triangle at the bottom right of the screen to scroll down the options list. Click
the 'Check for update online' button to check for a newer version of HijackThis and be sure to download and
install any available updates.

That covers the main scanning tools you need to remain free of malicious software. Of course there are
many, many different scanners out there and all purport to be vital to a safe, secure system. However the
recommended scanners covered above, if kept up-to-date and run regularly in conjunction with each other,
should keep your system clear of malicious software and yet also allow Windows XP to function optimally.

B GENERAL SECURITY TIPS

Below are a range of tips for minimizing your exposure to malicious software. Prevention is far better than
cure in this case, so keep the following tips in mind when online:

EMAIL

e Avoid opening any emails from unfamiliar senders, especially if the subject of the email seems
suspicious or inappropriate. Delete the email straight away.

e If you do open an unfamiliar email, don't click any of the links in it especially any links which
supposedly remove you from their mailing list — these are used by spammers to verify that the email
address is 'live' (i.e. a real person is reading their spam) and hence send you even more spam. For the
same reason, never send any kind of reply to spam, however tempting it might seem.

e Never provide your real name, address or any details in an email to an unverified source. If you receive
an email purporting to be from your bank or financial institution for example, never follow any links
they provide, however genuine they appear, and never verify your password, credit card numbers, etc.
with them. No reputable institution uses email to verify important details. Some of these scam emails
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refer you to a fake mirror image of your financial institution's website where they trick you into
revealing your credit card number and password on a phony login screen. To be sure you are going to
your actual financial institution's website, manually enter their website address into your browser and
then follow the relevant links to your online banking login screen. Links in emails can be 'masked' — that
is they can seem real but the actual link is different to the underlined hyperlink text shown.

e Never open or save an attachment from a suspicious email. Specifically, never open any zip files from
such emails even if you're intensely curious about what's inside, and quite obviously never run any
screensaver (.scr), executable (.exe, .bat) or even picture (.jpg) files that are attached. The file types are
often fake, and what you believe is a harmless file actually turns out to be malicious software.

e Never install any 'security patches' or 'important updates' that have supposedly been emailed to you
from Microsoft or a software vendor or financial institution for example. Software companies like
Microsoft never send out updates or patches via email — always refer to the secure Windows Update site
or the software providers' homepage for updates. Again, never follow any provided links to an 'update
site', manually type in the link to your software provider's page and check for updates there.

e Never click on links (or type them into your browser) that contain an IP Address at the start (e.g.
http://68.203.11.34). There is an obvious reason why these links don't provide a name — because the name
would tell you the site is a scam site, or not what it purports to be.

For Outlook Express users see the Outlook Express section later in this guide for details of how to set up OE
to filter most spam and also prevent harmful files from being easily accessible in emails.

INTERNET BROWSING

e If you are using Internet Explorer as your browser you must run the very latest version to ensure
maximum security. This means you must have installed Windows XP SP2, and also have visited the
Windows Update site recently and downloaded and installed all important updates.

e Try to avoid visiting sites that purport to provide free pirated software, free music, movies, pornography
etc — basically anything that seems too good to be true. Aside from often being illegal, 99% of these sites
don't actually contain anything of value, they are just fronts to get your traffic and earn money from
advertising clicks or referrals to other websites which then continue the cycle of advertising and false
referrals. Aside from the annoyance factor, such sites will often install malicious software on your
system such as spyware or trojans, or engage in browser hijacking.

e Never install any software or plugin for your browser that does not come with a certificate. Even if a
website insists that you must install certain software in order to view their content or perform a function,
ignore or cancel all such attempts unless the site is reputable. The most common software you require
for Internet multimedia functionality are the Macromedia Flash and Shockwave players, which you can
install safely by going directly to the Macromedia Website and installing the latest versions from there.

e If a site tells you that you will be connected to a secure encrypted server, once connected you can verify
this by looking in your browser's address bar and seeing https:// in front of the address (note the
difference between http:// and https://). To verify the credentials of a supposedly secure site before
entering any sensitive details, double-click on the padlock icon which appears in the Status Bar of the
browser and make sure the certificate is verified as being issued to the web address or name of the
company you believe it to be (e.g. Microsoft.com). If there is no padlock the site is not fully secure.

e Consider switching to a more secure Mozilla Firefox browser that is both free and easy to use. It can be

configured to look almost exactly like Internet Explorer, has virtually identical functionality, but is more
secure than Internet Explorer and virtually invulnerable to spyware. For more information see Other
Internet Browsers under the Internet Explorer section.

See the Internet Explorer section later in this guide for details of how to set up your browser for a good
balance of security and functionality.
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PEER-TO-PEER, MESSAGING AND IRC PROGRAMS

e If you use a peer-to-peer (e.g. Emule or Kazaa), instant messaging (e.g. ICQ, MSN or AIM) or an Internet
Relay Chat (IRC) program (e.g. mIRC) which can send and receive files, you must carefully go through
their configuration options and ensure that you are not sharing files or directories which contain
potentially sensitive information. If you must swap files using such programs, I strongly recommend
that you create a new empty folder and only allow download and upload access to this folder. Then
place copies (not originals) of all the files you wish to share into that folder, and disallow access to any
other directory or drive on your system. Note that many games and applications have files in their
directories which contain your serial numbers or passwords, and the use of peer-to-peer programs in
particular may see unscrupulous people access this information for their own benefit.

e Change your messaging and IRC settings so that you do not automatically accept downloads or
messages from people who are not on your contact list.

¢ Do not download or install any software which purports to allow you to steal other peoples' passwords
or serial numbers, or which lets you "hack Hotmail" for example. Ironically these are usually trojans
designed to steal your passwords and serial numbers. These types of programs are often given tempting
names, such as the name of the latest popular album or game.

¢ Before downloading a file from a peer-to-peer program you can usually tell if a file is real or fake by the
number of people who are sharing it: the less people available to share a particular file, the more likely it
is that it is either another file with a deceptive title, or worse it is a virus or trojan.

Sharing and downloading files over P2P is one of the most risky things you can do on your machine, and it
is strongly recommended that you minimize your exposure to such programs. If you engage in a lot of file
sharing then you might want to consider enabling all the background scanning functionality in the virus,
trojan and spyware/adware tools discussed above. In general whenever you believe you've downloaded a
suspicious file or program, or if you've been browsing "risky" sites on the Internet or engaging in a lot of P2P
file swapping, at the end of your session close all open applications and run a thorough manual scan of your
system with all the scanners mentioned in this section just to be safe.

ENCRYPTING FILES

If after reading all these security tips you suddenly feel the urge to protect certain files on your system even
more carefully, you can do so by using Windows XP's built-in File Encryption technology (on systems
formatted with NTES). To encrypt a file, open Windows Explorer, go to the file you want to encrypt and
right-click on it, then select Properties. Click the Advanced button at the bottom of the General tab, and
select 'Encrypt contents to secure data' and click OK then Apply. You may be shown the option to encrypt
the entire folder, in which case select to do so for maximum security but note that all the folder's contents
will also be encrypted. Now only a user with your account password and login can access the file. For all
other users the file will remain encrypted and inaccessible. You can give access to other users manually by
going back into the file's Properties>Advanced and clicking on the Details button and adding in a user.

If you're interested in more detailed Windows XP security information, read the Microsoft Windows XP
Security Guide.

B BALANCE SECURITY AND PERFORMANCE

I'just want to say that despite the panicky warnings security experts provide, I really don't believe you have
to have a million scanners running in the background slowing down your machine and crippling your
Internet functionality to keep you protected — just like you don't have to drive at 15 mph just to avoid having
accidents on the road. At the end of the day it is up to your specific needs as to how secure you make your
system. I believe that some basic knowledge, common sense and reasonable caution are all that is needed. By
using the advice and software recommended above you can remain protected against any harmful effects
from malicious software without sacrificing any performance whatsoever.
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BACKUP & RECOVERY

Once you are sure that your system is completely free of malicious software, the next step involves making
sure you have a backup copy of all your important and irreplaceable documents before commencing any
tweaking. Backing up is an unavoidable part of sensible computing so familiarize yourself with the
techniques in this section and use the most appropriate one(s) before proceeding with this guide. I
recommend at the very least a manual backup of all your important data if preparing for a reformat and
reinstall of XP, along with a new System Restore point and a full backup of your Windows Registry if
tweaking an existing installation of XP.

B MANUAL BACKUP

The following is a checklist for creating a manual backup of your data and settings in Windows XP. There
are several commercially available programs that can be used to create backups of your system, however I
personally use the method below to ensure I have a backup copy of all my important files, especially if I am
going to do a 'clean' installation of Windows XP. Any automated backup utility you use may inevitably
backup the problematic or sub-optimal settings you were trying to escape by reinstalling Windows anyway,
so a manual backup is strongly recommended. You can follow all the steps below, or only the more
important ones (Steps 1 - 4):

1. Backup all your important files/programs to another medium, such as another hard drive, or ideally to
blank CDs or DVDs. This is important simply because all hard drives eventually suffer from physical
failure which renders them totally or partially unreadable, not to mention more common software
problems which can erase or damage your data at any time, especially if you overclock your system.
When selecting which files to regularly back up, give top priority to files that are genuinely
irreplaceable, such as digital photos and financial documents. Anything that has a high sentimental or
monetary value should be backed up often to at least one other location or more if you can manage it.

2. If you don't already do so, from now on whenever you download a program or file from the Internet,
keep a copy of it for backup purposes. That way you don't need to re-download it again after a reinstall
of Windows for example. Ideally you should always download the full version of large system-critical
files (such as DirectX or Service Packs) and keep a copy to speed up future reinstalls.

3. Backup your Internet Bookmarks. In Internet Explorer you can do this by going to File menu>Import
and Export>Export Favorites. Follow the prompts to export your Favorites to a suitable location under a
single filename (the default name is Bookmark.htm). Back this file up, and you can then import your
Favorites back into Internet Explorer by going back to the Import and Export function and choosing
'Import Favorites'. If you use a browser like Mozilla Firefox, you can backup your favorite bookmarks
by going to the Bookmarks menu, selecting 'Manage Bookmarks', then selecting File>Export and
choosing where to save the Bookmarks.html file.

4.  Make absolutely certain you write down all the usernames and passwords you need to use on your
system. Don't store them in a document on your computer, as these can be compromised by trojans or
someone hacking into your system, or by another user. Store them safely in a physically secure place.
Remember, if you have any encrypted documents or password protected archives and you forget the
username/password they may be lost forever. Modern security measures under the Windows XP NTES
environment are very difficult to defeat. For more information on backing up and retrieving passwords
see the Backing Up and Restoring System Passwords section below.

5. If you want to manually restore everything to exactly the way it was after you reinstall XP, take some
screenshots of your desktop and even your various menus and favorite program settings. You can do
this by pressing the PRINTSCREEN key on any screen and then opening an application like MS Paint
and selecting Paste. Save these files in .jpg format with appropriate names (e.g. Desktop.jpg), and they
will remind you of exactly what your settings, icon placements etc. looked like. You can also backup the
.ini, .cfg or .con files in some program folders. These types of files typically contain your customized
settings, however I don't recommend doing this if you've experienced any problems with these
programs - copying the configuration files of problematic games or applications may simply perpetuate
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the problem on your new install of XP. Remember, as much as possible we want a 'clean' environment
after a fresh reinstall.

6. If you want to backup any saved games or game settings, these are typically held under the game's main
directory under a Saves, Savegames or similar subdirectory.

7. Don't backup entire program folders or bits and pieces of installed programs (aside from saved games)
as these will not run properly if they are copied back onto another installation of XP due to the lack of
registry entries, critical files in the \Windows\System directory, and so on. You must use the original
installation files or CDs to reinstall a program correctly.

B AUTOMATIC BACKUP

If you want a more comprehensive method of backing up your data that will take up more space but is more
foolproof and automated then you can use the Windows Backup Utility. Note that if you are having any sort
of system problems, I do not recommend using this method to backup your data and settings. This method
will ultimately capture and transfer the same problems you experienced before onto your new install of
Windows XP — defeating the whole purpose of doing a fresh install of XP. Only use this method if you aren't
experiencing any problems and have trouble-free performance.

You can access the Backup Utility by going to Start>All Programs>System Tools>Backup, or by going to
Start>Run and typing "ntbackup" (without quotes) and pressing Enter. Windows XP Home users will not
have access to the Backup utility by default, but it can be manually installed from the Windows XP Home
CD by following the instructions in this Microsoft Article. Basically it involves inserting the Windows XP CD
into your drive, opening Windows Explorer, going to the \VALUEADD\MSFT\NTBACKUP\ directory on
the Windows CD and double-clicking on the Ntbackup.msi file to start the installation of the utility.

The Backup Utility has several methods of usage, which are detailed in this Microsoft Article, but essentially
it involves the following steps:

1.  Run the Backup Utility and click the 'Advanced Mode' link to switch to a more customizable method of
backing up.

2. Go to the Backup tab, and put a tick in the boxes next to the directories that you want to back up.

3. Select the 'System State' box to ensure all the additional system settings relating to your setup are
backed up as well (i.e. your Registry settings etc.).

4. Click the Browse button at the bottom, and select the destination for the backup. This can be a floppy
disk drive, another hard drive, your CD/DVD writeable drives, another location on your network, etc.

5. Click the 'Start Backup' button to commence backing up. The process may take quite some time
depending on how many directories you chose to back up, and the type of medium to which they are
being transferred.

6. To restore this backup in the future, run the Backup utility again, but this time under 'Advanced Mode'
click the 'Restore Wizard' button and follow the prompts.

B SYSTEM RESTORE

Once the initial backing up of your irreplaceable data and programs is done, if you are not going to reformat
and reinstall Windows XP you need to create a new System Restore point as an additional safeguard before
starting any tweaking. Using System Restore means that even if you make a large number of changes you
can easily take your system back to the way it was before these changes were made. It is strongly
recommended that you create a Restore Point before implementing any of the tweaks in this guide by
following these steps:

1. Open MSConfig (Start>Run>MSConfig), click the Launch System Restore' button. Alternatively, go to
Start>Programs>Accessories>System Tools>System Restore.

2. In the System Restore Wizard, click 'Create a Restore Point' and follow the prompts to save your system
state in a new restore point.
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3. At any time, if you wish to return your computer to the state it was in when you created the Restore
Point, follow step 1 above to get to the System Restore Wizard. Then click 'Restore my computer to an
earlier time', and select the date on which you created the restore point you wish to return to.

Note if you want to clean out older restore points - thereby freeing up a great deal of hard drive space - you
can use the Disk Cleanup utility (see the Disk Cleanup & Defragmentation section). Also note that System
Restore will not function if you've disabled the System Restore service — see the Services Utility section.

B BACKING UP THE WINDOWS REGISTRY

The Windows Registry is a critical component of Windows XP, and any problems you experience with it can
make Windows unbootable, or result in a variety of errors or strange behavior (See the Registry Editor
section). That is why it is important to have a backup of the Registry before undertaking any tweaking.

The most efficient and foolproof way of backing up the entire registry is not to use the Export function in
Registry Editor - that method is only handy for saving individual branches of the Registry. Unfortunately
full Registry backups made by Registry Editor will not restore correctly if your registry becomes corrupted.
Instead, I strongly recommend you use a free utility called Erunt that is the Emergency Recovery Utility for
NT. Download this program and install it. Note that during the installation of Erunt you should answer 'No'
when asked if you want Erunt to be placed in the startup folder, as this is unnecessary.

To make a backup of the Windows Registry using Erunt, launch the program. You will be prompted to
backup your registry to a folder, which you should accept by clicking Ok until the backup has been made. If
you want to restore this backup at any point, simply go to the directory where the backup was made,
typically \ Windows\ ERDNT\[Date of backup]\, and launch the ERDNT .exe file there to restore that backup.

B SYSTEM RECOVERY

After any changes you make to Windows XP, if your system is crashing and you're having major problems
booting into Windows, it is typically because the Windows Registry contains unsuitable or corrupted
settings. If you can't boot into Windows to use System Restore or Erunt to restore your system or registry,
follow one of the steps below:

e During bootup, keep pressing the F8 key and you'll soon see an option to 'Load last good configuration'.
Select it and your computer will boot into Windows, hopefully devoid of the changes you made which
caused any recent serious problems; or

o If you have a recent Restore Point, but can't boot to the Windows desktop for some reason, keep pressing
F8 during bootup, but this time choose the option to 'Boot into Safe Mode' (See Safe Mode under the
Troubleshooting section for more details). In Safe Mode you can access System Restore by going into
Control Panel>System and selecting the System Restore tab, and following the method outlined further
above to restore an old restore point; or

o Alternatively you can press F8 repeatedly at bootup once again, and this time select to boot into 'Safe
Mode with Command Prompt, and at the command prompt which opens type
"C:\Windows\ System32\ Restore \ rstrui.exe" (without quotes) to open System Restore.

For more details on how to recover from a corrupted Registry, see this Microsoft Article. For more details on
how to identify the cause of potential problems, see the Troubleshooting section.

For those extreme cases when you've somehow managed to completely delete the information on your hard
drive and want to perform a recovery, read this Hard Drive Recovery Article for more details of techniques
you can undertake. Also see the Recycle Bin section for information on how to perform some basic data
recovery from your drive, as well as the Troubleshooting section for details on the Recovery Console.
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B BACKING UP AND RESTORING SYSTEM PASSWORDS

One of the biggest headaches when running Windows XP would be losing your login password, particularly
if you're the System Administrator on your machine. With the NTFS file system it is virtually impossible to
access the data on your hard drive without the correct login password. Clearly the best thing to do is back
up your password now before anything happens, so that if necessary you can restore it without pulling out
all your hair. Instead of writing your login password down, the correct way to back it up is as follows:

BACKING UP LOGIN PASSWORD

1. Go to Control Panel>User Accounts and click on your User account.

Click on 'Prevent a Forgotten Password' in the left pane. The Forgotten Password Wizard will open up.
Click Next.

3. Insert a blank formatted 3.5" floppy disk into your A:\ drive and click Next. If you need to format a
blank floppy first, insert the disk into your floppy drive, open Windows Explorer, right-click on A:\ and
select Format. Click Next.

4. Type in your current User Password in the box and click Next. Once the disk has been created, click
Next and select Finish. Store this disk somewhere very safe, as anyone can use it to access your account.

Note that most people will use any old 3.5" floppy they find to backup their password and typically these
disks are quite old. A floppy disk has an error-free life of about 10 years on average, so I would strongly
urge you to buy a fresh box of 3.5" floppies for this purpose. Nothing is worse than when the time comes to
restore your password (or flash your BIOS) and the floppy has an error and screws up your system.

RESTORING BACKED UP LOGIN PASSWORD

If you ever need to restore your password from the disk created above, follow these steps:

1. Boot your PC as normal, and on the Windows Login screen select your User Name.
Without entering anything, press the Enter key once and you should see the 'Did You Forget Your
Password?' message. Select the 'Use Your Password Reset Disk' and insert your password reset disk.

3. Follow the Password Reset Wizard to set a new password and log back into your system.

Note that the password reset floppy disk needs to be write-enabled (hole closed) so that Windows can
update your disk with the new password automatically during this procedure. When done, you should once
again put the disk away in a very safe place.

RECOVERING OTHER PASSWORDS

To recover Internet passwords stored in Internet Explorer or your Outlook Express passwords you can use
the Protected Storage PassView Utility. This utility lets you see the username and password for each
site/email account on your system. Alternatively if you have forgotten a password which is now only visible

as a series of ****'s you can try using Revelation or Asterisk Key to show you the actual password being

used. Finally, you can use RockXP to retrieve a series of passwords and keys on your Windows installation
that are usually hidden. Detailed usage instructions for the utilities above are not provided here because
quite frankly I don't approve of these tools when used in the wrong hands. However they are provided here
as a last resort for people who have genuinely lost or forgotten passwords and urgently want them back.
Hopefully the presence of these tools lets you see that nothing is completely safe on your machine, so the
most important security tip is to always restrict physical access to your machine to trusted individuals.

While the tweaks in this guide are safe for the most part, there are times when human error, Act of God or a
rare incompatibility may result in problems. Or you simply may not be happy with the changes you have
made. As mentioned in the Using this Guide section, I cannot take responsibility for any data loss or damage
that occurs from using this guide. Get in the habit of backing up regularly if you don't already. Once you're
satisfied that everything is backed up and secure, you can proceed with the rest of this guide.
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BIOS OPTIMIZATION

An often-overlooked, yet extremely important aspect of tweaking your system is the BIOS (Basic
Input/Output System). If there is an incorrect setting in your BIOS - that is a setting which is not optimal or
correct for your hardware configuration — then you will have problems regardless of what you change in
Windows, or which driver versions you install.

uoneziundo SOId

The BIOS is a program held on a small ROM chip on your motherboard. It provides the instructions for what
your PC should do as soon as it turns on. Your BIOS is independent of your Operating System, which means
that it is not affected by which operating system you use, or which version of drivers you've installed, or
what your settings are in Windows for example. The BIOS supersedes all of that, and your drivers and
operating system will load after the BIOS has already loaded up. The BIOS controls a range of hardware-
related features and is the 'middle-man' between your CPU and all the attached devices in your system.

B BIOS POST SCREEN

As your BIOS starts to load, the first thing it does is the Power-On Self Test (POST), a diagnostic program
which checks your components and makes sure everything is present and working OK. The POST sequence
is usually extremely fast. You will only really notice it if it stops when encountering an error. POST error
messages can be a bit obscure, but usually give you a lead as to where to look in your BIOS settings. A quick
general guide to what the startup error beeps mean is this POST Error Codes, but a more accurate
description is usually found in your motherboard's manual.

If you have no POST errors you will see your PC's startup screen, which shows such information as your
BIOS type (e.g. Award BIOS), the key to press to access your BIOS settings (e.g. DEL, ESC or F2), the type of
processor and its speed, RAM amount and RAM test results, drive information, and so on. Note that if any
of this information is clearly incorrect, it may be that your hardware is extremely new and hence not
recognized correctly by the BIOS, you've overclocked your PC too far, or you have bad hardware or related
BIOS settings.

At this point, if you quickly press the indicated key (usually DEL) repeatedly you can access your BIOS
settings screen. If your BIOS has a password then you'll have to enter it first to access your BIOS settings. If
you've forgotten the password, then try the following site BIOS Passwords.

B BIOS SETTINGS

To access the settings in your BIOS, you typically need to press a particular key (usually the DELETE key)
repeatedly as your system is booting up. Once in your BIOS screen you will see a multitude of settings — the
layout of the BIOS, and the names of the various settings will vary depending on the particular motherboard
brand and model you own. It is not possible to go into detail here about all the possible settings, and how
you can tweak your BIOS - it would simply take too much space to cover properly. The best thing to do is go
straight to Adrian Wong's The Definitive BIOS Optimization Guide (scroll down to find the 'Free Access' link
to the guide). It covers all the common BIOS settings in detail, and combined with your motherboard's
manual it allows you to undertake the very important task of optimizing your BIOS settings before doing
any Windows tweaking. I cannot stress the importance of making sure all the major settings in your BIOS
are correct for your particular hardware setup — it may take some time but it ensures maximum performance
and stability, and no amount of software tweaking can overcome a badly set up BIOS.

If you're planning on reinstalling Windows XP, the Interrupt Requests section further below contains one
very important reason why the BIOS is best tweaked before Windows installation.
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B BIOS UPDATES

The BIOS is actually written on a rewriteable ROM chip, which means that it can be updated (or 'flashed')
with new information. Motherboard manufacturers often release new BIOS versions that can improve
performance, stability and compatibility, add new features or modify existing features, and fix known bugs.
These new BIOS versions are available for download on the manufacturer's website. I can't list all the
manufacturer websites here, as there are far too many (and the links often change) however if you have a
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look through your motherboard manual you should see a relevant link to the appropriate website.

Download the latest BIOS for your exact motherboard brand and model and follow the instructions on the
site to Flash (reprogram) the BIOS chip on your motherboard with this new BIOS version. A word of
warning — flashing the BIOS is not to be taken lightly. If something does go wrong then your PC may not
boot up and you may have to take your motherboard to a dealer to have the memory chip replaced. While
this is rare, when updating your BIOS make sure you follow the instructions provided to the letter and
things should go smoothly.

B INTERRUPT REQUESTS (IRQS)

Interrupt Requests (IRQs) are the way in which all of your major system devices get the CPU's attention for
instructions/interaction as often as necessary. There are at least 16 IRQs (numbered 0 — 15) in a PC, with most
newer PCs having 23 or more IRQs. To view your current IRQ allocation go to Control
Panel>System>Hardware>Device Manager and under the View menu select 'View Resources by Type', then
select the 'Interrupt Request’ item. You will see all the devices currently active on your PC arranged by IRQ
number, starting at IRQO [System Timer].

Each IRQ has a priority assigned to it as to which gets the CPU's attention first when several are competing
at once. While Windows XP is designed to allow several devices to share an IRQ, you may have problems or
reduced performance if two or more major devices (such as the sound card and graphics card) share the
same IRQ.

DISABLE UNUSED DEVICES

Under Windows XP, as this Microsoft Article explains, ACPI (Advanced Configuration and Power
Interface)-compliant systems - which is most modern PCs - will have their IRQs automatically allocated by

Windows upon installation. Even if you manually attempt to reassign them in the BIOS (if the option exists),
Windows XP typically assigns them back to the default IRQs. This default assignment of the IRQs is done
when Windows XP is first installed, and eight IRQs (IRQs 0, 1, 2, 6, 8, 9, 13 and 14) are automatically
reserved for critical system devices on all PCs and cannot be altered or reassigned. The best way to ensure
that you are less likely to end up with shared IRQs (and potential problems) is to disable any unused devices
in the BIOS before installing Windows XP. The most common devices that can be disabled are:

Serial Portl (COM1)
Serial Port2 (COM2)
Parallel Port (LPT1)
Game Port

Midi Port

Secondary IDE Channel

Disabling unused devices not only frees up unreserved IRQs and reduces the chances of sharing, it can also
speed up bootup time noticeably. Clearly if you already have, or plan to have, a piece of hardware connected
to any of these Ports then you should not disable them. For example if you have a printer which connects to
the Parallel Port (LPT1) then disabling the Parallel Port in the BIOS will simply mean your printer will not
function. If you have two or more system drives which connect to an IDE channel, then you cannot disable
that IDE channel and expect the drives to work. You can always re-enable these devices in the BIOS at any
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time, so this is by no means a permanent disabling of particular devices. However you should only disable
devices that you are certain will not be used during your normal Windows usage.

MOVE CONFLICTING DEVICES

If you are using an existing installation of Windows XP you can still attempt to reduce IRQ sharing. Note
however that on certain motherboards particular IRQs are shared by default and cannot be changed. For
example on many Intel-based motherboards IRQ16 is often shared by both the AGP Port (Graphics card) and
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the USB Host Controller (USB Peripherals) - this is unavoidable and usually does not result in any problems.
In such cases where you feel there may be a conflict or reduced performance, your only course of action is to
move one of the items to another physical location on your system. In the example above, it would be best
not to use a USB device on the particular USB Host Controller that is shared on IRQ16 to ensure optimal
graphics performance.

To attempt to reduce IRQ sharing on existing XP installations, you should first disable unused devices as
instructed above and see if Windows reallocates the free IRQs upon rebooting. Disabling unused devices is
always recommended if only because it improves general performance, such as speeding up initial Windows
start times. However it is likely that it will not result in IRQ reallocation, in which case a more successful
method is to physically shift one of the devices sharing an IRQ if possible. For example, if your sound card is
sharing an IRQ with your graphics card, shift the sound card from one PCI slot to another free one. If you
have a particular USB Host Controller sharing with a major device, try plugging your USB device into
another free USB port so that it uses another USB Host Controller.

DI1SABLING ACPI

There is one final method of reallocating IRQs short of reinstalling Windows. Since ACPI is one of the
reasons why Windows XP automatically allocates IRQs, if you disable ACPI you can manually allocate and
rearrange IRQs and hence remove any IRQ sharing. I strongly recommend that you do not disable ACPI, as
the side effects are much worse than any problems IRQ sharing could cause. ACPI is there for a reason -
disabling it can effectively destabilize your system and cause your components not to function correctly. The
instructions provided below are for the sake of completeness, and for the truly desperate or the very curious:

1. Backup all your important data before attempting this procedure as it is highly risky.
Go into your Control Panel>System>Hardware>Device Manager and under the Computer component,
double-click on the 'ACPI Uniprocessor PC' (or similar ACPI) device.

3. Click the 'Update Driver' button, then select 'Install from a list or specified location'.

Select 'Don't search. I will choose the hardware to install'

5. Untick the 'Show compatible hardware' box, and in the list below click on the 'Standard PC' option and
select Next.

6. The non-ACPI drivers will be installed and you will need to reboot your machine, perhaps several times,
to redetect all your hardware components. Make sure to disable any ACPI options in your BIOS.

7. You can now use any BIOS options available to manually assign IRQs to particular devices. Note that it
depends on your particular BIOS as to how much flexibility you have in assigning IRQs to all the devices
on your system. Disabling ACPI doesn't suddenly add any new BIOS options.

b

I can only repeat that disabling ACPI will cause a lot of problems, and you may not be able to return to using
ACPI unless you reformat and reinstall Windows XP completely. Please undertake these steps at your own
risk, as they are not recommended at all.

If you have major IRQ sharing difficulties, ultimately anything short of a reformat/reinstall of Windows XP
is unlikely to work in a suitable manner because of the way existing Windows XP installations will simply
reallocate the same IRQs to your devices on ACPI-compliant systems.
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SETTING IRQ PRIORITY

The following tweak is generally considered to be non-functional in Windows XP, as it does not recognize
this setting in the Registry. However it is included here for the sake of completeness - and because it does no
harm to implement it - but for all intents and purposes you do not need to use this tweak.

[HKEY LOCAL_ MACHINE\SYSTEM\CurrentControlSet\Control\PriorityControl]
IRQ8Priority=1

Determine the IRQ of the device you want to give top priority. Create a new DWORD with the IRQ number
you want to assign a priority to (e.g. IRQ5Priority) and give it a value which determines its priority (e.g. a
value of 1 gives it the highest priority). It was often recommended that the 'System CMOS/Real Time Clock'

(IRQ8) be given the top priority to provide greatest overall system boost.

uoneziundo SOId
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FORMATTING THE HARD DRIVE AND INSTALLING WINDOWS XP

If you are going to reformat and reinstall Windows XP on your hard drive, follow the procedures in this
section to ensure the correct setup of your hard drive and optimal installation of Windows XP.

B PREPARING TO FORMAT

Here's a general rundown of things you should do prior to formatting your hard drive:

1. Scan for viruses and other malicious software — See the Virus Cleaning section.
Backup your data and passwords - See the Backup & Recovery section above.

3. Download and back up all the latest drivers for your hardware. This includes the latest version of
DirectX and Windows XP SP2 - See the Driver Installation Order section.

4. Download and back up the various utilities we will be using later in this guide - See the various sections
of this guide such as the System Information Tools, Installation of Applications and Games and Backup
& Recovery sections for example.

5. Create some Windows XP Bootdisks if necessary - See Windows XP Bootdisks further below.

6. Importantly, read this Microsoft Article on partitioning and formatting hard drives.

Here's a quick checklist of things you should have nearby to execute a smooth installation of Windows XP:

e Your original Windows XP CD.

¢ Your Windows XP Product ID Number.

¢ Your Windows XP Bootdisks.

e An earlier 'Full Version' CD of Windows if you are using a Windows XP 'Upgrade Edition'.

e Any drivers which have to be installed during the Windows installation process — e.g. some
motherboards require a floppy disk with SATA drivers to be used during the XP installation process in
order to detect your hard drive correctly.

e Your motherboard manual and a printout of relevant sections of The Definitive BIOS Optimization
Guide, a printout of this guide, and any other associated articles or guides you may need. Remember,
you should not connect to the Internet immediately after installing XP, so you will need offline or hard
copies of these guides in prepared advance.

e (CDs/DVDs/Floppy Disks containing the latest drivers for your hardware. These should have been
downloaded earlier, but in some cases you may only have the original driver disks that came with the
hardware.

e All your backups, as well as retail versions of applications and games on CD/DVD. Also make sure to
have any software serial numbers or registration details handy.

e Pen and paper for recording passwords, registration numbers or other important information.

Once you've gathered as much of this material as possible around you, familiarize yourself with the
information below before finally beginning the actual formatting and installation process.

SLIPSTREAMING WINDOWS XP SP2

If you own an older Windows XP CD that does not contain SP2 already built into it, you can create a new
Windows XP CD that incorporates all the files from SP2 using a process called 'Slipstreaming'. When a
slipstreamed XP CD is used for installation it automatically installs SP2 along with the rest of Windows XP,
and hence you won't need to run SP1 or SP2 separately after installation, nor do you need to worry about
any outdated files being installed on your system first, or any SP2 installation problems. It's a detailed

process, but relatively straightforward when you use this Windows XP Slipstreaming Guide. Using a
slipstreamed CD is the recommended method for installing Windows XP SP2, but is not vital, so if you don't
feel comfortable doing it you can skip this step.
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NTFS vs. FAT 32 FILE SYSTEMS

During the formatting of your hard drive, you will be asked whether you want to use the NTFS (NT File
System) or FAT32 (File Allocation Table) File System for the drive. This is an important choice and the
answer depends on your requirements:

Use FAT32 if
e Your hard drive is smaller than 32GB.
¢ You want to install more than one operating system on your computer.

Use NTFS if

¢ Your hard drive is larger than 32GB and you are running only one operating system on your computer.
¢ You want enhanced file security.

¢ You need better disk compression.

For more details of the differences read this FAT & NTFS File Systems Article. Essentially NTFS is a newer,
more stable and much more secure file system that has several benefits FAT32 doesn't. For example, if you
format your hard drive in NTFS and password protect it, no one can access the information on the drive
without the correct password, even if they physically steal it. As for the speed difference, for larger drives it
is negligible. For more details on the features of NTFS, read this NTFS Tech Article. In my opinion the
benefits of NTFS make a strong case for formatting your drive in NTFS, unless you have a very small drive
or want to install more than one Operating System on it (See Dual Boot/Multiboot System below).

CONVERTING AN EXISTING FAT32 DIsK TO NTFES

If you already have a FAT32 drive and don't want to reformat just to use NTES, you can still convert the
drive to NTFS using the Windows Convert tool - however note that this may result in a sub-optimal cluster
size, especially for drives formatted in FAT32 under older versions of Windows. To set an optimal cluster

size you will have to read this Converting Fat32 to NTFS Guide.
The following is the simple method if converting an existing Windows XP FAT32 installation:

1. Go to Start>Run and type "cmd" (without quotes), then press Enter.
In the Command Prompt which opens, type "Convert C: /ESINTFS" (without quotes) and press Enter.

3. Enter the name of your hard drive when prompted. If you don't know the name of the drive, type "Vol
<driveletter>" (without quotes or brackets - e.g. Vol C:) to find it out.

4. Reply Y to each of the prompts. Reboot if prompted.

This will take some time to complete, so leave your system alone until the process is finished.

MULTIPLE PARTITIONS

During the formatting of your hard drive, you have the option to create one large partition which takes up
all available space on the drive, or creating several smaller partitions of various sizes on the drive. These
partitions can hold different information, such as separate Operating Systems (See Dual Boot/Multiboot
System below) or simply fence off different parts of your hard drive under the same Operating System.

Unless you have specific needs I recommend that you create a single partition using all the available space
on your hard drive, on which you install Windows XP using NTES as the sole operating system. In my
experience this will provide the most stable, trouble-free setup for a home PC. Multiple partitions do not
necessarily improve pagefile (Virtual Memory) performance or simulate the performance benefits of having
two or more hard drives, since on a single hard drive the first partition is always the fastest, and
performance is still primarily limited by how fast the single hard drive head can seek (move around to read
or write) information. It can't be in two places at once, whereas with two hard drives, each hard drive's head
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can seek information independently, such as one drive reading game information while the other
concurrently reads/writes virtual memory information in the pagefile.

Some people suggest using multiple partitions for backup purposes — that is one partition holding backups
of your important files etc. separate from the other partition(s). This is not a great idea in my opinion as it is
not a good substitute for having physical backups of your important data on CD or DVD. Hard drives can
and do become physically corrupted, or their components become damaged effectively killing the drive, and
this affects all partitions on the drive. If you mainly rely on backing up to another partition this simply lulls
you into a false sense of security, which disappears the second you discover your entire hard drive is
unreadable and all your data — both backups and the originals - are gone. See the Backup & Recovery section
for more details.

If you want to use multiple partitions and you're after a utility that will make partition management easier,
the most reputable utility available is Norton Partition Magic. Unfortunately it is not free, so I will not be
covering it in detail here, however if you wish to undertake complex partitioning of your hard drive(s) it is a

worthwhile investment.

DUAL BOOT/MULTIBOOT SYSTEM

If you want to set up your system so that each time you bootup you get the choice of two or more Operating
Systems to use - such as Windows XP and Windows 98 - read this Microsoft Article for instructions. There
are no performance benefits in doing this — it is normally done if you use software that only works under
another operating system for example. Once again, unless you specifically require this functionality I do not

recommend a multiboot system. My philosophy is that if you want to minimize problems then keep it
simple all the way.

B FORMATTING AND INSTALLING WINDOWS XP

At this point you are ready to begin the actual format and installation process, which differs depending on
whether you're using a brand new or freshly formatted hard drive as opposed to a hard drive with an
existing installation of Windows.

NEwW HARD DRIVE

If you have a new or reformatted (but empty) hard drive, the entire procedure for formatting the drive and
installing Windows XP is relatively straightforward. Follow these steps:

1. If it's not already in your system, connect the new hard drive to your system by following the
instructions that came with the drive. Typically this involves plugging into the back of the drive both a
power connector and either a wide IDE ribbon cable, or a thin SATA cable.

2. Start your system, go into your BIOS and make sure the hard drive is being detected, whether on one of
the IDE Channels, or as a SATA device - whichever is relevant to the particular type of hard drive and
channel it's connected to. If the hard drive is not detected at all in the BIOS, you cannot install Windows
XP on it. Look around the BIOS and make sure you've enabled the channel on which the drive is
connected. You may have to re-check your drive cabling (i.e. SATA/IDE cable and power cable), and
also whether any small switches on the back of the hard drive are set correctly (e.g. the main hard drive
is typically set as the Master on the Primary Channel). In some cases (mainly for SATA or SCSI drives)
you may have to insert a driver disk into the floppy drive to load up appropriate hard disk drivers
during Windows installation, so have those handy if need be and proceed with the next step.

3. Insert your Windows XP CD into your CD/DVD ROM drive, and reboot your system.

4. Upon rebooting your system, since the hard drive is empty the computer will skip loading from it and
instead will attempt to boot from the next boot device that should be the Windows XP disk in the
CDROM drive. This should lead to the blue Windows Setup screen. If that doesn't occur, check your
BIOS settings to ensure that firstly the relevant CD/DVD ROM drive is being detected as present on
your system and that any option for 'First Boot Device' (or similar) is set to CDROM.
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5. From this point onward, you should follow this step-by-step: Windows XP Pro Installation Guide or
Windows XP Home Installation Guide as relevant. These excellent guides cover the procedure in far
more detail (including screenshots for every step of the way) than I can do here due to space
considerations. You should ideally have a printout of these guides handy for use during the installation.

ALREADY FORMATTED HARD DRIVE

If you have an already-formatted hard drive with a current installation of any version of Windows on it,
follow the steps below to begin a reformat and reinstallation of Windows XP. Note you shouldn't just install
Windows XP over an existing installation of Windows - start afresh with a full reformat and fresh
installation of Windows XP otherwise you will get sub-optimal results:

1. Insert your Windows XP CD into your CDROM drive.
Reboot and go straight into your BIOS settings. Set the 'First Boot Device' (or similar) option in the BIOS
to CDROM. Reboot your system.

3. As your PC is booting up keep pressing the F8 key repeatedly until you see a message saying 'Booting
from ATAPI CDROM'.

4. The blue Windows Setup screen will eventually appear.

5.  From this point onward, you should follow this step-by-step: Windows XP Pro Installation Guide or
Windows XP Home Installation Guide as relevant.

6. Make sure that you choose to format the hard drive and do a clean installation of Windows XP. Again,
do not install Windows XP over an older version of Windows as an 'upgrade' (not to be confused with
the Windows XP Upgrade Edition which is fine) - start with a new installation of Windows XP.

WINDOWS XP BOOTDISKS

If you still can't get to the Windows Setup screen using the instructions above, you can download a
Windows XP Bootdisk image from the Microsoft site for your particular version of Windows XP:

Windows XP Home:

Windows XP Home
Windows XP Home with SP1
Windows XP Home with SP2

Windows XP Professional:
Windows XP Pro
Windows XP Pro with SP1
Windows XP Pro with SP2

Make sure that the version you download matches your Windows XP CD exactly — that is if your CD doesn't
say Service Pack 2 or Service Pack 1 on it, don't download that version of the bootdisk. Usage instructions for
the bootdisks are in this Microsoft Article. Basically the MS Bootdisk program will ask for 6 blank 3.5" floppy
disks with which it can create a startup disk set. This is tedious, but once created you then insert the first
floppy of the bootdisk set into your floppy drive (make sure 'Bootup from Floppy' or similar is enabled in
your BIOS), reboot and your PC should eventually reach the blue Windows Setup screen and you can then
continue as per step 5 above.

Once you've successfully installed Windows XP and booted into Windows for the first time you can follow
the rest of the guide.
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WINDOWS PRODUCT ACTIVATION

One of the first things you will notice when Windows XP has finished its installation procedure and has
booted into Windows for the first time is the Windows Product Activation (WPA) notice. Even if you skip
Activation at Windows startup and go to the Windows Desktop, a little popup balloon in the System Tray
tells you that you have 30 days left to activate Windows XP, and when you click on it, it provides various
options for activation.

So what is Activation? It is a protection system Microsoft uses to ensure that Windows piracy is reduced. If
you're interested in the facts about Windows Activation, how it works and what parameters it checks on
your system I recommend you read this detailed and accurate Windows Product Activation Guide as well as

Microsoft's own Activation Basics Article.

Ideally if you've just installed Windows XP I would strongly recommend that you don't change any of your
hardware - aside from attaching some peripherals. Major hardware changes are best made prior to XP
installation. By 'major hardware' I am referring to the motherboard, CPU, graphics card, the hard drive, and
so forth. If however you are aware that your hardware setup may undergo some further changes shortly, it
is recommended that you don't activate Windows XP right away. You have 30 days within which to bed
down your final hardware configuration. Activating before your hardware setup is finalized could see you
having to re-activate repeatedly, including having to call Microsoft to complete Activation.

If you are absolutely certain that the major hardware components of your system are not going to change
soon and/or that you are not going to reinstall Windows XP again shortly, then go ahead and activate XP.
Otherwise ignore the constant nagging Activation gives you and wait until your system configuration is
finalized before going through with Activation. Microsoft views multiple activations in a very short period
of time as suspicious, and you can find more details of this in the Windows Product Activation Guide
mentioned above.

Something you should do after you have activated Windows XP is to backup your wpa.dbl and wpa.bak files,
found in the \WINDOWS\system32 directory. These files are Windows Product Activation system files, and
should your installation of Windows XP become corrupted and you need to attempt a recovery (See
Troubleshooting section), you can use these backed up wpa files to help in restoring your system.

Please note I will not provide any information on how to view or change your Windows Product Key, or
how to bypass Windows Product Activation. All I can say is that your Windows Product Key can be found
on a sticker usually on the Windows XP CD case, or on/inside one of the manuals which comes with your
copy of XP. Once entered during the installation of Windows XP you should never need to alter it on a
legitimate copy of XP.

If you have a pirated copy of Windows XP please don't ask for assistance as I will give none. If you have a
legitimate copy of Windows XP and you follow the advice above, bed down your hardware prior to
activating, avoid constantly reformatting and reinstalling Windows, and follow the rest of the tips in this
guide then you will never have any issues with Activation.
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DRIVER INSTALLATION ORDER

The first thing you should do with your fresh installation of Windows XP is to install the core system
software and drivers that are vital in helping to run XP optimally. Installing these prior to anything else, and
in the correct order, is key to reducing the chance of any problems and also ensuring peak performance.
Note that during installation of these, if you are prompted to reboot at any time, you must do so to allow
proper driver installation. The reason for this is that some driver files are currently loaded into memory
areas that are used by the system and protected from being overwritten. Thus they can't be replaced without
Windows first marking them for replacement, and subsequently replacing them with the newer version only
after a reboot. So whenever Windows asks you to reboot after installing any driver or application, you
should do so as soon as possible.

I recommend you download the following software and drivers in advance of reformatting and reinstalling
Windows XP as you should not attempt to connect to the Internet or browse any sites at this point. If you
have a permanent connection to the Internet and it is already on after installing XP, follow the procedure in
Step 8 to enable the built-in Windows XP Firewall before following the rest of the steps below.

The core software installation process is provided below in order of first to last, starting immediately after
you've installed Windows XP.

STEP 1

Install the full version of Windows XP Service Pack 2 (SP2). SP2 is a compilation of important updates for
Windows XP, and you can read about exactly which updates it contains here. SP2 also contains all the fixes
contained in SP1, so you don't need to install Windows XP SP1 before installing SP2. You will need to have
downloaded the full 234MB SP2 package in advance from here: Windows XP SP2. Back it up somewhere safe

for use in this step. Quite obviously if you used a Windows XP CD which already has SP2 incorporated into
it to install Windows, such as a Slipstreamed SP2 CD (See Slipstreaming Windows XP SP2 above), then you
don't need to undertake this step as all the SP2 files were automatically installed with Windows XP.

STEP 2

Install the latest version of DirectX. You will need to have downloaded it in advance from here: Microsoft
DirectX. Select the Download option to save the full DirectX file for use in this step. DirectX is already built
into Windows XP, but you will need to install the latest version of it to ensure maximum performance,
security and compatibility with the latest programs and games.

STEP 3

Prior to installing any other drivers go to Start>Control Panel>System>Hardware and click on the 'Driver
Signing' button. In the Driver Signing Options screen, select 'Ignore - Install the software anyway and don't
ask for my approval' and tick the 'Make this action the system default' box. Click OK when done. This
ensures that even if your drivers are not Windows Hardware Quality Labs (WHOL) Certified they will be
installed. WHQL certification is meant to indicate that Microsoft has tested the drivers and certified them to
work with Windows XP. However many important drivers are not WHQL certified, and 99% of
unsigned/uncertified drivers are perfectly fine to use, so just because a driver isn't WHQL certified doesn't
mean it will cause problems or incompatibilities - WHQL certification is a luxury, not a necessity. You
should instead judge a driver's robustness based on the reputation of its author and any release notes that
come with the driver, as well as feedback from other users.
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STEP 4

Install your motherboard chipset drivers. These are very important in achieving optimal, trouble-free
performance. These vary depending on which particular motherboard chipset type you run:

e For Intel motherboards, download and install the latest Intel Chipset Software, also known as the 'INF
Update Utility'. You should also download and install the Intel Application Accelerator if you use IDE
hard drive(s), or the Intel Application Accelerator RAID Edition if you have a RAID drive setup.

e For VIA motherboards, download and install the latest VIA Hyperion Drivers. To find out more about
these drivers read my VIA Hyperion FAQ.

e For Nvidia motherboards, download and install the latest Forceware Unified Drivers.

e For SiS motherboards, download and install the latest SiS Chipset Software. Note that there are several

separate SiS chipset drivers - they don't come in a unified package. You should only download and
install the drivers that support your particular chipset. This means the AGP and IDE drivers for all
chipsets, and the SATA/RAID drivers for chipsets that have SATA and RAID support.

Note that the motherboard chipset type is not the same as the motherboard's brand. The chipset type is
based on the company that manufactures the actual chipset architecture used in the motherboard. The
motherboard's brand is based on the company that buys this chipset, packages it with certain features and
sells it under its own brand name. See the System Information Tools section for a list of utilities which can
help you determine your motherboard's chipset type if in doubt.

Also note that the motherboard chipset drivers are not the same as a motherboard BIOS (See the BIOS
Optimization section above). The motherboard chipset drivers are Windows-based drivers that control the
way the motherboard communicates through its various components under Windows, the same as graphics
drivers or sound card drivers for example. The BIOS on the other hand is not dependent on Windows at all
and operates at the machine level to control the motherboard's behavior. The latest versions of both are
recommended, but at the very minimum the latest version of the chipset driver is strongly recommended.

Some motherboards come with built-in 'onboard' audio and video. If you don't have a plug-in (i.e. separate)
graphics card and/or sound card and want to use these onboard features, you may need to install additional
drivers specific to your motherboard chipset, as well as altering the relevant BIOS settings for these functions
to work correctly. Search the chipset manufacturer's websites above, or the motherboard manufacturer's
website (see your motherboard manual for the web address) for these additional drivers and install them as
part of this step. In particular see your motherboard's manual for details of how to enable or disable these
onboard features. For example if you have a separate plug-in sound card you should disable any onboard
audio for optimal performance and minimal conflicts.

STEP 5

Install your Graphics card video drivers. These vary depending on the chipset type of your graphics card:

e For ATI graphics cards, download and install the latest ATI Catalyst Drivers. For details on how best to
install and set these up correctly read my ATI Catalyst Tweak Guide.
o For Nvidia graphics cards, download and install the latest Forceware Graphics Drivers. For details on

how to install and set these up correctly, see my Nvidia Forceware Tweak Guide.

e For SiS graphics cards, download and install the latest 5iS Graphics Drivers. Note that some SiS
graphics cards don't have Windows XP drivers available. Use Windows 2000 or NT drivers instead if
available, but be aware there may be problems.

e For S3 graphics cards, download and install the available S3 Graphics Drivers. Note that you can

download non-XP S3 graphics drivers here, but there may be problems with these under XP.

e For Matrox graphics cards, download and install the latest Matrox Graphics Drivers.
o For XGI graphics cards, download and install the XGI Graphics Drivers.
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e For motherboards with onboard graphics cards, the drivers for these are usually contained with your
specific chipset driver, or available as a separate download from your motherboard manufacturer. See
Step 4 above for more details on onboard functionality.

Note that as with motherboards, graphics chipsets are usually sold to different manufacturers who then
package them together with certain features and capabilities and market them under their own brand name.
The important thing to know is the manufacturer of the chipset on which your graphics card is based — for
most graphics cards this will be either Nvidia or ATI.

The drivers found on the CD that comes with your graphics card are typically fairly old by the time you get
them, so install the latest versions of these drivers from the links above. Note that installing these 'Reference’
chipset drivers from the sites above will not cause any problems on the majority of graphics cards regardless
of their brand. You don't have to use manufacturer-specific drivers unless your graphics card has special
features (like Video In-Video Out) that do not appear to be functioning correctly with the reference drivers.
So in the first instance install the generic Reference drivers from above, then if you believe any functionality
has been removed or impaired, consider installing the manufacturer-specific driver instead. In terms of
performance, stability and compatibility the latest Reference drivers are the best to use.

STEP 6

Install your Sound card's audio drivers. These vary depending on the brand of the sound card you are
running. Only the major brands are covered below:

e For Creative sound cards, download and install the latest Creative Audio Drivers.

e For Turtle Beach sound cards, download and install the latest Turtle Beach Audio Drivers.

e For Hercules sound cards, download and install the latest Hercules Audio Drivers.

e For AOpen sound cards, download and install the latest AOpen Audio Drivers.

e For motherboards with onboard audio (such as AC '97 Audio), the drivers for these are usually
contained with your specific chipset driver. See Step 4 above for more details of onboard functionality.

Note that if your sound card comes with a CD containing a range of audio utilities, such as 'Creative
Liveware', install that first before updating your sound card drivers with the latest downloaded version.

STEP 7

Connect any remaining devices to your system (e.g. Mouse, Printer, Digital Camera etc.) and test their
functionality. If they appear to working fine and all their major functions are intact, then I suggest you do
not install a new driver for them. For example, if you connect an optical mouse and it appears to have full
functionality, do not then install the drivers that come on the CD with the mouse, or download and install
new drivers. The reason for this is that such drivers typically need to load into the background at Windows
startup and usually add to overall resource usage, increase boot times, and quite often don't add anything of
real value to the device's function. One of the many benefits of Windows XP SP2 over other Windows
versions is that it supports a wide range of devices by default without the need for additional drivers.

However should your device not function correctly, or a feature that you need to use appears disabled, you
will need to install the latest driver for that device. I recommend you go to the device manufacturer's website
and download the latest available drivers. There are far too many device manufacturers to list here, but the
website address is usually prominently listed on the device's box and/or in the manual. Where possible
follow the device installation instructions in the device's manual (or on its website) for the best method of
installation. Typically this involves connecting the devices to your machine one by one, and when Windows
XP detects them and prompts for drivers, insert the appropriate driver disk or point Windows to the
directory where you have placed the latest driver files for the device.
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Note that device drivers in .exe format only need to be executed to automatically install the drivers. However
drivers in .zip archived format must have their contents unzipped first before following the steps below:

Go to Control Panel>System>Hardware>Device Manager, and double click on the device to update.

Go to the Driver tab and click the 'Update Driver' button.

Select 'Install from a list or specific location' then click Next.

Select 'Don't search, I will choose the driver to install'

Click the 'Have Disk' button.

Click on the Browse button and go to the directory where you placed the latest drivers.

Highlight the relevant driver file (usually an .INF file) and click next to install.

Reboot your system if prompted and upon reboot the device should be using the latest drivers. You can
check this by checking the driver tab in device manager again (Steps 1 & 2 above).

PN

You can use the above procedure to manually update any of your device drivers whenever you download a
new driver package for any device.

STEP 8

You will need a connection to the Internet for this step. That means your network adapter or modem must
be installed and set up correctly — refer to your modem/network adapter's documentation as each has unique
setup procedures and requirements. You must also have your ISP (Internet Service Provider) details handy
(e.g. access number, username, password, configuration scripts, proxy settings, port numbers etc.). Once you
have installed the modem or network adapter, and prior to connecting to the internet, you must enable a
Firewall. A firewall prevents malicious access to your machine via the Internet, and you can enable the
default Windows XP Firewall — which is actually good enough for most people - as follows:

1. Go to Start>Control Panel>Network Connections.
In the Network Connections box, right-click on the connection you want to use for connecting to the
Internet and select Properties.

3. Go to the Advanced tab, click the Settings button and select On to enable Windows XP's built-in Internet
Connection Firewall and click OK. If you have third party Firewall software you wish to use, install it
and enable it instead. Either way make sure a Firewall is activated before you connect to the Internet.

Now you can safely connect to the Internet, but do not visit any other website, nor check your email, or
download any programs. Go directly to the Windows Update website, either by clicking the Windows
Update icon in your Start menu, or by going to Internet Explorer>Tools>Windows Update, or by clicking this
Windows Update link. Once on the Windows Update site, click the 'Custom Install' link and wait for the
scan to finish. If you have any problems with Windows Update, see the Internet Explorer section below.
Note that Windows Update will only work on Internet Explorer - other browsers will appear to freeze when

accessing the site or scanning for updates.

You will notice that all the 'High Priority Updates' items have automatically been added to your 'Review
Updates' list. It is important that you install all of these critical updates for security, stability and
compatibility purposes. Under the 'Optional Software Updates' section, you should also add any fixes or
updates you see which are relevant to the programs or features you use or wish to use. In particular, even if
you don't use or like Windows Media Player, I suggest you install the latest version as it is the only software
capable of correctly playing .WMYV files, of which you will find many on the internet. The latest version of
Windows Media Player also addresses some security flaws in previous versions, so updating is a necessity -
see the Windows Media Player section of this guide for more details.

Finally add in all 'Optional Hardware Updates' shown, as these are important updates of drivers for the
hardware on your system. They are all safe to use and will only be available for installation if they are newer
than the drivers you are currently using for your device(s). You can (and should) install newer versions of
hardware drivers over these versions when they become available.
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Once you've added all the relevant updates, click 'Install Updates’, and click the Install button. It may take
quite some time for the various updates to download and install depending on your internet connection.
Reboot as often as prompted. Don't install any other applications or games - go straight to the next section.
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DiSK CLEANUP AND DEFRAGMENTATION

B DISK CLEANUP

The Disk Cleanup utility provides the ability to automatically find and remove unnecessary Windows files,
reducing wasted hard drive space. To access the Disk Cleanup utility go to Start>Run and type
"Cleanmgr.exe" (without quotes) and press Enter, or look for it under your Start>Programs>Accessories>
System Tools menu.

The Disk Cleanup utility has several functions, as shown below:

REMOVE UNNECESSARY WINDOWS FILES

To remove unnecessary Windows files, open the Disk Cleanup utility and under the main Disk Cleanup tab
make sure only the following are ticked:

Recycle Bin

Setup Log Files

Temporary Files

Catalog files for the Content Indexer

You may also tick the "Temporary Internet Files' option if you want to clean out your Internet Explorer file
cache. If you are short on disk space you can tick the 'Compress Files' option, however I recommend against
this as disk compression can be time consuming and will reduce your overall performance in Windows XP.
Click OK when done, and OK again. This will remove a lot of unnecessary files on your system and may
take a while. These files will be moved to the Recycle Bin by default (See the Recycle Bin section).

ADD OR REMOVE WINDOWS COMPONENTS

To add or remove Windows XP components under the 'More Options' tab click the 'Clean Up..." button
under the 'Windows Components' section. In the 'Windows Components' box that opens, items with ticks
next to them are currently installed. You can install additional items by ticking them, and untick any existing
components that you want to remove. Note that some items, such as Windows Messenger or Internet
Explorer, cannot be fully uninstalled this way - unticking them only removes the shortcut to the program.

When you highlight certain components, you may see a Details button appear on the bottom right. Click it to
see which particular sub-components you can select to install/keep/uninstall. For example, if you highlight
the Accessories component, click Details and you will see two types of sub-components - Games and
Accessories. Highlight the Accessories sub-component and click Details again, and you'll see the full list of
Windows accessories installed on your system. Untick the ones that you know you do not need or use, and
tick those which you want to install or keep. If in doubt, do not install or uninstall any items. Items that are
already ticked are currently installed, and leaving the tick mark against them won't see them installed again
— it just means you wish to keep them.

Once you're finished, click OK until you are back at the main Disk Cleanup utility screen and click Next.
Any changes will see the relevant components installed/uninstalled as specified. Note that you may be
prompted to insert your original Windows XP CD if you've chosen to install a new component.

REMOVE OLD SYSTEM RESTORE POINTS

To remove all the System Restore points other than the most recent Restore point, thereby freeing up a great
deal of disk space, under the 'More Options' tab click the 'Clean Up..." button under the 'System Restore'
section. Click Yes on the subsequent prompt, then click the OK button.

Sexyo(q 29 dnuesp) ysiq

Copyright © 2005 Koroush Ghazi 4 5




Gwmu THE WINDOWS XP TWEAKING COMPANION

B DEFRAGMENTATION

The Windows Disk Defragmenter (Defrag) utility performs a very important function. As information is
written to, and deleted from, your hard drive, parts of individual files will become fragmented and
physically spread out all over the hard drive. The defragmenter puts all these file fragments back together
with each other in the same location and attempts to pack them closer to the start of the drive to speed up
reading and writing to these files. This reduces loading times and in particular greatly reduces annoying
loading pauses and stuttering in games. Defrag should always be run after any large file changes such as
application, game or driver installations/deletions.

To access the Defrag utility, go to Start>Run and type "Dfrg.msc" (without quotes) and press Enter, or look
for the Disk Defragmenter icon in your Start>Programs>Accessories>System Tools menu. Make sure there
are no open applications or games running in the background and then in the Defrag window simply click
the Defragment button to begin defragmentation. Do not do anything else while this process is being
completed. It may take quite a while to complete so be patient. The longer it takes, the more good it is doing
your drive. Make sure that you run Defrag immediately after installing all the system drivers and core
software outlined in the previous sections. This will move all the most often-accessed system files and
drivers closest to the start of your hard drive where drive access is fastest, improving overall system
performance.

DISKEEPER

If you want to do a more thorough defragmentation of your hard drive and get much better results you will
have to look beyond the built-in Disk Defragmenter in Windows XP. Diskeeper is an excellent
defragmentation and drive optimization utility which does much more than Windows Defrag can (the
differences are spelt out in this document), however it is not a free utility. Fortunately you can download it
and try it for 15 days for free from here: Diskeeper. Importantly, when installing this trial version make sure
you choose to install the 'Professional Edition' of Diskeeper trial as that is the edition that has all the
functionality we need. Once it is installed, it will take the place of the built-in defragmentation utility, so if
you click the regular Defrag icon it will also launch Diskeeper. Close all open applications and games, then
start up Diskeeper and follow these steps to defragment your hard drive:

1. Right-click on the logical drive you want to defragment, and select Analyze.
Once the drive analysis is over - the progress is shown in the bottom right corner - click on the 'Drive
Map' tab and look at the results, paying attention to the color legend shown on the bottom left corner.

3. Right-click again on the logical drive and select Defragment.

4. Once the defragmentation is over, you will see that the layout shown under the 'Drive Map' section has
changed, showing a defragmented drive.

Note that while Diskeeper is an excellent utility, and you should consider purchasing it if you find it useful,
the normal Windows Defrag does a sufficiently good job that you shouldn't feel you have to purchase
Diskeeper. Also, it should be noted that Diskeeper has several features and startup programs that should be
turned off to reduce its resource usage. Follow these steps to do just that:

1. In Diskeeper, highlight each of your drives, click on the 'Set It and Forget It' link at the top left, and
underneath it select 'Clear a schedule' to prevent regularly scheduled defragmentation - unless you
prefer this option. I strongly recommend that you manually run Diskeeper and defragment after each
large file or program/driver installation/uninstallation rather than at scheduled intervals.

2. In the Windows Registry remove the 'Diskeeper Systray' startup entry (Dklcon.exe) - see the Microsoft
Configuration Utility Section for details on how to do this.

3. If you don't run Diskeeper often then you can disable the Diskeeper service for day-to-day usage. Note
however that this service must be set to Automatic for Diskeeper to work - see the Services Utility
section.
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If you don't like the way Diskeeper takes over your Windows Defrag utility in Windows, the way the trial
version has a nag screen at your Windows startup and the need to run an additional Diskeeper service to
maintain its functionality, then once you've completed this guide, defragmented all your major files and
moved the pagefile (See the Virtual Memory section below) you should uninstall the program and revert to

using the normal Windows Defragmentation utility. Most of the benefits will have come from our initial
usage of Diskeeper.

Whichever method you use to defragment your drive(s) I strongly suggest you get into the habit of
defragmenting as often as possible, particularly after:

e any large file additions or deletions;

e any driver installations;

e any time you install or delete a new application or game; and

e any time you patch an existing application or after running Windows Update.

Neglecting to defragment your hard drive often will see your applications and games take longer to load,
exhibit frequent stuttering and pausing, and generally reduce your hard drive's performance.

Copyright © 2005 Koroush Ghazi
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VIRTUAL MEMORY

In this section we optimize the Windows XP virtual memory settings. This step is best undertaken soon after
installation of XP for one simple reason: the pagefile performs best when physically located closer to the start
of the hard drive. This is because hard drive read/write speeds are at their fastest at the start of the drive.
Since the pagefile cannot be moved around easily, it's best to set it up correctly prior to loading much of the
remaining data onto your hard drive.

B VIRTUAL MEMORY IN WINDOWS XP

Memory management in Windows XP is different to that under the previous Windows 95/98/SE/ME series.
No matter how much physical RAM you have in your system, your Windows XP Virtual Memory (also
called the Swapfile or Pagefile) settings will have a major impact on your system's performance. The
information provided here is based on the definitive Virtual Memory in Windows XP Guide and RojakPot's
Virtual Memory Optimization Guide. These guides give you an excellent insight into how Virtual Memory
works in Windows XP. I recommend that you read them both if you want to gain a clearer understanding of
what virtual memory is, and why most of the myths you've heard concerning virtual memory and 'freeing
up RAM' are blatantly untrue. What follows below are my personal recommendations for Virtual Memory
configuration based on a combination of the above guides and my own experience.

To access your Virtual Memory settings, go to the Control Panel>System>Advanced>Performance>Settings>
Advanced>Virtual Memory section and click the Change button.

CLEARING THE PAGEFILE

Before setting a new pagefile size, first clear your existing pagefile. To do this select the 'No Paging File'
option and click the Set button, then reboot your system. This step does two things: first it deletes the
pagefile, fixing any potential pagefile corruption which can occur after a bad shutdown (remember this tip
for future troubleshooting purposes); and secondly it ensures that any new pagefile you create will start off
as a single unfragmented contiguous block on your hard drive for optimal performance.

SETTING THE PAGEFILE SIZE

Once you've cleared your existing pagefile, you can now set a new pagefile. Which drive or partition this
pagefile should be located on is based loosely on the following rules:

One hard drive and one partition: The pagefile can only be located on the primary partition of your hard drive.

One hard drive and multiple partitions: Make sure the pagefile is placed on the first partition as this is the
fastest partition. Placing it on another partition does not simulate the benefits of having two hard drives
since the read head of the drive can still only seek information from one place at a time. Highlight the logical
drive where you want the pagefile to be placed under the Drive window.

Two or more physical hard drives: You should put the main pagefile on the drive that doesn’t contain your
Windows installation and applications/games. This will reduce hard drive head movement on the main disk
and speed up access to the pagefile on the other disk. Highlight the drive where you want the pagefile to be
placed under the Drive window.

After selecting the location of the pagefile, you can then determine its size in MB. In the Virtual Memory
settings screen select the 'Custom Size' option. Although there are many differing opinions on how big the
pagefile should be, one rule every Windows XP expert agrees on is never 'disable’ your pagefile regardless
of how much RAM you have. Windows XP needs a pagefile in order to operate correctly. Setting the pagefile
to zero or a tiny size does not speed up your performance by 'forcing’ XP to use physical RAM. Windows
XP's memory management does not work that way - refer to the guides above for more details.
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To accurately determine the optimal pagefile size you should see how much memory your most memory-
intensive programs use and then set the pagefile to comfortably accommodate this. A rough and ready way
of doing this is to configure your Task Manager as specified under the Task Manager section, then run what
you believe is your most memory-intensive application or game and use it for a period of time. Then without
quitting the game or application, bring up the Task Manager and check the peak memory usage figure for
the largest process under the Processes tab - this should indicate how much memory the program usually
needs. Also after a period of time using various applications and games on your system, open up Task
Manager and go to the Performance tab, then check the Peak figure under the 'Commit Charge (K)' section -
this is approximately the maximum amount of memory in KB required so far by your system. These will
give you an indication of how much total memory you need when going through the next step.

I understand that for most people accurately working out which is the most memory intensive application or
game, and more importantly predicting the amount of memory future software will require is tedious if not
impossible. Therefore follow my general recommendation below to set a fixed pagefile that should be
sufficient for all your needs. Since the total memory available to Windows XP is a combination of your
Virtual Memory plus your 'Real Memory' (System RAM), you should ensure that the sum of these two is
sufficiently large to prevent Windows from running out of memory. In general, I suggest a minimum of 2GB
(2048MB) for your Virtual Memory + RAM:

Example: If you have 256MB of RAM set the Initial and Maximum pagefile sizes to 1792MB each.
Example: If you have 512MB of RAM, set the Initial and Maximum pagefile sizes to 1536MB each.
Example: If you have 1024MB (1GB) of RAM, set the Initial and Maximum pagefile sizes to 1024MB each.
Example: If you have 2GB of RAM or more, set the Initial and Maximum pagefile sizes to 200MB each.

Once you've adjusted your Virtual Memory size settings click the Set button and reboot if required. Your
pagefile will now be in a single fixed unfragmented file, created closer to the start of the hard drive for faster
performance (See Position of the Pagefile below). There will be plenty of headroom for memory-intensive
applications and games and you should notice smoother performance.

Note that the common myth about the pagefile being '1.5 x RAM' or some other multiple is quite clearly
counterintuitive. Consider the situation where you only have 128MB of RAM: setting the maximum pagefile
size to 1.5 x 128MB = 192MB + 128MB = 320MB of total available memory for Windows XP which is
obviously not going to give you enough memory for modern games and applications. Remember, it is about
how much total memory (RAM + Pagefile) that should be made available for Windows to operate efficiently.

If at the end of all this you still have doubts about what to do, or you run into any problems, you can either
increase the fixed pagefile size further (which never hurts), set a 'semi-permanent’ pagefile which has an
Initial size equal to your current RAM, and a Maximum size which is very high, e.g. 3000MB, or failing that
simply choose the 'System Managed Size' setting to revert to the Windows default pagefile size. Whatever
you do, don't set a zero pagefile.

POSITION OF THE PAGEFILE

The position of the pagefile is an important factor in how quickly it is accessed by your hard drive head. The
closer it is to the 'start' of the drive, the faster it can be accessed. By default Windows XP does not position
the pagefile at the start of the drive, nor can you use any built-in utilities like the Disk Defragmenter to move
it there. This is because the Defrag utility can't defragment or move protected files in use by the system such
as the pagefile.
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This is one of the major advantages of Diskeeper (See Disk Cleanup & Defragmentation section) - it can be
set to defragment and move the pagefile prior to Windows startup, thereby defragmenting all files, system
or otherwise. Note that in the following procedure Diskeeper will actually determine the optimal location of
the pagefile, and furthermore depending on the amount of free space you have on your drive it may not be
able to completely optimize the pagefile location. To optimize the pagefile position, open Diskeeper and
follow these steps:

1. Highlight the drive where your pagefile resides.

Click on the 'Change your settings' link and underneath it select 'Set a boot-time defragmentation'

3. In the box that opens, select 'On Next Manual Reboot’, and then tick all the options underneath except
'Produce a summary log file'. Ignore the greyed out bottom option.

4. Click the Apply button, and a boot-time defragmentation will be scheduled. Note if you ever want to
cancel this, simply follow the steps above but this time select 'Don't run boot-time defragmentation’' and
select Apply instead.

5. Reboot your system and upon rebooting the Windows Check Disk function will begin, and after it has
completed Diskeeper will commence defragmenting the pagefile and relocating it for optimal
performance.

Do not disturb this process and at the end of it press ESC to boot into Windows. Upon booting back into
Windows I recommend doing a manual defragmentation of your drive again with Diskeeper using the
procedures under Defragmentation in the Disk Cleanup &Defragmentation section.

Note that if you don't wish to use Diskeeper, you shouldn't be significantly disadvantaged, since by creating
the pagefile at an early stage in the Windows setup process and prior to installing all your games and
applications it should still be positioned relatively close to the start of the hard drive. And by deleting it and
recreating it we have ensured that it is not fragmented in the first place.

MORE RAM

Remember, the optimization of your Windows pagefile is primarily to improve loading times, prevent 'out
of memory' errors and provide smoother performance in games and applications. If after all the tweaking
possible in this guide you find that is still not the case, you will simply have to increase the amount of
physical RAM in your system and/or consider purchasing a faster hard drive. For example, 256MB of RAM
is generally insufficient for current games to run smoothly in Windows XP regardless of any virtual memory
tweaking you undertake.
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MEMORY OPTIMIZATION

This section covers the optimization of the memory subset on your system. When talking about the 'memory
subset' I am referring to a combination of your CPU's L1 and L2 Caches, your physical RAM, your graphics
card's Video RAM and your Windows Memory Management settings. These components when combined
have a major influence on your system's performance and stability. If there is a sub-optimal setting or
unstable configuration for any one of these components the entire memory subset is at risk of unsettling
your machine, leading to crashes, freezes and even data corruption.

Each component of the memory subset is dealt with separately below however all components must be
configured as recommended for optimal performance.

B CPUL1AND L2 CACHE

The CPU Level 1 (L1) and Level 2 (L2) Caches are memory chips that cache (buffer) information for faster
usage by the CPU, since the CPU is the fastest component in your system. The caches assist in temporarily
storing the information in anticipation of reading/writing by the CPU. They vary in size depending on your
particular CPU, but essentially they are physical chips that you should not have to worry about.

Windows XP and your associated hardware are designed to automatically detect the size of these caches and
use them optimally as long as you have them enabled in your BIOS. That is, if options relating to the use of
CPU L1 and CPU L2 Cache are present in your BIOS, do not disable them. Aside from BIOS settings, there is
a known Windows XP tweak for manually adjusting your CPU's L2 Cache setting. It is provided below,
however you should understand that it will likely have no performance impact, since Windows XP should
already be using the correct L2 Cache size. To undertake this tweak, open Registry Editor and go to:

[HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\Memory
Management]

SecondLevelDataCache=256

Edit this value and insert your CPU's L2 cache size (in KB) in Decimal view. Microsoft suggests the default
setting of 0 in Windows XP will automatically detect your L2 Cache size, however entering it manually in
this way shouldn't harm performance. If the entry doesn't exist, create it as a new DWORD. If you don't
know your CPU's L2 Cache size, do not perform this tweak.

B PHYSICAL RAM

This is probably the most well-known part of the memory subset. RAM stands for Random Access Memory,
and usually comes in sticks composed of multiple memory chips adding up to a certain size (such as 256MB
or 512MB). Physical RAM, much like your hard drive, holds information in storage that can be read from
and written to by your system components. It is a temporary holding area for data, and is constantly being
accessed when your machine is on. However the advantage of RAM is that it is much, much faster than any
hard drive, so optimal RAM usage means faster and smoother performance for your system. There are three
main factors affecting RAM performance — RAM size, RAM speed and RAM timings:

RAM Size: This is the amount of RAM in Megabytes. The main impact of having more RAM is that - when
combined with appropriate Virtual Memory and cache settings — your system will perform more smoothly.
This is because data has to be loaded from your hard drive less often as more of it is stored in RAM. There
are no RAM size tweaks, essentially if you have a low level of RAM (e.g. 256MB) then you should consider
getting some more if you constantly experience stuttering and long pauses in games for example.

RAM Speed: This is the frequency at which RAM operates (in MHz) much like the speed at which a CPU
operates. The higher the RAM's speed, the faster it can undertake the operations it needs to perform. Each

uonyezrwnd( A1owaN

Copyright © 2005 Koroush Ghazi 5 1




Gwmu THE WINDOWS XP TWEAKING COMPANION

stick of RAM has a speed rating, which is the speed up to which a stick of RAM is certified to safely operate.
However the actual speed a RAM module is running at on a particular system varies depending on how fast
it is set to operate in the BIOS and your FSB (Front Side Bus) speed. For example, a DDR PC3200 RAM
module can operate at up to 400Mhz (2x200Mhz) while staying within specifications. However on an
overclocked system it may actually be operating at a higher speed. Alternatively, if you're running it on a
motherboard where the FSB is only 266Mhz (with a 1:1 Memory Divider ratio) the RAM will only run at
266MHz, well below its 400MHz potential (See the Overclocking section for details). The bottom line is, the
faster the RAM's actual speed, the faster it reads and writes information and the better your performance.
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The speed rating is not the same thing as the actual RAM speed - it is only an indicator of how fast it can
potentially perform and has no direct bearing on performance. However the more the RAM's actual speed
surpasses its rated speed, the greater the chance for instability. Note that running RAM below its speed
rating will not cause any problems, it just means you're not working the RAM to its maximum potential.

RAM Timings: These are composed of several variables, set in your BIOS, which determine not the frequency
of the RAM module (RAM speed), but the latency of the RAM - that is, the amount of time it waits between
updating various signals. For example the RAS (Row Access Strobe) and CAS (Column Access Strobe)
latency settings measure in nanoseconds the delay in sending signals which specify firstly the row in which
a particular memory cell is located, and then the column. The lower the RAM timings in nanoseconds, the
less time the RAM rests between these operations, and hence the faster it performs, but the greater the
chance for errors and instability. Just like speed ratings, RAM modules come with recommended timings
already encoded in their Serial Presence Detect (SPD) on a special chip. These SPD settings are used by
default unless manually changed in the BIOS, and when combined with the recommended speed rating (See
RAM Speed above) ensure maximum stability.

If you want to improve the performance of your RAM, and hence your entire system, you can lower its
timings and/or increase its speed - see the Overclocking section and the Benchmarking and Stress Testing
sections for more details.

B VIDEO RAM

Video RAM (VRAM) is the memory on your graphics card and the size of this is usually quoted as part of
the graphics card's specifications (e.g. 128MB Radeon 9800 Pro — indicates 128MB of VRAM). This RAM acts
as a buffer to store graphics information much the same as system RAM does for general information. For
this reason the VRAM is also called the Frame Buffer, in that it holds graphics 'frames' ready to send to your
monitor through the RAMDAC (RAM Digital to Analog Converter) that converts the digital signals to an
analog viewable image onscreen. Just like physical RAM, VRAM has a speed in MHz, and a latency in
nanoseconds, with the higher the speed and the lower the latency the better the graphics performance.
Unlike physical RAM, altering the latency of your VRAM is tricky but still possible. The speed in MHz can
also be altered up or down using an overclocking utility, with the faster the speed the higher the
performance, but once again the greater the chance of graphical glitches and freezes. See the Overclocking
and Benchmarking and Stress Testing sections for more details of graphics card overclocking.

B WINDOWS MEMORY MANAGEMENT

The final part of your memory subset is the Windows Memory Management settings. These include Virtual
Memory, the System Cache and related Windows Registry entries. This is the area with the most tweaking
potential, and all the known working memory management tweaks are covered in this guide.

VIRTUAL MEMORY

The key component of Windows memory management is Virtual Memory, and this is covered in detail in
the Virtual Memory section. Follow the instructions in that section to optimize your virtual memory if you
haven't already, as it is a very important component of your memory subset.
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SYSTEM CACHE

The next component is your System Cache size, which can be set through the System component of the
Control Panel (See System under the Control Panel section), in the Windows Registry, or by using a utility
like Cacheman. This setting controls how much RAM is set aside to assist in buffering information written to
and read from your hard drive(s) to achieve faster information transfer. The optimal setting for maximum
disk speed is the 'System Cache' option under Memory Usage in Control Panel>System, or 'Maximize
throughput for file sharing' option in Cacheman. However, keep in mind that selecting these options may
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result in Delayed Write Failure for people with ATI graphics cards that have more than 512MB of RAM, a
large NTFS disk and/or multiple large volumes (60-100 gigabyte hard drives possibly in RAID arrays). I
suggest you do not use these settings if your system meets any of the conditions above. Instead use the
Programs option (in Control Panel>System) or Balance option (in Cacheman) for maximum stability while
still retaining good performance.

OTHER MEMORY SETTINGS

The last component of the memory subset involves several registry settings that control various caches and
memory usage behaviors on your system. These are covered below, but it should be noted that different
people have differing experiences with them. The settings below are recommended based on my personal
experience from tweaking a variety of systems, and none of these should harm performance on any system.
All of these changes can be made using Cacheman, and that is the recommended method, however if you
prefer to use the manual method open the Registry Editor and go to the following keys:

[HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\Memory
Management]

DisablePagingExecutive=1

This setting attempts to keep your core Windows XP files in system RAM and not on the pagefile. This
tweak is not recommended for those with less than 512MB of RAM.

LargeSystemCache=0

If set to 1 this setting will provide more RAM for the Disk Cache, which is generally most useful for
improving performance on servers. This setting is identical to selecting 'System Cache' under the Control
Panel>System>Advanced>Performance Settings>Advanced section. As noted previously this tweak is not
recommended for those with less than 512MB of RAM and also may cause hard drive corruption on systems
with ATI graphics cards, more than 512MB of RAM and/or a large drive. It is strongly recommended that
you leave set this setting at 0 unless your machine is running as a server.

IOPageLockLimit=226492416

Enter the value (in Bytes) in Decimal view. This setting is not recognized in Windows XP, and hence while
enabling it is harmless, it does nothing. If you still wish to implement this tweak, use the Cacheman utility to
implement it instead.

[HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer]

AlwaysUnloadDLL=1

Create a new Key (a sub-folder, not an entry) called AlwaysUnloadDLL. Once created double-click on the
(Default) entry in the right pane and enter a value of 1. You can also use Cacheman to activate this tweak,
which is the recommended method. I use this tweak primarily to ensure a reduction in potential memory
conflicts, because the fewer DLLs are kept in memory after a program closes, the less likelihood of memory
conflicts (such as General Protection Faults) during periods of heavy memory usage.
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[HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\Memory
Management \PrefetchParameters]

EnablePrefetcher=3

The Windows Prefetcher attempts to preload information into memory for the most commonly used
programs, thus speeding up their loading times. The allowable values for EnablePrefetcher are: 0
(disable Prefetcher), 1 (Application launch prefetching), 2 (Boot prefetching) and 3 (Both application and
boot prefetching). The default is 3, however you can try undocumented values such as 4 or 5 to see whether
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this improves your overall system performance.

Note that if the Task Scheduler service is Disabled (See the Services section), much of the Prefetcher
functionality becomes disabled. I personally leave the Prefetcher registry setting above at its default of 3, and
set the Task Scheduler service to Disabled as this provides the most optimal performance for Windows
bootup and game/application loading times.

B SPEED AND STABILITY

The bottom line is that because the memory subset is such a crucial component of Windows and every
application and game you run depends on it, it is vital that you optimize it for speed and stability, not just
one or the other. Overclocking your system beyond stable boundaries, or choosing overly aggressive timings
on your RAM, or setting a zero pagefile size for example can lead to a variety of problems, some of which
may confuse and confound you. If you system suddenly reboots without warning, or crashes to desktop
during a game for example, you can be sure that it is a memory-subset related problem. See the
Troubleshooting section for more details of these sorts of problems, see the Overclocking section for more
information on how to perform overclocking correctly, and see the Benchmarking & Stress Testing section
for details of how to test for memory-related problems.
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INSTALLATION OF APPLICATIONS AND GAMES

B GAME AND APPLICATION INSTALLATION

At this point you can now install each and every game and application that you wish on your system. Make
sure that in each instance, if prompted to reboot that you do so. Be particularly careful during the installation
of certain programs, as they may install unnecessary components on your system if you do not pay attention
— that is how certain adware such as Gator is installed for example. Only select the options you prefer during
installation. Wherever possible, if there is a 'Custom Installation' option available, select that and patiently
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sort out what you need and what you don't. Try and avoid installing unnecessary components and don't
allow a program to load at Windows startup if provided with the option. If in doubt, don't install a
component - if a component is truly critical to a program's function you typically won't get the option to skip
installing it anyway.

If any of the programs prompt for connection to the Internet, or to a particular website for updates (such as
Virus Scanners), or to register your details, cancel all such attempts. You can connect to the Internet and
update or register these programs once the tweaking and maintenance procedures in this guide have been
completed. Note that once all your programs and any of their updates have been installed you should go
through all the steps outlined in the Regular Maintenance section.

B VIRUS, TROJAN, SP YWARE/ADWARE SCANNERS

While it is important to install and use the scanning utilities covered in the Virus Cleaning section above,
you must be especially careful about the way in which these utilities are installed and set up. Certain virus
scanning packages like Nortons Antivirus make a great many system changes and install a lot of background
programs and services, hence they require a lot of vigilance both during the installation process, and
immediately afterward during their configuration phase. In particular, I strongly recommend that you do
not allow these utilities to run in the background at any time. If these programs run in the background, they
can and will cause problems with other games and applications, such as memory conflicts, slowdowns and
crashes. Furthermore, they take up precious memory, use some CPU cycles, but most important of all: they
slow down reading/writing to the hard drive particularly during system intensive periods. Disable all
options for such background scanning. Run manual scans of your system at regular intervals instead. Again,
see the Virus Cleaning section for more details.

Note that Nortons Antivirus will not install correctly if the NTFSDisable8Dot3NameCreation Registry
setting is enabled. See the Registry Editor section for more details on this setting.

Once you've installed the scanning utilities you prefer, make sure to remind yourself to connect to the
Internet and update each scanner after you've finished tweaking. It is these updates that provide the
scanners with the latest information they need to track down and destroy malicious software.

B TWEAKING AND CLEANING UTILITIES

While you are installing your other software, this is a good time to install the utilities we will require for
tweaking Windows XP. More details about these utilities and their correct usage are in the relevant sections
later in this guide, but below are the main programs I strongly recommend you download and install. If you
are doing a fresh install of Windows XP ideally you should have downloaded and backed up these
programs beforehand and have them ready for installation now.

Cacheman - Make sure to select Cacheman 5.50 default distribution, not CachemanXP. Cacheman is
completely free, while CachemanXP is a fully-functional trial for only 15 days. Also Cacheman does a much
neater job for our purposes and doesn't attempt to automatically "manage memory" which is undesirable.
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RegSupreme - RegSupreme is a fast and friendly Windows Registry cleaning program. The only down side
is that it is not free, however you can download the 30 day fully-functioning free trial and it should meet the
bulk of your cleaning requirements in that time. If you still want to use it beyond that period consider
purchasing it, or you can always use the older (but free) RegCleaner.

RegCleaner - RegCleaner is the forerunner to RegSupreme, but in many ways it is equally powerful and has
a lot more features, and importantly it is completely free. Even if you use RegSupreme, RegCleaner is handy
to install as well because of its additional user-friendly registry editing functionality. Just make sure you
install the correct version of RegCleaner as several other similar (but less useful) applications use the same
name. The correct version of RegCleaner says RegCleaner 4.3 by Jouni Vuorio at the top of its main screen.
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BootVis - Bootvis is a free Microsoft utility for analyzing your bootup sequence and automatically
optimizing it to speed up the time it takes to bootup Windows.

CCleaner — Crap Cleaner is a free utility which finds and removes a variety of useless files from your drive.
Although it is usually safe to use, CCleaner requires a bit of caution as desirable files can also be removed if
the user is not careful when choosing what to scan for and remove. There is a slightly longer (but safer)
manual method of cleaning your drive of most useless files, and this is also detailed in the CCleaner section
below.

TweakUI - TweakUI is a free Microsoft utility that lets you customize a range of Windows XP settings. It is

safe, easy to use and a must-install. TweakUI is part of the larger Windows XP PowerToys collection that
you should check out for yourself and see which other PowerToys you want to try.

Full instructions for optimal use of these utilities are in the relevant sections below.

Note that there are many, many other tweaking and cleaning utilities available. I am aware of many of these,
and have indeed tried some of the more popular ones at one point or another. I don't particularly
recommend any of them beyond the ones listed above. Why? Well most of them take a 'black box' tweaking
approach - they make changes and undertake well-known tweaks (most of which are covered in this guide),
but they do so in a way which doesn't make it clear to the user what has been changed, and where the user
can go to undo the changes should anything go wrong.

I am an ardent believer that if you want to tweak something you have to learn how to do it manually, and in
doing so learn a little something about how the various components of your system work. That way you can
troubleshoot your own problems — and believe me any PC user will constantly run into problems — without
being dependent on a utility or being totally unaware of what does what on your PC. There is no 'one size
fits all' tweaking utility that cleans and optimizes your machine automatically. Even this guide is presented
on the basis that you have to read the descriptions and use your own judgment on what to tweak, and
whether it is relevant to your own circumstances or suits your tastes.
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THE CONTROL PANEL

The following section covers all the options available under the default Windows XP Control Panel, which is
the central place to change most of Windows XP's settings. I cannot go into each section of the Control Panel
in great detail due to space considerations however all the important settings are covered and my
recommendations for each are safe to use on most systems unless you have very special requirements. Take
the time to go through this section carefully as it is extremely important for optimal XP performance and
functionality.

B ACCESSIBILITY OPTIONS

There are a range of features here that can be used to accommodate different keyboard usage styles, make
Windows easier to see on screen, or provide audible notification of events for example. Quite obviously
which settings you choose will depend on your individual requirements. If you want to find out more about
these options go to the Windows Accessibility Page.

For the majority of users who do not need to use any accessibility functions, make sure that every option
under each of the tabs is unticked for maximum performance and minimal interference with the
functionality of games and applications. For example, if the 'Sticky Keys' option is left enabled, it is known to
cause unintended interruptions in games.

B ADD HARDWARE

This utility allows you to go through a set of procedures for adding a new piece of hardware to your system.
In most cases though, since Windows XP is a plug-and-play operating system, and as long as you have Plug
and Play' enabled in your BIOS (See the BIOS Optimization section) and the 'Plug and Play’ service set to
Automatic (See the Services Utility section), all you need to do to add any new hardware is to connect it to
your system and XP will detect it, and either automatically install basic drivers for it, or if it can't determine
the type of hardware, request that you insert a driver disk. Follow Step 7 under the Driver Installation Order
section.

I strongly recommend that before adding any new piece of hardware, you spend some time and read
through the installation instructions which come with the hardware, as some have unique requirements for
optimal installation which may be different to what you might expect, and in some cases the default
Windows XP driver will not function as well as the latest specific drivers for the device.

B ADD OR REMOVE PROGRAMS

The main use for this utility is not so much for the addition of new software - that typically only requires
that you insert the installation CD/DVD into your drive and follow the procedures from there, or the
execution of the software's setup executable file. Rather this tool is most useful for looking at the software
and drivers currently installed on your system and quickly being able to remove ones that are no longer
needed. It is always a good idea to go through this list periodically and remove software that hasn't been
used for a long time. You can sort this list in various ways by going to the top right corner and for 'Sort by',
selecting either Name, Size, Frequency of Use or Date Last Used.

On the left side of the screen, you will see the major functions available under this utility. We've covered the
addition and removal of software so far. You can also 'Add/Remove Windows Components', which is
covered in the Disk Cleanup & Defragmentation section. The final option is the ability to 'Set Program
Access and Defaults' that is covered below.
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SET PROGRAM ACCESS AND DEFAULTS

Click the 'Set Program Access and Defaults' button, and on the next screen you can choose from two presets
(Microsoft Windows or Non-Microsoft), or as I recommend, click on the third Custom option. Next, click the
double down arrows to the right of Custom. Here you can set the default Web Browser, email program,
media player, instant messaging program and Java virtual machine.

For example, if you want to make Mozilla Firefox the default browser instead of Internet Explorer, as long as
you already have it installed on your system the option to select it as the default should appear here. Select
it, and make sure a tick appears in 'Enable access to this program' next to it. You can disable access to
Internet Explorer by removing the tick in the 'Enable access to this program' box next to it as well. This won't
uninstall Internet Explorer, it simply removes access to it, which is not recommended. I recommend you
select 'Use my current Web browser' instead which should be fine for most purposes and ensure a tick
appears next to all browsers below it so that you can access them all as need be.

Although Microsoft has incorporated this feature as a result of charges relating to monopolistic behavior,
bear in mind that quite often you must use a Microsoft product for optimal trouble-free usage. For example,
only Internet Explorer can access the Windows Update site, and only Windows Media Player can provide
playback of WMV files. Don't disable access to these default applications for that reason. In all cases I
recommend selecting 'Use my current...' and allowing access to all the components beneath. There is one
exception - if you want to disable access to Windows Messenger as part of removing it from Windows,
untick the 'Enable access to this program' box next to it, as it has no other use.

B ADMINISTRATIVE TOOLS

There are seven main administrative tools under this category. Some of them may not be available if you run
Windows XP Home. In particular if you are running Windows XP Professional, you will also have access to
the Group Editor, but that is covered separately in the Group Policy section. If you have installed the .NET
Framework on your machine, you will also have access to the NET Config and NET Wizard tools. I cannot
go into detail about all the functions of these administrative tools because they are capable of a great many
things, as described in this Microsoft Article. However, I provide brief details of the primary Administrative
Tools and point out their most useful aspects for the average home PC user below.

COMPONENT SERVICES

This tool allows system administrators the ability to deploy and administer component services applications
or automate administrative tasks. For our purposes, the only real usage is the Event Viewer and the Services
components, both of which also have separate tools to allow direct access to them - see each of these below.

COMPUTER MANAGEMENT

The main unique use for the Computer Management tool is the Disk Management sub-component, which
you can access by double-clicking on the Storage item in the left pane and then clicking on the Disk
Management (local) item that appears underneath it. You will then see your hard drive(s) listed in the top
right pane, with all your available drives (including CD/DVD/CDRW drives) listed in the bottom right pane.

If you want to change any of the drive letters on your system - for example if you want to swap your
CDROM drive from D: to E: or just change it to a new letter like Z:, you can do so here by right-clicking on
the drive letter in the bottom right pane and selecting 'Change Drive Letter and Paths', then highlighting the
drive letter which appears, and selecting the Change button, and assigning a new drive letter.

If you want to convert a hard disk from a Basic to a Dynamic volume, you can do so here by right-clicking
on the Disk 0 (or Disk 1, etc) box in the bottom right pane, and selecting 'Convert to Dynamic Disk'. Dynamic
disks can emulate a RAID array - that is they can span multiple drives as though they are one large drive.
The features of Dynamic Disks are discussed in this Microsoft Article. Note that dynamic disks are a storage
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type not supported on Windows XP Home Edition or earlier versions of Windows. It is not recommended
that you convert your disk from basic to dynamic, because even though you can covert back to a basic disk
you will lose all your data. If however you have a specific reason to use this function, the option is here.

DATA SOURCES (ODBC)

This tool lets you add and configure drivers for managing access to data on various database management
systems. Unless you use databases extensively on your machine, you can ignore this tool. There are no
general functions for this tool that can be discussed here. Note that this is the same tool as the Data Sources
(ODBC) item in the main section of the Control Panel.

EVENT VIEWER

The Event Viewer tool shows a list of events under the Application, Security and System categories. These
events are recorded by Windows over time, and reflect information alerts, warnings and errors that have
occurred to date. You can view the (limited) details of an event by double-clicking on it. Event Viewer can be
used to troubleshoot an event if you haven't had the chance to see an error message — for example because
your system rebooted before you could read it.

LOCAL SECURITY PoLICY

This tool allows the setting and altering of security-related settings. This is best left at default and I
recommend that you do not change any of these settings unless directed to by a Network Administrator or a
Technical Support expert.

PERFORMANCE

This tool allows users to examine the various performance variables on their system, such as CPU usage or
page file usage in graphical and numerical form. You can add components to the display by clicking the
large '+' button above the graph. A more user-friendly interface can be added to the Performance Monitor by
downloading the Microsoft Performance Monitor Wizard.

SERVICES

This tool is extremely useful in configuring service usage under Windows XP. Changes to settings made
under this tool can affect both performance and XP functionality quite noticeably, so see the Services Utility
section dedicated to explaining these features in more detail and showing you how to optimize them.

That covers the initial look at all the administrative tools in Windows XP. As mentioned, certain tools are
covered in more detail later in this guide due to the need to use them often. Generally though, aside from the
Services utility you should not need to access the administrative tools very often and great caution should be
used when changing any settings with them.

B AUTOMATIC UPDATES

The Automatic Updates function in Windows allows your machine (when connected to the Internet) to
periodically check for updates on the Windows Update website and depending on the options you set here,
download and install them as necessary. When set to Automatic here, Windows will check for updates as
often as you specify, and if an important update for your system is found it will download and install it for
you at the same time. If you specify 'Download updates for me, but let me choose when to install them’,
Windows will download the updates but only install them when you choose. Neither of these two options is
recommended, as updates may be downloaded at inconvenient times (e.g. during the playing of an online
game), and without your explicit consent. Although no Microsoft updates are harmful, I still recommend
you keep tight control over the downloading and installation of Windows Updates.
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Instead, if you feel as though you will forget to check the Windows Update site regularly, and want to be
told whenever important updates are available, select the 'Notify me but don't automatically download or
install them' option. That way you will be told when an important update is available, but you can still
choose if/when to download and install them.

My personal preference (and the most optimal for performance and privacy) is the final option: "Turn off
Automatic Updates'. This means the Windows Update service will not constantly run in the background,
taking up valuable resources, and at the same time you can simply check the Windows Update website
manually every few days to see if you should download any important updates.

Note that under Windows XP SP2 the 'Automatic Updates' service must be set to Automatic to allow you to
access the Windows Update website, even if you set Automatic Updates to Off here. See the Services Utility
section for more details.

B DATA SOURCES (ODBCQ)

This tool is discussed under the Administrative Tools entry above, and has exactly the same function.

B DATE AND TIME
DATE AND TIME

Set the current date and time under this tab.

TIME ZONE

Select the time zone that applies to you, and also tick the 'Automatically adjust clock for daylight savings'
option. This means that whenever daylight savings changes in your area, the clock will be automatically set
forward or back as appropriate — handy if you rarely remember when daylight savings actually occurs.

INTERNET TIME

Unless having the exact system time is critical to your Windows usage, untick the 'Automatically
synchronize with an internet time server' to reduce any interference during your internet usage (e.g. during
online gameplay). Instead of this you can manually update the clock every once in a while under the Date
and Time tab. See the Services Utility section for details on how to disable the Windows Time service as well
to reduce further unnecessary resource usage.

B DISPLAY
THEMES

You can switch between the Windows Classic theme, which makes XP look like previous versions of
Windows, or select the unique Windows XP theme. You can also save any changes you make to Windows
XP's look by creating a custom theme and saving it. Selecting the Classic theme will provide some memory
savings due its less graphically intense nature, however if you prefer the Windows XP theme I recommend
you use it regardless. There's no reason why you should tweak the aesthetics of Windows XP away for no
performance gain — uglier does not equal faster.

DESKTOP

Select a Wallpaper you would like to display in the background of the Windows Desktop. If the defaults
ones listed in the preview pane are not to your liking, you can choose one from an existing picture anywhere
on your hard drive or an inserted CD/DVD by clicking the Browse button. Note that to minimize memory
usage and speed up bootup time, you should either not use a wallpaper at all, or preferably select a
wallpaper that is the same size as your desktop and less intricate — that is a picture with a smaller file size.
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Click the 'Customize Desktop' button and untick the 'Run Desktop Cleanup Wizard every 60 days' option to
minimize its annoying intrusion. You can also select whether to display or remove the My Documents, My
Computer, My Network Places and Internet Explorer icons from your Desktop. Removing these icons
(unticking them) here will not disable their functionality - it will simply remove their icons from the
Windows Desktop. Note that if you wish to remove the Recycle Bin from the Desktop see the Group Policy
section or the Registry Editor section for the relevant tweak.

You may wish to change the appearance of any of the major system icons that appear on the Desktop. You
can choose to alter their appearance by highlighting them in the scroll list below, selecting 'Change Icon' and
assigning a new icon in their place.

Under the Web tab, you can choose to have Internet-based content displayed on your Desktop. Tick the 'My
Current Home Page' box if you want the home page specified in Internet Explorer to be used on the Desktop.
Alternatively, click the New button and you can assign a different URL for the page used on your Desktop.
For performance reasons I strongly recommend against having any web content on your Desktop, so I
suggest unticking all of the boxes on this page.

SCREEN SAVER

I recommend you set the screen saver to None. Modern CRT monitors do not require screen savers to protect
their display from 'burn-in' (permanent image imprinting), and unless you enjoy the novelty of a screen
saver, it is unnecessary. If you have any other type of monitor or display you may want to enable the
screensaver to prevent static images becoming temporarily or permanently imprinted on the screen. For
example, although LCD monitors do not suffer burn-in, a residual of a long-displayed static image may
remain on some screens for a while, so an animated screensaver is an easy way to prevent this. Note that the
settings under the Power button are covered in the Power Options section below.

APPEARANCE

I personally prefer the Windows XP Style for Windows and buttons. This uses a small amount of extra
memory over the Windows Classic Style, but looks much nicer in my opinion and has no impact on
performance in applications or games for example. You can adjust the individual elements of the desktop
theme by clicking on the Advanced button, selecting the element you want to change from the drop-down
list, and adjusting its properties accordingly.

Under the Appearance tab, click the Effects button, and I recommend unticking as many (if not all) options
as possible for maximum performance and responsiveness. I personally only have 'Show window contents
while dragging' ticked here.

SETTINGS

You may find two monitors listed under the Display list. This is normal for graphics cards such as ATI
Radeons, even when only one physical display is currently attached. Select the Screen Resolution you want
for the Desktop, and the Color Quality to go with it. Note that some recent programs and games may
experience problems if the Desktop is anything less than 32 bit Color quality, so 32 bit (if available) is
recommended for maximum stability and compatibility. The performance degradation is minimal if not
insignificant on your Desktop.

If you click the Advanced button under the Settings tab, you will be taken to the control panel for your
graphics card. While many sections of this screen differ based on your particular graphics card, all graphics
cards share the following common elements, which are described here:

Under the General tab, the DPI (Dots Per Inch) setting determines the relative size of everything on your
screen. If you run at extremely high or extremely low resolutions for example, you can change the DPI to
scale the elements of your screen to a more suitable size without having to change your resolution. The
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default of 96 DPI is recommended for most people. I also recommend selecting the 'Apply the new display
settings without restarting' option, as you do not need to restart your machine each time you change a
display setting.

Under the Adapter tab, you will find the details of your current graphics adapter (i.e. your graphics card). If
the details are incorrect, this could indicate a poorly installed or incorrect driver, or modified hardware.

Under the Monitor tab, you can set the Refresh rate used by your monitor for the current screen resolution. I
strongly recommend that you first tick 'Hide modes that this monitor cannot display’, then select the highest
refresh rate listed. The refresh rate determines how many times per second the image onscreen is redrawn.
The higher the setting, the more times the screen is 'refreshed’, and the less strain there is on your eyes. It is
strongly recommended that you use a utility called Refresh Force to force the highest possible refresh rates at
each resolution on your system. This utility is easy to use, and is supported by all graphics cards. It is
covered in more detail near the bottom of this page of my ATI Catalyst Tweak Guide.

Under the Troubleshoot tab, move the slider under 'Hardware acceleration' to the far right, and tick 'Enable
write combining'. This ensures maximum performance, and you should only change these if troubleshooting
a specific graphics-related problem.

Under the Color Management tab, select the color profile that matches your monitor model and click the 'Set
As Default' button. If there is no profile listed for your monitor, click the Add button and select one which
matches your monitor model, or if none seem appropriate, insert your monitor's driver CD, browse to your
CDROM drive and find the correct .LCM file, then click Add. The color profile ensures your monitor
displays colors as they are intended to appear.

CLEARTYPE

For users of LCD panels and other display devices that may require some enhancement to make text appear
sharper and clearer on screen, Microsoft has a hidden option called ClearType you can enable in one of two
ways - firstly by using this Microsoft Online ClearType Tuner or by downloading and using the ClearType

PowerToy Ultility. In either case, ClearType helps improve font display quality on some displays, so check it
out and see if it meets your needs.

GRAPHICS CARD CONTROL PANEL

For full details on how best to configure the remaining graphic card-specific elements of Display Properties,
for ATI graphics cards you should refer to my ATI Catalyst Tweak Guide. For Nvidia users, refer to my
Nvidia Forceware Tweak Guide for details of the various features of the Nvidia control panel.

When you're done altering the settings in Display Properties click the Apply button. Then go back to the
Themes tab, click the 'Save As' button and select a new name and location to save your customized theme
settings.

B FOLDER OPTIONS
GENERAL

Under the General tab, select 'Use Windows classic folders' to get rid of the lumped-together 'common task’
icons. The choice is yours of course, but this guide assumes you are using the classic folders view when
giving directions on accessing features. If necessary you can use classic folders while following this guide,
and then switch back to the default XP folder view once you're finished.

Select 'Open each folder in the same window' to reduce open windows.
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Select 'Double-click to open an item (single-click to select)' as this is the default method most Windows users
are familiar with, and the one which is assumed when providing descriptions in this guide. You can always
switch to the other method once you have completed using this guide.

VIEW

In this section I recommend you tick the following options:

Display file size information in folder tips

Display simple folder view in Explorer's folder list
Display the contents of system folders

Show hidden files and folders

Show and manage the pair as a single file
Remember each folder's view settings

Show encrypted or compressed NTEFS files in color

It is highly recommended that the following are unticked for best performance and functionality:

Automatically search for network folders and printers (only tick if you are on a Network)
Do not cache thumbnails

Hide extensions for known file types

Hide protected operating system files

Launch folder windows in a separate process

Show popup description for folder and desktop items

Use simple file Sharing

Any remaining options can be ticked or unticked according to your tastes.

FILE TYPES

You can view and change which tools will open particular file extensions by default. For example, scroll
down to the TXT extension (text documents) and highlight it. In the details below you can see that the
default tool for opening .txt files is Notepad, and if you click on the Change button you can choose another
application as the default. Sometimes certain installed applications will quietly change these to suit their
own needs without asking you, so check back here if you find your files opening with something other than
the application you want to use and make changes as appropriate.

OFFLINE FILES

I recommend you untick 'Enable Offline Files'. You'll still be able to view saved/cached web pages offline. If
the option is unavailable, it is because you have Fast User Switching enabled (See User Accounts below), in
which case you can ignore this section.

B FONTS

This item displays the contents of your \ Windows\ Fonts folder, which contains all your currently installed
system fonts. Fonts are the various types of text styles used by a variety of programs such as word
processors, paint programs and the Windows Notepad for example. You can install a new font simply by
copying its .FON or .TTF files into this folder, or by going to the File menu and selecting 'Install New Font...'
and pointing to the directory where the new font files reside. Note that TrueType is a font technology that
ensures good scaling and that what is displayed on your screen should come out exactly the same on your
printer. Other types of fonts may look slightly different in different applications and/or when printed and/or
when using different font sizes. To find out more about fonts, go to the Microsoft Typography Website. A

good site that contains additional fonts you can download and install for free is Simply The Best Fonts.

[PueJ [013U0D) YT,

Copyright © 2005 Koroush Ghazi 6 3



http://www.microsoft.com/typography/default.mspx
http://simplythebest.net/fonts/

Gwmu THE WINDOWS XP TWEAKING COMPANION

B GAME CONTROLLERS

This tool allows you to add or remove gaming controllers on your system. This typically includes gamepads,
joysticks and game simulation hardware. Note that although often used in PC games, the mouse and
keyboard are not classed as 'game controllers' here - they have their own separate setup tools in the Control
Panel (see Keyboard and Mouse below).

Note that most joysticks require something called Calibration - a process under the device's Properties which
tells Windows when the joystick is at absolute center, when it is at far right, far left, etc. If this is not done
then often you will find the joystick will be unresponsive in certain directions, or it will constantly appear to
be pushing in one direction when it is actually at rest, etc.

The majority of game controllers have their own software for installing and setting up the device, however
firstly I recommend clicking the Add button in the Game Controllers section and using the closest device
description which matches your device. If then during gameplay you find your device is not functioning at
all, or missing certain functionality, you should then install and use the device-specific software in place of
this utility. This will minimize the background resource usage that specialized device drivers often bring
with them.

Finally, if you play certain games only using the keyboard and mouse combination, and you find your
character is displaying strange movement behavior (e.g. constantly walking forward with no user input),
then physically disconnect all game controllers from your system (excluding keyboard and mouse) and
reboot, then relaunch the game.

B INTERNET OPTIONS

This setting in the Control Panel simply brings up the Internet Explorer 'Internet Properties’ box. There is no
difference between accessing it here and accessing from within Internet Explorer, so see the Internet Explorer
section for full details of how to configure these options. Note if you are using another browser as the system
default browser then clicking this item will still bring up the Internet Explorer 'Internet Properties' box - this
is normal and cannot be changed.

B KEYBOARD

Under the Speed tab, I recommend you set the 'Repeat Delay' slider to the far right and also set the 'Repeat
Rate' slider to the far right. This will increase the responsiveness of the keyboard in Windows XP. You can
also adjust the 'Cursor Blink Rate' to your taste, and then click OK to apply. You can test these settings in the
box provided to see if they suit you. Note you can further customize the cursor's blink rate and width under
the Display tab of the Accessibility Options item in Control Panel.

B MOUSE

I only cover the basic mouse settings here, and most of the settings in this section can be adjusted to taste. If
you have installed a special mouse driver for your mouse, you may see different settings under this screen,
however the settings below should still be available on most systems with a mouse.

POINTERS

I recommend you untick 'Enable Pointer Shadow' at the bottom.

POINTER OPTIONS

I recommend ticking the 'Enhance pointer precision' option before you adjust your pointer speed. This
option enhances the acceleration/deceleration of your mouse to provide for larger movements when you
move the mouse fast, and finer movements when you move the mouse more slowly, allowing more
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precision. I recommend unticking the 'Display pointer trails' option to reduce mouse 'lagginess' unless you
have an older or less clear screen and have difficulty keeping track of mouse movements.

WHEEL

If your mouse has a mousewheel, you can increase the wheel's responsiveness by increasing the number of
lines it will scroll on each turn of the wheel. Even an increase from the default of 3 to 4 will make a subtle,
but noticeable difference if you previously found the mousewheel relatively unresponsive.

B NETWORK CONNECTIONS

Because of the sheer variety of network connection hardware, altering your Network Connections settings is
not a simple procedure and I will not be covering it in detail in this guide. If you have a Dialup connection -
that is 56K or lower connection speed - then read this Dialup Modem Tweak Guide for more details. If you

have DSL or Cable, use the information from this DSL/Cable Tweak Guide for guidance. If you are on a
network, consult your Network Administrator before attempting to alter any of the Network Connection
settings, and be very careful about which settings you implement from this guide, especially those under the
Services Utility and Folder Options sections.

QO0S PACKET SCHEDULER

The following is recommended for home dialup and Cable/DSL users (but not for Network or Shared users).
Right-click on the device you use to connect to the Internet, and select Properties. Go to the Networking tab,
and under the 'This connection uses the following items' list, make sure the Internet Protocol (TCP/IP) option
is available and ticked. Now select every other item listed, especially the 'QoS Packet Scheduler' and select
the Uninstall button to remove them. None of these are required for regular Internet usage, and removing
them will reduce wasted resources and maximize your bandwidth. Should they be needed again you can
choose to reinstall them from here at any time.

Note if you disable the QoS Packet Scheduler you should also disable the 'QoS RSVP' service (see Services
Utility section).

WINDOWS FIREWALL

Under the Advanced tab click the Settings button and turn the Windows Firewall On (as advised
previously), unless you have third party firewall software already installed, in which case activate that
instead. To find out more about the Windows Firewall, read this Microsoft Article.

B NETWORK SETUP WIZARD

This wizard will take you through the steps required to connect a network device, including any device that
connects your machine to the Internet. You can follow the steps in the wizard to connect your device,
however I generally recommend following the procedures that come with your device. Typically this
involves connecting the device to your machine and installing the device drivers that come with it (or vice
versa).

B PHONE AND MODEM

As mentioned under Network Connections above, because of the variety of modems that can be used to
connect to the Internet, or to other electronic devices, I cannot provide specific setting recommendations here
for each device. Check the links under Network Connections above for more details.

As with installing any other type of peripheral device under Windows XP, typically the best installation
procedure is to simply connect the device to your system, and wait for Windows XP to identify the device
and install the default drivers. However in the case of modems I recommend installing the latest available
drivers or at the very least the drivers which come on the device's driver CD. If you have any doubts about
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what settings to use once the device is installed, I strongly recommend leaving them at their defaults.
Changing these settings can see your modem or device not function correctly, and hence you may not be
able to connect to the Internet.

Note that devices listed under Phone and Modem includes devices loosely identified as 'modems' such as
mobile phone/PDA data hookups.

B PORTABLE MEDIA DEVICES

If you have a portable media device connected to your system, such as an MP3 player, you can manage the
device here. It is recommended that you refer to your device's instructions as to how best to configure it for
connection and usage with Windows.

B POWER OPTIONS
POWER SCHEMES

You can set the periods of time after which your monitor, your hard drive and/or your entire PC go into a
power-saving standby state to conserve energy. You can select an appropriate preset scheme such as
"Portable/Laptop' or 'Always On', or you can customize the settings yourself.

Unless you have a power-limited device, such as a laptop running on batteries, I recommend selecting
‘Always On'. If you are often away from your machine for extended periods of time while it is left on, select
a reasonably long turn-off time such as 'After 2 hours'. That way your system is not constantly powering up
and powering down, which doesn't really save much energy in the end and can increase wear and tear on
components such as monitors.

ADVANCED

I recommend unticking the 'Always show icon in the taskbar' option to remove the unnecessary power icon
in the system tray. If you don't use system standby, or if security is not a concern then I also recommend
unticking 'Prompt for password when computer resumes from standby'. In the Power Buttons section, select
the action you want for 'When I press the power button on my computer'. Once again, if you don't want to
use standby, and just want your machine to shut down when you press the power button, I recommend
selecting Shut Down from the list for the most trouble-free results.

HIBERNATE

I recommend not using Hibernation and hence I suggest you untick the 'Enable Hibernation' option here.
Hibernation uses a great deal of disk space to store the state of your machine at the time of hibernation
(equivalent to your physical RAM size), and for optimal stability I recommend that you start each computer
session with a clean bootup. This will reduce the possibility of memory-related problems and crashes.

uPs

If you have a power supply that is specifically classified as an Uninterruptible Power Supply (UPS), you can
configure it here. Most people do not use UPS power supplies, and if you're not sure whether you have one
then it's almost certain that you don't hence you can ignore this section. See the Services Utility section for
more details about how to disable the UPS Service altogether if you don't have a UPS power supply.

B PRINTERS AND FAXES

This section allows you to view all connected printers and faxes, and add or remove such devices. It is
recommended that you refer to the particular device's instructions for optimal setup information under
Windows XP as each will differ.
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Importantly, note that if you have disabled the 'Print Spooler' service then any printer on your system will
not function. Make sure the 'Print Spooler' service is set to Automatic - refer to the Services Utility section for
details. Furthermore if you have disabled the port to which the printer is connected in the BIOS or in Device
Manager (e.g. LPT1 or the specific USB Host Controller), perhaps to free up an IRQ, then once again your
printer will not function. Finally, if you are connected to a network printer and you have followed my
service configuration recommendations under the Services Utility section - which as noted are not intended
for networked computers - then your network printer may not be detected by Windows.

B REGIONAL AND LANGUAGE OPTIONS
REGIONAL OPTIONS

Select the language format that suits your particular region of the world. You can also set your country at the
bottom, and it is recommended that you do so to allow all your software to be able to customize options and
text displays to suit you, not just in Windows XP itself, but also in all the games and applications you use. If
you wish to customize any specific settings, such as data/time display formats, currency formats etc. click the
Customize button and do so accordingly. If you've selected the appropriate country though, the defaults
shown here should already be correct.

LANGUAGES

Click the Details button. In the 'Text Services and Input Languages' box that appears, select the default input
language.

If you only ever use one particular text service on your machine for each language, such as Keyboard (the
default, and a necessary service), then remove any other text services displayed under each language (such
as Speech Recognition) as they take up additional memory. Do this by highlighting the displayed text service
in the Installed Services box, and click on Remove.

Alternatively, if you want to Add a text service, or configure these advanced text services for various
functionality, see this Microsoft Article for more details. Remember, the use of advanced text services takes
up memory and can reduce system performance, so only enable these functions if you really use them often,
and not just as a novelty.

In the preferences section below it, if you have more than one text service installed you can click on the
‘Language Bar' button (otherwise it is unavailable). I recommend selecting 'Close the language bar' to
remove it from your desktop unless you specifically need it there. If you do use more than one language
often, I still recommend closing the Language Bar, and instead assign keyboard shortcuts for switching
between these languages, by clicking on the 'Key Settings' button here. This is a much more efficient method.

Under the Advanced tab of the Text Services and Input Languages box, unless you use any advanced text
services such as speech or handwriting recognition, tick the "Turn off advanced text services' option. If you
do wish to use advanced text services, and also want them to be available to all your programs and
applications, then tick the 'Extend support of advanced text services to all programs'. Click Apply and OK to
go back to the Regional and Language Options box.

Back under the Languages tab of the Regional and Language Options box, unless you use a right-to-left
language (such as Arabic or Thai), or an East Asian language, then make sure both boxes under the
Supplemental language support area are unticked. This removes unnecessary files from your hard drive.

ADVANCED

Select the language you want for non-unicode programs. Since Unicode basically allows most modern
programs to adapt their menus and dialogs to your system's default language, this setting only applies to
older non-unicode programs. These older (non-unicode) programs will use the Code page conversion tables
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listed to convert from other languages to your preferred language. While you can choose to remove or add
(untick or tick) various conversion tables in this section, I recommend against doing so as this can affect the
correct language display of any older programs you use. Some of the conversion tables are greyed out as
these are installed by default for Windows XP and cannot be removed.

If you want to make the settings you have modified in the Regional and Language Options box the default
for every user account created on this system as well as the current account, tick the 'Apply all settings to the
current user account and to the default user profile' box. Unless you share your machine with several people,
I recommend that you tick this option, but it is not essential that you do so.

B SCANNERS AND CAMERAS

This section will allow you to manage any digital image devices such as scanners or digital cameras
connected to your machine. Refer to your device's manual for specific setup recommendations. Typically
you will simply need to attach your device, turn it on and either Windows XP will detect it and install basic
(but adequately functional) drivers. I recommend that only if you are having problems accessing the device,
or with any of its important functionality that you should install device-specific drivers or software.
Otherwise the default Windows XP drivers are the most efficient and minimize background resource usage.

B SCHEDULED TASKS

The Scheduled Tasks utility allows you to set up particular tasks that your machine will then run at a
predetermined time and in a predetermined sequence. To create a new task, click the 'Add Scheduled Task'’
entry, and the Scheduled Task Wizard will commence, allowing you to detail the task to be run.

You can also view and edit existing scheduled tasks in this panel. I recommend you go to the Advanced
menu and select the 'View Hidden Tasks' option to ensure all scheduled tasks are shown. I personally do not
recommend having any scheduled tasks. Regular system maintenance for example is best carried out
manually, at intervals determined by frequency of use and not set periods of time (See the Regular
Maintenance section).

Note that the 'Task Scheduler' service must be set to Automatic for scheduled tasks to function - see the
Services Utility section for more details.

B SECURITY CENTER

The Windows Security Center is a new addition for SP2 that unifies access to, and monitoring of, major
security-related Windows settings on your system. Primarily these are the Windows Firewall for protecting
against externally-initiated intrusions into your system, Automatic Updates which ensures notification
and/or installation of important Windows XP updates as they are released by Microsoft, and Virus
Protection which works in conjunction with your virus scanner to make sure your system is free of infected
files which can compromise your system's security, stability and privacy.

Each of these areas and appropriate recommendations is covered in the relevant section of this guide: the
Windows Firewall is covered in the Windows Firewall section below; Automatic Updates is detailed in the
Automatic Updates section above; and Virus Protection is covered under the Virus Cleaning section above.
The Security Center is simply a means of gaining access to all of these and changing some of their settings in
a central location. As such, it's not actually a dramatic improvement in security - simply one that makes
users more aware of the types of things they have to monitor and change to maintain system security.

The one new setting which I do find very annoying and I recommend you change is the Virus Protection
setting. In the 'Virus Protection' box in the Security Center click the Recommendations button. In the
Recommendation box which opens, I suggest you tick the box at the bottom. This will prevent Windows
from constantly reminding you that your virus scanner's reference file is out of date, or that your virus
scanner is not found, or that it is not currently active. For starters many popular antivirus programs are not
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supported by this feature. Secondly, it should be part of your regular maintenance procedure to manually
update your virus scanner and run manual scans as often as possible. Finally, as I recommend throughout
this guide, having a virus scanner running in the background can and will reduce your system performance
for marginal gains in security. For all intents and purposes as long as you follow the other recommendations
in this guide your system should be quite secure and clear of malicious software. If however you are
genuinely forgetful and your virus scanner appears to be supported by this feature, you may wish to keep
the monitoring function of Virus Protection enabled.

Note the Windows Security Center won't function fully if the 'Security Center' service has been Disabled (See
the Services Utility section). I recommend that the 'Security Center' service be set to Automatic to begin with,
then adjust your settings as recommended above, then disable the 'Security Center' service again as it is not
necessarily to continually access the Security Center to maintain security on your system. That is, disabling
the 'Security Center' service will not disable the Windows Firewall, Automatic Updates or Virus scanner
functionality at all.

B SOUNDS AND AUDIO DEVICES
VOLUME

Adjust the volume to suit your taste, and make sure the Mute option is unticked. I recommend ticking the
'Place volume icon in the taskbar' option as adjusting the volume is something you may do often in
Windows, so this provides quick access by placing a speaker icon in the System Tray.

I will cover the settings under the Advanced button a bit later below, as part of my instructions for optimal
sound output.

Under the Speaker settings section, you can independently adjust each speaker's volume level by clicking the
Speaker volume button. In general this volume can be adjusted under the Volume tab as described above, so
you only need use this section of the Sound options if you want to adjust the speakers to have different
volume levels each - which is generally not recommended.

I recommend you click the Advanced button here, and under the Speakers tab select the type of speaker
setup you are using, such as Headphones or Desktop Stereo Speakers. Choose the setting closest to your
particular setup. Under the Performance tab, move the 'Hardware acceleration' slider to the far right. This
ensures full use of your sound hardware's features. Only reduce the slider by one or two notches if you are
troubleshooting sound problems in a game for example. Move the 'Sample rate conversion quality' slider to
the far right. This ensures optimal sound quality, and there is no performance difference between the various
settings on this slider anyway.

SOUNDS

You can assign different sounds to particular system events in this section. Click on the Program event (e.g.
'Start Windows') and either scroll through the list of default system sounds in the Sounds list below and
select one, or click the Browse button to find a sound file elsewhere on your system which you can use. Press
the Play button to hear a preview of the sound.

I strongly recommend that you disable as many system sounds as you can, as they take up system memory
by being loaded into RAM at startup. In particular I recommend disabling sounds for 'Start Windows' and
‘Exit Windows' to both reduce memory usage and speed up booting and shutting down. Also note that
many programs such as Windows Messenger and Norton Antivirus add sub-entries to this section and
include their own specific sounds, even if you uninstall them later on. Go through the entire list carefully
and disable all unnecessary sounds.

You can quickly disable all system sounds by selecting the 'No Sounds' item under the Sound scheme area -
this doesn't turn off sound on your system, it simply removes sounds effects from all the various system
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events thereby reducing memory usage by these sounds. Then if you want to keep sounds for certain
important events, such as Default Beep or System Notification, I recommend you apply the same sound to
several similar events. For example, on my system I use the Exclamation.wav sound for all warning and alert
events (i.e. Asterisk, Critical Stop, Default Beep, Exclamation, New Mail Notification and System
Notification). That way if Windows runs into a problem or provides a warning/notification I can still hear an
audible indicator of it, but by using the same sound for each my memory usage is greatly reduced.

Once done, Save these new settings by clicking 'Save As..." and entering a new name.

AUDIO, VOICE

Make sure the default device in each of these categories is your primary sound hardware then tick 'Use only
default devices' to minimize problems and conflicts with any other sound devices on your system.

OPTIMAL SOUND CONFIGURATION

To configure your Sound settings for optimal sound output on your particular setup, the following is a
procedure you can follow:

1. Click the first Advanced button under the Volume tab of the Sounds and Audio Devices box.
Alternatively, simply double-click on the Volume icon in the system tray.

2. In the Volume Control dialog box that appears, go to the Options menu and make sure the 'Advanced
Controls' option is ticked.

3. Select the Properties setting under the Options menu, and in the box that appears select your main
sound output device in the Mixer Device list. Select Playback in the next section. Place a tick against
every item in the list shown, and click OK. Back in the Volume Control window, you will notice it has
expanded to show Volume, Balance and Mute options for every audio output method on your system.

4. Go to the master Play Control (far left) and adjust the master Balance setting. Unless you specifically
need an offset balance, the neutral (absolute middle) position is recommended.

5. Make sure the 'Mute All' option is unticked

6. Set the master Volume level to around the center position on the slider, then play a high quality music
or audio file on your system (not CD Audio as that uses independent sound) and adjust your speaker
hardware's physical volume controls until the sound level is correct.

7. Click the Advanced button, and if available to you (depending on your sound hardware) adjust the Bass
and Treble settings to taste. If you don't have Digital Output from your sound hardware, make sure the
'Digital Output Only' box is unticked, otherwise you will not hear any sound. Click Close when done.

8. Now go to the Wave output method in the Volume Control box, and make sure the Mute option is
unticked. Again, while playing some music on your system adjust the Wave volume and your speaker
hardware volume control together until the combination suits your taste and has the least amount of
background noise/hiss. The Wave output method is the output method used by most games,
applications and audio playing software so it's clearly important to set it up correctly and at a tolerable
level.

9. Go through and adjust all the other sound output methods' Volume and Balance settings to taste. To
further reduce background noise and hissing, I recommend muting (tick the Mute option) for every
sound output method you do not regularly use. Input devices, such as Line-In, TAD-In and Microphone
in particular can significantly contribute to background hissing, so mute them until needed.

10. Once done, go to the Options menu and select Properties, then untick all the sound output methods
except those that you will be adjusting the properties for quite often. This will not disable these
methods, only remove them from displaying in the Volume Control box, making it more manageable
the next time you open it. At a minimum I recommend you leave the Play Control and Wave items
ticked, as these are used most often on all machines.
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If you have a complex speaker setup or third party audio software you may wish to use that to adjust
equalizer settings for example. In which case after you've followed the advice above go into that software
and conduct more setting tweaks as necessary.

Importantly, if your sound hardware has any Environmental Audio or Special Effects settings in your sound
card-specific software (such as the EAX Control Panel in the AudioHQ for SoundBlaster cards), open these
settings and disable all effects. These additional effects typically cause problems in games and can distort
music and other audio played back on your machine.

B SPEECH

This utility allows you to configure the speech recognition and text-to-speech capabilities of Windows XP. To
use speech recognition, you will require an input device (i.e. microphone) connected to your system.

To use text-to-speech functionality, you don't require anything other than audio playback hardware such as
a sound card and speakers/headphones. You can select the voice style used to convert text to speech, and
adjust its speed here. Note that this functionality must be supported by the program or game you are using
if you want it to work. Also note that in most games or applications where you can enable a synthesized
voice (e.g. Unreal Tournament 2004), you should be able to adjust the characteristics for this voice in this
section of the Windows Control Panel since it is likely using the default Windows voice engine.

B SYSTEM

This is a very important section of Windows XP, and is covered in detail here. Each of the tabs under System
Properties is dealt with below.

GENERAL

If any of the details displayed are incorrect then it is a sign of a bad install, new/unsupported hardware, IRQ
conflicts, poorly installed/incorrect drivers or overclocking problems. In general if your system is
functioning correctly then the information in this section should be correct. You may notice your CPU's
speed rating is shown slightly higher or lower than its actual rating - this is normal.

COMPUTER NAME

Leave the Computer Description field blank, or use a generic description. To change your computer name,
click the Change button. In both cases I strongly recommend against placing anything uniquely identifiable -
such as your real name or address - in these fields. Unless you are part of a network of computers (the
Internet doesn't count as a network), there is no need to alter your Network ID, nor the Workgroup you
belong to. If you are part of a network, consult your System Administrator before attempting to change any
of the settings above as it may result in problems or completely dropping out from the Network.

HARDWARE

If you have any hardware that is not being detected correctly try the Add Hardware Wizard. As previously
recommended, click the Driver Signing button and select 'Ignore - Install the software anyway and don't ask
for my approval'. Tick 'Make this the system default'. Despite what Microsoft says, most drivers are OK if
unsigned and there is no problem at all with them as long as they are from a reputable manufacturer, such as
ATI, Nvidia or Intel.

DEVICE MANAGER

Click the Device Manager button, go to the View menu and select 'View Devices by Type' and also tick the
‘Show Hidden Devices' option. You will see all the devices connected to your system at the moment, most of
which are physical devices, some of which are virtual devices. Devices with a yellow question mark or
exclamation mark next to them will need further troubleshooting to correctly identify and install. Typically
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this involves ensuring the device is correctly attached to your system, then double-clicking on the device in
Device Manager, selecting Update Driver under the Driver tab, and following the prompts to install or
reinstall the correct driver for the device. You may also need to install any software that came with the
device to correctly use it. See the Troubleshooting section for more details of Device Manager error codes.

You should disable devices that you don't regularly use to speed up windows and free up resources. Ideally
this should be done first in the BIOS (See BIOS Optimization section above). However, to disable a device in
Device Manager, double-click on the device and select 'Do not use this device' under the Device usage area.
A red cross will appear next to it. Make sure to only disable devices you knowingly do not use. If in doubt
leave them enabled, or re-enable them if you experience any unusual behavior.

Go to the View menu and choose 'View Resources by type', then expand the 'Interrupt Request (IRQ)' item.
Make sure each major device in your system (graphics card, sound card etc.) is on a separate IRQ from other
major system devices. See the BIOS Optimization section for more details on IRQ sharing.

DEVICE MANAGER - OPTIMIZE DRIVES

To optimize the performance of your hard drive(s), go to the Disk Drives section in Device Manager and
expand it. Right-click on each hard drive available, select Properties, and under the Policies tab make sure
'‘Optimize for Performance' is selected. If available, also tick the 'Enable Write Caching on the disk' option.
The aim is to allow the hard drive to use a Cache — a small area of memory set aside specifically for the hard
drive — to speed up reading and writing to the drive. Note that these options may not be available to be
changed here if you are using a SCSI or certain Serial ATA (SATA) hard drives. If you are using such a
SATA or SCSI disk, select the SCSI properties tab and make sure that both 'Disable tagged queuing' and
'Disable synchronous transfers' are unticked for maximum performance.

To optimize all system drives, in Device Manager go to the IDE ATA/ATAPI Controllers section and expand
it. Right-click on the Primary IDE Channel, select Properties, and under the Advanced Settings tab select
'DMA if Available' for all devices actually connected. For devices that are not connected to your system,
select None under Device Type to speed up bootup. Do the same for the Secondary IDE Channel. Once
again, DMA Mode settings may not be available for certain drives such as SATA or SCSI devices.

DEVICE MANAGER — REMOVE UNUSED DEVICES

For each device that has ever been connected to your system, Device Manager will retain a range of entries in
the Windows Registry relating to the device type, and the drivers and settings it used. That way if it is ever
reconnected it can be quickly recognized again. However there are times when you have permanently
discontinued the use of a device and you want to clean out the Device Manager of these unused devices. To
firstly view unused devices in Device Manager, do the following;:

1. Open a Command Prompt by going to Start>Run and type "cmd" (without quotes) then press Enter.
Once the MS DOS prompt is open, type the following lines exactly as shown, pressing return after each:

Set devmgr show nonpresent devices=1

Devmgmt .msc

3. You can now type "exit" (without quotes) and press Enter in the command prompt window to close it.

4. In the Device Manager window that opens go to the View menu and select 'Show Hidden Devices'. Now
start looking through all the devices. Devices in gray are usually old/unused and safe to remove by right
clicking on each one and selecting 'Uninstall'.

5. In particular, you might find several entries under the Monitors section from previous graphics driver
installations. You can typically delete all the greyed out entries but at least one un-greyed entry should
remain. You may also find old entries for previous graphics cards under the Display Adapters section
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that again can be removed. Remember that even with only one monitor connected there are usually two
entries for most ATI graphics cards, one of which is the Secondary - this is normal.

6. You should not remove any Microsoft devices such as those under the Sound section, or devices that
you are unclear about.

7. Once done, you can close Device Manager the usual way and the next time you open it up it will not
shown unused devices until you again use this method to do so.

Use this method with great caution. In particular I recommend you create a new System Restore point
beforehand. At the same time however if you do accidentally uninstall a hardware device which is currently
connected to your system, in many cases you can simply disconnect and reconnect the device, or reboot
Windows, and it will be redetected by Windows and the appropriate drivers installed again — so this method
doesn't permanently remove any device nor prevent it from future usage.

Back under the Hardware tab of System Properties, click the 'Hardware Profiles' button and for optimal
bootup speed have only one hardware profile and choose 'Select the first profile listed if I don't select a
profile in..." and set the time to 0 seconds.

ADVANCED

The Advanced tab of System Properties has three major areas of settings - Performance Settings, User
Profiles Settings and Startup and Recovery Settings - these are covered separately below:

Performance Settings

Visual Effects: For fastest performance, I recommend unticking everything except 'Use visual styles on
windows and buttons' and 'Use drop shadows for icon labels on the desktop'. That will reduce usage of
system resources for graphical effects, while still retaining the majority of Windows XP's trademark
appearance.

Advanced: In the Processor scheduling section select the Programs option for optimal performance on most
systems. The 'Background Services' option will only improve performance on systems where multiple
programs are often run together.

Under the Memory usage section, once again select the Programs option. The 'System Cache' option is
primarily for servers, where more memory is used to speed up disk access at the expense of available
memory for programs. Importantly, data corruption may occur under certain conditions if the 'System
Cache' option is enabled. These circumstances include one or more of the following: an ATI graphics card,
more than 512MB of RAM, and a large NTFS disk or multiple large volumes (60-100 gigabyte hard drives
possibly in RAID arrays). It is strongly recommend that you do not select the System Cache option in such
circumstances just to be safe.

For optimal settings under 'Virtual Memory', see the Virtual Memory section for full configuration details.

Data Execution Prevention (DEP): This is a new technology introduced with Windows XP SP2 that uses
software and (where supported) hardware detection of programs that try to access and run code from
designated 'mon-executable’ memory areas. Full details of it are in this Microsoft Article. In practice DEP
protects against viruses that have become resident on the system and which then try running malicious code
from such areas. When Windows DEP detects an attempt to launch an executable from a non-executable
memory area it will shut the program down and provide a notification that it has done so. Hence if you are
experiencing crashes or problems in games for example, unless you see Windows give you a specific DEP-
related warning, it is unlikely that DEP is the cause of the problem.

By default when "Turn on DEP for essential Windows programs and services only' is selected, DEP
protection is only enabled for programs that choose to work with DEP, and Windows system files. This is the
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minimum form of DEP protection. You can choose to extend this protection to all programs by selecting
‘Turn on DEP for all programs and services except those I select' - and then choose which programs to
manually exclude from DEP by using the Add and Remove buttons.

I recommend leaving DEP at its default setting ("Turn on DEP for essential Windows programs and services
only') as it is not problematic on most machines and helps reduce any potential damage from virus activity
on your computer. However if you want to change your DEP settings in more depth, including the total
disabling of DEP, you can do so by editing your Boot.ini file (To access Boot.ini see the Microsoft
Configuration Utility section). The entry to change in Boot.ini is the /NoExecute= option. By default it is set to
/NoExecute=Optln however you can change the Optln value to one of the ones below to change DEP's
implementation:

OptOut - Applies DEP to all processes and you must then set which programs are excluded manually. This is
the same as the "Turn on DEP for all programs and services except those I select' option above.

AlwaysOn - Provides full DEP coverage for your entire system. If you are concerned about potential virus
activity on your system and want maximum protection you can use this setting, although older software
may have problems with it.

AlwaysOff - This option turns off DEP completely. It is not recommended unless you are having a lot of
problems with program crashes even after thoroughly cleaning your system by following the advice under
the Virus Cleaning section of this guide.

My personal setting is the Windows default of /NoExecute=OptIn and so far I have had no issues or problems
with DEP. However if you are having DEP problems /NoExecute=AlwaysOff should fix them temporarily,
although I don't suggest it as a long-term solution.

User Profiles Settings

Back under the Advanced tab of System Properties, click the Settings button under User Profiles, and
examine the profiles stored on your computer. There will always be at least two profiles - the Administrator,
and the default User profile here. If you are absolutely certain any other profiles are no longer in use, you
can select them and press Delete to remove them from the system.

Startup and Recovery Settings

Under the Startup and Recovery section, click the Settings button. For a system with a single operating
system, select ""Microsoft Windows XP [Home/Professional]" /fastdetect’ in the list presented. For a system
with multiple operating systems, select the one that you want to boot up by default each time you start your
machine. If you only have one operating system, or you don't want to select a different operating system
each time you boot up, untick the Time to display list of Operating Systems' option. Tick the 'Time to
display recovery options when needed' option and select at least 10 seconds if not more. This is the amount
of time you'll get to choose the type of bootup from the recovery menu after a bad system crash.

Click the Edit button and change the timeout= value in the second line to =0. You can also change the
/NoExecute= setting here as covered under the DEP information above. When done, save and exit the text
editor and the changes will be made to your Boot.ini file in you base directory. Under the 'System failure'
section untick all three options for optimal performance, and the 'Write Debugging Information' option
should be set to None. That way if you run into problems you'll see the error displayed (usually a Windows
Blue Screen of Death (BSOD) message) and your system won't automatically reboot. At the same time you
won't get lots of logfiles and dumpfiles of the event cluttering up your hard drive. Re-enable these options if
troubleshooting a vague problem, or if Technical Support personnel ask you to provide these files.
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Environment Variables

Under the Environment Variables screen I suggest you leave all the listed variables at their default settings.
These should only be changed if instructed by a particular program or by Technical Support, and even then
you should record the original settings in case something goes wrong.

Error Reporting

Click the Error Reporting button and select 'Disable Error Reporting' and tick '‘But notify me when critical
errors occur'. This will prevent your system continually informing Microsoft of errors occurring on your
system, but at the same time will still show you important system messages and errors for notification and
troubleshooting purposes.

SYSTEM RESTORE

Only select 'Turn off System Restore' if you feel very confident about your Windows expertise. System
Restore can take up a great deal of disk space, however I recommend that you leave it enabled since it can
save you a great deal of heartache if things go wrong. See the Backup & Recovery section for more details of
how to use System Restore to backup your system state.

If you do choose not use System Restore, see the Services Utility section for details on how to disable the
'System Restore' service to save on system resources.

AUTOMATIC UPDATES

See the more detailed Automatic Updates section above for information on this functionality. I recommend
‘Turn off Automatic Updates' and instead use the manual method of regularly checking the Windows
Update site for updates.

REMOTE

I strongly recommend that you disable (untick) the available options in this section for security and
performance reasons. Only re-enable these options if specifically asked to do so by a trusted Technical
Support person who requires remote access to your machine. Allowing remote access pretty much lets
someone else access your machine and all its various files and settings as though they were sitting in front of
your PC, so clearly it can compromise your security if left enabled.

B TASKBAR AND START MENU
TASKBAR

The Taskbar is the bar which sits at the bottom of your screen and contains your Start button, buttons for any
open programs, and the System Tray. Most settings in this section can be chosen to suit your taste.

I recommend ticking the "Lock the taskbar' option to prevent accidentally moving or resizing the taskbar.

I also recommend you initially untick 'Hide Inactive Icons' so that you can see all the programs which are
loading in the background in your System Tray area. I recommend you disable most if not all of these - See
the Microsoft Configuration Ultility section for more information on disabling startup and background
programs. If you want to eventually enable 'Hide Inactive Icons', perhaps to hide an annoying but necessary
icon in the system tray (such as the 'Safely Remove Hardware' icon), tick the option and click the Customize
button to select precisely which applications to always hide in the system tray, which to always show, and
which should be hidden when inactive. Again, I recommend no applications be hidden when inactive or
hidden at all unless you are absolutely certain they are essential. Many application or game incompatibilities
and crashes can be due to one of these background programs. Hiding them will make it hard to troubleshoot
problems in the future.
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START MENU

I recommend you select the 'Start Menu' option here to use the Windows XP default menu system. It has
many advantages over the Windows Classic menu system. If you select this option click on the Customize
button next to it. Under the General tab, choose settings to taste. If you want to remove the Frequently Used
Programs listing normally available on the Start Menu under the pinned items, set the 'Number of Programs
on Start Menu' option to 0 and click the 'Clear List' button.

Under the Advanced tab, I recommend you tick 'Open submenus when I pause on them with my mouse' to
speed up menu access, and untick 'Highlight newly installed programs'.

Under the 'Start Menu Items' section, I recommend you tick the following:

Enable Drag and Dropping

Run command

Search

System Administrative Tools - Display on the All Programs menu

We need all of these features enabled when using this guide, and I recommend keeping them enabled
afterwards also. The other settings in this section can be ticked or unticked according to your needs.

When finished, click the Apply button and your changes will be made to the Start Menu.

B USER ACCOUNTS

Windows XP allows multiple users to have varying levels of access to the same machine. By creating a
separate User Account, each user can store their own settings, keep their own documents private, and have
limited access to the system-wide settings on the same computer. My recommendations are that unless you
have several people using the computer and each need separate accounts, you should only set up and use
one account (the Administrator) for fastest performance. That way you don't need to worry about logging
into and out of two or more separate accounts (the Administrator and a general User account) just to make
system changes and install/uninstall system software.

However security experts will tell you that this is very risky. It is true that using the Administrator account
by default carries some risks with it, but I believe the risks are minimal as opposed to the performance and
convenience benefits, especially when you set up your system using the methods in this guide. However if
security is a concern, create a separate account for day to day use with more limited access so that if your
regular account is compromised by a malicious program, it cannot be used to change important system-wide
settings. Remember though that you have to be logged in as the Administrator to make the majority of
changes in this guide, as well as being able to use certain programs and games properly.

FAST STARTUP - SKIPPING LOGIN SCREEN

If you have only one user on your machine, to have the fastest startup in Windows XP you can bypass the
Login screen altogether by doing the following:

1. Click 'Change the way users log on or off' and tick 'Use the Welcome screen', and untick 'Fast User
Switching'

2.  Go back to the main User Accounts screen and click the Guest account, and then click the 'Turn Off the
Guest Account' button

3. Delete any other accounts on the main User Accounts screen by clicking each one and selecting 'Delete
the Account'

4. Click on your main account, and if your account has a password select 'Remove my Password'
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Note, untick 'Fast User Switching' if you have only one account, or don't switch users often. Click 'Apply
Options' to finish, then see the advanced section below.

B USER ACCOUNTS - ADVANCED

Aside from the User Accounts tool in the Control Panel, you can access a further set of user account features
by going to Start>Run> and typing "Control Userpasswords2" (without quotes) then pressing Enter. The
following are details of the settings in this advanced user accounts tool:

USERS

If you have only one User account and you left your password field blank during Windows installation you
shouldn't be prompted for a username and password each time you bootup XP. This is the method I
recommend for the fastest (though less secure) way to bootup. However, if you have several user accounts
with associated passwords, but want one of those accounts to automatically log on to XP at bootup without
being prompted for a password, go to the Users tab and untick 'Users must enter a username and password
to use this computer’, and click Apply. In the new dialog box that appears, enter the username and password
for this 'autologon' user. Now each time you bootup Windows this user will automatically login to Windows
- but this is not as fast as not have a password in the first place. It all depends on your particular security
needs. I personally prefer the fastest way possible and have never had any security issues.

In general you should remove all user accounts from the list of 'Users for this computer' except for the
Administrator and the individual accounts for known users of your PC. Accounts such as ASPNET (the
.NET Framework account) can safely be removed by highlighting them and clicking the Remove button. The
less accounts you have on your machine, the safer and more optimal your machine will be.

You can also change the access level of individual accounts here by highlighting them and selecting the
Properties button. Go to the 'Group Membership' tab and you can select the level of access they have. Aside
from the Administrator and your own user account, you should ensure all other accounts have 'Standard
User' or 'Restricted User' level access, not Administrator level access.

ADVANCED

Under the Advanced tab, select the Advanced button under the 'Advanced user management' section. Select
the Users folder in the left pane, right-click on the 'Help Assistant' account, select properties and make sure
the 'User cannot change password’, Password never expires' and 'Account is disabled' boxes are ticked for
security purposes. You should do the same for the Support and Guest accounts. The only time you should
enable these accounts is if someone you trust, such as a Microsoft Technical Support person, ask you to do
s0.

Under the 'Secure logon' section, if you want to increase your security you can tick the 'Require users to
press CTRL+ALT+Delete' option. This will mean that users have to press the CTRL, ALT and DEL keys
together to bring up a logon prompt which then allows them to enter their username and password for
logging into Windows. This adds one extra layer of security however it can also be an inconvenience so I
don't recommend it.

B WINDOWS FIREWALL

The Windows Firewall is an important security feature that has been significantly upgraded with Windows
XP SP2. A firewall is a barrier between your machine and anything that attempts to connect to your system
from outside. Unless you are using a separate software firewall, it is strongly recommended that you use the
Windows Firewall and learn more about its features in this Microsoft Article.

In the General tab under the Window Firewall settings, I recommend you select On, and untick 'Don't allow
exceptions' for maximum functionality. Exceptions are instances of connections to your machine that you
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have consciously authorized, such as connections for online games or messaging programs. To completely
disallow exceptions will mean many of your online games and utilities simply will not function correctly.

Whenever you launch an application or game which requires external access to your machine, you will be
prompted by the Windows Firewall whether you want to 'Keep Blocking' the attempt, to Unblock it, or to
'‘Ask Me Later'. The simple rule is that you should only allow exceptions for (i.e. only Unblock) applications
or games which you use often, and which you know should definitely require Internet communication with
your machine, and which you trust. If a program that should have no need for Internet connectivity
suddenly raises the firewall's alert without providing a sound reason, I recommend you 'Keep Blocking' it.

Under the Exceptions tab of the Windows Firewall settings you can see all the applications and games which
you are currently allowing access to your machine. Remove any which you are no longer using, or which
you do not know or trust. You can do this by unticking them and/or highlighting them and selecting Delete.
For more details on exceptions, see this Microsoft Article.

A particular trusted application or game might require that you open a specific Port. A 'port' in this context
is like a small doorway into your machine, so opening a port also lessens your machine's security. However
some programs must have access through a specific port to be able to communicate with your machine. If
the application or game which requires the open port is on your Exceptions list then highlight it, otherwise
select 'Add Program' and add it to the list, then highlight it. Then select the 'Add Port' button and enter the
port number and protocol exactly as specified by the application or game's manual, help documentation or
technical support personnel. Remember that certain trusted programs simply cannot function without
appropriate access through the correct port, so this must be done from time to time. Technically speaking
though, the more ports you have open, the less secure your machine is — so remove all open ports for
programs you have not used in a while.

Finally, the Advanced tab of the Windows Firewall settings contains a range of settings that you can alter to
allow or disallow greater access to your machine. I strongly recommend you leave these at the default
settings, and only alter them if required by an often-used and trusted application or game. Almost all games
and applications should function correctly without the need to alter any of the Advanced settings. If you
want to know more about them refer to the articles linked above.

B WIRELESS NETWORK SETUP WIZARD

This feature is new to Windows XP SP2, and launches a Wizard that takes you through the steps of
connecting a security-enabled wireless device, such as a Bluetooth device. In many cases a wireless device
shouldn't require additional drivers, however if necessary you may have to install them from your device's
driver disk or its website.

That ends the recommendations and descriptions for the Control Panel utilities and tools. The following
sections go into certain useful utilities and tools in more detail.

[PueJ [013U0D) YT,

Copyright © 2005 Koroush Ghazi 78



http://www.microsoft.com/windowsxp/using/security/internet/sp2_wfexceptions.mspx

THE WINDOWS XP TWEAKING COMPANION

MICROSOFT SYSTEM CONFIGURATION UTILITY

Windows XP comes with a special built-in utility for additional tweaking and troubleshooting of your
system. This tool is usually hidden, in that no icon is provided for it by default. To access it, go to Start>Run
and type "MSConfig" (without quotes) and press Enter. The main use for the Microsoft Configuration Utility
(MSConfig) is to provide a brief snapshot of key system variables, and perform some
diagnostic/troubleshooting, as detailed in this Microsoft Article. Details of each section of the utility are

provided below.

GENERAL

This section shows the current status of system startup procedures. The default is Normal, which loads up
all your device drivers, services and startup items. However if you disable any startup items or alter system
variables using MSConfig, the Selective startup option becomes highlighted, showing which processes and
items have been changed. You should only use Selective startup mode for temporary troubleshooting
purposes - see the Services Utility section for details on how to correctly disable unnecessary services for
example.

If at any point you want to troubleshoot your system, and only want the essential services and drivers to
load up with Windows, select the Diagnostic Startup item. This can help you determine if a problem is
hardware or software based. This is similar to starting up using Safe Mode - see the Troubleshooting section
for more details.

There is an option here to start System Restore (if the System Restore service is enabled) by clicking the
Launch System Restore' button. See the Backup & Recovery section for details of System Restore
functionality.

The 'Expand File' button provides a utility for extracting archived files from cabinet files (.cab) such as those
on the Windows XP CD. By selecting the location of the cabinet archive, and the specific file required, you
can extract and restore individual files from the Windows XP CD in case the installed ones are corrupted or
deleted. This is much more handy than having to reinstall Windows completely. There are other methods of
repairing a Windows installation such as using the System File Checker - see the Troubleshooting section.

SYSTEM.INI, WIN.INI

These sections allow you to see and change the entries stored in the System.ini and Win.ini files, which
typically reside in your \Windows directory. Unlike previous versions of Windows, Windows XP does not
use these files at startup anymore. The contents of these files are usually only used by older 16-bit
applications. As such, you should leave all the entries under these tabs at their default settings, as there are
no performance gains to be had by editing them.

BOOT.INI

This section allows you to see and change the entries stored in the Boot.ini file, which sits in the base
directory of the hard drive you have installed Windows XP on (typically directly under the C:\ directory).
This file determines what XP should do at startup time if there are multiple partitions and/or operating
systems on your system, and any options to display prior to loading up Windows. In general you should not
change this file otherwise you may have problems booting into Windows.

I recommend that you make sure all options under the 'Boot Options' area as well as those found under the
'‘Advanced Options' button are unticked for the fastest startup. These options are provided to remove certain
features from Windows at startup for troubleshooting purposes, but should not be used if you want to start
Windows XP with full functionality. For example, ticking the /SAFEBOOT option will make Windows boot
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into Safe Mode (See Safe Mode under the Troubleshooting section). The /SOS option will remove the
Windows Startup screen, allowing you to see what goes on 'behind the scenes' as Windows starts up.

The two settings you can safely edit in Boot.ini are the timeout and /NoExecute settings. The timeout setting
should be set to 0 seconds for fastest bootup. However it can't be set below 3 seconds in MSConfig, so you
must go to the Boot.ini file, open it with a text editor such as Notepad, and edit the timeout= line to timeout=0,
then save and exit the file.

The /NoExecute= option controls the way in which Data Execution Prevention (DEP) functions in Windows.
To alter this setting you must again go to the Boot.ini file and manually edit it with a text editor. The options
available for /NoExecute are covered in more detail under System in the Control Panel section of this guide.

SERVICES

This section shows all the services currently installed on your system, and their present status - that is
whether they are running or stopped. If you want to quickly determine whether a service is necessary or not
for troubleshooting purposes, you can untick a service here and it will not load up the next time Windows is
booted. However this is not the recommended method for disabling services — see the Services Utility section
for more details.

The most useful feature here is the ability to tick the 'Hide All Microsoft Services' box, and hence quickly see
all the third party services which are installed on your system by software other than Windows. Many, if not
all of these services can be disabled to improve system performance, reduce memory usage and speed up
bootup time. Once again, see the Services Ultility section below for more details on how to correctly identify
and disable unnecessary services.

STARTUP

This section shows all the programs which load into system memory upon booting up your system (aside
from Services). Once again, most of these startup items are unnecessary and you will gain performance and
stability from removing them from your Windows startup. The hard part is determining which startup items
are absolutely necessary, and which aren't. I suggest you follow these steps to correctly identify and disable
unnecessary startup items:

1. Look at the items in your startup list and attempt to identify which programs they relate to. You can do
this by looking at the entry under the Command column in the list - it usually provides the name of the
file (.exe, .bat or .dll) being run at startup. Open up Window Search (Start>Search), select Change
Preferences>Change files and folders search behavior and then select the second option presented and
click OK. Now in the first search box enter the full name of the file, and see the directory where it
resides. This should usually tell you which program it is associated with.

2. If you are still uncertain about which program the startup item relates to, or what exactly it does, you
can do a search for it on the SysInfo List of Startup Programs and/or this Greatis Startup Program
Database. Note that some startup items can be viruses or trojans for example and hence their name and
source will be obscure on purpose, or may appear like a genuine Windows XP system file. If you look
through the sites linked above, you should be able to find the program the item relates to and a brief
description, including whether it is a virus or not for example and the best method for removing it.

3.  Once you've determined the source of the startup item, the first step in removing it is to launch the
source program, and look through its options for settings like 'Load with Windows', 'Load at startup’,
'Enable System Tray', 'Enable Shell Integration’, and so on. For example, the Cacheman utility (See the
Cacheman section) has under its options a setting called Load Cacheman at Windows Startup'. By
unticking this option you can prevent it from automatically running in the background each time you
start Windows — which is completely unnecessary by the way - and hence the Cacheman-related startup
item will automatically be removed from your startup list. Go through all the programs initiating an
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item in your startup and see if you can disable their startup functionality this way, as it is the preferred
method.

4. If you cannot find any options to disable a program or one of its components from running at startup, or
you are still unclear on whether the startup item is actually needed for the program to function
correctly, the next step is to experiment. You can temporarily disable a startup item for diagnostic
purposes by unticking its entry under the Startup tab in MSConfig. This prevents it from loading the
next time you boot up, but does not permanently remove it from the Window Registry. If you then
experience any adverse conditions, or lose particular functionality you require, you can re-enable the
item by ticking it again in MSConfig. If after a while you notice the startup item seems unnecessary you
can remove it permanently using the methods below.

5. Once you've decided which startup programs can be permanently removed - and in the majority of
cases most startup items can safely be removed - then the correct way to permanently remove them is to
use the Windows Registry Editor.

6. To open the Windows Registry Editor, go to Start>Run and type "Regedit" (without quotes) and press
Enter. This opens the Registry Editor, and for more details on its usage see the Registry Editor section.

7. Entries for startup items are usually stored under the following keys:

[HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\Run]
[HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Run]

8. Right-click on the name of the entry you want to remove and select Delete. It will be removed from the
Registry and no longer start up each time you bootup Windows. Of course you should make sure that
you follow all the steps above so that you don't remove a necessary startup item, since there is no undo
function in the Registry Editor. Alternatively you may wish to use a registry editing tool like
RegCleaner to edit your startup items, as that allows backing up of removed entries (See the RegCleaner
section). However in a worse case scenario where you have removed the startup item for a program you
shouldn't have, you can always simply reinstall that program and the startup item(s) will be recreated.

Finally, some startup items require special additional steps to completely remove from your startup. For
example the CTFMON startup item, which relates to an unnecessary 'alternative user input text input
processor' function for the Microsoft Office suite, requires following the procedures detailed in this
Microsoft Article to completely remove. Simply removing its startup item from the registry will not remove
it as it is recreated every time you run an MS Office application.

For programs which seem difficult to remove, a quick search of the filename on one of the startup lists linked
to above as well as on Google should bag you the correct removal procedures, as well as information from
other users who may have had similar problems and their experiences. Also check Safe Mode under the
Troubleshooting section for details of how to remove programs that cannot be removed during normal
Windows usage.
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SERVICES UTILITY

Services are programs that run in the background and support certain functionality in Windows XP. They
can be part of Windows itself, or they can be installed by other programs. They may start automatically at
bootup (Automatic), they may be triggered to start by the launching of certain programs or functionality
(Manual), or they can be blocked from running altogether (Disabled). The aim of editing your services is to
prevent unnecessary programs from taking up system resources, slowing down your bootup time,
conflicting with your games and applications and hindering performance in general.

The Services Utility gives you the ability to edit your Service configuration. To access the Services Utility,
you can either go to Control Panel>Administrative Tools>Services, or you can go to Start>Run and type
"Services.msc" (without quotes) and press Enter. This opens the Services Utility that lists all installed
services, tells you whether they are currently running or not, and whether they're set for Automatic, Manual
or Disabled startup. A brief description of each service is also provided.

The best guides to refer to on the topic of services are BlackViper's Windows XP Service Configuration
Guide and The Elder Geek's Services Guide. These guides contain many pages of details on precisely what
each service does, and a range of service configurations for differing needs, from default to hardcore. I urge

you to refer to one of these guides for more details if at any time you are curious as to what a particular
service actually does.

Below I provide my personal recommended Windows XP service configuration which should leave you
with all the functionality of Windows XP which most users require, while at the same time stripping down
many of the unnecessary services. I have been using this configuration for a while without any problems, so
I believe it is safe for most users. It is similar to, but not the same as the 'Safe' settings in BlackViper's guide.
However if you are connected to a network of computers (not counting the Internet), or have exceptional
needs, or a very unusual setup then do not blindly use my configuration - refer to the services guides and
spend the time to customize your service settings appropriately. The advice below would suit a standalone
Windows XP machine for general home use, with standard hardware and peripherals. But if in doubt do not
Disable a service. Set it to Manual or Automatic.

AUTOMATIC

Application Layer Gateway
Automatic Updates

Cryptographic Services

DCOM Server Process Launcher
DHCP Client

DNS Client

Event Log

IPSEC Services

Plug and Play

Print Spooler

Protected Storage

Remote Access Connection Manager
Remote Procedure Call (RPC)
Security Accounts Manager

Shell Hardware Detection

System Event Notification

System Restore Service

Task Scheduler

Themes

Windows Audio

Windows Firewall/Internet Connection Sharing
Windows Management Instrumentation
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DISABLE

ASP.NET State Service

Clipbook

Error Reporting Service

Fast User Switching Compatibility
Help and Support

HID Input Service

IMAPI CD-Burning COM Service
Indexing Service

Infrared Monitor

Machine Debug Manager
NetMeeting Remote Desktop Sharing
Network DDE

Network DDE DSM

Network Location Awareness (NLA)
Performance Logs and Alerts
Portable Media Serial Number Service
QoS RSVP

Remote Desktop Help Session Manager
Remote Registry

Routing and Remote Access
Secondary Logon

Security Center

Smart Card

SSDP Discovery Service

TCP/IP NetBIOS Helper

Telnet

Terminal Services

Uninterruptible Power Supply
Volume Shadow Copy

WebClient

Windows Time

Windows User Mode Driver Framework
Wireless Zero Configuration

WMI Performance Adapter

Any Microsoft services not listed above can be set to Manual, however if certain Windows functionality
doesn't seem to be working for you, or particular device(s) are not functioning correctly, spend the time to
research and refine your service configuration using a dedicated Service Guide. For identifying and
configuring non-Microsoft services, see further below.

At any time if you require the functionality provided by a disabled service, you can temporarily set it to
Automatic or Manual as needed. For example the Task Scheduler service can be Disabled by default, yet set
to Automatic temporarily to allow Bootvis to work (See the Bootvis section), then Disabled again after you've
finished using Bootvis. There is no point in leaving a service on Automatic all the time if you only need to
use its functionality on very rare occasions.

NON-MICROSOFT SERVICES

You may notice that your services list has several services that are not listed in the services guides or in my
list above. This is because particular programs and drivers, such as the ATI Catalysts, Norton's Antivirus or
Diskeeper for example, install their own unique services. These services power some of their specialized
functionality, but as with many of the Microsoft services some of these can be set to Manual or even
Disabled to reduce resource usage.
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The best way to identify unnecessary non-Microsoft services is firstly to run MSConfig (See the Microsoft
System Configuration Utility section), go to the Services tab and tick the 'Hide All Microsoft Services' box.
Any remaining services visible are those that have been installed by third party software. To determine
which are unnecessary, you will have to work out which software package has installed the service. In most
cases it is fairly obvious. The 'ATI Smart' service for example is clearly related to the ATI graphics drivers,
while 'Norton Antivirus Auto Protect' is clearly a Norton Antivirus service. Others however can be tricky so
follow these steps:

1. Write down the exact name of each non-Microsoft service.
Go to Start>Control Panel>Administrative Tools>Services and find the same services in this listing.

3. Double-click on the name of each non-Microsoft service and in the details for that service, look for the
'Path to executable' box. It contains the actual filename of the program being executed with the service.
For example, the 'Norton Unerase Protection' service has the path C:\Program Files\Norton
AntiVirus\ AdvTools\ NProtect.exe. Write down this filename (i.e. NProtect.exe).

4. Look up the program filename in the SysInfo List of Startup Programs or this Greatis Startup Program
Database, or on Google. You should then be able to determine if the service is absolutely necessary or
not, and also which program it relates to.

In general many third party services can be disabled, and should you then experience a problem or reduced
functionality which you require, you can easily re-enable the relevant service by setting it to Manual first,
and then finally to Automatic if the problem still occurs.

Services are one of the largest areas of "fat" built into Windows XP, so it is important that you identify and
disable non-essential services, as these can often use a huge amount of system memory, causing stuttering in
games for example, as well as the possibility of program conflicts.
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TASK MANAGER

The Windows Task Manager is a utility that allows you to view important real-time information about
which applications and processes are running on your system. You can also see how much memory, CPU
usage and network bandwidth is being consumed at present by these various processes. As an information
tool it is invaluable. To access the Task Manager, press the CTRL, ALT and DELETE keys together, or go to
Start>Run and type "Taskmgr" (without quotes) and press Enter. You can read more about the task
manager's functions in this Microsoft Article.

The Task Manager's primary use is to allow you to attempt recovery from system lockups and crashes.
Whenever a program stops responding you can attempt to launch the Task Manager and under the
Applications or Processes tab you can select the offending task or process and select 'End Task' or 'End
Process', usually regaining control of your PC without the need to reboot. If the Task Manager does not
appear after press CTRL+ALT+DEL then your system has 'hard locked’, meaning a reboot is required to
regain use of your computer. See the Troubleshooting and Overclocking sections for further details.

The first thing to do with the Task Manager is go to the Options menu and make sure the 'Show 16-bit tasks'
setting is ticked, then under the Processes tab make sure the 'Show processes from all users' option is also
ticked. This ensures that all running programs and processes will be shown. Note that if you cannot see any
menu items or tabs in the Task Manager window, simply double-click anywhere on the borders of Task
Manager and it will revert to its normal view. Also note that you don't require the User Name column,
however if you are on a PC with multiple users you can enable this functionality by making sure the Fast
User Switching Compatibility service is set to Automatic (See Services Utility section).

To customize the Task Manager to display the particular system information you want to see, go to the View
menu and under it click the 'Select Columns..." option. You will be presented with a dialog box that allows
you to select a range of items that can be displayed as columns under the Processes tab of the Task Manager.
I recommend that at the very least the 'CPU Usage' and 'Memory Usage' items be ticked. These will show
you for each process the proportion of the CPU's resources the process is currently using, and how much
system memory (RAM + Virtual Memory) it is using. I recommend also ticking the Peak Memory Usage'
item as well, as this will show you just how large a particular process has been at some point. We discuss the
reason for this below and also in the Virtual Memory section.

B RESOURCE USAGE MONITORING

One specific use for Task Manager that I find myself turning to often is that of monitoring my startup state.
That is, the programs and processes which are running in the background after a fresh bootup, and the
amount of memory being used. After a fresh bootup immediately open Task Manager, and click on the
Processes tab, then examine the following areas of Task Manager:

PROCESSES

Check the list of running processes - there should be as few as possible. For example, I have 16 processes
running after bootup (including Task Manager itself) that is the bare minimum I could get down to after
tweaking and removing unnecessary startup items and services. Note that certain processes can appear
multiple times — this is fine for svchost.exe for example, since it is the Service Host process and as such runs
groups of several Windows services. However some processes may be initiated by a virus or completely
unnecessary program, so see the Services Utility and Microsoft Configuration Utility sections for details of
how to identify all these processes, and programs and how to disable or remove unnecessary ones.

COMMIT CHARGE

Look at the total Commit Charge (memory usage) at the bottom of the Task Manager window. This shows
the amount of system memory (RAM + Virtual Memory) that has been used out of the maximum available.

1a3euelA yse],

Copyright © 2005 Koroush Ghazi 8 5



http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en-us/taskman_whats_there_w.mspx

Pu=A~susess

THE WINDOWS XP TWEAKING COMPANION

Although this may grow dramatically after you have run several programs — and this is quite normal - the
main point to consider is that the first figure in the Commit Charge section should be quite low at Windows
startup. My Commit Charge at startup is 115MB, which is the lowest I could reduce it to while maintaining
all important functionality. Once again, see the Services Utility and Microsoft Configuration Utility sections
for details on how to reduce such resource usage. Minimizing memory usage at startup is not about 'freeing
up' as much RAM as possible. Rather, the aim of minimizing memory usage at startup is primarily about
reducing the likelihood of program conflicts. The less information is in memory prior to launching a large
program, the less chance there is that program will attempt to access a memory location that is already taken
(resulting in a General Protection Fault for example), and also the less pagefile usage you will experience.

CPU USAGE

Pay attention to the CPU usage for your system when it is idle — that is when you have no open games or
applications. It should be at or close to 0%, and the 'System Idle Process' process should have 99% CPU
usage, indicating that the CPU has as minimal a load as possible. A CPU that idles correctly stays cooler and
hence is much more stable. If your system is using significant CPU resources when supposedly idle, this
indicates that you have a background program(s) or process(es) which is/are unnecessarily drawing
resources and hence there is scope for you to improve performance by disabling it/them.

You can also open the Task Manager during the running of an intensive game or application and check the
CPU % being used by its process — it should be consistently at, or close to, 100% CPU usage. If for some
reason it is quite low, check to see if any other processes are drawing CPU resources, and once again refer to
the relevant sections of this guide to remove/disable unnecessary background programs.

I do not recommend manually changing the process priority (right-clicking on the process and selecting Set
Priority>High for example) in order to 'increase performance'. Such tweaks increase system instability, and
should have no impact on an optimized machine since by default your current program should have 100%
CPU usage and the highest priority by default.

MEMORY USAGE

Examining the memory usage for each process can provide valuable information. If you have selected the
'Peak Memory Usage' item to add to the list of columns under the Processes tab (as recommended above),
you can combine that information with current Memory Usage to learn some interesting facts about the
performance of the processes over time. For example, you can open the Task Manager while running a
particularly intensive application or game and check to see how much memory its process is currently using,
and how much it has used at its peak so far. Compare these figures to the number on the right of the Commit
Charge figure at the bottom of the Task Manager window — which is the total amount of memory (RAM +
Virtual Memory) available to the system. If the game or application is using close to the total amount of
memory available on your system, you may have to increase the maximum size of your pagefile (See the
Virtual Memory section) otherwise you may experience crashes or 'Out of Virtual Memory' errors.

Note that whenever a program is minimized, i.e. shrunk down to the Taskbar, it will use less memory and
resources than normal. Therefore check the resource usage of a program when it is taking up the full screen
to get an indication of how intensive it is during normal usage.

Regularly checking your Task Manager resource usage as outlined above will give you early warning of
things such as virus or spyware infections, since they usually cannot be hidden from the Task Manager's
Processes list or memory usage statistics. If you see a sudden increase in memory usage at startup, or a new
and unknown process appears, or CPU usage increases at idle, you can be sure it is the result of a new
program or service running in the background. Most often this is the result of recently installed legitimate
software adding a program or service to your startup, and you should use the procedures in this guide to
determine whether it is necessary or not. If left unmonitored, your background resource usage can and will
blow out, slowing down your boot time and causing stuttering and program conflicts all over the place.
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REGISTRY EDITOR

The Windows Registry is a central database for a range of system and program-related settings. Whenever
you change your Windows settings, add or remove Windows components or install new programs and/or
change their settings, or even move or resize open windows, the registry will be updated with key pieces of
information. More detail about the functions of the registry can be found in this Microsoft Article. For our
purposes, the main reason for editing the registry is to alter settings that cannot otherwise be changed using
the normal Windows interface. To access the Registry Editor, go to Start>Run and type "Regedit" (without
quotes) then press Enter. Note that you can also access the registry editor by typing "Regedt32" instead of
Regedit, but Regedt32 is simply a small program that runs Regedit anyway, so there is no difference
between the two methods.

The Registry Editor is not the only way to make changes to the registry. You can also use utilities like
RegCleaner, TweakUI, Cacheman and even the Group Policy editor (See relevant sections below) to change
important settings in the registry and undertake the majority of the performance and visual-enhancing
tweaks in this guide. So if you feel uncomfortable using the Registry Editor, you don't have to use it - there
are other tools available which provide an easier-to-use interface and the safety of automatic backups.

However learning to use the Registry Editor is important because it is a powerful tool, and unlike any other
utility designed to edit the registry, using Registry Editor provides the most direct access to the entire
Windows Registry and ensures that you are aware of precisely what has been changed each time, and where
it originally resides should you need to change it back. And of course there are still a few tweaks in this
guide that can only be done using the Registry Editor, however minor they may be. I recommend you take
the time to learn more about this important tool.

OPTIMIZING THE REGISTRY

Before we enter into any Registry editing, there is a small utility called NTRegOpt that you should use to
optimize the layout of the Windows Registry. If you have installed Erunt (as covered under the Backup &
Recovery section) then you will have already installed NTRegOpt. If not, download it from the link above
and install it. Then run the NTRegOpt.exe file to start the program and click OK to begin the optimization
procedure. It may take some time, so be patient. You will have to reboot for the optimization procedure to
complete, but once completed your Registry will be as compact and optimized as possible.

EDITING THE REGISTRY

To use the Registry Editor correctly open it and you'll see what looks like a directory listing under 'My
Computer', with five folders starting with HKEY_ (e.g. HKEY CURRENT_USER). Under these Root Keys are a
series of sub-folders called Keys. Within each key there is at least one Value called (Default), visible in the
right pane of the Registry Editor window when you click on the key name. Typically there are several other
values underneath the Default entry. These values can be of several types, including String, DWORD and
Binary values.

The most common form of registry editing involves changing the contents of values, or adding new values
under certain keys. Note that in this guide the key name and location is provided in square brackets [ ], and
the name of the value to be edited is shown underneath it. The data to be entered into the value is given after
the '=' equals sign. To make sense of what all that means, follow the example below on how to edit the
Registry:

[HKEY LOCAL_ MACHINE\SOFTWARE\Policies\Microsoft\Messenger\Client]

PreventRun=1
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The text above indicates that to make this change, you should open Registry Editor and double-click on the
HKEY LOCAL MACHINE root key (or click the '+' sign next to it) in the left pane of the registry editor
window. This will show every key sitting directly under it. Next, you must open the SOFTWARE key, and so
forth until you arrive at the Client key underneath. At this point highlight the Client key by left clicking
on it once, and in the right pane of the Registry Editor window, look for a value called PreventRun.
Double-click on PreventRun and in the box that opens, click in the Value box, delete the current number
there and enter a '1' instead. Then click OK and the change has been saved — you can now close Registry
Editor if you wish. Note that there is no 'undo' function in the Registry Editor, so you must be very careful.

The following is the method for creating a new key or value in the Registry:

Go to the particular area where you have been instructed to create the key. Make sure you highlight the key
name of the particular key under which the new entry is to be created. If the new entry is a key, then right-
click on the name of the key under which it must be created in the left pane, and select New. Enter the name
for the new key and press Enter. It should now sit as a folder in the tree listing underneath the key it was
intended for.

If the new entry is a value, left-click on the name of the key under which it must be created, then in an empty
area in the right pane, right-click the mouse and select New, then choose the type of value it will be (i.e.
String, DWORD or Boolean). Enter the name for the new value and press Enter. Double-click on the new
value, and enter the data for the new value as recommended.

BACKING UP SECTIONS OF THE REGISTRY

The registry is such an important component of Windows that it is crucial for you understand that the
Registry Editor does not have an 'Undo’ function. Hence the best course of action prior to using the Registry
Editor to alter any part of the registry is to back up your important data and settings, as well as your entire
Registry (See the Backup & Recovery section for details). A more specific precaution is to make a backup of
the particular registry key(s) you are about to edit, especially if you don't feel confident about making the
change, or aren't sure how the change will impact on your system. That way if anything goes wrong you
don't have to go through a lengthy System Restore process — you can restore the individual key(s) that you
changed. The steps to backing up a specific registry key are as follows:

1. In the left pane of the Registry Editor window, right-click on the name of the key that holds the settings
you wish to edit.

2. Select the Export option, and choose a suitably descriptive name and appropriate location for the file.
Make sure the 'Selected Branch' option is ticked, so that only the particular key and all its sub-
components are saved, not the entire registry.

3. Once the relevant section of the registry has been saved, you can go ahead and edit the registry entries
underneath the key you've just saved.

RESTORING SECTIONS OF THE REGISTRY

If you experience any undesirable behavior after your registry changes - and remember that some registry
changes require a reboot before their effects can be seen - then you can restore the backup of your registry
keys by going to the place where you saved them, and double-clicking on the relevant .reg file. This will
overwrite the existing sections of the registry with the backed up versions, effectively undoing your changes
quickly and easily.

If you don't feel comfortable with the above method, or if you want to backup the entire Registry, see the
Backup & Recovery section for more details of the Erunt utility that automates this process.
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B MISCELLANEOUS REGISTRY TWEAKS

Where registry tweaks in this guide relate explicitly to a relevant section, such as Memory Optimization or
Internet Explorer for example, they are placed under that section. However the following are a range of
miscellaneous registry tweaks that are harder to classify, or are not vital to any particular aspect of your
computer, and hence are grouped together here. Remember, most of the important tweaks can be performed
with the tweaking utilities covered in this guide, not just the Registry Editor. Also note that some of these
tweaks will require a reboot before they come into effect.

Below are a range of miscellaneous performance and convenience tweaks - implement the ones you want to
use. My recommendations are provided for the performance-related tweaks:

IMPROVE MENU RESPONSIVENESS AND SHUTDOWN SPEEDS

The following tweaks improve the responsiveness of Windows. The values shown for each are the
recommended values for your system. If you don't feel comfortable making these changes, use Cacheman
instead (See the Cacheman section).

[HKEY CURRENT USER\Control Panel\Desktop]

HungAppTimeout=4000

This setting controls the delay before a hung application is allowed to terminate (each 1000 =1 sec).
WaitToKillAppTimeout=4000

This setting controls the delay before windows finally starts to shutdown (each 1000 = 1 sec)
MenuShowDelay=20

This setting controls the delay before a menu or sub-menu pops open (each 1000 =1 sec)
AutoEndTasks=1

If enabled this setting automatically closes all running applications when Windows shuts down.

INCREASE NTFS SYSTEM PERFORMANCE

These tweaks improve the performance of Windows systems that use the NTFS File System. See the
Formatting the Hard Drive & Installing Windows XP section for more details of NTFES. If the following
entries don't exist, create them as new DWORDs and assign the recommended values shown:

[HKEY LOCAL_ MACHINE\SYSTEM\CurrentControlSet\Control\FileSystem]
DisableNTFSLastAccessUpdate=1
This disables the constant updating of dates a file/folder was last accessed. Using this tweak can improve

disk performance, but if recording the times and dates of file access are important to you, you should not
undertake this tweak.

NTFSDisable8Dot3NameCreation=1

This disables support for old MSDOS 8-character filenames. Note that if you disable this setting, you will
have problems installing Norton programs. After you have installed and configured Nortons, and rebooted
your system, you can disable this setting again if you so wish.
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PREVENT MSN MESSENGER FROM RUNNING

If you don't use the Windows MSN Messenger utility, and want to prevent it from running - e.g. when it is
launched by default by certain applications - then implement these changes to your Registry. Note that you
can use the Group Policy editor instead to change these settings if you wish (See Group Policy section).

[HKEY LOCAL_ MACHINE\SOFTWARE\Policies\Microsoft\Messenger\Client]

PreventRun=1
This setting will prevent MSN Messenger from running.

PreventAutoRun=1
This setting will prevent MSN Messenger from popping up automatically.

REMOVE 'SHORTCUT TO...' FROM NEW SHORTCUTS

Whenever you manually create a new shortcut in Windows, it will have 'Shortcut to..." in front of it. To
remove this prefix, alter the Registry entry below:

[HKEY LOCAL_ MACHINE\Software\Microsoft\Windows\CurrentVersion\Explorer]

Link=00 00 00 00

If this entry doesn't exist, create it as a new Binary value, and set it equal to 00 00 00 00.

TURN OFF CD AUTOPLAY

By default Windows XP will automatically detect the presence of any CDs or DVDs inserted into
CD/DVD/CDRW/DVD-R drives on your system. As soon as such disks are detected, any applications, audio
or movies files on these disks will automatically be launched. To disable this Autoplay functionality, make
the following change:

[HKEY LOCAL_ MACHINE\SYSTEM\CurrentControlSet\Services\CDRom]

Autorun=0

Setting this value to 0 disables Autoplay, setting it to 1 enables Autoplay. Note you can also temporarily
disable Autoplay behavior by holding down the SHIFT key while inserting a CD or DVD (See the Visual and
Convenience section for details).

TURN OFF WINDOWS XP BUILT-IN CD BURNING

Windows XP has a basic form of CD burning which although adequate is not good enough to replace the
functions of a dedicated burning package like Nero Burning ROM. If you are using a third-party Burning
package — which is recommended - you can disable the built-in burning functionality by doing the following:

[HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer]

NoCDBurning=1

When set to 1, this setting disables the built-in Windows XP burning functionality, but still allows other
burning software to work.
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CHANGE THUMBNAIL QUALITY & SIZE

Whenever you view a folder with pictures in it, by default Windows will show the contents in Thumbnails
view. To change the size and quality of these thumbnails use this tweak:

[HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\Explorer]

ThumbnailQuality=50

To alter the quality of thumbnailed pictures displayed in Windows XP folders, enter a DWORD value in
Decimal view between 50 and 100. The larger the value, the better the thumbnail image but the slower the
thumbnailed images will load up.

ThumbnailSize=32

To alter the size of thumbnailed pictures displayed in Windows XP folders, enter a DWORD value in
Decimal view between 32 and 256. The larger the value, the larger the thumbnail but the slower the
thumbnailed images will load up.

DI1SABLE THUMBNAIL CACHE

When displaying folder contents in Thumbnails view, Windows creates caches of thumbnailed images,
usually saved in files called Thumbs.db in each folder that has been viewed in Thumbnails view at any point.
Thumbnail caching helps speed up repeated viewing of these folders in Thumbnails view, but you can
disable thumbnail caching by doing the following:

[HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Advanced]

DisableThumbnailCache=0

Set this DWORD to 1 to disable thumbnail caching, or set it to 0 to enable thumbnail caching. If you disable
thumbnail caching you should also go to Windows Search and find and delete every instance of Thumbs.db
on your system as they are no longer necessary.

TURN OFF 'LOW DISK SPACE' NOTIFICATION

Once the free space on your hard drive falls below a certain percentage Windows XP will give you a 'Low
Disk Space' notification. You can alter the threshold for this warning by changing it as follows:

[HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Services\lanmanserver]

DiskSpaceThreshold=0

Create a new DWORD and assign it a value in Decimal view of between 0 and 99 - this is the percentage of
free disk space left before a warning notification is given by Windows XP. Setting this to 0 turns off the
notification altogether, which is recommended.

DISABLE BALLOON TIPS

Balloon Tips are the small yellow pop-ups that appear throughout Windows informing you of various facts
or functions. To disable these, implement this tweak:

[HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Advanced]

EnableBalloonTips=0

Setting this to a DWORD value of 0 turns off the balloon tips.
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TURN OFF SYSTEM BEEPS

By default Windows XP makes beeping noises under certain situations, regardless of your Windows sound
settings. To alter this behavior, go to the following Registry entry:

[HKEY CURRENT USER\Control Panel\Sound]

Beep=Yes

Set this value to No to disable any system beeps that occur during Windows usage. Note that to disable
other Windows event-based sounds you will still need to go into Control Panel>Sounds and Audio Devices
(See Sounds & Audio Devices under the Control Panel section).

DISABLE WINDOWS KEY

If you want to disable the Windows Keys on your keyboard, perhaps because they are interfering in a game
you are playing, use this tweak:

[HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Control\Keyboard Layout]

Scancode Map=

Under the Keyboard Layout key (not Keyboard Layouts) create a new Binary value called Scancode Map
and then double-click on it and click once in the top right hand side of the value data box and manually type
in the following values in the exact order as shown (note all the 0's are zeros, and no spaces are necessary):

00 00 00 0O 00 OO OO 0O O3 00 OO 00 OO 00O 5B EO 00 0O 5C EO 00 00 00 OO

You will need to reboot for this change to come into effect. If you want to reverse this tweak, delete the
above key and reboot.

CHANGE FOREGROUND APPLICATION PRIORITY

For users who usually run one major application or game at a time on their machine, you can set Windows
XP to give even higher priority in allocating resources to such 'foreground applications'. Follow the tweak
below to implement the change:

[HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Control\PriorityControl]

Win32PriorityControl=38

Create a new DWORD called Win32PriorityControl and allocate a value of 38 to it in Decimal view.

If you're still in the mood for more Registry tweaking, a large range of Windows Registry tweaks can be
found in this Registry Tweaks for XP Page. Note that some of them may not work correctly on Windows XP
SP2, so please backup before using any of them. In general I don't recommend implementing a large number
of Registry tweaks as this makes troubleshooting difficult in the future. To start with, select the ones that you
feel are the most necessary for performance and convenience sake, and then if your system remains stable

and trouble-free, implement a few new ones each week.
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GROUP POLICY

The Group Policy editor is an Administrative Tool designed primarily for network administrators to alter
the way in which Windows XP behaves for the users on their network (See Administrative Tools under the
Control Panel section). It is only available in Windows XP Professional and not Windows XP Home, but
fortunately for Windows XP Home users the majority of the tweaks covered in this section can be performed
using other utilities, such as TweakUI and the Windows Registry Editor (See the relevant sections).

To access the Group Policy editor, go to Start>Run and type "gpedit.msc" (without quotes) and then press
Enter. This will open the Group Policy editor, which shows two main branches: ‘Computer Configuration'
and 'User Configuration'. Changes made under the 'User Configuration' sections only affect the current user,
while changes made under the 'Computer Configuration' section apply to the entire machine and affect all
users on that machine.

Below are a range of tweaks that you can apply through the Group Policy editor. To change a setting, go to
the sub-folder shown and double-click on the recommended setting in the right pane and then choose
Enabled, Disabled or 'Not Configured' as required then click Apply. My recommended settings for each are
provided in brackets, however you should first click once on the setting you wish to change and in the
Extended view you can see a brief description of the setting to the left of it. If in doubt, do not change a
setting - leave it at its default.

DISABLE SYSTEM RESTORE
Folder: Computer Configuration\ Administrative Templates\ System \ System Restore\
Setting: Turn Off System Restore (Leave at default)

TURN OFF BUILT-IN XP CD BURNING
Folder: User Configuration\ Administrative Templates\ Windows Components\ Windows Explorer\
Setting: Remove CD Burning Features (Enabled)
Note: Still allows third party burning software such as Nero Burning ROM to work without problems.

PREVENT WINDOWS MEDIA DIGITAL RIGHTS MANAGEMENT FROM INTERNET ACCESS

Folder: Computer Configuration\Administrative Templates\Windows Components\Windows Media
Digital Rights Management
Setting: Prevent Windows Media DRM Internet Access (Enabled)

REMOVE 'SHARED DOCUMENTS' FOLDER

Folder: User Configuration\ Administrative Templates\ Windows Components\ Windows Explorer\
Setting: Remove Shared Documents from My Computer (Enabled)

REMOVE SHUTDOWN/LOGOFF/RESTART MESSAGES

Folder: Computer Configuration\ Administrative Templates\System\
Setting: Remove boot /Shutdown /Logon / Logoff messages (Leave at default)

TURN OFF USER TRACKING (WILL ALSO DISABLE PERSONALIZED MENUS)

Folder: User Configuration\ Administrative Templates\ Start Menu and Taskbar\
Setting: Turn off user tracking (Enabled)

£orjog dnoioy

Copyright © 2005 Koroush Ghazi 9 3




OWW THE WINDOWS XP TWEAKING COMPANION

PREVENT ACCESS TO WINDOWS COMPONENTS

Folder: User Configuration\ Administrative Templates\System\
Setting: Don't run specified Windows applications

Note: You can also prevent users from accessing the Registry Editor and Command Prompt in this folder.

TURN OFF CD/DVD AUTOPLAY
Folder: Computer Configuration\ Administrative Templates\ System\
Setting: Turn off Autoplay (Enabled)
DISABLE INTERNET EXPLORER SPLASHSCREEN
Folder: Computer Configuration\ Administrative Templates\ Windows Components\ Internet Explorer\
Setting: Disable Showing the Splash Screen (Enabled)
DISABLE WINDOWS MESSENGER
Folder: Computer Configuration\ Administrative Templates\ Windows Components\ Windows Messenger\

Setting: (Set both to Enabled)

Note: see the Registry Editor and Outlook Express sections for more details on how to turn off Messenger
and fix the associated 'Outlook Express slowdown' issue.
CUSTOMIZE INTERNET EXPLORER APPEARANCE
Folder: User Configuration\ Windows settings\ Internet Explorer Maintenance \ Browser User Interface\
Setting: (Personalize as desired)
REMOVE RECYCLE BIN ICON FROM DESKTOP
Folder: User configuration\ Administrative Templates\ Desktop\
Setting: Remove Recycle Bin icon from Desktop (Leave at default)
REMOVE MY DOCUMENTS ICON FROM DESKTOP
Folder: User configuration\ Administrative Templates\ Desktop\
Setting: Remove My Documents icon from Desktop (Enabled)
REMOVE MY COMPUTER ICON FROM DESKTOP
Folder: User configuration\ Administrative Templates\ Desktop\
Setting: Remove My Computer icon from Desktop (Leave at default)

Note: Use this tweak with caution as enabling it can cause a great many problems.

There are a range of other Group Policy tweaks you can undertake, so have a look through the other areas of
the Group Policy editor and see if there is anything you would like to change. However be very careful to
remember precisely what you have changed, because when troubleshooting problems people tend to forget
the changes they implemented in Group Policy and spend a great deal of time checking elsewhere, especially
since you can perform these tweaks in a variety of places.
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TWEAKUI

TweakUI is a free Microsoft utility that provides a convenient tweaking User Interface (UI) for tweaking
many of Windows XP's hidden settings. It is easy to use and includes helpful instructions on what the
various settings do. If you don't feel confident in using the Registry Editor to make certain changes for
example, TweakUI gives you the flexibility to easily and quickly change most of the same settings using a
relatively foolproof utility.

To access TweakUI, first download it from the Microsoft TweakUI Page, then install it and launch it. To
navigate to the various areas of TweakU], click once on the name of the section (e.g. General), and in the
right pane tick or untick the appropriate settings and then make sure to click the Apply button for every
section or sub-section you change.

TweakUI covers a large number of settings, and as such I can't possibly cover them all here. Below are a
selection of the more significant settings which I recommend people change in order to improve general
performance and functionality. These changes should be safe for almost every system, but obviously you can
undo them by reversing the changes in TweakUI should they not suit you.

GENERAL

Tick 'Optimize hard disk when idle'

GENERAL>FOCUS

Tick 'Prevent applications from stealing focus'

EXPLORER

Tick 'Detect accidental double-clicks'
Untick 'Maintain network history'
Untick 'Show Links on Favorites menu'
Tick 'Use intuitive filename sorting'

EXPLORER>SHORTCUT

Select None to remove the shortcut arrows from shortcuts

EXPLORER>THUMBNAILS

Move the slider to the far left for Image Quality
Select the smallest value (32) for Thumbnail size

EXPLORER>CUSTOMIZATIONS

To conserve memory use a relatively low setting like 200 folders

TASKBAR AND START MENU
Untick 'Enable balloon tips'
Untick 'Warn when low on disk space'
CONTROL PANEL

Untick all the Control Panel components you never use, or which are installed by third party programs and
are unnecessary. Note that this only removes their icons from the Control Panel and not the programs
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themselves, and doesn't affect that program's functionality in any way. I recommend you do this tweak after
you have adjusted all the settings in the Control Panel.

You should customize the remaining settings as you see fit.

Although TweakUI is very safe to use, don't change everything all at once, and don't change settings that
you are unclear about. If anything goes wrong, it may be difficult for you to figure out which change in
TweakUI is causing the problem, or has removed the functionality you want. Take it slow and change a few
things at a time, and if in doubt I stress that you shouldn't change something.
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CACHEMAN

Cacheman is a free utility that provides a user-friendly interface for making most of the memory and cache-
related changes covered in the Memory Optimization section. Note that I recommend the free version of
Cacheman, not Cacheman XP. All the important changes can be made using Cacheman. To access
Cacheman, download Cacheman 5.50 default distribution from the Cacheman Website, install it and then
launch the program.

The best way to change settings in Cacheman is to go to the 'Show Wizard' menu and select All. Run
through each setting as prompted, and if you want to know more, click on the Help button on the main
screen. My recommended settings that correspond with the related settings I recommend in various other
sections of this guide are as follows:

Disk Cache: Balance

Icon Cache: Set large maximum Icon Cache size
Unload DLLs from Memory: Enable

Disable Paging Executive: Enable

IO Page Lock Limit: Large 10 page lock limit value
Disable NTFS last access update: Enable

Disable creation of short filenames: Enable

Reserve more space for the Master File Table: Do not enable
Defragment hard disk when idle: Enable

Hung App Timeout: Optimize

Wait to Kill App / Service Timeout: Optimize

Menu Show Delay: Optimize

Filename Completion: Do not enable

Note that Data corruption may occur under certain conditions if the 'Disk Cache' option is set to 'Maximize
throughput for Network Applications' or 'Maximize throughput for file sharing'. This can occur on systems
with an ATI graphics card, more than 512MB of system RAM, along with a large NTFS disk and/or multiple
large volumes (60-100 gigabyte hard drives possibly in RAID arrays). It is strongly recommended that Disk
Cache be set to Balance under such circumstances. Even if you don't meet any or all of the above
requirements, to be absolutely safe I recommend using the Balance setting.

Once all your changes have been made, click on the Settings button on the right, click the Tweaks icon, select
the Miscellaneous tab and manually change the 'Wait to kill application timeout' and 'Wait to kill service
timeout' to 4 sec each, and change the Start Menu 'Show delay' to 20 milliseconds. You can lower the menu
Show delay to 0 milliseconds if you wish, but I find this is too quick to allow easy access to menus. Also click
on the Options button and make sure you untick 'Load Cacheman on Windows Startup' as this is not
necessary for Cacheman to function correctly.

Finally, go to the File menu and select 'Save Settings' and close Cacheman. If necessary reboot your system
when prompted. Cacheman need never be run again or loaded into memory for these settings to work - the
appropriate changes have been to the registry and will stay there even if you uninstall Cacheman.
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REGSUPREME

RegSupreme is an extremely efficient and easy-to-use registry cleaner. The Windows Registry has thousands
of entries, and some of these can become outdated or incorrect due to changes in hardware and software,
and even registry corruption. A registry cleaner's job is to trawl through the registry and find invalid entries,
such as entries that point to non-existent files. Since the registry loads into memory at Windows startup, and
controls certain system behavior, the leaner and cleaner the registry is the less space it takes up, and the less
the likelihood for errors and strange behavior. To access RegSupreme, download it from the RegSupreme
Website and install it. Note that it is only free for a limited trial period.

RegSupreme has an extremely simple interface, unlike its predecessor RegCleaner (See RegCleaner below).
To begin a registry cleaning session, open up RegSupreme. The first time you run RegSupreme, it will
prompt you to update RegSupreme's cache. I recommend you click OK, as this process needs to only be
done once in every while and will speed up future registry cleaning sessions a great deal. Once
RegSupreme's caching has been completed you can continue with the actual registry cleaning.

Click the 'New Scan' button, or if automatically presented with the scanning options, I recommend selecting
Deep - it is a thorough but safe method of searching through your registry for invalid entries. Click the Start
button and the registry scanning will commence. This may take a little while depending on how large your
registry is, but usually no longer than a few minutes. Once the scan is completed, nothing is deleted or
altered in the registry. To actually remove all the invalid entries found, you should go to the Select menu and
choose All to place a tick next to all the invalid items. Then click the Fix button to remove them - you will be
prompted for a name to give the automatic backup that is created. Should anything go wrong after running
RegSupreme, this backup can be restored at any time by opening RegSupreme, clicking on the Backup
button, highlighting the backup and clicking the Restore button.

Note that RegSupreme will sometimes find hundreds of 'invalid' files, but don't be distressed: this doesn't
mean your registry was a total mess. Rather, RegSupreme categorizes such harmless things as MRU (Most
Recently Used) registry entries as invalid, even though they are perfectly normal. For example, if you use the
WinZip archiving utility it will record the last few archives you accessed should you want to quickly access
them again. Microsoft Word does the same with recently used documents. Ditto for a range of other
programs. Also, when you install a program for example, it unzips archived setup files into your temporary
directory for installation, and then eventually deletes them when done. References to these now-deleted files
will remain in your Windows Registry, so RegSupreme will label them as invalid, but as you can see they are
hardly an indication that there is anything wrong with your system. Of course they're better off being
removed, but they will simply build back up again within a matter of days, so don't be concerned if you run
RegSupreme again later and still find lots of invalid entries.

If you're worried about using a registry cleaner, don't be. I have used RegSupreme many, many times and I
have never had a problem. Should you run into a problem with any of your programs after using
RegSupreme (or RegCleaner for that matter) simply reinstall the particular program or driver that is giving
you problems and the relevant registry entries will be recreated. Clearly there was something wrong with
the original installation of that particular application such that its registry entries may have been corrupt or
messed up, so a full reinstall is a good opportunity to prevent any potential problems down the path.
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REGCLEANER

RegCleaner is a much more powerful tool than RegSupreme, but can be a bit trickier to use. However unlike
RegSupreme it is completely free, whereas RegSupreme requires paid registration to continue using it after
the 30 day trial expires. To access RegCleaner, download it from this RegCleaner Download Site or this
RegCleaner Download Site and install it, then click the RegCleaner icon. Make sure the software clearly says
‘RegCleaner 4.3' at the top of the RegCleaner window otherwise you are not using the correct version.

Before using the registry cleaning function in RegCleaner, start the program and under the Options>Registry
Cleanup>Method menu select Automatic, and under Options>Registry Cleanup>Ole Cleaner select 'Extra
Powerful'. This will use the most thorough (yet safe) registry cleaning method. Now to run the registry
cleaner, go to the Tools menu, and under the Registry Cleanup’ section select 'Do Them All'. After a few
minutes RegCleaner will complete scanning your registry and will list the redundant entries it has found.
They should then all be removed automatically to a single backup file, which you can see under the Backups
tab of RegCleaner. Should there be any problems after running the registry cleaner, you can restore this
backup by selecting it and clicking the Restore Backup' button.

The other functionality of RegCleaner is covered under its various tabs below:

SOFTWARE

The most important use for RegCleaner — and the one which sets it apart from RegSupreme - is the ability to
view software registry entries on your system (made by programs you have installed), grouped together by
the name of the company and/or software. To do this right-click on the name of a particular entry. Click the
‘Advanced Info' button, and it will show you all the individual registry keys and values that relate to that
particular piece of software. This is very handy, firstly if you want to see in one glance what a program has
installed in the various sections of your registry, and secondly if you uninstall a program but some of its
registry entries are left behind you can click on the item here and select 'Remove Selected' to completely
remove all traces of it quickly and easily. Note that anything you remove from here will be stored in the
Backups section of RegCleaner, so if you run into problems restore the item from there. This makes using
RegCleaner to edit your registry much safer than the built-in Windows Registry Editor.

STARTUP LiIST

If you have read the details in the Microsoft Configuration Utility section about streamlining your Windows
startup entries, but don't wish to use the Registry Editor to remove particular startup programs, you can go
to the Startup tab in RegCleaner and it will list all your current Windows startup entries. You can then
remove particular entries by ticking them and clicking the 'Remove Selected' button. Note that anything you
remove from here will be stored in the Backups section of RegCleaner, so once again if you run into
problems simply restore the item from there.

NEwW FILE

New Files are the file types listed when you right-click somewhere like the Desktop, and under the New
context menu you can see a list of new files you can create. Remove the entries in this section that you don't
want to appear in the New Files context menu. As usual, anything you remove from here will be stored in
the Backups section of RegCleaner, so if you run into problems restore the item from there.

RegCleaner has several other functions which are more advanced, but as you can already see it is a very
powerful Registry editing and cleaning tool which is much easier - and safer - to use than the Windows
Registry Editor, and is completely free. This is one of the reasons why I recommend you install it even if you
use RegSupreme: ideally you should use the registry cleaner function in RegSupreme, and the registry
editing functions in RegCleaner together - they won't conflict with each other.
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CCLEANER

CCleaner (Crap Cleaner) is a utility which can find and remove a wide variety of essentially useless files
from your system. It can be downloaded from the CCleaner Site, and is completely free to use.

As you use your system in day-to-day activities, a vast range of temporary, backup and unnecessary files
build up on your hard drive. Some of them are automatically deleted whenever you close an application, or
whenever you shut down Windows. Unfortunately many of them aren't, and over time they can build up,
taking up a lot of disk space and generally making a mess in your directories. CCleaner automates a task
that you can perform manually (see further below), but which takes longer to do by hand. CCleaner finds
and removes a range of files with common extensions identifying them as unnecessary files (e.g. .tmp, .bak,
.0ld) and also files which reside in known temporary or rubbish folders. It excludes important
backup/temporary files that should not be deleted, and if used with caution it is usually quite safe in
removing only unnecessary files.

To use CCleaner, first run the program and click on the Options button. Under the Settings section of the
options, untick all available boxes except 'Only delete files in Windows Temp folders older than 48 hours'
which should be ticked for maximum safety. The options under the other tabs can be left at their default for
the moment.

To start the cleaning process, first make sure you close all open applications. Then open CCleaner and under
the Windows tab make sure to untick anything which you don’t want cleaned/deleted. For example, if you
use Internet Explorer you should check to make sure you untick any components which you wish to keep
(e.g. untick "Temporary Internet Files' if you don't want your IE browser cache cleaned out). Everything else
is safe to keep ticked. Note that you should only tick the Advanced options if you know what you are doing,
otherwise they are all best left unticked.

Next, under the Applications tab CCleaner lists all your installed applications which it can help clean up.
Once again, if you have a browser like Firefox installed, make sure you untick any portions of it which you
don't want "cleaned" (e.g. untick the 'Internet Cache' option). Otherwise it should be safe to leave all other
options ticked here.

Once you have all the relevant options ticked, click the Analyze button and after a while CCleaner will come
up with a list of rubbish it wants to delete. At this stage nothing has been deleted yet, so scroll through the
list and make sure no files which you wish to keep are listed. If you're happy to continue — and usually it is
safe to do so — click the 'Run Cleaner' button to permanently remove the listed files. Note that if CCleaner
crashes when you click the 'Run Cleaner' button the files will not be removed. Restart the program, untick a
major component such as 'System’, click Analyze and then the 'Run Cleaner' button again. Then retick the
component(s) you unticked, and click the Run Cleaner' button again. This is a known problem with
CCleaner.

Finally the Issues tab in CCleaner attempts to find redundant Registry and Windows Desktop entries —
however I strongly recommend against ticking any of these or using this section of CCleaner unless you
know exactly what you are doing. I also do not trust CCleaner to do something this delicate - registry
cleaning is best done by RegCleaner or RegSupreme (See relevant sections above) which are foolproof.

MANUAL DRIVE CLEANING

I will briefly outline the free manual method for cleaning out the more obvious redundant files in your
system. If you want to be absolutely sure you only delete unnecessary files, you can do things manually by
following these steps:
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1. Close all open applications and games as some of these may have created temporary files that cannot be
deleted because they are in use. The same goes for any games, applications or drivers you may have
installed but not yet rebooted for them to finalize their installations - make sure you reboot and allow
any installation procedures to finish before continuing these steps.

2. Make sure you empty your Recycle Bin before undertaking these steps. Also ensure that the option to
move files to the Recycle Bin is enabled (i.e. they are not deleted straight away — see the Recycle Bin
section). This will provide maximum protection against accidentally deleting a necessary file.

3.  Open Windows Explorer and navigate to the following directories on the hard drive where you have
installed Windows XP. Delete the entire contents of each one, including any subdirectories beneath it -
but not the directory itself:

\Documents and Settings \ [your username]\ Local Settings\ Temp\
\ Windows\ Temp \

4.  Go to \Windows\ and delete all directories starting with $NtUninstall - these are directories which allow
you to uninstall Microsoft updates typically installed through Windows Update as well as any archived
files from an SP2 installation. It is highly unlikely you will need to uninstall a Microsoft patch or SP2, so
deleting these directories is perfectly safe.

5. This step involves finding files with file extensions that identify them as redundant. Go to Windows
Search (Start>Search) and select 'All files or folders' to bring up the search box. In the first box, enter the
following text and press Enter. In each case delete all incidences of files with these extensions:

*BAK
* TMP
N*.*

*OLD

6. Delete any files you know are not needed anymore, such as older versions of downloaded driver
packages, extractions of downloaded archives from which you have installed programs, and so on.

That covers the bulk of unnecessary files on your system. Do not empty your Recycle Bin just yet. Reboot
your system and use it for a while just to be sure the files you deleted are not important.
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BooOTVIS

Bootvis is the Boot Visualizer tool from Microsoft, which shows information about the type of programs,
drivers and services that are loaded up during your Windows startup procedure, and how long each one of
them takes. This information can be very useful in identifying precisely what is taking the most amount of
time at bootup, and if necessary lead to uninstalling or altering hardware and software which is causing any
long delays. Bootvis does more than just analyze the startup procedure — it can also optimize it by laying out
the required files in an optimal pattern for faster bootup times. This usually results in dramatically faster
loading of Windows, and that is the primary purpose to which we will put Bootvis. To access Bootvis
download it from this BootVis Download Site and install it.

Before you use Bootvis however you should note that although it is a Microsoft-produced utility, it was
removed from the Microsoft BootVis Page a while ago for an unspecified reason. The likely reason is that it
can cause problems on certain systems, although it is unclear which particular types of systems. Pentium4
systems with HyperThreading (HT) CPUs are one possible source of incompatibility with Bootvis, although
many users with HT systems report using Bootvis without any problems. The bottom line is that you should
backup your data before using Bootvis, just in case. I have personally never experienced a problem using
Bootvis, and most people haven't either, but there must be exceptions otherwise Microsoft wouldn't have
removed the tool from their site.

Note that for Bootvis to operate correctly, the Task Scheduler service needs to be set to Automatic (see the
Services section). This is very important, otherwise Bootvis will not complete its optimization task after
rebooting.

To analyze your system with Bootvis, run the program and go to the Trace menu, then select 'Next Boot +
Driver Delays'. Let Bootvis reboot the system, and on rebooting wait patiently for Bootvis to pop back up
when it's finished analyzing. It will display a graph that shows the various startup components laid out
sequentially in time shares. If you want to identify which programs are associated with particular
applications or drivers, consult the Microsoft Configuration Utility section for more details.

To optimize your bootup procedure using Bootvis, first go to your \ Windows\ Prefetch folder and delete the
entire contents. Then start Bootvis, go to the Trace menu and select 'Optimize System'. Once again let Bootvis
reboot and wait for it to restart after the reboot. It will say 'Optimizing System' for a while. Once this is done
you can reboot your system and observe that your bootup times will now be much faster. Ideally any time
you install new drivers or add new pieces of hardware to your system you should redo the entire Bootvis
procedure to maintain an optimal startup time.

Note that if you do not want the Windows XP prefetcher to create lots of prefetch files for various
applications then make sure to set the Task Scheduler service back to Disabled and delete everything except
for Layout.ini in your \ Windows \ Prefetch folder after finishing all of the above steps. In theory these prefetch
files are meant to help in improving loading times for applications, however in my experience they simply
increases the overall Windows startup time in exchange for barely noticeable improvements in application
and game loading times. This is my personal recommendation and you can ignore it if wish and leave these
prefetch files where they are if you believe they are beneficial to your system.
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RECYCLE BIN
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The Recycle Bin provides a storage area for deleted files and acts as an additional layer of protection against

permanently deleting files on your system. This section covers the optimal configuration of this essential
Windows tool.

BASIC SETTINGS

If you don't want deleted files to automatically move to the Recycle Bin and instead want them permanently
deleted every time, right-click on the Recycle Bin icon on your Desktop, select Properties and under the
Global tab tick the 'Do not move files to the Recycle Bin. Remove files immediately when deleted' option. I
don't recommend that you do this, since the Recycle Bin is useful insurance to have against accidentally
deleting important files.

I recommend you untick the 'Display delete confirmation dialog' option under the Global tab of the Recycle
Bin Properties. This will stop Windows from asking you each and every time you want to delete a file
whether you really want to do it — instead the file will go immediately into the Recycle Bin when deleted.

If you have enabled the Recycle Bin, but sometimes want to delete files permanently and not have them
moved to the Recycle Bin first, highlight the file(s) and press SHIFT + DELETE. You will be asked to confirm
this action each time, but this will delete them immediately without placing them in the Recycle Bin.

You can specify the maximum amount of disk space the Recycle Bin can take up at any time by adjusting the
slider under the Global tab of the Recycle Bin Properties. I recommend setting aside enough disk space so
that should you delete several large files on your system you can still recover them if necessary. Typically
around 2GB is sufficient for most people. Work out what percentage of your drive that would be, and apply
it here (e.g. 2GB of an 80GB drive = around 3%). To see the exact amount of maximum space allocated, click
the tab that has your hard drive's name.

RECOVERING DELETED FILES

Files in the Recycle Bin are no longer part of your active Windows installation, and as such have no impact
on your system performance. They take up disk space, but are not used by the system. If you empty your
Recycle Bin, the files are removed and you regain the space on your hard drive, however the files are still not
permanently deleted from your hard drive. In fact, nothing on your drive is permanently deleted when you
delete it. Whenever you delete a file Windows simply marks it for deletion by changing one character in the
file table. The file is still sitting on your hard drive, but it is hidden from view. Windows then allows other
files to write over the space where it resides if required, but the file is not gone from your hard drive until it
is completely overwritten at some point. This means that you can actually recover files that have been
‘permanently’ deleted, but you will require special software to do so. There are various programs available
which attempt to recover deleted files with free ones such as Disk Investigator and retail products like
Undelete.

The best utility I have found to restore deleted files is a small free tool called Restoration. To use Restoration
first download the file, and extract the contents to an empty directory on your hard drive, or to a blank 3.5"
floppy disk. Then run the Restoration.exe file and either enter a filename in the search box, or leave it blank
(to find all recoverable deleted files) and click the 'Search Deleted Files' button. Restoration will scan your
hard drive for files which can be restored and list them. Once done, you can highlight a file and click
‘Restore by Copying' to recover it - however note that the file may not be complete since portions of it may
have already been overwritten, so there's no guarantee you can recover an entire file this way.

Remember that the more hard disk activity there is after you have deleted a file, the less chance you can fully
recover it, since portions of it may have been overwritten by new data. If you have accidentally deleted an
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important file, try and minimize any further disk activity. Do not play a game, start an application,
defragment your hard drive or even reboot Windows for example as these all aid in potentially overwriting
the area where the file is sitting. Don't even leave your system idle for long periods of time either, since by
default Windows XP starts defragmenting your hard drive in the background when idle. Run an undelete
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program like Restoration immediately.

PERMANENTLY DELETING FILES

If you happen to ever want to completely delete a file so that others can't undelete it, you can again use the
Restoration program mentioned above. First delete the files you want to permanently delete the normal way
- i.e. highlight them and press Delete, then empty the Recycle Bin. Then launch Restoration and enter the
name of the file in the search box and click 'Search Deleted Files'. When Restoration finds the file and lists it,
highlight the file (left-click on it once) and go to the 'Others' file menu in Restoration and select 'Delete
Completely'. This will permanently delete the file so it is unrecoverable by virtually any program or method.
Note that the file may still be recoverable by law enforcement agencies using specialized methods.

Low LEVEL FORMAT AND ZERO FILL

People might suggest that you 'Low Level Format' your drive. This is not recommended unless you are
experiencing severe hard drive problems, and even then only as a last resort. Modern hard drives are low-
level formatted at the factory to create tracks and sectors and do not need to have it done again. The correct
course of action is to Zero Fill your drive, which people often confuse for a low-level format. This method
overwrites the entire hard drive with blank data, ensuring that everything is deleted permanently for most
intents and purposes, but it is not as intensive or potentially disk-damaging as a low-level format. A note for
the extremely paranoid - nothing short of physically destroying the drive (by burning it for example) can
guarantee that data cannot be recovered from a hard drive by law enforcement agencies. So essentially a
zero fill is your best bet in getting back to a 'good as new' hard drive.

To zero fill a drive, check your hard drive make and model, then consult your manufacturer's website for an
appropriate format/installation utility such as the Seagate DiscWizard, Western Digital Data LifeGuard or

Maxtor PowerMax.

If you still believe you have to low level format your drive — for example if it seems heavily damaged with
bad sectors and is unresponsive to a zero fill — then you will have to look for a specific utility available from
your hard disk manufacturers' website to undertake this. I would only recommend this as a final step and
even then it may not save your hard drive.

RENAMING OR DELETING THE RECYCLE BIN

You can rename the Recycle Bin or even delete it by using this tweak. Open the Registry Editor and go to:

[HKEY_CLASSES_ROOT\CLSID\{645FFO40—5081—101B—9F08—OOAA002F954E}\ShellFolder]
CallForAttributes=0x00000000(0)

Attributes=50 01 00 20

First double-click on the CallForAttributes key and change its value to 0. Then double-click on the
Attributes key and change its value to 50 01 00 20 to add a Rename option to the Recycle Bin icon's
context menu (when you right-click on Recycle Bin, the Rename option now appears). To add a Delete
option as well, change the value to 70 01 00 20. You will have to reboot your machine for this tweak to be
implemented.

Note: It is strongly recommend that you do not delete the Recycle Bin. If you do you can use TweakUI to
repair it (see the TweakUI section).
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WINDOWS EXPLORER

Windows Explorer is the primary tool for manipulating files and directories in Windows XP. This section
covers many of the tweaks, customizations and useful tricks relevant to Explorer that you can undertake.
Importantly, there are many settings you can alter in Folder Options that have a direct impact on what you
can see when in Windows Explorer. These are covered under Folder Options in the Control Panel section, so
make sure you use the recommended settings there for maximum performance and functionality. For
example, by making sure that file extensions and system files aren't hidden in Folder Options, you will be
able to see these files in Explorer and perform some of the tweaks in this guide, as well as making general
troubleshooting easier.

Below are a range of tweaks, tips and tricks for Windows Explorer:

DISABLE DISK INDEXING

This is a performance tip that I strongly recommend you implement. The disk indexer indexes all files on
your machine to allow for faster searching using the Windows Search function for example. Since most
people don't constantly search their machine, having Disk Indexing enabled provides a performance hit for
no good reason. Follow these steps to turn off the Windows Disk Indexer to improve hard drive
performance and responsiveness:

When in Explorer, right-click on your hard drive name and select Properties.

Untick the "Allow Indexing Service to index this disk for fast file searching’'.

Select 'Apply changes to [Drive letter]\, subfolders and files' in the subsequent prompt.

Your system will now go through and remove all indexing on existing files, and not index any new or
moved files in the future - this will speed up drive read/writes and general responsiveness. Ignore any

LN

‘errors' which are shown, this occurs simply because some files are in use or protected and can't have
their properties changed to remove indexing - this is normal.

Make sure you also disable the 'Indexing Service' service as it is no longer necessary when disk indexing is
removed from your hard drive (See the Services Ultility section).

SET EXPLORER'S DEFAULT STARTUP FOLDER

If you usually open Explorer from a shortcut, this tweak allows you to set which directory it will start in by
default when launched from that shortcut:

1. Right-click on the shortcut icon you use to launch Explorer and select Properties.
In the Target box replace the existing text with the following:

%SystemRoot% \ Explorer.exe /e, path
3. In place of path above you should enter the actual path to the directory you want open by default. For
example C:\ Windows or C:\ Documents and Settings etc. The path doesn't require quote marks around it.

4. C(lick OK, and now using this shortcut will open a Windows Explorer window in the directory specified.

Note that there are several other switches and options you can use in the Properties box to further customize
Explorer's default view as detailed in this Microsoft Article.
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SPEED UP EXPLORER

The following tweak can improve the response time of Windows Explorer (and also Internet Explorer). Go to
the following key in the Windows Registry:

[HKEY LOCAL MACHINE\Software\Microsoft\Windows\CurrentVersion\Explorer\RemoteCom
puter\]

NameSpace

To prevent Windows Explorer from searching for remote scheduled tasks, under the Namespace key find
the {D6277990-4C6A-11CF-8D87-00AA0060F5BF} key, right-click on it and select Delete to remove it.
To also prevent Explorer from searching for remote shared printers, delete the {2227A280-3AEA-1069-
A2DE-08002B30309D} key as well. This will speed up the time it takes for Explorer to open and navigate.
If you are connected to a network of computers do not undertake this tweak.

REMOVE 'SHARED DOCUMENTS' FROM MY COMPUTER

If you want to remove the 'Shared Documents' folders under My Computer use this tweak:

[HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\MyCompute
r\NameSpace\DelegateFolders]

{59031a47-3£72-44a7-89c5-5595fe6b30ee}

Delete the key above by right-clicking on it and selecting Delete. This will remove all the superfluous 'Shared
Documents' folders permanently.

FORCE ALL COLUMNS IN EXPLORER TO BE VISIBLE

Sometimes when you open Explorer, or Explorer-based interfaces (and there are many, such as the Registry
Editor) there may be columns that are much too wide or narrow to show everything they contain. To quickly
force Windows to resize these columns appropriately press the CTRL key and the + (plus) key together. This
will instantly resize all columns so that even the largest value in each column is visible. This may require
you to expand the surrounding window or use the bottom scroll bar to see them all, but at least there won't
be any hidden or overly wide or thin columns. See the Visual and Convenience section for more handy
keyboard shortcuts.

RENAME MULTIPLE FILES

If you have a large number of files you want to rename, you can do it rapidly by doing the following;

1. Highlight the group of files you want to rename in Windows Explorer. You can do this two ways:
e Hold down the SHIFT key and click on the first file in the group, then still holding down shift, click
on the last file in the group and everything in between will be highlighted.
e Hold down the CTRL key and click on any individual files you want to select until all the files you
want to select are highlighted.
You can also combine the two methods, i.e. SHIFT select a range of files, then use CTRL to remove or
add individual files to the highlighted ones.
2. Without clicking anywhere else, right-click on the first file you want to rename, and select Rename.
3. Enter a name for the file and press Enter.

Now all the remaining highlighted files will be renamed with the same name you gave the first file, however
they will also have a number in brackets after them. For example, if I rename the first in a series of files
Screen.jpg using this method, the remaining highlighted files will be renamed Screen (1).jpg, Screen (2).jpg and
so forth.
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EDIT CONTEXT MENUS

Many programs insist on becoming a part of your context menus. A context menu is the little menu which
pops up when you right-click on a file, folder or icon for example, whether in Explorer-based views or on
your Desktop. Many of the entries in the context menu have been unnecessarily put there by programs you
have installed. The first step to getting rid of these excess entries involves opening the programs in question
and looking through their options to see if you can unselect any 'shell integration' or 'context menu' options
they have. If that fails, you can manually remove these entries by opening Registry Editor and following
these steps:

1. Before making any of these changes you should ideally have a full System Restore Point already, but
more specifically back up the registry keys which will be affected in this tweak (See the Registry Editor
section for details). The keys involved in this tweak are:

[HKEY CLASSES ROOT\*]

[HKEY CLASSES ROOT\Directory]
[HKEY CLASSES ROOT\Drive]
[HKEY CLASSES ROOT\Folder]

2. Now, go to the following sub-folders and delete references to programs you know have set up offending
context menu entries. For example, on my system under:

[HKEY CLASSES ROOT\*\shellex\ContextMenuHandlers]

I found the key Symantec.Norton.Antivirus.IEContextMenu that is a Norton Antivirus context
menu entry. I have no use for this so I deleted it.
3. Below are all the places you should look in for any such entries:

[HKEY_CLASSES_ROOT\ * \OpenWi thList]

[HKEY CLASSES ROOT\*\shellex\ContextMenuHandlers]

[HKEY CLASSES ROOT\Directory\shell]

[HKEY CLASSES_ROOT\Directory\shellex\ContextMenuHandlers]
[HKEY CLASSES ROOT\Drive\shell]

[HKEY CLASSES ROOT\Drive\shellex\ContextMenuHandlers]
[HKEY_CLASSES_ROOT\ Folder\shell]

[HKEY CLASSES ROOT\Folder\shellex\ContextMenuHandlers]

4. Asyou're removing all the unwanted program entries, you can test the effects immediately by checking
to see if the relevant entry was removed from the context menu. When you're done, you should see the
context menus devoid of the added rubbish.

If any of the programs whose context menu entries you've removed start displaying strange behavior,
restore the registry entries you backed up previously, or just reinstall that particular program. As long as
you only delete program entries and none of the default Windows entries, all the normal context menu items
will still remain.

ADD 'CoPY TO' AND 'MOVE TO' COMMANDS TO CONTEXT MENUS

If you want to add two useful commands to your context menus - namely 'Copy To' and 'Move To, use the
tweak below:

[HKEY CLASSES ROOT\AllFileSystemObjects\shellex\ContextMenuHandlers]

Copy To={C2FBB630-2971-11d1-A18C-00C04FD75D13
Move To={C2FBB631-2971-11d1-A18C-00C04FD75D13

Create two new keys under the ContextMenuHandlers folder - that is, right-click on
ContextMenuHandlers and select New>Key twice and name them 'Copy To' and Move To'. Then left-
click once on each folder, go to the right pane in Registry Editor and double-click on the (Default) entry
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and assign the appropriate values shown above. This will create two new context menu entries that allow
you to right-click on files and either 'Copy To Folder' or 'Move To Folder' them to other locations.

FOLDER VIEWS NOT BEING SAVED

Sometimes when you change the way a folder's contents look, or its position on your Desktop, or the size of
the window it opens in, after a reboot the changes don't seem to have been saved. The first thing to do is go
to Control Panel>Folder Options and under the View tab make sure that 'Remember each folder's view
settings' is ticked. However even with this setting ticked you may inevitably end up with unsaved settings.
This can be due to corrupted registry entries brought on by a bad shutdown for example. The easiest way to
fix this problem is to open the Registry Editor and go to the following keys:

[HKEY CURRENT USER\Software\Microsoft\Windows\ShellNoRoam\BagMRU]
[HKEY CURRENT USER\Software\Microsoft\Windows\ShellNoRoam\Bags]

Right-click on each key (i.e. BagMRU and Bags) and select Delete to get rid of both of them. Reboot your PC
and open up each folder or window you want to customize. They will be back at their default appearance,
and you will need to adjust again them to suit your tastes. However this time after you reboot your PC the
view settings should be exactly as you set them prior to the reboot. By deleting the registry entries above
Windows is forced to recreate them and in doing so get rid of corrupted entries. If you find you have to do
this very often, then see the tips in the Troubleshooting and Overclocking sections for possible resolutions in
preventing regular Registry corruption. This is a clear sign that your system is not completely stable, and is
not normal behavior for Windows.

MOVE THE MY DOCUMENTS FOLDER

By default the "My Documents' folder is in a specified location, and moving it manually will not work. To
move the My Documents folder to another location, you must do the following;:

1. Click on Start, go to My Documents and right-click on it, then select Properties. Alternatively in
Windows Explorer find the My Documents folder under your \Documents and Settings\[Username]\
directory, right-click on it and select Properties.

2. Click the Move button and select a new location. Click OK.

3. Choose whether you wish to move your existing documents across to this location.

Alternatively you can just type the new path in the Target box. When you're done, Windows will now
recognize the new location as the home of My Documents. Note that you can also change the name of My
Documents to something else if you wish, such as simply 'Documents'.

MAKE THE MY DOCUMENTS FOLDER PRIVATE

If you want to password protect your My Documents folder, or in fact any folder which is unique to your
user account (such as My Photos, Favorites, Desktop, Start Menu), and you're using the NTFS file system,
you can do the following: Right-click on the folder in Explorer, select the Sharing tab and tick the 'Make this
folder private' box. Now the folder and all its subdirectories will be password protected with your user
password. If you're logged in as the Administrator, or you have not set a user password (for quicker logon to
Windows), this tweak won't do anything. If you try it, you'll be prompted to set a password, and unless
you're worried about others accessing your private folders, I do not recommend setting a password.

Also see the Virus Cleaning section for more details on how to protect files and folders using Windows
Encryption.

12101dXg SmopuIp

Copyright © 2005 Koroush Ghazi 1 0 8




Pu=A~susess

THE WINDOWS XP TWEAKING COMPANION

DISABLE WINDOWS FILE PROTECTION

By default Windows XP protects a range of important system files from accidental deletion. This tweak
allows you to remove that protection - I strongly recommend against using it though:

[HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Winlogon]
SFCDisable=0

A setting of 1 will allow you to view and delete protected system files. This is not recommended as these
system files are protected for a reason - to specifically prevent harmful changes or deletions to core system
files that can destabilize your system. Note you need to untick the 'Hide protected operating system files'
option under Control Panel>Folder Options>View to be able to see protected files in Windows Explorer.

CHANGE DEFAULT LOCATION FOR PROGRAMS AND COMMON FILES

To change the default location for the Program Files and/or Common Files folders, open Registry Editor and
go to the following key:

[HKEY LOCAL_ MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion]

ProgramFilesDir=C:\Program Files

Change this entry to another path if you want to change where Windows points to by default when
installing new programs.

CommonFilesDir=C:\Program Files\Common Files

Change this entry to another path if you want to change where Windows points to by default when
installing common files for programs. Reboot Windows to bring the changes into effect. Keep in mind that
using this tweak may result in problems with existing installed programs and file associations, as well as
running Windows Update. You may have to manually move some of the existing program folders to the
new location for them to work correctly.

That concludes the Windows Explorer section.
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INTERNET EXPLORER

Internet Explorer (IE) is the most popular Internet browser in the world today. Although it is not as efficient
or as secure as some other browsers, many Windows users are extremely comfortable and familiar with
Internet Explorer, and also know that it is the one browser upon which all Internet content will display
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correctly. Even if you use an alternate browser as your main browser, you will need to use Internet Explorer
from time to time because certain websites will not display correctly on other browsers and/or may not
function correctly. The best example of this is Microsoft's own Windows Update website which only
functions when viewed with Internet Explorer.

While I recommend that you begin trialing alternatives to Internet Explorer (See Other Internet Browsers
further below), this section deals with the best way to set up Internet Explorer so that you retain both
functionality and security as well as performance. Note that your Internet Explorer should be completely up
to date by using Windows Update for maximum security before starting this section.

B INTERNET EXPLORER SETTINGS

Open Internet Explorer, go to the Tools menu and select 'Internet Options' — note this is the same as if you go
to Control Panel and choose 'Internet Options'. Below are my recommendations for the important settings
under each tab of Internet Options in Internet Explorer:

GENERAL

Under the 'Home Page' section, you can set the page that opens by default whenever you start Internet
Explorer. If you don't want any homepage to start when IE is opened, click the 'Use Blank' button. If you
want to set the website you are currently viewing as your homepage, click the 'Use Current' button. If the
home page will not change and remains stuck on an undesirable page, see the Virus Cleaning section for
details of browser hijackers.

Under the' Temporary Internet Files' section select the Settings button. Under the 'Check for newer versions
of stored pages' section select 'Every visit to the page'. This can increase loading times but guarantees that
you always see the very latest content on the sites you visit — this is my personal preference. However if you
want to shorten loading times select 'Automatic' and Internet Explorer will attempt to detect if a site has
changed since you last visited it and only update if it has. If at any time you want to see the latest version of
a page regardless of your settings here, press CTRL + F5 when in Internet Explorer and the page will be
forced to reload with the latest information available.

I recommend assigning around 30MB of disk space for the Temporary Internet Files folder. This cache will
help speed up your browsing by storing major portions of web pages (such as graphics and flash
animations) on your hard drive. A cache which is much too large, aside from taking up more disk space,
may actually end up making site loading slower because IE has to search through it for existing entries,
while a cache which is too small will not greatly help in speeding up browsing. Once changed, click OK to
close this box.

Under the History section, select the number of days you want a record of your visited sites to be kept. If
you don't want a history of visited sites to be kept at all, click the 'Clear History' button and set Days to 0.

SECURITY

I recommend at least the Medium level of security. Any higher is up to you, but bear in mind this will
prevent some websites from functioning as designed. This can be a good thing if the website is harmful or
annoying, but as many websites have genuinely useful interactive content which may be blocked by higher
settings, this can be a bad thing. If you want to be more selective, click the Custom Level button and
manually select each security function.
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PRIVACY

I recommend the 'Medium High' level for the best security/functionality compromise here. To be even more
selective, click the Advanced button and tick 'Override automatic cookie handling'. Third-party Cookies can
be Blocked without any major issues, as these are usually from advertisers. First-party Cookies on the other
hand can be useful (e.g for forums, or recording visual settings), and blocking them can impair a site's
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functionality. If you do decide to block all first party cookies, click the Edit button under the Websites area.
This will allow you to block or allow specific website's cookies. For example, if you set a High or Very High
privacy setting this will block almost all cookies, but you can still allow specific sites' cookies (such as those
of TweakGuides.com!) by adding it to the list of allowed sites. For full details of the security and privacy
features of Internet Explorer, see this Microsoft Article.

As of Windows XP SP2 this section of the Internet Explorer options now has a 'Pop-up Blocker' section. If
you tick the 'Block pop-ups' box, the built-in pop-up blocker becomes enabled. Pop-ups are browser
windows that are launched without your permission, 'popping up' in various locations and in various sizes.
Enabling the pop-up blocker is highly recommended to prevent them. Click the Settings button to make
adjustments to the pop-up blocker. Under the 'Notifications and Filter Level' section at the bottom I
recommend unticking both Play a sound when a pop-up is blocked' and 'Show Information Bar when a pop-
up is blocked' as these can get very annoying if left enabled. Under the 'Filter Level' I recommend the
Medium level so that most ad-related pop-ups are blocked, however legitimate pop-ups should be shown.

In fact regardless of your Filter Level settings, the best way to guarantee that pop-ups are shown for the sites
which you know have legitimate pop-ups is to enter their address in the "Address of Web site to allow' box,
and then click the Add button. This will add the site to the list of 'Allowed Sites' shown below it. For
example your Internet banking site may need to show legitimate pop-ups to function correctly. Enter the site
address in simple format (e.g. TweakGuides.com) and add it to the list to make sure it is not affected by the
pop-up blocker.

For more information about the pop-up blocker, click the 'Pop-up Blocker FAQ' link at the bottom of this
page, and a help file with more details will open.

CONTENT

If enabled, the 'Content Advisor' allows you to attempt to filter out and control access to websites that
contain offensive material/language. The settings here are obviously determined by tastes and tolerances,
but for most adults I don't see why Content Advisor needs to be enabled. If however you do wish to use the
content advisor, click the Enable button and work your way through the settings under the various tabs,
then click Apply to enable the advisor. Please be aware that the advisor is not a fail-safe Internet filter, it only
uses content advice from the ICRA (Internet Content Rating Association). You can find out more about the
Internet Explorer settings for this section, and about ICRA's role, in this ICRA FAQ.

Certificates are quite important, but also too complex to get into here. For full details see this Microsoft
Article. The best thing to do for the average user is not to alter any of the settings in this section. Click on the
Certificates button, and under 'Intended Purpose' select All. Now use the small arrows just below that box to
scroll across to the 'Trusted Publishers' tab. Make sure the entries in this box (e.g Microsoft Corporation) are
companies you know and have actually chosen to trust. Double click on each certificate to see more details.
Highlight a certificate and click Remove if you don't trust it.

Click the Autocomplete button next. Autocomplete can be useful, but if other people have access to your PC,
it can be very dangerous, as others can accidentally or intentionally see which websites you've visited, what
data you've entered on online forms, and even what your username and password is on sites which require
login (e.g. Internet forums or online stores). In such cases I recommend that you untick all forms of
Autocomplete and click the Clear Forms and Clear Passwords button as well for maximum safety.
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Otherwise if you are the sole user of the PC, I recommend ticking the 'User names and passwords on forms'

box and unticking the other boxes. This allows you to maintain user names and passwords for faster logging
in on Internet forums and the like. This could be considered a security risk but again it is important to have a
balance of security and functionality, not just be skewed to one extreme.
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Under the 'My Profile’ button I don't recommend creating and maintaining a profile of yourself on your PC,

especially if it contains information such as your phone number, address, work details etc. If a profile exists I
suggest deleting it by going into Outlook Express (See the Outlook Express section), and selecting 'Address
Book' under the Tools menu, clicking on 'Shared Contacts' and highlighting your profile(s) in the right pane
and selecting Delete. A profile should not be necessary for the most part, and is a genuine security risk that
can be avoided without much inconvenience.

CONNECTIONS

Set up all information in this box as provided by your Internet Service Provider (ISP). Under the 'Local Area
Network (LAN) Settings' area, click the LAN Setting button and unless you are connected to a network of
computers (not counting the Internet) untick all available boxes.

PROGRAMS

Set the programs used to taste. If Internet Explorer is your default browser and you don't have any other
browsers installed, untick the 'Internet Explorer should check to see whether it is the default browser' option.
This will both decrease Internet Explorer's startup time, and also prevent conflicts with other browsers if you
are using an alternate browser as your default browser. Note if you press the 'Reset Web Settings' button it
only sets your home page and search options back to their defaults - this is not recommended.

As part of Windows XP SP2, there is a new setting in this section called 'Manage Add-ons'. Add-ons are
small programs that enhance Internet Explorer's functionality for specific purposes such as showing movies
in a browser window or playing back a particular audio codec. Click the 'Manage Add-ons' button and in the
box that opens select 'Add-ons currently loaded in Internet Explorer'. The list below shows add-ons that are
currently loaded up in Internet Explorer starts, and by highlighting an add-on you can select either to enable
or disable it - however you cannot uninstall them here. For the most part you should minimize the number
of add-ons that load with Internet Explorer, since they take up resources and can also cause conflicts. Many
programs, such as media players or messaging programs insert add-ons which are rarely used or undesired,
and you should select the 'Add-ons that have been used by Internet Explorer' option at the top of this list to
see every possible add-on that IE can use on your system. Go through and disable the ones that seem
unnecessary. Then if during browsing you notice a site which you like is not showing its content correctly,
you can re-enter this list and re-enable the relevant add-on if need be.

ADVANCED

Below are my specific recommendations for important settings in this section.
Tick the following settings:

Disable script debugging

Disable script debugging (Other)

Enable Install on Demand (Internet Explorer)
Enable Third Party Browser Extensions

Use Passive FTP

Use smooth scrolling

Check for publisher's certificate revocation
Check for signatures on downloaded programs
Do not save encrypted pages to disk

Use SSL 2.0
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Use SSL 3.0

Warn about invalid site certificates
Warn if forms submittal is being redirected

Untick the following settings:
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Automatically check for Internet Explorer Updates

Display a notification about every script error

Enable Install on Demand (Other)

Enable offline items to be synchronized on a schedule

Enable Personalized Favorites menu

Empty Temporary Internet Files folder when browser is closed

The remaining settings in this section can either be left at default or set to taste. If in doubt, leave the others
at their default. Once you've changed these settings, click the Apply button, exit the settings and try out a
few of your favorite web pages. If they do not function properly or to your taste then you may have to
change specific security or privacy settings until you are comfortable with the balance between Internet
security, privacy and functionality.

B INTERNET EXPLORER TWEAKS

The following are some useful tweaks and customization to make Internet Explorer easier to use:

STREAMLINED INTERNET EXPLORER VIEW

One of the criticisms of Internet Explorer is that it is too bulky, and that other browsers take up far less real
estate on the screen. Well I have been using a customized view of Internet Explorer for years now which I
believe "streamlines" the Internet Explorer window to the point where it provides maximum viewable space
yet maintains quick access to its important functionality. My method for customizing Internet Explorer is
provided as follows:

1. Open Internet Explorer, go to the View menu and under the Toolbars sub-menu untick 'Lock the
Toolbars'.

2. Still in the View menu, under the Toolbars sub-menu untick the Links item.

Once again in the View menu, under the Toolbars sub-menu select the 'Customize...' option.

4. In the 'Customize Toolbars' box, select 'No text labels' in the "Text Options' box, and select 'Small icons' in
the 'Icon Options' box at the bottom.

5. Highlight each function's icon in the right pane that you do not need displayed and click the Remove
button. Make sure to also highlight each 'Separator' item and click Remove as well. You can also add
new icons from the left pane, and use the Move up and Move Down buttons to rearrange the icons in the
right pane into the final order you wish them to take on the toolbar. Try and minimize the number of
icons shown to only those that you use often. Once done, click Close.

6. Back on the Internet Explorer main screen, left-click and hold on the far left side of the icon toolbar (the
thin vertical rectangle) and drag the entire bar up next to the Menu toolbar, then let go.

7. Do the same for the Address Bar, this time moving it up to the right of the Icon toolbar, so that all the
components (Menu, Icons, Address Bar) are on one line.

8. Use the thin vertical rectangle on the far left of each toolbar to slide it around until they all fit together
without any large gaps or overlaps. If you need additional space, right-click on the word 'Address' in the
Address Bar and untick the 'Go button' to remove it.

9. Once you've completed resizing the toolbars and adding/removing elements, go to the View menu, and
under the Toolbars sub-menu place a tick next to the 'Lock the Toolbars' option to prevent accidental

@

resizing/movement in the future.
10. To gain even more space at the bottom of Internet Explorer, you may want to turn off the Status Bar by
going to the View menu, and unticking 'Status Bar'.

Copyright © 2005 Koroush Ghazi 11 3



Gwmu THE WINDOWS XP TWEAKING COMPANION

This new format may take some getting used to, but it provides the maximum amount of viewable browser
space, while at the same time still providing you with all the menu options, all the important icons, and a
decent-sized Address Bar for entering/viewing URLs. Note that this format best suits people who display
their Desktop at 1024x768 resolution or higher.
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CHANGE OR DISABLE INTERNET EXPLORER CLICK SOUND

Every time you navigate anywhere using Internet Explorer, or for that matter in Windows Explorer, you will
hear a 'click' sound. To disable this clicking sound, or to change it to another sound altogether follow these
steps:

Go to Control Panel>Sounds and Audio Devices>Sounds.

Under the Program Events list, scroll down to 'Start Navigation' under the '‘Windows Explorer' section.
Left-click on 'Start Navigation' to highlight it.

To disable the sound completely go to the sounds list below and select [None] at the very top of the list,
then click Apply.

5. To change the sound, pick another more suitable sound from the list, or click the Browse button to find
another sound file on your hard drive to use - remember, the larger the sound file the more memory is
used (See Sounds & Audio Devices under the Control Panel section). Click Apply when done.

Ll e

Note that changing or disabling this sound will affect both Internet Explorer and Windows Explorer equally.
I personally use windows xp pop-up blocked.wav as my default Explorer click sound. Note, the default is
Windows XP Start.wav.

INTERNET EXPLORER LAUNCHED FROM SHORTCUTS

The most common annoyance reported by Internet Explorer users involves the apparently ever-changing
size of Internet Explorer windows — they never seem to stay the way you want them. The following
information deals with possible ways to resolve this problem, depending on how you launch an Internet
Explorer window.

To determine the size of the window which opens up when you launch Internet Explorer from a shortcut
(i.e. a Desktop icon or menu entry), you will need to configure the specific Internet Explorer shortcut you
use. If you use the default Internet Explorer desktop icon, or the default one in the Start Menu, their
configuration cannot be altered. Follow the steps below to configure the default window behavior for IE:

1. Right-click on the Internet Explorer Desktop icon and select 'Create Shortcut'. A new shortcut will
appear on your Desktop with a name like 'Internet Explorer (2)".

2. Go to Control Panel>Display Properties and select the Desktop tab.

3. Click the 'Customize Desktop' icon, select the General tab, and under Desktop Icons untick 'Internet
Explorer'. This will remove the default Internet Explorer desktop icon (which cannot be configured),
leaving you with the shortcut you just created (which can be configured). Rename this shortcut to
"Internet Explorer" (without quotes).

4. Right-click on the new Internet Explorer shortcut and select Properties.

5. Under the Shortcut tab, select Maximized from the Run box to run Internet Explorer as a maximized
full-screen window each time you start it. Alternatively, select Minimized if you want it minimized on
start up, or select 'Normal Window" if you want a custom size. Click Ok.

6. If you've selected 'Normal Window' in the Run box, to select the default window size for Internet
Explorer, launch Internet Explorer from the shortcut and resize and position the window exactly the
way you want it, then select File>Close. The next time you open Internet Explorer from this shortcut it
will open exactly the same size and in the same position.
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You can now copy this Internet Explorer shortcut to other places, such as into menus, in place of existing
ones if you want to guarantee that these settings are used every time you launch Internet Explorer from a
shortcut.

INTERNET EXPLORER LAUNCHED FROM HYPERLINKS
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Now that we've set the initial Internet Explorer window size when launched from a shortcut, another

annoyance is the size of the Internet Explorer window which opens when you click on a hyperlink. You can
set the default size for this window by doing the following:

1. Start Internet Explorer, and go to a web page with visible hyperlinks.

Left-click on a hyperlink while holding down the SHIFT button — this ensures that it will open in a new
Internet Explorer window.

3. Now hold down the SHIFT key and move and resize this new window however you like it. If you want
to size it so it fills the entire screen, don't use the maximize button - resize it manually until it's the same
size as a maximized window.

4.  Still holding SHIFT, click on the File menu and select Close — don't use the close button on the top right
corner of the window.

Internet Explorer should now use these settings whenever a new Internet Explorer window is launched from
a hyperlink. Note that if your system isn't saving window sizes or positions after a reboot, see the 'Folder
Views Not Being Saved' solution under the Windows Explorer section.

If none of these methods work for you, there are utilities available which can force Internet Explorer to open
every window fully maximized every time, such as Autosizer, however I do not recommend these because
they have to keep running in the background to do their job and hence take up system resources, and may
cause conflicts — all for the sake of a minor annoyance which can usually be fixed by doing the above.

In the end, if your Internet Explorer window is resized at any point during a session it may remain that way
the next time you open it. The only permanent, efficient way around this is to use another browser like
Mozilla Firefox if it really bothers you that much (See Other Internet Browsers further below).

CHANGE INTERNET EXPLORER DEFAULT DOWNLOAD DIRECTORY

By default Internet Explorer uses the same directory path to save files whenever you download a file from
the Internet. You can change this default path at any time by opening the Registry Editor and going to:

[HKEY CURRENT USER\Software\Microsoft\Internet Explorer]

Download Directory=C:\Documents and Settings\User\Downloads

This setting specifies the default directory where IE will save downloaded files. Change the path to wherever
you want the new default to be. If this entry doesn't exist, create it as a String and assign the full path you
wish to use.

REMOVE 'LINKS' FOLDER IN FAVORITES

Another common annoyance of Internet Explorer is its insistence that a folder called 'Links' be kept in your
Favorites listing. Every time this folder is deleted, it will be recreated the next time Internet Explorer is
launched. To get rid of it permanently, use Registry Editor and go to:

[HKEY CURRENT USER\Software\Microsoft\Internet Explorer\Toolbar]

LinksFolderName=Links
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To delete Links for good, edit this string so that it equals a blank (empty) value. Now go into your Favorites
and delete the Links folder (right-click on it and select Delete) and it won't reappear ever again.

CUSTOMIZE INTERNET EXPLORER TITLE BAR
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If you want to customize what is displayed at the top of each Internet Explorer window (typically the name
of the site followed by Microsoft Internet Explorer), go to:

[HKEY CURRENT USER\Software\Microsoft\Internet Explorer\Main]

Window Title=Microsoft Internet Explorer

Create a new String called Window Title (ensure there is a space between the two words), and assign
whatever text you wish to use. The next time you launch a new Internet Explorer window this text will be
displayed at the top of IE.

INCREASE MAXIMUM SIMULTANEOUS DOWNLOADS

By default Internet Explorer only allows 2 downloads at a time. This is the Internet Standard for maximum
number of simultaneous connections to a server. You can increase this value beyond 2 by going to:

[HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\Internet Settings]
MaxConnectionsPerl 0Server=0x00000005 (5)

MaxConnectionsPerServer=0x00000005 (5)

Create two new DWORD keys with the names shown above. To assign values to them, double-click on each
one and before entering a value, make sure to select the Decimal view option. Then enter the maximum
number of simultaneous downloads you want in the 'Value data' box (e.g. 5) and click Ok when done. The
number shown in the right pane for these keys will be displayed in Hexadecimal format first followed by the
normal Decimal value in brackets - make sure the value in the round brackets is the maximum number of
connections you want. Note that increasing the maximum number of simultaneous connections to a server is
technically a breach of Internet Standards, so if you experience any problems reset these values to 2.

DISABLE INTERNET EXPLORER SEARCH ASSISTANT

When you click the Search button or press CTRL + E to use the Search function in Internet Explorer, by
default this brings up the Search Assistant interface. This interface is annoying, and can be improved by
using the Registry Editor and going to:

[HKEY CURRENT USER\Software\Microsoft\Internet Explorer\Main]

Use Search Asst=No

To use a custom search sidebar (See below) and get rid of the somewhat annoying default interface, turn off
Search Assistant by setting this entry to No. Note that the 'Main' registry key may not exist in your registry,
so in Registry Editor right click on the 'Internet Explorer' key, select New>Key, and call it "Main" (without
quotes). You will then have to create a new String value in the right pane called "Use Search Asst" (without
quotes, and remember to include a space between each word), double click on it once created and give it the
value "No" (without quotes).
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USE CUSTOMIZED INTERNET EXPLORER SEARCH ASSISTANT

If you have disabled the default Internet Explorer Search Assistant (which is recommended - see above), you
can customize the search sidebar to have a nifty Google search interface instead for example. To do this,
open the Registry Editor and go to:
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[HKEY CURRENT USER\Software\Microsoft\Internet Explorer\Main]

Search Page=http://www.google.com

Search Bar=http://www.google.com/ie

[HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Internet Explorer\Search]
SearchAssistant=http://www.google.com/ie
Change all of the registry entries shown above to implement this tweak. If any of the above registry entries
doesn't exist, create it as a new String and set the value to the relevant addresses shown above.

CHANGE INTERNET EXPLORER ADDRESS BAR SEARCH ENGINE

By default you can perform an Internet search by entering a word in the Internet Explorer Address Bar. This
will work if under the Tools>Internet Options>Advanced section in Internet Explorer you have the option
Just display results in the main window' or 'Display results, and go to the most likely site' selected. Internet
Explorer will use the Microsoft Network (MSN) search engine by default to perform the search and show the
results, or go to the most likely site. To use a better search engine such as Google open Registry Editor and
go to:

[HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Internet Explorer\Search]

CustomizeSearch=http://ie.search.msn.com/en-us/srchasst/srchcust.htm

Changing the value to that shown above will allow Internet Explorer to use other search engines. If the
CustomizeSearch key doesn't exist, create it as a new String value.

[HKEY CURRENT USER\Software\Microsoft\Internet Explorer\SearchUrl]
Provider=gogl
This setting determines the search engine used if a customized search engine is allowed (See above). If it

doesn't exist, create it as a new String value. In the example above, it is set to gogl (for Google), however
you can use other values which correspond to other search engines, as listed below:

Msn - MSN (default)
Yaho - Yahoo

Alta - AltaVista
Aols - AOL

Lksm - LookSmart
Askj - Ask]Jeeves
Nets - Netspace

Infs - InfoSpace

You can also change the search provider by launching Internet Explorer, opening Search (CTRL + E or click
the magnifying glass), clicking the Customize button, then clicking the 'Autosearch Settings' button. Select
your Address Bar search engine provider there. Note that you may have problems searching from the
address bar if you use a proxy or some Firewall software. Also note that whichever provider you choose for
the search bar, the search will still be processed through MSN initially, which will then pass the search to the
chosen search engine and show the results in that engine. This behavior can't be changed.
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B INTERNET EXPLORER PROBLEMS

If you're experiencing difficulties with Internet Explorer, the first thing to do is to double-check your settings
in detail. However sometimes Internet Explorer's behavior can be so inexplicable as to leave you wondering
what exactly is going on. Since Internet Explorer is a core component of Windows XP, it cannot be
completely uninstalled or deleted from your system and then reinstalled 'cleanly’. You can however attempt
to fix the problem by doing one (or all) of the following:
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SCAN FOR VIRUSES, TROJANS, SPYWARE OR BROWSER HIJACKERS

Many viruses, trojans, spyware and browser hijackers can significantly alter your Internet Explorer behavior
- such as changing your default home page or the number and size of IE Windows which open. You should
run through the procedures under the Virus Cleaning section of this guide to begin with before embarking
on any major Internet Explorer repairs.

REPAIR INTERNET EXPLORER

If you suspect a corrupted system file, you can use the System File Checker to scan for and repair all such
files. The System File Checker will require that you have your original Windows XP CD handy. See the
Troubleshooting section for details on how to use the System File Checker.

Alternatively, you can trick Windows into thinking Internet Explorer 6 isn't installed, and this will allow you
to reinstall Internet Explorer 6 over the top of your existing installation (which isn't normally possible). To
do this, open the Registry Editor and go to the following key:

[HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Active Setup\Installed Components\
{89820200-ECBD-11cf-8B85-00AA005B4383}]

IsInstalled=1

Change this setting to =0 and click OK. If it doesn't exist, create it as a new DWORD value and set it to 0.
Now go to the Microsoft Internet Explorer Homepage, download the latest full version of Internet Explorer
and install it. Once completed, go to Windows Update and install all the available patches and updates for
Internet Explorer once again. These steps should resolve any issues you are having with Internet Explorer if
the cause was a corrupted file or registry entry. If they don't then see below.

TEMPORARY INTERNET FILES FOLDER

If you're having problems with Internet Explorer while browsing the Internet, such as freezes or laggy
behavior, it may well be that the Temporary Internet Files folder is the culprit. If you've previously tried to
manually delete files from there, or even tried moving or deleting the entire folder, this may trigger
problematic behavior in Internet Explorer which can only be resolved by doing the following:

1. Empty your Internet Explorer cache by opening Internet Explorer, going to Tools>Internet Options and
clicking the 'Delete Files' option, ticking the 'Delete all offline content’ on the next screen and click OK.
Also click the 'Delete Cookies' and 'Clear History' buttons while you are there.

2. Reboot your PC and make sure you don't open Internet Explorer or Windows Explorer, or anything
which accesses them.

3. Go straight to Start>Run and type "Cmd" (without quotes) then press Enter. This opens a Command
Prompt.

4. Type "CD\" (without quotes) at the prompt to take you to the root directory.

5. Open Windows Task Manager (CTRL + ALT + DEL) and under the Processes tab highlight the Explorer
process and click 'End Process'. The desktop will vanish, but this is normal.

6. Go back to the command prompt, and copy or type the following text (including the quotes) into the
command prompt and press Enter:

del "%userprofile%\local settings\temporary internet files\content.ie5\"
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7. Answer'Y' when prompted if you want to delete the file.
8. Go to the Windows Task Manager again and click on the File Menu and choose 'New Task (Run)..." and
type "Explorer” (without quotes) and hit Enter. This will reload the desktop.
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Doing the above will delete the Index.dat file which lies in your Temporary Internet Files folder and in doing

so it will be recreated with the correct references to your cached internet files the next time you open Internet
Explorer. Any strange browser behavior should be resolved.

DNS CACHE ISSUES

Whenever your browser tries to load up a page on the Internet, it has to access a Domain Name System
(DNS) server to resolve or translate the text address you use (e.g. www.Google.com) into the actual IP
address for the website (for Google.com the IP address is actually 216.239.57.99). As you can see, the concept
of having text for an address rather than a bunch of numbers makes browsing a lot easier for users. For more
information about DNS see this DNS Site.

However since your browser needs to check DNS addresses each time it loads any web pages, the browser
speeds up this process by caching (locally storing) the addresses you use for a period of time so that next
time you try to go to the same address it uses the IP address it has cached rather than looking it up again on
a DNS Server. Unfortunately if a site is down temporarily then your DNS cache may store the site as being
inaccessible for a while even if it comes back online shortly afterwards, and every time you try to connect to
it for several hours you will get an error message.

To resolve any DNS problems with web pages not loading up at all or loading up with outdated
information, go to Start>Run and type "CMD" (without quotes) and press Enter to open a new Command
Prompt window, then in the Command Prompt type "ipconfig /flushdns" (without quotes) and press Enter.
This will clear the DNS cache.

Furthermore, to make sure that your browser never stores a negative' DNS cache entry —i.e. one which says
a site is inaccessible — then go to the Registry and do the following;:

[HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Services\Dnscache\Parameters]

MaxNegativeCacheTt1l=0

If the value above doesn't exist, create it as a new DWORD and assign it a value of 0 so that no negative DNS
entries can be kept in the DNS cache.

You can also set the length of time in 'Time To Live' (TTL) for a 'positive' (or working) DNS cache entry to
remain active before being updated. To do this, in the Registry go to:

[HKEY LOCAL_ MACHINE\SYSTEM\CurrentControlSet\Services\Dnscache\Parameters]

MaxCacheTt1=10800

If this entry doesn't exist, create it as a new DWORD and assign it a value which measures (in seconds) the
total Time To Live for the positive cache entry. Make sure to enter the amount of seconds in Decimal — not
Hexadecimal — view. Also do not set this value too low as your DNS cache will effectively become useless
and browsing will take longer. A value of between 3 and 6 hours (10800 — 21600 seconds) should be fine.
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B WINDOWS UPDATE

Windows Update is an essential website which you should access regularly to download and install
important updates for Windows XP. This section covers the types of things you can do to make using
Windows Update easier and trouble-free.
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A brand new version of Windows Update was released for Windows XP SP2 and you will need to update to

this version to access Windows Update correctly. To access Windows Update at any time, open Internet
Explorer and go to the Tools menu, then underneath select Windows Update. Alternatively, if you want to
create a shortcut or bookmark to it, the address is Windows Update. If you are having problems accessing
the site through the common methods above, you can try accessing it using a secure server through this link:
Windows Update Secure. Note that the secure link differs by having https:// instead of http:// in the address.

To find out more about how Windows Update works, see the Windows Update FAQ.

WINDOWS UPDATE CUSTOM INSTALL

Whenever you access Windows Update I strongly recommend that you click on the 'Custom Install' option
instead of the 'Express Install' method. This is because Custom Install allows you to see what the updates
are, and you can select which you wish to install. Once you've clicked on Custom Install, you will see
Windows Update scanning your machine and after a while it provides a list of updates. I recommend you
click on the 'Review High Priority Updates' option and make sure all the available updates there are selected
- these should be installed on any Windows XP installation.

However you should then click on the 'Select Optional Software Updates' link and go through the list of
optional updates. Quite often an important (but not 'critical’) update will be provided here, and you should
add it to your list.

Finally, you should click on the 'Select Optional Hardware Updates' and see if anything is provided here.
These updates are newer versions of drivers for the hardware on your system and I recommend that you
first follow the procedures in the rest of this guide to update your drivers, and then if these driver updates
still appear you should install them as well. They won't cause any harm to your system and you can always
manually install newer versions over them.

If you feel adventurous (or impatient) and want to see any 'beta’ (pre-release) software, drivers or fixes in
Windows Update, click on the Settings link under 'Other Options' and place a tick against the 'Show beta
products and related updates'. Now click on the Home link at the top left of the page and start another
'Custom Install' scan to update the list with beta drivers included.

USING WINDOWS UPDATE ON OTHER BROWSERS

Microsoft has designed the Windows Update website to function correctly only with Internet Explorer. If
you try to access the site using another browser you will have problems, and there is currently no fix for this
- you must use Internet Explorer to check and update your PC with Windows Update. That is precisely why
you should never try to prevent access to, delete or uninstall Internet Explorer.

FIXING WINDOWS UPDATE

Many people find that Windows Update can exhibit strange behavior - such as endlessly scanning your
machine but never providing any list of updates, or giving strange error codes. To start with you should
make sure you are using Internet Explorer to access Windows Update, try the secure Windows Update
address: Windows Update Secure and of course if you have a pirated copy of Windows XP then consider
purchasing a legitimate copy. However these tips may still not resolve your problem, so here are some steps
you can take to repair Windows Update:
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1. Reboot your PC and don't open Windows Update.
Go to Internet Explorer>Tools>Internet Options and click on the 'Delete Cookies' and 'Delete Files' (tick
'Delete all offline content’) buttons. Click OK to finish and close Internet Explorer.

3. Open Windows Explorer, and go to your C:\Program Files\ System32 directory. Find and delete the files
wuapi.dll, wucltui.dll, wupdmgr.exe, and wuweb.dll.

4. Still in Windows Explorer, go to your Windows Update Temporary folder if it exists, typically
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C:\WUTemp. Delete this folder and all its subfolders and contents. Note that you can delete this folder at
any time in the future after a Windows Update session and a reboot. Close Windows Explorer.

5. Click on Start>Run and type "REGSVR32 IUCTL.DLL /U" (without quotes) and click OK. Click OK again
when done.

6. Go to Start>Search, select All Files and Folders and type in "IUCTL.DLL" (without quotes) in the top
search box then Press Enter. Delete every instance of this file found (except in the /ServicePackFiles/
directories) - highlight the files in the right pane and press DEL.

7. Repeat step 6 for "TUENGINE.DLL" (without quotes) and delete all entries found again.

8. Reboot your PC. Open Windows Update and Windows will re-download the Windows Update software
and everything should be fine from there.

If that doesn't work, and you are experiencing particular Windows Update errors when trying to use
Windows Update - such as error code 0x800A138F - then see this Windows Update Fails article for a list of
fixes for various Windows Update error codes. There is no single fix for all error codes and each one has

several methods you can try to resolve the issue.

And as always, remember to run Windows Update at least once a week and install all important updates to
maintain the security of your PC.

B OTHER INTERNET BROWSERS

By now you may be wondering if there are other browsers you can try which may overcome some of the
inherent problems of Internet Explorer. The simple answer is yes, there are other browsers which are free
and easy to use, and in many ways better than Internet Explorer. The two main alternate browsers are Opera
Browser and Mozilla Firefox.

My personal preference is for Firefox. It is an excellent, stable, optimized Internet browser which is
completely free and well-supported. It runs without any problems alongside Internet Explorer, and this
gives you the opportunity to try it out for a while to see if you prefer it. When you first install Firefox, it
imports your Internet Explorer settings so that you can begin using it straight away without the need for
significant customization. However if you want to add additional functionality to Firefox, you can select
from over 120 Extensions which you can download from the Firefox Extensions page.

If you want to undertake find out more about Firefox and undertake some tweaking I recommend you read
my Firefox Tweak Guide.

I do recommend you try Firefox though, because it is virtually invulnerable to spyware and generally more
secure than Internet Explorer, it loads web pages very efficiently and quickly, it can be customized in a
variety of ways, and it has a new method of viewing multiple pages called 'tabbed browsing' which you
might find incredibly handy. You have nothing to lose by trying it out.
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OUTLOOK EXPRESS

Outlook Express, which is not to be confused with the full version called Outlook, is a very useful
email/newsgroup program. It should meet all your basic email needs, but it also has some useful built-in
features people rarely get around to configuring or using. This section covers the main Outlook Express
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settings and tweaks. Note, if you don't have the latest version of Outlook Express use Windows Update to
update it for security and functionality reasons.
B OUTLOOK EXPRESS SETTINGS

The first thing to do is optimize Outlook Express' basic settings for efficient, trouble-free operation. Open
Outlook Express, go to the Tools menu and select Options. Below are my recommendations for the
important settings under each tab of Options:

GENERAL
Tick 'When starting go directly to my Inbox folder'

Untick 'Automatically Log on to Windows Messenger'

Note if you have removed Windows Messenger from your system (See the Registry Editor section), you will
also have to apply the Outlook Express slowdown fix (See below) otherwise Outlook Express will take a
long time to load up each time you start it.

READ
Untick 'Automatically download message when viewing in the preview pane'
Tick 'Read all messages in plain text'

Both these are recommended for security reasons.

RECEIPTS

I personally don't like sending (or receiving) read receipts. They can be quite annoying, and whether you
want to use them is up to you, but for the 'Returning Read Receipts' section I recommend selecting 'Notify
me for each read receipt request'. That way you know when someone has sent an email to you with a receipt
request, and you can choose whether to accept the request when you open the email.

Secure receipts are similar, but might be more useful if you're sending a very important message and you
want to make sure that the recipient has opened the message, and that the message arrived at the other end
unaltered. Otherwise the same settings apply.

SEND

Tick 'Send messages immediately’
Untick 'Automatically put people I reply to in my Address Book'

Making sure that you don't add everyone to your Address Book is one way of preventing any viruses on
your system from emailing everyone in your Address Book with the virus. I recommend instead either
writing down email addresses or keeping existing emails from various people so you can reply to them.

COMPOSE, SIGNATURES, SPELLING

There are no specific recommendations for these tabs. If you want to know what any of these features do,
right click on them and click 'What's this' or press F1 for Windows Help.
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SECURITY

The security features in Outlook Express are excellent in protecting against most viruses and malicious code
sent in emails. However you need to know how they work and configure them correctly. Here's what I
recommend:
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There is an option to select either the 'Internet Zone' or 'Restricted Sites Zone' for your default email

behavior. When in Internet Zone mode, HTML-based emails with active content will display their content
just like a web page in Internet Explorer. In fact the security settings you choose under the Security tab in
Internet Explorer Options also apply to Internet Zone email content. When in Restricted Sites Zone mode,
Outlook Express will disable active content from HTML-based emails, which is much more secure, but
reduces email functionality. I recommend running in Restricted Sites Zone mode, as most HTML-based
emails nowadays are spam, or worse still malicious or viruses.

Tick 'Warn me when other applications try to send email as me'

Tick 'Do not allow attachments to be saved or opened that could potentially be a virus'. This will protect you
against attachments, the vast bulk of which are dangerous, unsolicited email viruses. If you receive an
attachment from an address you don't know, don't save or open it. For example Microsoft will never email
you an update or patch, neither will your bank. These are all hoax emails. If you receive an attachment from
an address you know, it may still be a virus which was auto-mailed from that user's account, so double-
check with the sender if you're genuinely unsure of whether to save or open the attachment. If it is a
legitimate attachment, then close the email, open Options and untick this setting, go back and open up the
email and save the attachment, then make sure to retick this option afterwards.

Note that certain file types (such as .exe files) are automatically blocked with this setting enabled. To
configure which other types of files are affected when this setting is ticked, go to Control Panel>Folder
Options>File Types, highlight a file extension and click the Advanced button. Select 'Confirm open after
download' to add the file type to the unsafe file list which Outlook Express uses to block attachments when
this setting is enabled. Again remember that some file types are permanently on the unsafe list and cannot be
taken off.

Tick 'Block images and other external content in HTML email' - once again for security reasons.
You shouldn't have to change the remaining settings in this section.

CONNECTION

Uses the same settings as Internet Explorer, so see the Internet Explorer section.

MAINTENANCE

I recommend the following settings to reduce wasted disk space:
Tick 'Empty message from the Deleted Items folder on exit'.
Tick Purge deleted items when leaving IMAP folders'.

'Clean Up Now' — Click and select Compact to reduce existing wasted space immediately.

If you are wondering where your emails are physically being saved, then the following option will show you
email store directory:

'Store Folder' — This is the location of your emails and Outlook Express folder settings.
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Once you've changed all the settings you wish to change in Outlook Express, click the Apply button and exit
the settings screen. You will need to close and relaunch Outlook Express for some of the settings to come
into effect.

B BACKUP/RESTORE EMAILS IN OUTLOOK EXPRESS
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If you want to back up the emails you've saved in Outlook Express, follow these procedures:

1.  Open Outlook Express, go to Tools>Options and open the Maintenance tab.
Click the Store Folder button and highlight the directory path shown with your mouse (right-click on
the text and choose Select All).

3. Right-click again on the highlighted text and select Copy.

4.  Go to Start>Run and right-click in the box. Select Paste, then click OK. This opens an Explorer window
in the folder where Outlook Express holds your emails and email folders as .dbx files.

5.  The folder names should be self-explanatory. Select individual .dbx files where you stored emails and
copy them to another location for backup purposes.

To restore these emails back into Outlook Express at any point, say after a reformat of Windows, follow
these procedures:

1. Open Outlook Express, go to File>Import>Messages.
Select 'Microsoft Outlook Express 6' from the list (or whichever version of OE you saved the messages
under).

3. Select Import mail from an OE6 store directory' and click OK.

4. Browse to the directory where you backed up your Outlook Express messages as .dbx files. Click OK,
then click Next.

5. Click All Folders, select Next, then select Finish. Your messages should be restored as you saved them.

You can also use these Import and Export functions in Outlook Express to save and restore your Address
Book, Email account and Newsgroup account data. These aren't detailed here, but the procedure is similar to
that outlined above.

B BLOCKING SPAM IN OUTLOOK EXPRESS

Spam is unsolicited email with useless and often offensive content. Outlook Express has some built-in
features which can be used to sort mail automatically and prevent a great deal of spam. Note that these
features won't work for IMAP and HTTP (i.e. Web-based) email accounts such as Hotmail. Use these tools
for your POP3 accounts such as the ones your ISP provides, or Yahoo when set up as POP3. To access and
configure these tools do the following:

1. Open Outlook Express and go to Tools>Message Rules and select Mail.

Click the New button to create a new rule. The New Mail Rule window will open.

3. Select a condition for your rule. For example, we'll choose 'Where the message is more than size'. We
will set the size parameter for this rule in Step 5.

4.  Select the action for the rule. For example, 'Move it to the specified folder'.

5. Set any parameters required for the rule by clicking on the blue underline text in the Rule Description
box. For example, we'll click on the Size text and choose 40KB as our size limit for the rule set up in step
3. We'll click on the Folder text and choose Deleted Items.

6. Give the rule an appropriate name, such as 'Large email redirector' and click OK.

7. In the Mail Rules window, put a tick next to this new rule and click the Apply Now button. If you want
to add more parameters or change the rule, click the Modify button, and go back through steps 3 — 6
above until you're happy.

8. Create as many rules as you like, and arrange them in order of priority/application to new messages by
using the Move Up and Move Down buttons.
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Now when you check for new emails the above rule will automatically check each email's size and if it is
over 40KB, will redirect it to your Deleted Items folder automatically. You can have a quick look in there
after checking your mail and see if it's anything you want to keep, otherwise just empty the deleted items
and you've cleared some hefty spam straight away. Create more rules once you identify patterns in your
email. For example I was getting a lot of spam emails with phony virus screensavers attached. So I set up a
new rule which automatically deletes from my mail server any emails with 'Screensaver' in the message
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body (so I don't even download them).

Of course you can do a lot more with Message Rules, such as block certain individuals, block any email
accounts from particular domains (such as MSN, Yahoo or AOL), etc. Experiment with the tool as it is more
useful than most people would believe. To begin with set the action for any rule to redirect flagged mail to a
separate folder you set up and see if any legitimate mail is getting caught up by the rule. Also, create
multiple rules to finely sift through the mail and get rid of the genuine rubbish.

B OUTLOOK EXPRESS TWEAKS

REMOVE OUTLOOK EXPRESS SPLASH SCREEN

The following is a simple tweak which skips the blue Outlook Express splash screen when Outlook Express
is loading up. To perform this tweak, open Registry Editor and go to:

[HKEY CURRENT USER\Identities\{numbers}\Software\Microsoft\Outlook Express\5.0]
NoSplash=1
Create this new DWORD value and set to =1. Delete the entire entry if you want to regain the splash screen
at any time.

F1x OUTLOOK EXPRESS SLOWDOWN

If you have disabled MSN Messenger either in Group Policy or the Registry Editor (See relevant sections)
then you may experience slowdowns when launching Outlook Express. To resolve this problem, implement
the following change to your Registry:

[HKEY LOCAL_ MACHINE\SOFTWARE\Classes\CLSID]

{FB7199AB-79BF-11d2-8D94-0000F875C541 }

Find this key and under it select the folder IniProcServer32. In the right pane of the Registry Editor
double-click on the (Default) entry at the top and completely delete the data it contains. Now do the same
for the LocalServer32 folder as well. This prevents the slowdown which some users experience with
Outlook Express when MSN Messenger has been disabled.
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WINDOWS MEDIA PLAYER

Windows Media Player is Window XP's built-in utility for playing music and movies. The latest version of
Windows Media Player is available as a free download from the Windows Media Player Home Page. I
highly recommend that you update to the latest version of Windows Media Player and then follow this
section of the guide to see how to configure it for optimal performance and privacy. Note that you should
also implement the Windows Media DRM tweak under the Group Policy section to maximize privacy.

Windows Media Player has many great features and is actually a very efficient, feature-packed media
player, but is often dismissed as being 'bloated’ or 'spyware' when this is far from the truth. In actuality it is
smaller and more efficient than many popular media players like WinAmp for example. I will quickly run
through the various sections of Windows Media Player, providing recommended settings for each of the
important options under each tab. Any settings not covered are left up to your personal preference as they
have no significant impact on performance or privacy.

B WINDOWS MEDIA PLAYER SETTINGS

Open Windows Media Player, go to the Tools menu and select Options. Or if it is running in Skin Mode,
right-click on the top left corner of the player and select Tools>Options. Each section below refers to the tabs
under the Options page.

PLAYER

Tick the 'Once a month' option under 'Check for updates', so that the player doesn't constantly search for
updates when you are connected to the internet. Tick 'Download codecs automatically' so that if you attempt
to play a media file for which you don't have the correct codec (and you are online), Windows Media Player
will automatically attempt to download the required codec and install it so you can play the file. See the
Windows Media Player Codecs section below for more information.

Under the 'Player settings' section make sure to untick the following for maximum privacy:

Add music files to Media Library when played
Prompt me to back up my licenses
Connect to the Internet

Rir MuUsIC

Click the Change button and select the directory where any music or media copied to your hard drive is
placed. Under the Rip Settings' section make sure to untick the 'Copy protect music' option.

DEVICES

Select each playback device and click the Properties button. Adjust settings as appropriate, however for your
speakers, make sure the playback device is your main sound card, and if you have a 24-bit capable sound
card (e.g. SoundBlaster Audigy series), tick the 24-bit box for optimal sound during CD audio playback. For
your Display properties, you can alter the aspect ratio if it appears to be wrong. For most standard 4:3
monitors, an aspect ratio of 1.000 is optimal.

Click the Advanced button to alter the settings for file conversions when being transferred to/from devices.

PERFORMANCE

I recommend selecting 'Detect connection speed' and 'Use default buffering' in this section. Under the 'Video
acceleration' section click the Advanced button, and place a tick against every option (except Use Overlays
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under 'Use video mixing renderer') in the subsequent dialog box. If you run into any difficulties with display
of video clips or DVDs, you can reduce video acceleration and change settings to experiment.

LIBRARY

The Media Library is not a necessary function of Windows Media Player, and for optimal privacy and
security untick every option on this page. Click the 'Monitor Folders' button and remove every folder
displayed by highlighting the folder name in the box and clicking the Remove button - no folders should
remain listed in the Folders box. In the two KB boxes, enter 9999 (the largest amount possible) so that
Windows Media Player doesn't attempt to automatically add files below this size to your Media Library.

PLUG-INS

Plug-ins are various modules which add functionality to Windows Media Player and can be added, removed
or configured here. For example, you can install a free and highly useful Microsoft plug-in for Windows
Media Player called TweakMP. You can download TweakMP from the Microsoft TweakMP Page, and full
installation and usage instructions are also provided there. Alternatively you can download the Windows
Media Bonus Pack which contains TweakMP and a range of other free plugins and add-ons for WMP.
Additional plug-ins can be found at the Plug-ins for Media Player site, and elsewhere on the Internet,
however make sure you trust the source of the plug-in before installing it, and if you run into any problems
with any of them highlight the suspected plug-in and click the Remove button to uninstall it.

PRIVACY

This is an important area of Windows Media Player which causes users a lot of concern. There is a fear that
by using Windows Media Player, Microsoft is spying on your media usage behaviors. This is not true,
however to ensure that none of the media on your hard drive is altered, or information about it reported
back to Microsoft, follow the recommended settings in this section. To begin with untick every option on this
page. None of them are necessary and in fact all of them (except for 'Set clock on devices automatically') will
breach your privacy in some way. Click the 'Clear History' and 'Clear CD/DVD' buttons as well.

As an added precaution, I suggest that you make sure all of your media files (e.g. .mp3, .mpeg, .avi files) are
all write protected. To do this, in Windows Explorer go to the folders where your media files are stored and
highlight all of them, right-click on them, select Properties and place a tick in the 'Read Only'. By write-
protecting all your media, Windows Media Player can't alter them or add any identifying information.

Finally, for Windows XP Professional users see the Windows Media Digital Rights Management (DRM)
tweak in the Group Policy section of this guide and enable it to prevent Windows DRM from accessing the
Internet when you use Windows Media Player. This significantly enhances your privacy.

SECURITY

Most of your security settings from Internet Explorer will be used when using Windows Media Player
online, but untick the 'Run script commands when present’ option under the Content section. You might also
want to tick the 'Do not run script commands...' option to increase security on web pages which use media
player functionality, but this may impair such functionality.

FILE TYPES

Manually select which types of files will be associated with Windows Media Player in this section. For
example, if you have a tick against the 'Movie file (mpeg)' option, double-clicking on an .mpeg/.mpg file will
automatically launch it in Windows Media Player. Untick any files you do not want to automatically be
played by Windows Media Player when launched. This doesn't affect Windows Media Player's ability to
play such files, only the default file associations in Windows (See Folder Options under the Control Panel
section for more details on viewing and changing file associations).
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DVD

If you have a DVD-ROM drive on your system and use Windows Media Player to play DVDs, you can
adjust the settings in this section to suit your needs. In particular click the Advanced button and select your
preferred speaker/audio setup.

NETWORK

Configure this section according to your needs. I personally have all the streaming protocols ticked, and
under the 'Streaming proxy settings' section for each protocol I recommend clicking the Configure button
and selecting 'Autodetect proxy settings'. This ensures maximum compatibility with all forms of streaming
media on the Internet.

WINDOWS MEDIA PLAYER SKINS

You can customize the way Windows Media Player looks through the use of 'skins'. These skins can change
the appearance and visible functionality of Windows Media Player. There are several skins which already
come with the player. You can view them by opening Windows Media Player, and under the View menu
select 'Skin Chooser'. In the Skin Chooser box you can click on each skin to see a preview of it in the right
pane. If you want to try a skin out, click the 'Apply Skin' button. If you want to get new skins, you should
connect to the Internet and then either click the 'More Skins' button, or go to a site such as The Skins Factory
to download more skins. Some skins will install automatically when you download them, but if you
download a skin file in .wmz format you can manually install it so that it appears in the Skin Chooser by
putting the .wmz file into your \Program Files\ Windows Media Player\ Skins directory. Note that using more
complex and elaborate skins can take up slightly more memory and CPU power when you run Windows
Media Player, so if you want to ensure the fastest performance and least resource usage simply set the skin
to something like Classic or 9SeriesDefault.

In fact as of Windows Media Player 10, my preferred look for WMP is to switch to Full Mode, and simply
use the resizing bar at the bottom right of the player to shrink it down to the smallest size possible. This
gives a translucent blue media player which is attractive and compact yet functional and uses minimal RAM.
In 'Mini Player' mode WMP uses even less resources (See below).

B WINDOWS MEDIA PLAYER MINI PLAYER

One of the neat features of Windows Media Player is the ability to shrink it down into a 'Mini Player'
interface which sits in the Windows Toolbar. To activate this, right-click on an empty area of your Windows
Taskbar and under the Toolbars sub-menu select the 'Windows Media Player' option so a tick appears next
to it. Now open Windows Media Player and click the Minimize button on the top right of the player
window. The player will minimize and sit in your Taskbar with a handy interface which allows access to all
the major functions of the player, and whenever you want to maximize it again click the Maximize button on
the bottom right of the player.

Not only is this a neat feature, but more importantly while sitting in the Taskbar the player also uses much
less memory as well, less than that of most other media players. CPU usage is normal, typically being in the
3-6% range, which is less than or equal to other popular media players. You can also access WMP's seek
functionality by hovering your mouse over the mini player, and using the slider bar which appears at the
bottom of the visualization box. To maximize WMP again either double-click on the mini player or click on
the small Maximize button at the bottom right of the mini player.

B WINDOWS MEDIA PLAYER CODECS

While Windows Media Player should cover all your media playback needs, there are certain types of media
which it won't play due to proprietary issues with the codecs necessary to play them. The QuickTime .mov
and the RealPlayer .rm formats are two types of files which can only be played by their respective players -
that is QuickTime Player and RealPlayer. However if there are other formats for which you require a codec,
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then see this article: Codecs for Windows Media Player. It details where and how you can find and install
more codecs to play media you are having problems viewing/listening to in Windows Media Player. Also
have a look through my Game Music Extraction Guide for an outline of digital audio theory and some of the
differences between various popular codecs.

I strongly discourage installing large 'codec packs' as these have been known to cause problems on various
systems. Install only the codecs you need, when you need them, and if possible first let Windows Media
Player try to automatically download the required codec from the Internet. If you are having problems and
want to determine if any of your codecs are broken you can use the Codec Detective which will list broken
codecs and generate a text file which you can examine or send to a tech support person or post on an
Internet forum for further help (See the Troubleshooting section for more details).
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VISUAL AND CONVENIENCE TWEAKS

This section covers a range of miscellaneous tips and tweaks which are designed to allow you to further
customize the appearance of Windows XP, as well as improving XP functionality. None of the tweaks in this
section is necessary for ensuring that you have a fast, stable system — however many of them will save you
time or make using Windows XP more enjoyable, so they are still worth considering.

Please note that many of these tweaks can also be performed by a range of tweaking and customization
utilities, such as TweakUI (See TweakUI section above). It is up to you the method you choose to achieve the
end you desire - just be sure to remember what you used to make which changes, so that if they don't suit
your tastes you can readily change them back. Also note that where the Windows Registry Editor is
involved, since it does not have an 'undo' function you should check the Backup & Recovery section for
more details of appropriate precautions to take before editing the Registry in particular.

REMOVE TEXT FROM DESKTOP ICONS

To remove the text beneath an icon on your Desktop, follow these steps:

1. Right-click on the icon whose title you want to remove and select Rename
Instead of entering any characters in the text box, hold down the ALT key and type 255 (ALT +2 +5+5).
Note you need to use the NUMPAD number keys for this to work (i.e. the numbers to the right of your
arrow keys, not the ones at the top of the keyboard).

3. When you release the ALT key the title will be blank, and you can press Enter to accept this. Blank titles
are usually denied under Windows, but not when done this way as it inserts a blank character in place of
the name.

4. For every other icon whose title you wish to remove do the same as above. Note however that since no
two icons have the same name, for each subsequent icon you'll have to add an additional ALT 255 to the
end of the string you enter. That is, to blank a second icon name you'll need to hold down ALT and type
255, then ALT and 255 again. For a third, you'll have to type ALT 255, ALT 255, ALT 255, and so on.

If you want to regain the icon names you will have to manually edit each icon's name.

REMOVE THE BOX AROUND DESKTOP ICON TITLES

If you have applied the 'Remove text from desktop icons' tweak above and you still see a faint box where the
text was, you can remove that box by doing the following:

1. Go to Control Panel>System>Advanced and click the Settings button under Performance.
. Tick 'Use drop shadows for icon labels on the desktop' under the Visual Effects tab and click OK.
3. Check your desktop. The boxes should be gone, regardless of whether you removed the text or not. If
they're still there, right click on the desktop, look under 'Arrange Icons By' and make sure there's no tick
against 'Lock Web Items on Desktop'.

CREATE DESKTOP ICONS FOR SHUTDOWN OR RESTART

Instead of clicking Start>Turn Off Computer and selecting Shutdown or Restart, you can create desktop
icons which automatically shutdown or restart your PC with just a double-click. This tweak makes use of the
Shutdown.exe command line to create a new shortcut as follows:

SHUTDOWN ICON

1. Right click on an empty area on your desktop.
. Select New>Shortcut.
3. In the first box of the Create Shortcut Wizard, type "Shutdown -s -t 00" (without quotes). Click Next.
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4. Call the shortcut something descriptive like 'Shutdown' and click Finish.
5. To add the finishing touch, right click on this new icon, select Properties, click the Change Icon button
and select an appropriate icon.

REBOOT ICON

Follow the same steps as for the Shutdown Icon, but substitute the following steps in place of the
corresponding ones above:

3. In the first box of the Create Shortcut Wizard, type "Shutdown -r -t 00" (without quotes). Click Next.
4.  Call the shortcut something like 'Restart' and click Finish.

Note that double-clicking on these icons will shutdown or restart the PC straight away without any warning.
If you want a countdown before a shutdown or restart, substitute a time in seconds in place of the '00' entries
in the shortcut properties above (e.g. 'Shutdown -s -t 10" gives 10 seconds warning before shutting down).
Also note that once the shutdown or restart process begins it can't be aborted. If you want more command
line switches which can be used with the shutdown command, go to Start>Run and type "cmd" (without
quotes) and press Enter, then type "shutdown" (without quotes) in the command prompt.

CREATE DESKTOP ICON TO LOCK THE COMPUTER

Just as you can create Shutdown and Restart icons, you can also create an icon which locks your computer
and requires that a user login again before gaining access. To do this, follow these steps:

1. Right click on an empty area on your Desktop.
. Select New>Shortcut.

3. In the first box of the Create Shortcut Wizard, type "Rundll32.exe User32.dll,LockWorkStation" (without
quotes). Note there is no space between the comma and LockWorkStation, which is also one word. Click
Next.

4. Call the shortcut something like "Lock PC" and click Finish.

5. To add the finishing touch, right click on the new icon, select Properties, click the Change Icon button
and select an appropriate icon.

Now whenever you click this icon your PC will instantly be locked, and can only be accessed by the user
entering a correct password in the Login box. Note you can also lock the computer at any time by pressing
WINDOWS + L. Also note that if you have an account with no password, locking the desktop is pointless as
anyone can login by just leaving the password field blank and clicking OK to log back in.

SAVE DESKTOP ICON POSITIONS

This tweak is a personal favorite of mine. Basically it allows you to save the current positions of your
desktop icons so that if the icons are rearranged or moved you can restore them back to these original
positions at any time. To give you this added functionality in XP, do the following:

Download the file Layout.zip and extract the contents to an empty directory.

Copy the file Layout.dll to your \ Windows \ System32 directory.

Double-click on the Layout.reg file to automatically make the appropriate changes to your Registry.

Go to your Desktop and arrange all your icons as you'd like them to be saved.

Once done, right-click on the Recycle Bin and select the new 'Save Desktop Icon Layout' option. The
positions of all the icons are now saved. You can move the icons around freely and whenever you want
them restored to their original saved positions, right-click on Recycle Bin again and select 'Restore
Desktop Icon Layout'.

A
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This tweak is particularly handy if you're installing new graphics card drivers for example and your
Desktop icons get messed up, or you change resolutions and they get bumped around, or if you accidentally
move an icon while trying to double click on it.

CHANGE DESKTOP ICON SIZE

You can alter the size of Desktop icons by using this tweak as follows:

[HKEY CURRENT USER\Control Panel\Desktop\WindowMetrics]

Shell Icon Size=32

The value of this entry determines the size in pixels both for the height and width of desktop icons. The
smaller the value, the smaller the desktop icon. The default value is 32, which is a 32 x 32 pixel icon. Create
the entry as a new String if it doesn't exist, and assign your desired value, then reboot Windows to
implement the new icon size.

SET SPACING BETWEEN DESKTOP ICONS

To adjust the spaces between your desktop icons, you can manually move them. However if you've chosen
automatic spacing (Right-click on the Desktop and select Arrange Icons by>Auto Arrange) then you can
adjust the vertical and horizontal spaces placed between each icon by doing the following:

1. Right-click on the Desktop and choose Properties to bring up the Display Properties box.
Select the Appearance tab, then the Advanced button.

3. Under Items select 'Icon Spacing (Horizontal)' and 'Icon Spacing (Vertical)' and edit their values to
determine how many pixels are placed between the icons. The defaults are 43 pixels between icons.
Smaller values squeeze them together, higher values spread them apart.

REMOVE 'SHORTCUT TO...' FROM NEW SHORTCUTS

Whenever you create a new shortcut, the words 'Shortcut to..." appear in front of the shortcut's name. To
remove this default prefix for new shortcuts, open Registry Editor and change the following:

[HKEY LOCAL MACHINE\Software\Microsoft\Windows\CurrentVersion\Explorer]

Link=00 00 00 00

If this entry doesn't exist, create it as a new Binary value, and set it equal to 00 00 00 00 to remove the
‘Shortcut to..." prefix in front of new shortcuts. Reboot Windows to implement the change.

CREATE A CUSTOM POPUP MENU ON THE TASKBAR

To put your favorite shortcuts all under one easy-to-access pop-up menu on the taskbar, do the following;:

Open Windows Explorer and create a new folder wherever you prefer.

Put shortcuts to all your favorite programs, pictures, documents, songs etc. in this folder.

Right-click on an empty area of your Taskbar, and choose Toolbars>New Toolbar.

In the New Toolbar dialog box, browse to where you created your new folder with all the shortcuts,
highlight the folder and click OK.

L

You will now have a new item on your Taskbar with the name of the folder you created earlier. Click on the
double arrows just above its name and you'll get a popup menu of all the programs you can now quickly
access. If you want to remove this folder from the Taskbar, right click on an empty area of the Taskbar and
select Toolbars, and untick the folder's name from the list.
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WINDOWS XP THEMES

One of the biggest benefits of Windows XP over other Windows versions is that you can customize
Window's Graphical User Interface (GUI) or 'skin’ as much as you want. By default XP comes with two main
Visual Styles — Windows Classic Style and Windows XP Style. You can choose either of these by going to
Control Panel>Display Properties>Appearance and selecting one under the 'Windows and Buttons' section.
Note that you must have Themes enabled to do this - you can enable Themes this by going to Control
Panel>System>Advanced, click the Settings button under Performance and on the Visual Effects tab make
sure there's a tick next to 'Use visual styles on windows and buttons'.

Microsoft has not made it easy to modify or install any styles beyond those which it provides. You will need
specialized tools and some detailed information on how to download and install new themes, or to create
your own. Rather than getting into those details here, I refer you to the following websites which cover the
full range of customization details, tools and themes you can use to customize your Windows XP's
appearance and functionality: ThemeXP, XPTheme, WinCustomize, and the Windows Blinds Utility which
allows you to customize Windows XP safely and easily.

Note, adding custom themes and visual enhancements to Windows XP can increase startup times and
background memory usage. If you have low amounts of system RAM I recommend you steer clear of
installing complex themes as they may make your system less responsive and increase loading times and
stuttering in applications and games.

B KEYBOARD & PROGRAM SHORTCUTS

Most people know that you can use the keyboard to speed up access to common commands and functions in
Windows XP. Some people use these keyboard shortcuts a great deal, others rely mainly on their mouse for
everything. This section contains the majority of the most useful Windows XP keyboard shortcuts, and even
some shortcuts you can type in the Start>Run box to gain quick access to useful utilities in Windows. I
recommend you get used to using some of these regularly as they quickly become second nature.

MICROSOFT ON-SCREEN KEYBOARD

If you are having problems using your keyboard you can bring up the Microsoft Onscreen Keyboard utility
by going to Start>Run and typing "OSK" (without quotes) then press Enter. The virtual keyboard will be
displayed, allowing you to use your mouse to click on virtual keys as though you were using a keyboard. To
make things easier, position the OSK somewhere convenient and then select '‘Always on Top' under the
Settings menu in the Onscreen keyboard so you don't constantly have to switch back and forward between
tasks to use it.

Note if you can't click the left mouse button to select keys, under the Settings menu select 'Typing Mode' and
then select the 'Hover to Select' option. Now you can just place your mouse cursor over a key on the
Onscreen Keyboard and it will register as an entry. Set the length of time needed to hover over a key before
it registers as an entry (values in seconds between 0.00 and 1.00 second).

MOUSEKEYS

If instead of your keyboard you are having problems using your mouse, you can enable the Windows
MouseKeys functionality by going to Control Panel>Accessibility Options>Mouse and ticking the 'Use
MouseKeys' box. Alternatively you can press CTRL + left SHIFT + NUM LOCK to activate this functionality.

MouseKeys allows you to use the Numpad keys - the numerical keys on the far right of your keyboard - to
move the mouse cursor around on screen.
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COMMON KEYBOARD SHORTCUTS

The following are the most commonly-used keyboard shortcuts for Windows:

CTRL + A - Selectall

CTRL +C - Copy selected item(s)

CTRL +X - Cut selected item(s)

CTRL+V - Paste copied/cut item(s)

CIRL +Z - Undo last action

CTRL+Y - Redo last action

SHIFT + DEL - Deletes item, bypasses Recycle Bin

CTRL + ESC - Open Start Menu

ALT +TAB - Switches between active programs

CTRL + ALT + DEL - Opens Task Manager

ALT +F4 - Closes program or opens 'Shut down computer'
SHIFT + LEFT CLICK - Select multiple items at once within a range
CTRL + LEFT CLICK - Select multiple items at once individually
TAB - Steps forward through screen elements
SHIFT + TAB - Steps backward through screen elements
F1 - Open Help function

F2 - Rename/Enter text for item

F3 - Search key

F5 - Update/Refresh active window

F11 - Toggle Fullscreen mode

SHIFT +F10 - Open Context Menu for item

ALT + SPACEBAR - Open Windows Properties menu

SHIFT + CDROM - Hold Shift & insert CDROM to prevent Autoplay

WINDOWS KEY SHORTCUTS

The following are common shortcuts which use the Windows Key:

WINDOWS - Show Start Menu

WINDOWS +D - Minimize/Restore all Windows
WINDOWS + E - Open Windows Explorer
WINDOWS + F - Open Windows Search
WINDOWS + L - Lock Workstation

WINDOWS + R - Open Start>Run box
WINDOWS +U - Open Accessibility Utility
WINDOWS + BREAK -  Open System Properties
WINDOWS + F1 - Open Help & Support

PROGRAM SHORTCUTS
The following are file names you can insert into shortcuts or in the Windows Run box (Start>Run) to access
commonly used Windows components.

ADMINISTRATIVE TOOL SHORTCUTS

The following are shortcuts to the Administrative Tools:

Services.msc - Services Utility
Gpedit.msc - Group Policy Editor
Comexp.msc - Component Services
Eventvwr.msc - Event Viewer
Secpol.msc - Local Security Policy
Perfmon.msc - Performance Monitor
Compmgmt.msc - Computer Management
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ACCESSORIES SHORTCUTS

The following are shortcuts to common Windows Accessories:

Cmd - Command Prompt
Calc - Calculator
Cleanmgr.exe - Disk Cleanup Utility
Dfrg.msc - Disk Defragmenter
Notepad - Notepad

Pbrush - Paint

Wmplayer - Windows Media Player
Wordpad - Wordpad

Wupdmgr - Windows Update

CONTROL PANEL SHORTCUTS

The following are shortcuts to the Control Panel and its main components:

Control - Control Panel

Sysdm.cpl - System Properties
Devmgmt.msc - Device Manager
Desk.cpl - Display Properties
Main.cpl - Mouse Properties
Timedate.cpl - Clock Properties
Inetcpl.cpl - Internet Properties
Mmsys.cpl - Sounds & Audio Devices

DIRECTORY SHORTCUT

If you want to get to a particular directory folder, go to Start>Run and type the name and path of the folder
in the Run box, then press Enter. Windows Explorer will open up in that directory instantly. If you don't
specify the full path, Windows Explorer will open up at the first incidence of that directory. You can also
assign this path to a shortcut and use it to open Windows Explorer there by default whenever the shortcut is

used - see the Windows Explorer section for details.

That covers our look at visual and convenience tweaks and tips. Clearly you can do a lot to customize and
tweak your Windows XP. I urge you to experiment with Windows XP to get it looking and feeling exactly

the way you want.
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OVERCLOCKING

B BASIC THEORY

When people want additional performance from their machines, they often undertake a procedure called
Overclocking - so what exactly does this involve? Overclocking is the process of increasing the clock speed
of a component in your PC. The 'clock’ referred to is a specialized oscillator pulsing with a frequency that
determines the rate at which a data processor can perform instructions. A 3 Gigahertz (GHz) Intel Pentium 4
CPU for example has a frequency of oscillation of around 3 billion pulses per second. The theory of
overclocking is simple: increase this clock speed and you'll increase the rate at which instructions are
performed, leading to a faster PC. Overclocking is possible on a range of hardware components including
CPUs, Graphics cards, Motherboards and RAM.

There is also another way of overclocking which isn't really overclocking: altering timings. Memory-based
components such as system RAM and Video RAM have latency timings — rest periods between operations
measured in nanoseconds. By decreasing the latency time, a memory component can be made to wait less
between completing specific operations and hence function faster. This method can be used in conjunction
with normal overclocking, or on its own. More details of how to overclock and change latencies on specific
hardware components are provided further below in The Procedure section.

So why is overclocking possible, or even necessary? Why aren't the hardware components you buy not
already performing to their absolute maximum potential? Well ironically the reason for that is just the same
as the reason we discussed for Windows XP having so much scope for potential optimization and
customization: the many different circumstances under which the hardware will potentially be used.
Because components are expected to work in diverse environmental conditions and be put to vastly different
tasks, hardware manufacturers ensure a safe headroom is provided so that in adverse conditions the
component can still operate safely and with stability. Overclocking takes up this slack by pushing the
component beyond manufacturers' specifications.

Of course when you push a component beyond specified operating frequencies and/or timings, the
component requires ideal conditions to continue operating with stability. That usually means more cooling —
since any cooling already used on most hardware is only really designed to deal with stock operation. The
component also requires stable voltage from the Power Supply either directly or through the motherboard.
Often to achieve a stable overclock the component may even require additional voltage, which in turn can
add to heat and hence raise the cooling requirements even further. Furthermore, the additional heat being
dissipated from one component may cause other nearby components to overheat. As you can see
overclocking is not as simple as it first sounds, and there are often complex interactions involved which must
be taken into account to achieve stability.

Before going into any more detail about overclocking I feel it's important to discuss the advantages and
disadvantages of overclocking objectively, so you don't undertake it without knowing what you're getting
yourself into:

BENEFITS

e Increased performance — the degree to which performance improves depends on the component(s) being
overclocked and whether they are the hardware most relied upon by games and applications. Hence the
performance difference can be anywhere from negligible up to 25% or more.

e Bragging rights or 'coolness factor' attached to overclocking — some people gain a great deal of
satisfaction and prestige in having the fastest machine, or the highest overclocked component, or the
highest benchmark score. They also feel they are getting the absolute most out of their hardware.

SuppopIiaaQ

Copyright © 2005 Koroush Ghazi 1 3 6




Pu=A~susess

THE WINDOWS XP TWEAKING COMPANION

DRAWBACKS

e There will be costs in providing additional cooling — in almost all cases you will have to purchase
additional cooling for your system in the form of more efficient heatsinks and/or fans, or even more
specialized equipment like water cooling or VapoChill units.

o The component, and therefore your entire system, may become unstable and crash randomly — the
number one cause of problems in games and applications is overclocking. People often refuse to
acknowledge that their overclocking is the cause of the problem, and mistakenly blame software such as
Windows XP, the game or their drivers instead.

o Certain games and programs are extremely sensitive to overclocking and will crash — as a corollary to
the above point, it must be noted that different programs react differently to overclocking. Some can
tolerate much higher levels of overclocking on particular components, some cannot tolerate any
overclocking at all.

e DPotential data corruption if certain components are pushed beyond their limits — pushing components
like the CPU or RAM beyond their limits on your system can result in instability leading to data
corruption, up to and including the loss of all your hard drive data (e.g. if your NTFS security
descriptors become corrupted).

e Excessive heat can damage or permanently kill a component — since computer hardware is based on
sensitive electronic equipment, if a hardware component is not kept adequately cool (and even in some
cases if it is) it can be permanently damaged or destroyed through overclocking. It happens quite often,
especially with graphics cards, so it is not as rare as you might think.

e Overclocking automatically voids the warranty on the component — hardware manufacturers make it
clear that overclocking beyond recommended clock speeds or timings will void your warranty. This also
goes for any physical modifications to the hardware such as adding a larger heatsink or fan for example.
A warranty is only designed to cover a stock piece of hardware operating within specifications.

e Overclocking reduces the life span of the component — since the component is working beyond
specification and working hotter and faster than it was designed to handle, most components will have
reduced life spans. This can vary from a reduction of a few months to a few years, depending on the
extremity of the overclock, and the quality of the components. A mild overclock typically has little
practical impact on the life expectancy of a component; an extreme overclock can drastically reduce the
working life of a component.

So far the disadvantages seem to far outweigh the advantages of overclocking. This is not strictly true. It all
depends on just how much performance you can gain and how much instability, additional costs and risk
you wish to put up with. Don't get me wrong - I'm not suggesting you shouldn't overclock. I just want to let
you know that despite everyone urging you to overclock your system there are many genuine downsides to
the procedure, and that you should weigh up the options rationally and either choose to avoid overclocking
due to potentially modest performance gains and/or the strong likelihood of instability/damage; or
alternatively —research the topic properly and invest appropriately to achieve a good
performance/stability/safety balance in your overclocking.

The bottom line is if you genuinely can't afford to replace a vital system component should it get damaged,
do not overclock it. If your CPU dies for example and you can't replace it your entire computer becomes
unusable.

B THE PROCEDURE

This section will cover the basic procedures for overclocking key system components. The actual details will
vary depending on your particular hardware configuration and BIOS options. These instructions are
indicative and should give you a good idea of the types of steps involved in overclocking.

Important: Before commencing any overclocking make sure you are as familiar as possible with the exact
brand, model and specifications of your major hardware components. If necessary refer to any packaging or
manuals which came with your system, and more importantly see the System Information Tools section for
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links to information tools which can help you identify your components and their capabilities (and current
speeds/timings) in detail.

Also make sure that before changing any BIOS settings for the purposes of overclocking that you record
your existing BIOS settings. This is because in some cases when overclocking beyond the point of stability,
you will have to reset your BIOS (or it may reset automatically) back to its factory default settings, losing any
customized settings you've put in. So make sure you document what the major BIOS settings are which
you've altered through any BIOS customization for example.

CPU OVERCLOCKING

Overclocking a CPU on most systems involves increasing the Front Side Bus (FSB) speed of your
motherboard in your BIOS (See BIOS Optimization section). The FSB is the main pathway between your
major system components, and as the FSB speed increases, information is transferred back and forth more
rapidly between all your major components working off this bus speed. However there are certain problems
with increasing the FSB. To start with, some components running off this bus, such as your AGP graphics
card and PCI devices (e.g. a Sound card) operate at a much lower bus speed by default, so your motherboard
has special Dividers/Multipliers or even a Lock to maintain the PCI and AGP bus speeds at or close to their
default (typically this is 33Mhz for PCI and 66Mhz for AGP). Also your system RAM will typically rely on
the FSB to determine its speed in conjunction with some form of divider/multiplier. If this divider/multiplier
is limited in its options or set incorrectly your RAM may be pushed too far to operate with stability.

Your CPU also has a Multiplier, which as the name suggests sets the CPU speed in MHz as a multiple of the
FSB speed. For example on a system with an effective FSB of 200MHz and a CPU that has a multiplier of 20
gives you a CPU speed of 20x200 = 4000MHz = 4GHz. Most CPUs have their multiplier locked at the
hardware level, which means you can't actually change it. The best way to find out is to attempt to change
the multiplier in the BIOS without changing the FSB, and on reboot see if the MHz speed for your CPU has
changed - if it has your CPU is multiplier-unlocked. In general no recent Intel CPUs are multiplier unlocked,
and some AMD CPUs are either unlocked automatically on certain motherboards, or can be unlocked using
a trick similar to the ones described here: Multiplier Unlocking Mod and AthlonXP Multiplier Mod.

The Multiplier and the FSB can be used together to achieve a performance result - however do not
automatically assume that raising your CPU's clock speed to the highest possible level is the ultimate form of
system overclocking. Depending on your CPU type, and whether you have the option of using a Multiplier
or not, you have three basic options: Lower the multiplier and raise the FSB to maintain CPU clock speed,
but gain performance through faster RAM and faster information transfer through the Bus; Raise the
Multiplier and raise your FSB to obtain a higher clock speed on the CPU as well as a higher FSB; and if you
have no option for altering the Multiplier, simply raise your FSB to overclock your CPU and your entire
system.

Clearly which of these you choose depends on whether your CPU Multiplier is locked or not, and also
whether your RAM can tolerate higher speeds, especially in conjunction with any RAM divider/multipliers
available to you (See RAM Overclocking section below for details). The actual procedure for overclocking
the CPU follows these general steps:

1. Go into your BIOS and find your FSB and Multiplier settings. The FSB and Multiplier settings may have
many different names, so see the BIOS Optimization Guide discussed in the BIOS Optimization section.
Familiarize yourself with your current FSB and also jot down your present Multiplier value. Some
BIOSes allow you to directly change your CPU's clock speed (also called 'CPU Frequency').

2. Check the CPU to see if it is multiplier-locked as covered above. If it is, then you now have one more
variable in the equation - altering your Multiplier along with the FSB. You will have to experiment to
determine the combination of multiplier and FSB which works fastest overall on your system in
conjunction with the Benchmarking and Stress Testing tools covered in the relevant section below.
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3.  Go into your BIOS and check for an AGP/PCI divider, ratio, or lock. Wherever possible, you should try
to set this so that your AGP and PCI Bus both remain at 66MHz and 33MHz respectively. Some
motherboards allow you to lock in the AGP/PCI speed regardless of FSB, in which case activate this lock
or manually select 66/33 (or as close as possible) for the AGP/PCI speeds respectively. Other
motherboards may express your AGP and PCI speeds as an actual divider e.g. %2 - in which case ensure
that your current FSB multiplied by this divider is not significantly greater than the stock
66MHz/33MHz of the relevant Buses. As the AGP Bus exceeds 66MHz you may experience greater
probability of graphics-related crashes, and as the PCI Bus exceeds 33MHz the rest of your system
components will become unstable (e.g. your hard drive may become corrupt). In general there is no
reason why you'd want to overclock the AGP and/or PCI buses since any (minor) performance
advantages of doing so would be far outweighed by instability problems and potential damage.

4. In your BIOS, check the Memory (RAM) divider/multiplier/ratio setting, or your RAM Frequency
setting. The aim is to make sure your RAM is always running closest to the highest speed which it can
tolerate. If you have a memory divider or ratio, use it to determine your current RAM speed. For
example a 1:1 ratio implies that your RAM will run at the same speed as your FSB. If your FSB is
200MHz for example, and you have Double Data Rate (DDR) RAM, then with a 1:1 FSB:RAM ratio your
RAM will be running at 400MHz (DDR means 2 x 200MHz FSB). Make sure your RAM is rated to
perform at this speed with your chosen memory timings (See RAM Overclocking section below for
details). Higher ratios, e.g. 3:2 will run your RAM at a lower speed than the FSB, which is useful if you
are pushing your FSB very high to get the most out of your CPU, but your RAM cannot cope with the
increased speed.

5. To overclock your CPU using the FSB, raise the FSB by a small increment, e.g. 5MHz — keeping in mind
that the higher your CPU's multiplier, the smaller the increment should be. For example, a 10MHz
increase in the FSB on a CPU with a 20 multiplier = a jump of 100MHz in CPU speed. Be patient and
with each increment reboot your system and do a quick test with a CPU stress tester like Prime95 and/or
play a system-intensive game for a very short period. Once you are nearing what you believe to be the
limits of your CPU, start using a variety of benchmarking programs to measure the performance gain,
and also to test stability in more 'real world' applications for longer periods. This may all seem a bit
tedious, but it is sound practice to make sure that you don't suddenly overshoot the stable limit of your
system and corrupt your Windows installation for example. To get some idea of just how far your CPU
can be overclocked, try checking the Overclockers.com CPU Database for other peoples' overclocking
results on the same CPU as yours. Note that there is no guarantee your CPU will go as far as anyone
else's due to the variable quality of particular CPUs.

6. You may reach a point at which Windows and/or your PC refuses to boot up or has errors doing so. At
this point you have exceeded the tolerance of one of your system components - typically the RAM or
your CPU. You can either reduce your FSB (and/or CPU Multiplier), decrease your RAM speed (alter its
divider), or reduce your RAM timings until you can boot into Windows and run programs with
stability.

7. At what you believe is the highest stable point, after booting into Windows run a series of benchmarks
and stress tests. Don't just concentrate on the CPU stress testers, run graphical benchmarks, games,
memory testers etc. The main aim is to make sure your system is stable under a variety of conditions,
over a reasonably long length of time. What appears to be a stable overclock can still cause subtle data
corruption or random crashes if not thoroughly tested first.

8. Make sure that your CPU is running at a reasonable temperature when under load, otherwise it may
crash your system, overheat and shut down, perhaps even become damaged, or in the case of Intel
CPUs the Thermal Throttling technology built into the CPU will begin to automatically reduce your
CPU's speed and hence your performance - defeating the entire purpose of overclocking in the first
place. See the Cooling section below for details of how to check your system temperatures.

9. If you still want to overclock further, you will have to experiment with the CPU Multiplier (if available
to you). For example you can raise the CPU Multiplier slightly and reduce your FSB, thereby obtaining
the same CPU clock speed, but relieving your RAM by reducing its speed. More commonly however
you will have to look into additional cooling solutions and/or adjusting the voltage to your CPU. These
are covered in the Cooling and Voltage sections below.
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At some point, regardless of the type of cooling used and the voltage applied the CPU simply will not clock
any higher or remain totally stable. At this point you should scale back your overclock until you can run
benchmarks and stress testers for hours on end without a crash or sudden reboot. However don't assume
that an overnight loop on a single benchmarking program like 3DMark indicates stability. Use a range of
benchmarking and stress testing programs as detailed in the Benchmarking and Stress Testing section, since
each stresses different components in different ways. At the same time, if after 10 hours of stress testing your
system eventually crashes, you may determine that for all intents and purposes the system is stable enough
and doesn't necessarily have to be 'rock stable'. This can be a wise choice if the period of time without a crash
or fault is quite long.

GRAPHICS CARD OVERCLOCKING

Note: The following is a modified extract from my ATI Catalyst Tweak Guide and my Nvidia Forceware
Tweak Guide. It will apply to all graphics card users regardless of brand, however if you are an ATI or
Nvidia graphics card user I strongly recommend you read through all of the relevant guide above at some
stage.

The modern graphics card is a lot like a small computer by itself. It has a Graphics Processing Unit (GPU)
which is the graphics equivalent of the CPU, it sits on a motherboard-like Printed Circuit Board (PCB), and
has its own Video RAM (VRAM). And just like a computer system, the components on a video card can be
overclocked to increase performance. Overclocking a graphics card involves increasing the frequency at
which particular video components perform their functions. For more details on basic overclocking theory
see the Basic Theory section above as it applies to graphics cards as much as CPUs.

The two components of a video card which can be overclocked are the GPU (also called the Engine or Core),
and the Video RAM (also called VRAM or Graphics Memory). You can overclock one or both of these
components, with varying results based on a number of factors, but generally resulting in an increase in
performance the higher you overclock each component.

To overclock your video card, you'll need a tool which allows you to change the clock speeds of the Core and
the VRAM. For ATI graphics card users, some reliable tools you can use are: PowerStrip, ATI Tray Tools,
RadLinker, ATI Tool, and of course there is an overclocking tab in the Omega Drivers. They are all popular
tools, so they should be safe to use. For Nvidia graphics card users, I recommend using: RivaTuner,
PowerStrip, or the built-in Coolbits functionality. For those with another brand of graphics card, PowerStrip
is compatible with all graphics card.

Overclocking your video card is similar to CPU overclocking and RAM overclocking combined - simply
increase the clock speed of the Core/Engine, and/or the clock speed of the Graphics Memory, both of which
are measured in MHz. The Core generates graphics data, and depending on your CPU and the rest of your
system specifications, increasing the core speed can result in a small or large performance improvement. The
Memory transfers information to/from the Core, and increasing its speed can once again improve
performance either slightly or significantly, in conjunction with your Core speed and the speed of the rest of
your system.

As a general rule, if you have a fast graphics card and a slow CPU, then overclocking your graphics card
yields less performance improvements. If you have a fast CPU and a slower graphics card, then overclocking
the graphics card can show greater improvement. The reason for this is that if the graphics card is the 'weak
link' or bottleneck' in the equation, and a particular game requires more graphical power and speed, then
quite clearly overclocking the graphics card can show more of an improvement than in situations where the
CPU or the rest of your system is the weak point. For example if you have a new ATI X800 graphics card and
a 1.6Ghz CPU, overclocking the graphics card really won't improve performance dramatically since the CPU
is usually the bottleneck for most games.
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The whole overclocking procedure goes something like this:

1. Select a graphics card component to overclock (Core or Memory).
Increase its clock speed by a small increment, e.g. SMHz.

3. Run a game or a benchmark for a short period (See Benchmarking & Stress Testing section below),
testing to see if you get any crashes, freezes, stuttering, or 'artifacts' (small graphical anomalies, such as
white dots, strange colored blocks/lines, or flickering textures). None of these should occur at any point
during your testing or during normal usage.

4. Repeat steps 2 and 3, until you experience a glitch or problem - this means you've reached the current
limit of your overclock for that component.

5. You can opt to increase the cooling to your graphics card to see if you can achieve a higher overclock
without artifacts. Remember that any physical modifications to the card such as the installation of a
larger heatsink or fan will void the warranty, and more importantly may damage the card. The weight
of the new cooling hardware must be taken into account since the graphics card sits in a thin slot
typically suspended horizontally with no real support along its width (See Cooling section below). After
increased cooling run a graphical benchmark for a period of time to determine if you have increased
performance and stability.

6. You can also opt to increase the voltage to your graphics card (See the Voltage section below) to see if
you can reach a new high, however once again be careful not to over-volt the card or it will become
permanently damaged or cease functioning. After increasing the voltage, run a graphical benchmark to
again determine stability and performance changes. If you can monitor the card's temperatures, do so to
make sure additional voltage isn't overheating the card (See Cooling section).

7. Once you believe you have both a stable and fast overclock, do a much longer run of graphical
benchmarking and/or play some games for a long period of time (e.g. 2 hours straight), paying
particular attention to any small artifacts which may appear, or crashes/freezes - indicating the need to
reduce the overclock ever so slightly and/or increase cooling. If at any point your system becomes
unstable or displays artifacts reduce the overclock on the component by 5MHz or more to provide some
headroom.

8. Repeat the entire procedure for the other component (Core or Memory).

Remember if you have an old or low-end graphics card (e.g. the GeForce MX series), then overclocking is
unlikely to improve performance dramatically. The reason for this is that certain lower end graphics cards
simply do not have hardware support for the advanced functionality demanded by recent games - like the
latest Pixel Shaders and Vertex Shaders. If your card does not have hardware support for a required
advanced function, overclocking cannot surmount this handicap. Unfortunately there are no tweaks to
emulate the required hardware support either, or to "trick" the software into thinking you have the correct
hardware.

Finally, you can also alter your graphics card's Video RAM latency, however this is less common as a form of
overclocking and far more risky. The theory behind it the same as that of altering system RAM latencies, so
see the RAM Overclocking section below for details. You will require a special program to access and change
your Video RAM latencies in the graphics card's BIOS — yes graphics cards also have their own BIOS just like
motherboards. One such tool is RaBiT that allows you to edit an existing Video BIOS file with new latency
information. You can see your current Video RAM latencies under the 'Logging' tab of the program. I repeat

that this method is quite risky, and is not covered in detail here, nor is it recommended.

RAM OVERCLOCKING

Increasing the speed of your RAM is dependent on a number of factors. Overclocking refers to the process of
increasing the clock speed of a component. In the case of system memory, or RAM for short, this involves
raising the system FSB and/or changing the memory divider/multiplier and/or simply raising the RAM's
Frequency directly to alter the RAM's speed in MHz. However you can also alter the Timings (or Latency) of
a memory chip such that it refreshes faster between operations, meaning less waiting time between each

SuppopIiaaQ

Copyright © 2005 Koroush Ghazi 1 41


http://rusjaz.narod.ru/

Gwmu THE WINDOWS XP TWEAKING COMPANION

operation and hence faster performance. Changing timings is not overclocking strictly speaking, since you

are not increasing the clock speeds, but in general terms it has similar performance-boosting potential.
Because you can carry out both procedures independent of each other, the procedure for each is presented
separately.

To increase your RAM speed, follow these steps:

1.

As noted earlier, you must be familiar with your RAM's capabilities. That means knowing the speed and
timing ratings of each of the individual RAM sticks in your system (See the System Information section).
RAM is typically given a Memory Speed rating in MHz (e.g. 400MHz) or in the Memory Bandwidth
format (e.g. PC3200). The Memory Speed format is intuitive — it basically shows the speed in MHz up to
which the RAM can 'safely’ operate. A 400MHz stick of RAM should operate at speeds up to and
including 400MHz without any errors or problems. Of course it can usually operate faster than that due
to the headroom provided by manufacturers, as we've discussed before, but it is only rated (or
guaranteed) to perform without errors up to 400MHz. Remember that Double Data Rate (DDR) RAM
performs two operations per cycle, so at any given FSB it is effectively running at 2 x FSB speed, which
is what its speed rating refers to. The Memory Bandwidth format may be harder to understand, but it
represents the amount of MB per second the RAM can pass back and forth. For example, PC3200 (which
is 400MHz rated RAM) can provide roughly 3200MB/s (3.2GB/s) in bandwidth. RAM also has Latency
ratings (e.g. CAS 2) as well, but we will look at these in more detail further below.

Once you know your RAM's capabilities, check the memory divider/multiplier/ratio in your BIOS. As
with any other BIOS setting it may have a variety of names, so check the BIOS Optimization section for
details on how to find out more about BIOS terminology. Calculate your current actual RAM speed by
using the divider/multiplier and the FSB. Your RAM may be running at anything from one-half of the
FSB speed, at the same speed as the FSB, or even up to twice the FSB speed depending on the
motherboard and the system in question. If the RAM is not running as close as possible to its rated
speed rating, then you can safely change the divider/multiplier to one which brings it closer to its rated
speed. This is not overclocking — it is simply making full use of the RAM within specifications. If
however it is running at maximum rated speed, you can opt to further increase this speed to achieve an
increase in RAM Bandwidth and hence a potential performance increase.

Alternatively, if your system has a RAM Frequency setting that allows you to directly alter the RAM's
speed, changing it to a higher setting than default is in effect overclocking the RAM.

If you've changed the RAM speed, reboot your system and run a series of memory stress testers and
graphical benchmarks to test for performance and stability changes. You can keep changing the RAM
speed until such time as there is an indication of system instability, such as crashes to desktop, data
errors or sudden reboots.

If you want to achieve a higher overclock on your RAM, you may have to relax the RAM timings (see
below) and/or increase the voltage (See Voltage section below) and to a lesser degree you might
consider providing a cooler environment for the RAM sticks (See Cooling section below).

To alter your RAM latencies, follow the steps below:

1.

As per the instructions for overclocking RAM above, you must familiarize yourself with your RAM's
rated Timings. The most prominent of these is called the CAS (Column Access Strobe) Latency. All
RAM has a CAS Rating indicating the safest CAS timing to use on the RAM when it is running at or
below its rated memory speed. For example, a PC3200 stick of DDR RAM may have a CAS 2 rating,
indicating it can perform up to and including 400MHz with a CAS latency of 2 clock cycles between
each operation, which is quite fast. There are several other RAM timings that can be altered in the BIOS
of most motherboards. The CAS timing has the greatest impact, but the others also have varying
degrees of impact on both performance and stability. The default 'safe’ settings for all of these timings
are programmed onto the RAM chip as SPD (Special Presence Detection) settings. When you choose the
'SPD' setting in the BIOS for memory timings, you are telling your system to automatically read the SPD
timings and implement them.
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2. If you want to change any of the timings, the first thing you should try is lowering your CAS latency as
it usually has the largest impact on performance out of all the timings. However be aware that the
higher your RAM speed, the more likely it is that lowering your CAS latency will result in instability or
simply not let you boot into Windows. You may have to actually reduce your current RAM speed to
allow you to lower CAS latency, and in many instances a lower CAS latency can give more of a
performance improvement than just having a higher RAM speed. This is because raising RAM speed
raises bandwidth, which accommodates more data in transfers. However some programs rely not so
much on how much data is transferred, but how quickly it is accessed for calculations when in RAM.
That's where lower latency can improve performance more than just increasing bandwidth.

3. If you've changed any of the timings, reboot your machine and run a memory stress tester and a
graphical benchmark to determine if your system is unstable and whether there has been any noticeable
performance improvement. If your system appears stable you can either further reduce timings, or
reduce the timings other than CAS. You may also consider enabling any additional 'Memory Turbo' or
similar options in the BIOS (See BIOS Optimization section). These additional memory options use
different methods to boost RAM performance, usually by either enabling faster (but sometimes
unstable) methods of reading/writing and/or reducing other latency-related settings.

4. Once you believe you've reached the lowest latencies and the highest speed possible with your RAM
make sure you thoroughly test your system for stability since RAM instabilities can sometimes take a
while to show up, or may only appear when the system is heavily stressed during particular
applications or games. That means you may well not notice subtle data corruption or random game
crashes until it's too late and important data is corrupted, or in the heat of an exciting game your system
suddenly crashes back to desktop or instantly reboots.

5. If at any point you want to return to your default timings, simply select the 'SPD' or '‘By SPD' setting in
your BIOS and the RAM will run at the manufacturer's recommended timings. This will ensure that
your timings are not the source of any instability when troubleshooting for example (See the
Troubleshooting section)

As you can see, with RAM there are two major variables at work in determining performance and stability —
RAM speed and RAM latency. Which is better for performance? There is no set answer - it all depends on
your system and the applications and games you most commonly run as to the precise combination of RAM
speed and RAM latency which will perform best and with greatest stability, so you will have to experiment.
Generally speaking, applications or games which have large amounts of non-graphics information to
transfer to the CPU and back will benefit more from greater RAM speed, which provides more bandwidth.
On the other hand applications and particularly games which primarily require very complex calculations
with repeated access to information in memory will benefit more from lower RAM latency.

On some systems with Dual Channel memory architectures and high default FSBs with fast memory a
further boost in RAM speed is not going to provide much additional benefit, since RAM bandwidth will
already be very high. My personal preference is to run my RAM with the tightest (i.e. lowest) timings
possible. As I have repeatedly mentioned, RAM which is even remotely unstable can cause a great many
problems, like General Protection Faults in Unreal engine-based games, so I choose not to overclock my
RAM speed at all and this has kept my system completely rock-stable for quite some time.

One last note - RAM overclocking depends a great deal on how many sticks of RAM you have, their quality,
and how 'matched’ they are. Because your RAM sticks work together, if you have two or more sticks of RAM
in your system, you must try and ensure that firstly they are all equally matched in terms of rated speed and
timings, and secondly that they should ideally be from the same brand and model of RAM. RAM sticks can
vary in quality and performance, so having mixed brands or types of RAM can lead to a variety of problems
— even when running at default speeds. There is no tweak to fix this situation, you may have to purchase
new RAM to ensure they all match as closely as possible.

That covers the basics of overclocking your main components. Of course if you want more detailed
information you will have to do some additional research, but a great place to start is this Comprehensive
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Overclocking Guide. I strongly recommend you read it - along with researching more information specific to

your own hardware - before embarking on any major overclocking.

B COOLING

The very first thing that happens as you begin to push your components beyond their recommended
specifications through overclocking is that they will work harder, and hence will generate more heat. It is
essential that you provide more cooling to these components, so that they can expel the additional heat and
remain within safe operating temperatures - otherwise the components will begin to malfunction, and
ultimately they may be permanently damaged, sometimes within a matter of minutes.

Furthermore, a typical computer case is designed such that it traps heat, and hence excess heat output from
one component can begin to affect other components in the case, causing them to overheat even if they are at
stock speed. In extreme cases, on a very hot day your entire system can begin to malfunction even if
everything is at stock speed due to high ambient temperatures in the case. So good cooling is absolutely
vital, even if you don't plan on overclocking your components.

MONITORING TEMPERATURES

To begin with, you may be wondering how to measure your system's temperature. Well your CPU and
motherboard both have built-in diodes that measure the temperature for these components. The CPU
temperature monitor is a reasonably accurate measure of the temperature at or near the core of the CPU,
while the motherboard temperature monitor is a good measure of the general system (or case) temperature -
the ambient temperature of the air in the immediate vicinity of the motherboard. Some graphics cards, such
as the ATI XT series, come with built-in temperature diodes as well, allowing measurement of the
temperature near the core of the graphics card. Most other components do not come with temperature
measurement devices, and so you can only tell their heat by touching them, or by using specialized
equipment such as an electronic thermometer.

To actually see the temperature readings from your components, you can check them in your BIOS typically
under a 'Hardware Monitor' section or similar. This gives you the CPU and motherboard temperatures while
the CPU is relatively idle. Clearly you need an additional method of checking temperatures under Windows
XP, especially when running a system intensive application. Your motherboard may already come with such
a software utility - for example ASUS brand motherboards can use the ASUS Probe software. Check your
motherboard manual and driver CD for a similar utility. If your motherboard doesn't come with any
desktop temperature measurement utility, you can use Motherboard Monitor, which works with all systems.
Usage instructions for Motherboard Monitor are on MBM's website and in accompanying material, so will
not be covered here as they are quite lengthy.

Monitoring your graphics card's temperature is possible through your graphics card control panel, generally
accessed via Control Panel>Display>Settings>Advanced. On ATI graphics cards for example, this
temperature display is under the Overdrive section of the Control Panel/Control Center. Remember, only if
your graphics card is equipped with a temperature sensor can you monitor its temperatures in this way. If it
is not so equipped, the only possible course of action is to buy an electronic thermometer and attempt to
measure the temperatures near the GPU of the card.

The main thing to note is that you will need to monitor your CPU and motherboard temperatures at the very
least, and in particular you should run a temperature monitoring utility while running a CPU stress-tester or
an intensive graphical benchmark (See the Benchmarking & Stress Testing section). This will simulate just
how hot your system can get during sustained usage of CPU-intensive games or applications; that is when
CPU usage is consistently around 100%. If you see your CPU and/or motherboard and/or graphics card
temperatures reaching dangerously high levels during such stress testing, it is very likely you will
experience crashes, freezes and even damage to your components unless you introduce additional cooling to
reduce temperatures.
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SAFE TEMPERATURES

So what is a 'safe' operating temperature for your components? The answer is different based on different
CPU architectures, as some are designed to run hotter than others, but you can ascertain what a safe
temperature under full load is by checking with other people who have a similar system on any PC tech
forum. For indicative purposes refer to these articles: CPU Maximum Operating Temps, MBM CPU
Temperature Database, and The CPU List.

Note that Intel Pentium 4, Celeron, Pentium Xeon and Pentium M CPUs have a special Thermal
Management technology built into them which prevents the CPU from becoming damaged through
excessive heat - however this 'thermal throttling' can result in a severe reduction in performance. If you are
concerned that your Intel CPU's performance is being throttled due to heat, you can check to see by using
the ThrottleWatch Utility while the CPU is under full load.

AthlonXP and Athlon64 CPUs also come with a similar technology, which when used in conjunction with
particular motherboards can read the CPU'’s onboard temperature diode and throttle the CPU's temperature
when overheating. Some AMD CPUs also have Thermal Limiting which immediately shuts down the CPU if
it reaches a preset temperature.

COOLING METHODS OVERVIEW

The methods of cooling differ, but below are the basic cooling technologies you will find in most systems,
along with some simple tips you can undertake to troubleshoot and resolve cooling issues.

Heatsinks: These square or rectangular solid metal objects have many long square 'spines’ on the top. The role
of a heatsink is to sit on top of a chip like the CPU or GPU, or even RAM, and draw out the heat these
components are producing through conduction. This heat then travels along the length of the heatsink to the
top of the individual metal spines where cooler air and a large surface area help in accelerating the
dissipation of the heat. Typically a fan is bolted on top of the heatsink to aid in blowing more cool air over
the heatsink's spines and hence dissipate the heat more quickly. In some cases where just a heatsink is
sufficient for the job, no fan is used — such as the heatsinks on the motherboard or heatsinks placed onto
VRAM. This is referred to as 'passive cooling'. Note that heatsinks must be kept clean of dust, and have a
regular flow of cool air around them to do their job correctly otherwise they cannot dissipate heat efficiently.
Further note that depending on the metal from which the heatsink is constructed, some heatsinks will be
more or less efficient — for example copper heatsinks transfer heat faster, but may dissipate it more slowly
than aluminum.

Fans: These are placed inside and around a PC case by themselves to draw in cool air and/or blow out hot air
from the enclosed space around the hardware components on the motherboard. Given the way heatsinks
work, the air around components will heat up quickly as heatsink(s) dissipate the heat drawn from
hardware components. Fans of varying sizes and speeds aid in cooling the air in the entire case by removing
this heat. Fans should be regularly cleaned of dust, and if blowing on a component they should have access
to plenty of cool air behind them; if sucking hot air from a component, they should exhaust this hot air
outside the case or into an area of very cool air: exhausting hot air into a closed case defeats the purpose of
the fan and simply aids in overheating other components. You can also get fans which move larger
quantities of air, measured in Cubic Feet per Minute (CFM) - in general the higher the CFM rating of a fan,
the more it will cool a component by moving more cool air around it. However fans generally make more
noise the faster they spin and the more air they move (measured in Decibels), so a balance has to be found
between acceptable noise and volume of air moved.

Thermal Tape, Thermal Paste, Thermal Pads, Thermal Glue etc.: These are some of the types of thermal interface
material used between a heatsink and the actual object it is trying to cool. The reason for using them is
simple - for optimal conduction of heat, the greater the surface area of the component which is mated

SuppopIiaaQ

Copyright © 2005 Koroush Ghazi 1 4 5



http://www.gen-x-pc.com/cputemps.htm
http://www.3degs.net/index.php?page=weblinks&dsn1=nav_weblinks
http://www.3degs.net/index.php?page=weblinks&dsn1=nav_weblinks
http://mondo-daemon.sourceforge.net/README_CPUS.html
http://support.intel.com/support/processors/pentium4/sb/CS-007999.htm
http://support.intel.com/support/processors/pentium4/sb/CS-007999.htm
http://www.panopsys.com/Downloads.html

Pu=A~susess

THE WINDOWS XP TWEAKING COMPANION

perfectly with the surface area of the heatsink, the more heat which can be transferred efficiently to the
heatsink and hence the better the heatsink can do its job and the cooler the component will remain. Thermal
paste for example must be spread in a very thin, even layer on the component to be cooled. Too thick and it
will impair conduction of heat, too thin and there will be patchy areas where no contact is made and hence
heat will not transfer and build up. Note that some thermal materials are electrically conductive, so they
must not be placed onto areas where they can cause a short circuit — e.g. between the pins on the CPU chip.
Also note that using superglue to hold fans and heatsinks on components is not ideal because the glue is
both next to impossible to remove, can run onto other components causing short circuits (and can't be
cleaned off), and doesn't have good heat conduction capabilities. Purchase a thermal pad or thermal glue
instead if you want an interface that also has adhesive qualities. In general, using thermal interface material
of some kind is always recommended for optimal cooling.

Lapping: This is where the surface of the heatsink that will connect with the component to be cooled is
continually sanded back and polished until it is perfectly flat and smooth, providing better surface contact
and hence better conductivity. Lapping is not essential, and most good heatsinks come with smooth, even
contact surfaces, and as long as an appropriate thermal interface is applied correctly, contact area should be
excellent regardless. This is because the thermal material should fill in any gaps in either surface if applied
correctly, and any additional benefits from lapping are marginal at best. Lapping correctly is a delicate
technique that I do not recommended for the average overclocker.

Water Cooling: This technique employs a metal block, similar to a heatsink, which is mounted on the
component to be cooled, combined with a radiator that acts like a fan. The difference is that the main cooling
mechanism in this technique is water and not just air. The water is circulated around the block to draw the
heat away from the component, then drawn into and out of the radiator to cool it as it again goes into the
block — much like an automobile radiator. Clearly the presence of water around electronic components
requires far more care, and hence the technique is more complex than simple heatsink and fan cooling and is
not recommended until you do a great deal of research into the topic.

Peltiers, Phase Change, Liquid Nitrogen: There are several advanced methods of cooling which can lower
temperatures well below freezing point. The science behind these methods varies, but essentially they are
relatively extreme methods of cooling which rely on the chemical properties of certain substances to
accelerate the cooling process. They can be very expensive to implement and sometimes have significant
downsides. These are for "hardcore' overclockers who are looking to push their components to the absolute
limit and generally not for everyday usage, although you can purchase pre-made solutions such as the
VapoChill case which implement these sort of extreme cooling measures in a contained environment.
Regardless, unless you know what you are doing you are well advised to steer clear of these methods.

GENERAL COOLING TIPS

If you are experiencing problems with heat in your system, or if you just want to ensure that you remain
problem-free with regards to heat, try the following simple tips. They will help you obtain a more stable
overclock or even just a more stable system at stock speeds:

e Remove any obstructions from around your case — for example do not have any of your case grills/air
holes obscured, pressed against a wall, blocked by dust etc. Insufficient flow of air into and out of the
case is the number one cause of heat buildup and heat-related problems. See the Troubleshooting section
for the correct method of cleaning and handling the contents of your case.

e If you have few or no major case fans drawing in cool air and expelling hot air, remove the sides of your
case so that the fans on the CPU, graphics card and Power Supply can get a fresh supply of cooler air,
and can expel hot air outside the case.

e If you do have several case fans, arrange them so that some are to the front and low in the case, sucking
air into the case (as the air near the floor is cooler) and some are to the rear and/or the top of the case,
blowing hot air out of the case (where the hot air expelled will rise away from the case). In this situation
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make sure to keep the sides of your case closed so that the fans have more pressure to suck/blow air
through the case's contents like a wind tunnel.

e Don't position a sucking and a blowing fan(s) too close together as they will 'short circuit' each other —
that is they will pass air through the shortest line between the two, bypassing your components and
hence not cooling them as efficiently. As mentioned above, fans sucking air into your case should be low
and on the furthest side of the case from the blowing fans that expel heat from the case.

e Tidy up the internal components of your case. This means all ribbon cables, power cables, etc. should be
clipped or twisty-tied to be as neatly arranged as possible, primarily to avoid blocking the flow of free air
around components, especially the CPU and graphics card which are the two hottest components in
most cases. Securing cabling and ensuring snug plug connections also means you can be sure nothing
becomes accidentally unplugged or short-circuited over time and hence causes hardware-based errors
that will confuse you in the future.

e If using additional internal cooling like larger heatsinks or fans, make sure they are not too heavy for the
surface they are mounted on. For example, using extremely large heatsinks on a graphics card can result
in the card actually bending under the weight and hence becoming permanently damaged. Even a large
heatsink mounted on a motherboard can cause it to warp or crack, once again damaging the
motherboard PCB beyond repair. If you feel you require such hefty cooling you should consider
reducing your overclock or buying a case that has better cooling instead of risking physical damage to
components through excessive weight.

e Do not bother with any additional cooling for your system RAM. While any electronic component can
overheat in theory, RAM does not become hot enough even when overclocked to impair its functionality.
Simply ensure your case contents are generally cool and the RAM will also remain sufficiently cool. Note
that Video RAM is different and significantly benefits from additional cooling.

e Make sure your hard drive is not smothered by cabling or crammed into a stuffy area of the case with no
nearby cooling or fresh air. Higher speed hard drives in particular (i.e. 7,200RPM or 10,000 RPM drives)
can heat up quite a bit — one touch of their metal casing will tell you just how hot. Hard drives are often
overlooked in cooling, and yet they are a vital system component, and as such you should make sure
they receive plenty of fresh cool air. You can buy specific 'drive cooler' fans which take up a CDROM or
Hard drive slot in your case and blow on the hard drives, but this is not really necessary as long as you
keep the area around the drive(s) free from obstructions.

e Make sure that any heatsinks on the motherboard itself are not covered or blocked by other components
or cables, or covered in dust. There is a reason why these heatsinks are there — that's because
motherboard memory controller chips for example require cooling otherwise they can malfunction due
to excessive heat just like any other major component. Don't assume a heatsink without a fan implies the
component requires minimal cooling, as sometimes manufacturers skimp on putting a fan on these
heatsinks, which simply means the heatsinks have to do more work — keep them well exposed to cool air.
You can even consider installing a small fan on them if you wish, and this can aid in system stability.

That covers the basic cooling tips I can provide. Of course the most simple of all of these tips which anyone
can undertake is to provide greater access to fresh cool air for the case's contents - either by moving the case
to a more open area and/or by opening the case's sides in the absence of many case fans. Furthermore, a
regular clean of the case and its grills/air oils to remove dust buildup can do wonders. Dust can reduce
airflow significantly, so keep your case dust-free by using a damp cloth or compressed air (never use a
vacuum cleaner due to static electricity — see the Troubleshooting section).

B VOLTAGE ADJUSTMENT

As components are pushed outside specifications with overclocking, they will do more work. Often they can
accommodate this extra work within their current voltage, however sometimes to gain stability and/or to
push a component further, you will have to increase the voltage to these components. The three main
components that can benefit from voltage tweaking are the CPU, the graphics card and RAM. The two main
voltage adjustments you will find in the BIOS are VCore and VDIMM, and these are explained below.
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VCore or CPU Voltage: This is the amount of voltage applied to the CPU. The base voltage will vary
depending on the CPU architecture, however make sure to note what your CPU's default voltage is before
raising it. The only reason to alter the VCore from its default is that when overclocking your CPU you may
notice that you cannot overclock it beyond a certain point, or that you experience a lot of instability at a
relatively low overclock. Raising the VCore slightly in your BIOS may allow the CPU to regain stability
and/or allow you to push the CPU further. The theory behind raising the VCore is more complex than just
supplying more juice to the CPU, and you can read the theory in this CPU Overvolting Explained Article.
The most important thing to understand is that upping the VCore beyond a certain point can result in
permanent damage to your CPU, and generally speaking any increase in the VCore can further shorten the
life span of a CPU. However for the most part a bump in voltage (e.g. 0.1 or 0.2 volts) can help stabilize an
overclocked CPU that is acting slightly unstable. Just remember that more voltage requires greater cooling to
maintain safe temperatures (See Cooling section).

VDIMM or RAM Voltage: Also sometimes called DDR Voltage, this is the amount of voltage for the RAM
DIMMS (Dual Inline Memory Modules). Just like VCore, increasing VDIMM can improve stability, and
RAM in particularly can benefit from higher voltages when your system is suffering from stability issues
under overclocked conditions. This is particularly true if you're experiencing random reboots or crashes to
desktop as these are almost always RAM (and memory-subset) related. Once again, increasing the voltage to
your RAM can result in permanent damage so do not overvolt by a substantial amount without first
consulting with other owners of the same RAM and motherboard combination to see what a recommended
'safe’ voltage level would be. RAM does not usually require additional specific cooling even after a voltage
increase, however as always make sure it has plenty of fresh cool air circulating around it to prevent any
heat buildup.

AGP Voltage: If there is a setting available in your BIOS to adjust AGP Voltage, it controls the voltage
supplied to the AGP Port on your motherboard. Unless you have a PCI graphics card — which is rare —
upping the AGP Voltage affects your AGP Graphics card's stability and overclockability. The same warnings
as with VDIMM and VCore voltage adjustments apply, and it is not recommended that you increase the
AGP Voltage greatly otherwise the excess voltage and heat will permanently damage your graphics card. Of
course if you do increase AGP Voltage you will need to improve the cooling for your graphics card
accordingly.

Volt Modding: For those who do not have an AGP Voltage setting in their BIOS, or who want to increase
voltages beyond the increments provided in the existing voltage options, you will have to physically modify
your graphics card through 'volt modding' — a process which uses a soldering iron to make changes to the
circuitry and components on the card itself. Quite clearly this is a relatively advanced procedure and is not
recommended for the average overclocker because of the high risk of permanently damaging or rendering
useless the component you are volt-modding. Strictly speaking any physical modification you make to an
electronic component in your system to change its voltage is a 'volt mod', whereas just changing the voltage
of a component in the BIOS is not volt modding.

Stable Voltage and your Power Supply Unit: Your Power Supply Unit (PSU) is an essential part of your system,
and one that is often ignored, especially when overclocking. For more details on PSUs, see this PSU Guide
and this brief description which talks about the common output specifications for PSUs and what they mean.
Essentially while the amount of voltage supplied for each component is important, equally as important is
the variability in this voltage and how closely it adheres to the specified requirements for each component.
Sensitive electronic components require stable 'clean' voltage to operate at maximum stability. If there is
substantial variability in the voltage to a particular component as its demands change, this can contribute

towards crashes, freezes and sudden reboots.

There are two main aspects to a power supply that will tell you how good they are for your system. The first
is the Wattage. This specifies the maximum power output of the PSU in Watts, and a simple rule is that the
more devices you have connected to your system, the higher the Wattage of the PSU you will need. As a rule
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of thumb, I recommend at least a 350W power supply for modern PCs. However as soon as you attach
several optical drives, hard drives, case fans and various USB devices for example you will find even 350W
may not be enough when combined with a power-hungry CPU and graphics card. A 480W or 550W power
supply is ideal.

The second, and more important, but lesser known aspect of a PSU is the stability of the voltages along the
+12V, +5V and +3.3V rails. That is, how close is the actual voltage being supplied to your components on
these rails to the advertised requirements (i.e. 12V, 5V and 3.3V). For an explanation of these see the PSU
guide mentioned above. The most accurate way to check is to use a voltmeter, but that requires the right
equipment and a bit of technical expertise. The common way for most people to get an indication of voltage
stability is to use some sort of monitoring software, with Motherboard Monitor being one program that

works across a range of systems to report voltages. Use it to check your voltages and see how variable they
are when performing various tasks. The more variation there is in the voltage over time, and greater the
variation from the rated voltage for a rail - especially when you computer is under load - the greater your
chances of experiencing crashes, freezes and reboots due simply to inadequate and/or unstable power
supply to your components — especially when overclocked.

That concludes the overclocking section. Please don't undertake overclocking lightly, as despite the fact that

it is becoming much easier to do, it is also much more common now for people who don't know what they're

doing to overclock their components and then wonder why their system is unstable. I often hear: "But my

friend who has the exact same system can overclock it much higher than me and his games don't crash!". A

comment like that demonstrates a lack of understanding of some fundamental principles of overclocking:

e No two components of the same brand and speed are exactly the same. For example, two Pentium 4
3GHz CPUs may have very different tolerances to overclocking depending on which factory they were
produced in and which revision they are (how early/late into the production run they were produced —
called 'Stepping).

e No two people have the same exact conditions for their overclocking. Your computer room may be
hotter or cooler than your friend's, your case may provide better or worse cooling, your combination of
components may mean your RAM cannot tolerate the overclock you are attempting to force on your
CPU by raising its FSB, etc.

¢ Your Windows XP settings and environment will not be identical to anyone else's. You may have sub-
optimal settings, background programs that are the source of conflicts, or even a virus or two causing
problems. Of course if you run through this guide hopefully all that should be a thing of the past!

¢ No two games are identical in the way they stress components on your machine, and hence if all of your
other games work absolutely fine at a certain level of overclock, it may well be that the latest game you
are playing has a completely different tolerance to your overclock and will crash 3 times out of 4.

The above points bring me to my golden rule about troubleshooting on an overclocked system: Always
assume your overclock is the primary source of any problems. See the Troubleshooting section for more
details, however as a general rule always start out by suspecting your overclock as the source of a problem
such as a random crash or reboot. Reset your entire system to its default speeds and see if the problem
persists or is as severe. If the problem goes away, or doesn't happen as often you can be certain your
overclocking is contributing to, or the sole cause of, your problems. You will have to lower your overclock
and/or increase your cooling.

Sometimes it is psychologically difficult to lower an overclock because although your system will still
perform faster than stock at a lower overclock, you may feel you are losing performance because you're no
longer at the higher overclock — this is something you will have to deal with. Overclocking can give extra
performance for free, but if not done cautiously, with stability and in moderation it can give you extra
headaches for free too!
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BENCHMARKING AND STRESS TESTING

Sometimes when you change settings in Windows XP or your BIOS, or perhaps if you've overclocked a
system component it is difficult to tell whether your overall performance and/or system stability has
improved or decreased, and by how much. The best way to gauge performance changes and system stability
is to run some benchmarks and stress tests on your system, and see the results they produce. There are a
range of utilities that are reasonably valid, objective benchmarking tools, and we will look at them in this
section. We will also look at some reputable stress testing tools.

It is important to understand that some benchmarking tools double as stress testing programs since they put
your system through a series of relatively rigorous tests to produce their performance figures. These tests
should assist in highlighting any latent instabilities in your system, so the simple act of benchmarking can
also result in stress testing your system.

B BENCHMARKING

To set the actual 'benchmark’, or base level of performance, you should ideally run the benchmarking
program(s) prior to the majority of performance tweaks or changes you make, and note the initial results they
provide. That way once you've started tweaking you can run the benchmarks again to confirm that the
tweaks are having the desired effect — i.e. improving performance. However, since most benchmarking tools
already provide some information on the comparative level of performance of your system — that is, whether
or not your system is above or below an average level of performance given the type of hardware your are
using. You can often compare results online with other users with similar systems for example.

You may choose instead to take your base level of performance as being a freshly installed and tweaked
Windows XP (as per this guide) with no overclock for example, then perform additional alterations and
perhaps even overclock certain components, then retest against the base level to see what impact your
changes have had. The main point is that for benchmarking to be successful you need a reference point or
starting point — something to compare with down the track to determine whether your performance is going
up or down with the changes you have made.

Important notes about benchmarking:

e Benchmarking programs usually focus on testing the performance of particular components of your
machine. Graphics benchmarks for example usually test the graphics card and to some extent the CPU's
performance. That means that if you want to test any tweaks you've made to your hard drive's speed for
example, a graphics benchmark may not be the best tool to use.

e All benchmarking (and stress testing) programs can result in sudden crashes and reboots, and on rare
occasions data corruption, so as a precaution always make sure any valuable data has been recently
backed up before doing comprehensive benchmarking.

e For optimal results make sure that you do not have any other programs or games running in the
background when benchmarking, since these can lower your results and introduce significant
variability. They can also cause a benchmark to crash prematurely, misleading you into believing your
system is overly unstable.

o For the purposes of using a benchmark as a stress test you may want to run other stress testing and/or
benchmarking programs in conjunction with the benchmark, or other applications/games, to really put
the pressure on your machine. Of course this can still result in prematurely crashing a system, but it
would be an extreme test of system stability.

Below are the more popular benchmarking programs available for free, and how to use them correctly —
including details on the component(s) they primarily focus on testing:
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3DMARK 2005

You can download 3DMark 2005 from the FutureMark Website. 3DMark is an eye-catching, popular and
reasonably accurate 3D graphics benchmarking utility that has been around for several years (the
forerunners being 3DMark 1999, 3DMark 2000, 3DMark 2001 and 3DMark 2003). The latest version of
3DMark (3DMark 2005) primarily utilizes your graphics card and to a lesser extent the CPU, with the
memory subset a player as well in this benchmark. 3DMark results will give you a good indication of 3D
gaming performance on your machine, and broadly speaking the higher your results the faster the
performance of recent games on your system. And in very general terms if one system scores higher in
3DMark05 than another, then it should be better for gaming.

There has been some controversy surrounding graphics card manufacturers 'optimizing' their graphics
drivers to give higher 3DMark results — with no commensurate improvements under 3D games - but as long
as you use the latest build of 3DMark this sort of "cheating" should be kept to a minimum and the playing
field should remain level between all types of systems.

To use the free version of 3DMark05 start the program and click the 'Run 3DMark' button. You will see a
series of tests running. These use various graphical techniques, some of which may not be supported by your
graphics card, and some of which are only available in the purchased version of the benchmark. At the end
of the run the benchmark will present a final score. You can then use this score to compare with other people
who have run the benchmark and this will tell you whether your system is relatively faster or slower, and if
compared with others who have virtually the same system specifications, it will tell you whether you have
room to improve on your particular system. Note however that some systems with the same specifications
may be heavily overclocked and not particularly stable for day-to-day use.

One method of comparing results with others is to simply find an appropriate forum and post your results
for comparison and discussion. An easier method is to use 3DMark's Online Result Browser (ORB) to
compare results with others who have posted their 3DMarks. Using the ORB means you have a better chance
of finding a precise match for your system specs since the ORB has many thousands of users. To enter the
ORB at any time, click the 'Options’ button under the Results section of the main 3DMark03 screen, and then
click the 'Online ResultBrowser' button.

If at any time you want to know your exact System Specifications, you can click the 'Details..." button under
the System section of the main 3DMark screen, and a list of all the items in your computer will be shown.
You can expand each major device by clicking the black triangle, and details such as clock speeds and driver
versions can be viewed (See the System Information Tools section).

You can also install and run earlier versions of 3DMark, such as 3DMark03 or 3DMark01 if you want to see
how older games would perform on your system - or simply to see what previous versions looked like.
However remember that the scores from the different versions are non-comparable, and that the different
versions stress the components of your system in different ways.

AQUAMARKS3

You can download Aquamark3 from the Aquamark Website. Aquamark3 is another Direct3D/DirectX9.0-
based benchmark that also provides a result at the end of a series of graphical tests. Install Aquamark3 and
start the program. On the main screen click the 'Select Measurement' button, and on the free version of
Aquamark you can only select the 'Start Measurement' under Option 1. At the end of the run, record your
score, and you can then compare this with others in the online Aquamark Result Comparator, which is
similar to 3DMark's ORB.

CODECREATURES

An older Direct3D/DirectX8.1 benchmark, CodeCreatures can be downloaded from the MajorGeeks
CodeCreatures Download Area. It is useful as an indication of performance for slightly older games, and

Sunsa] ssang 29 Sunjrewypuayg

Copyright © 2005 Koroush Ghazi 1 5 1


http://www.futuremark.com/download/
http://www.aquamark3.com/
http://www.majorgeeks.com/download.php?det=1256
http://www.majorgeeks.com/download.php?det=1256

OWW THE WINDOWS XP TWEAKING COMPANION

also a good stress tester just like 3DMark03 and Aquamark3. Install the program and start it, then click the
Run button on the left side of the main screen to begin a series of strenuous tests. Record the results you get
at the end and keep them handy for future reference.

You may have noticed that all of the above are Direct3D benchmarks. This reflects the popularity and more
common usage of this Microsoft standard for developing games. However, there are some OpenGL
benchmarks you can use. One of the more popular ones is:

GLEXCESS

You can download GLExcess 1.2 (also called XSMark) from the GL Excess Website. As with most
benchmarks, installing and running the program results in a run through a series of tests, with results
provided at the end. You can upload and compare these results online using the XSMark Results Page.

In terms of general non-graphics benchmarks, the following are the more popular ones:

PCMARK 2004

You can download PCMark2004 from the FutureMark Website. This general benchmarking utility from the
makers of 3DMark has been around for several years as well, and although not as reputable or as widely
used as 3DMark, provides a reasonably good benchmark of your computer's general performance. It runs a
series of tests based on such things as file encoding, disk reads/writes and basic graphics display.

To use PCMark2004 run the program and click the 'Run PCMark' button on the main screen. After several
tests it arrives at a score you can compare with others online, whether on a forum or again on the ORB. Note
that PCMark results are recorded separately from 3DMark results and are not comparable figures.

SANDRA 2005

You can download Sandra 2005 Lite from the SiSoft Sandra Website. Sandra (System ANalyser Diagnostic
and Reporting Assistant) is mainly a system information utility with some benchmarking and stress testing
functionality. It contains a range of modules, each designed to inform you about — and often test — certain
components of your system, such as the RAM, or your various Drives. The free version of Sandra is limited
in the particular modules you can access and hence the tests you can run, however there are sufficient
modules and benchmarks in the free version for you to be able to use it as a decent system benchmarking

tool.

To use Sandra, open the program and click on a particular module to see the relevant information for that
component. For example, click on the 'Mainboard Information' module to see details about your
motherboard such as the manufacturer, chipset, current FSB, memory speeds etc.

The following modules have benchmarking functionality as well as providing information about that
particular system component:

CPU Arithmetic Benchmark
CPU Multimedia Benchmark
Cache & Memory Benchmark
CD-ROM/DVD Benchmark

File System Benchmark
Memory Bandwidth Benchmark

To run a benchmark, open the appropriate module and press F5 or click the blue 'opposing arrows' (Refresh)
icon at the bottom of the module. This will begin a benchmarking run, after which you will eventually see
the results displayed at the top of the module. You might want to record the score(s) somewhere. You can
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put the benchmarking results in context by looking at the reference figures provided beneath it. You can also
change the reference data to reflect a variety of hardware to compare against.

Note that for the File System Benchmark, by default it does not use the Windows File Cache, and this can
give quite low results. To enable the file cache, and hence see the real-world results of Windows memory
management tweaking on your Windows XP system, click on the Options button at the bottom left of the
File System Benchmark module, untick the 'Bypass Windows File Cache' option, click OK then run the
benchmark.

Note also that you can run the 'Internet Connection Benchmark' and the 'Network/LAN Bandwidth
Benchmark' modules as benchmarks in Sandra, however the Network/LAN benchmark is irrelevant if you're
not connected to a network of computers, and the Internet Connection benchmark can often give inaccurate
results depending on your geographic location.

Sandra also has a role as a stress tester, but this functionality is covered in the Stress Testing section below.

HDTACH

You can download HDTach from the HDTach Website. HDTach is a hard drive benchmarking utility that
allows you to test your hard drive's speed. Launch the program, make sure all background programs and
applications are closed, select 'Quick Test' then click the 'Run Test' button and wait for the testing cycle to
complete. You will be presented with a graph showing the drive speed over the course of the drive. In the

right hand pane you can see the various speed statistics and CPU usage information for the tested drive.

If you want to compare your results to users online, click the "Long Bench' option and then 'Run Test', and
this time when the benchmarking run is completed you can click on the 'Upload Results' button to lodge
your results to the database.

HD SPEED

If you want a quick method for benching your hard drive's average speed (sequential) and burst speed
(bandwidth) then download HD Speed from George Breese's Website and launch it. Untick the Continuous
checkbox, set the 'Test duration' for 7 seconds (the maximum) then click the Start button and your results
will be shown in each box. This is a somewhat more 'down and dirty' drive tester, but generally speaking it

gives accurate results.

NERO CD-DVD SPEED

You can download CD-DVD Speed from the CD Speed Homepage. You may already have a version of this
utility installed on your system if you have installed Nero Burning ROM CD burning software on your PC. If
you have, it can be found under your \ Program Files\ Ahead\ Nero Toolkit\ directory.

This program provides the means to benchmark your CD or DVD drive with a range of tests which you can
select by going to the 'Run Test' menu, and selecting the relevant test under it. If you don't want to select any
specific tests, simply launch the program, leave it at default settings, insert a disc into the drive to be tested,
and click on the Start button. You can save your results in various file formats, and you can share these
results with others on an Internet forum for comparative purposes.

GAME BENCHMARKS

Many of the most recent games such as Doom 3 and Half Life 2 contain built-in benchmarking utilities. For
details of these game benchmarks see this page of my ATI Catalyst Tweak Guide.
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B STRESS TESTING

Stress testing has one primary purpose on a PC: to exaggerate and bring out any instabilities or sub-optimal
settings as quickly as possible. The reason for this is that instability usually manifests itself at various times
on your system, and thus its causes may not be clear. A stress tester accelerates the process by placing
extreme stress on certain components of your system to quickly and accurately determine whether they are
the likely cause of system instability. For example, running a program which almost solely stress-tests your
CPU (See Prime95 below) can give you a good indication of whether it is your CPU which is causing crashes
or freezes, or whether another component may be to blame.

However specialized a stress tester may be, it will still not provide you with rock-solid evidence that a
specific component is to blame. In the case of the CPU tester for example, it must be recognized that if the
program indicates CPU instability, the causes can still vary. A CPU can appear to be unstable due to one or
more of the following reasons:

e alack of sufficient CPU cooling

e alack of voltage to the CPU

e a physical fault with the CPU chip

e the memory subset (i.e. RAM, motherboard etc.) being unstable

e a particular incorrect software or BIOS setting

e afault with the motherboard's CPU mounting

The best the stress tester can do is point you in the right direction — it usually can't provide a precise solution
for your problem. However often this is enough for you to rule out many other causes and hence save you a
lot of time and trouble, and even prevent you from wasting money on repairing or replacing another
component which is not the cause. This is typically the case when you are experiencing game-related
problems, since it may not be clear which of the many components involved in running a game are the
actual culprit. Often the graphics card or the game software itself is blamed when the cause may be anything
from your power supply to the RAM in your system, to general settings in Windows.

Below are the more popular stress testing programs available for free, and how to use them correctly —
including details on the component(s) they primarily focus on stress testing:

PRIME95

You can download Prime95 from the Prime95 Website. This small mathematics program will effectively
stress test your CPU and memory subset. Once you've installed the application, to run the actual stress test
run Prime95.exe and choose the 'Just Stress Testing' button. Next, under the Options menu select "Torture
Test' to start stress testing.

If you want to primarily test your CPU, select the 'Small FFTs' option. If you want to test your CPU in terms
of stability under high heat and voltage usage, select 'In-place large FFTs'. If you want a general system test
which is more 'real world' and combines CPU, cache and RAM testing, select 'Blend'. Once you click OK the
testing will begin. If the program aborts with an error, you will be notified. If at any point you want to stop
the test, go to the Test menu and select Stop.

Make sure you read the document Stress.txt that comes with the program when you get the chance. It will
explain more about CPU stress testing and how Prime95 helps uncover instability. The program
recommends running the torture test for between 6 — 24 hours. In my experience a heavily overclocked PC
that is unstable will crash within a few minutes of running the test. In general if your PC lasts for over 2
continuous hours under the Prime95 torture test it proves that the CPU and memory subset are very stable
and that your overclock and/or system cooling is up to the task.

Note that stability under Prime95 does not equate to stability for 3D gaming applications for example, since
Prime95 does not stress the graphics card or test graphics functionality in any way. So if you're testing for
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stability on a gaming machine, make sure that once you achieve a stable Prime95-tested system, that you
then run a long loop of a graphics benchmark/stress tester like 3DMark afterwards.

SANDRA 2005

Sandra's information and benchmarking functionality has already been covered in detail in the
Benchmarking section above. Here we look at its stress testing abilities. To use Sandra as a stress tester of
various components on your system, use the modules mentioned under the benchmarking section, namely:
CPU Arithmetic Benchmark; CPU Multimedia Benchmark; Cache & Memory Benchmark; CD-ROM/DVD
Benchmark; File System Benchmark; and the Memory Bandwidth Benchmark. However instead of simply
running them once, if you want to stress test the relevant component simply refresh the benchmark
repeatedly (by pressing F5) whenever it completes each run.

Until recently you could stress test components by using the 'Burn In' module of Sandra, however in the
latest free version of Sandra this module is no longer available. If you have a purchased version of Sandra
you can use the Burn In module to undertake more thorough stress testing of your machine.

MEMTEST

You can download MemTest from the MemTest Website. MemTest is a Windows-based memory test for all
systems, and will help in stress testing your RAM to detect any errors. Memory-related errors are one of the

primary causes of system instability, so a RAM tester is a necessity. To use MemTest simply launch the
program, and if you want to use the default memory amount ('All Unused RAM') simply click the 'Start
Testing' button to begin RAM testing.

Allow the test to run until it has reached 100%. However ideally you should run the test for at least an hour
or more, or even overnight if you want to test for total system stability. If any errors whatsoever are found
then you have unstable memory which can lead to many types of system problems such as sudden reboots,
memory-related errors in games (e.g. General Protection Faults) or sudden crashes to desktop in programs.
Consider reducing any overclocking and/or increasing your RAM timings and/or even swapping or
replacing your RAM module(s) until you achieve total stability.

MEMTESTS86

You can download MemTest86 (not to be confused with MemTest above) from the MemTest86 Website.
Memtest86 is another good memory test, however it only functions on x86 architecture systems - basically
Intel-based systems. It is better than MemTest in that it tests your memory before Windows XP loads into
memory, which is a much better test/check of your RAM and memory subset free of any memory spaces
taken up by the operating system. To use MemTest86 download the latest zip file and extract the contents.
Run the Install.bat file from the archive and enter a blank 1.44MB floppy as prompted. To run Memtest86,
leave the floppy in the drive and reboot your system - it will run from the floppy and test your RAM.

GOLDMEMORY

You can download GoldMemory from the GoldMemory Website. GoldMemory is another memory tester
that runs before your operating system and other programs are loaded into memory, which is the most
optimal condition for memory testing. Usage of GoldMemory is similar to MemTest86, and involves running
the install.bat file of the package to create a bootable floppy disk that can be used for running GoldMemory
upon rebooting.

RTHDRIBL

You can download RTHDribl from the RTHDRIBL Website. RTHDribl (Real Time High Dynamic Range
Image-Based Lighting) is actually a DirectX9 tech demo and not a benchmark or stress tester as such. You
must have a graphics card with Pixel Shader 2.0 support to run it, such as a Radeon 9600 or newer, or a
GeForce FX or higher card. It does not have a series of tests to run, so simply start up the program and
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observe your framerates (top left corner). You can turn off the text shown on the screen at any time by
pressing F1 and F3. You can also cycle through a range of object shown (Press O), the materials used on their
surfaces (Press M), and the backgrounds used (Press L). You can change the display resolution or simply
increase the size of the program's window, either of which will increase the load on your graphics card.

To use it as a stress tester, go to the File menu and select 'Config Display'. In the Direct3D Settings screen
which opens, click the 'Fullscreen' option, then select a higher resolution such as 1024x768 or 1280x1024. If
you really want to stress your graphics card, select the highest resolution available. You don't need to alter
any of the other options on this screen unless you know what you're doing. Click Ok and the changes will be
implemented. Now start the Auto Demo mode by pressing F5 (or Demo>'Enter Planet Demo') and let the
program run for a while and any graphics instabilities will soon become apparent through crashes, artifacts
or glitches. You can also manually rotate the objects, change them, their materials and background
environments often to put further stress on the graphics card.

Of course you can use the benchmarks listed in the section above as stress testers simply by running them at
their highest settings in a continual loop for example.

The benchmarking/stress testing tools above are my personal recommendations, and generally the most
popular such tools available. However for a complete list of benchmarking tools, check the list at
BenchmarkHQ. Benchmarking and stress testing tools are an essential part of any PC troubleshooting, so
you should download as many as you possibly can for usage now and further down the track.
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REGULAR MAINTENANCE

One of the key ingredients to keeping your Windows XP setup in optimal working order is regular system
maintenance. This consists of several steps, which must be followed initially after you have completed the
tweaking in this guide, and then at least weekly and ideally after any installations or uninstallations of
software or drivers, and any medium to large file additions or deletions. It may seem that some steps are

duBUBIUTEA Te[n3ay

unnecessary or tedious, but proper system maintenance can make a significant performance difference.

More importantly, if you correctly maintain your Windows XP installation you will greatly increase the
length of time before you need to reinstall Windows. Case in point: my system has been running for over a
year on the same installation of Windows XP and is running flawlessly, exactly as responsive and trouble-
free as it was the day I installed it. Why? Because aside from the tweaks I recommend throughout this guide,
I continually maintain Windows using the steps below.

REGULAR MAINTENANCE PROCEDURE

The following are regular maintenance steps you should perform in the order provided. This procedure is
best followed at least once a week - more often if you regularly make major changes to your system:

1. Scan for Malicious Software: Follow the procedures under the Virus Cleaning section to update your
scanners and then scan for viruses, trojans, spyware, adware and browser hijackers.

2. Update Windows: Check the Windows Update site for any updates to Windows XP and install all
important updates (See Internet Explorer section).

3. Remove Unnecessary Startup Programs and Services: Using MSConfig, quickly check for any newly installed
startup programs and/or services, and then remove or disable those which are unnecessary (See
Microsoft Configuration Utility and Services Utility sections).

4. Run a Disk Check: Open Windows Explorer, right-click on your main Hard Drive and select
Properties>Tools>Check Now. Tick 'Automatically fix file system errors' and click OK, then reboot your
system to allow Windows to run a Check Disk scan and repair of your hard drive.

5. Remove Unnecessary Files: Manually delete all files you know are unnecessary on your system, then run
CCleaner or do a manual search and delete all additional unnecessary files (See CCleaner section).

6. Clean the Registry: Use either RegSupreme or RegCleaner to run a thorough clean of your Registry (See
RegSupreme and/or RegCleaner sections).

7. Optimize the Registry: Use NTRegOpt to optimize your Registry (See Registry Editor section).

8. Run a Disk Cleanup: Open the Disk Cleanup utility and configure it as per the recommendations in the
Disk Cleanup & Defragmentation section, then click OK to begin the cleanup.

9. Defragment: Using either the default Windows Disk Defragmenter or Diskeeper, run a full
defragmentation of your hard drive (See Disk Cleanup & Defragmentation section).

10. Optimize Windows Startup: Use the BootVis utility to optimize your Windows startup procedure (See
BootVis section).

If done correctly, all of the above shouldn't take longer than an hour - with most of that time taken up by the
Virus Cleaning step at the very start. If you want to perform a faster maintenance routine you can run steps
2 - 9 in a much shorter period of time. However make sure you run through the entire set of procedures at
least once a week if you want to keep your Windows XP installation responsive, secure and up-to-date.

As an aid to remembering which steps to perform and in which order I personally have Desktop icons for
each of the tools used in each step above. I've arranged them in order on the side of my Desktop, then I run
through the icons one by one, launching each and allowing the relevant utility to do its job as specified
above. That way I don't forget any steps and I have a reminder in front of me to run this procedure
regularly.
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TROUBLESHOOTING

The information throughout this guide is already aimed at helping you configure your system for optimal
performance — which is a form of troubleshooting in itself. However this section contains specific procedures
and utilities that are my recommended methods for undertaking troubleshooting on your PC so you can
better diagnose the cause of any problems, and quickly get underway in finding a resolution for them. It is
by no means a comprehensive listing of procedures to follow in troubleshooting problems — that could be an
entire guide in itself and still not cover all the possibilities. It's just a starting point in addressing the more
common problems in Windows XP.

B DIAGNOSING A PROBLEM

I've noticed that whenever a problem occurs on a PC, new users tend to think everything that's going wrong
is due to faulty hardware, and that they've just damaged their machine or screwed up thousands of dollars
worth of equipment by editing their registry or changing a setting in a game.

More experienced users go to the opposite extreme — they are always convinced that every fault they see on
their PC lies with the software, despite their massive overclocks for example, or the fact they went ahead and
superglued a giant heatsink onto their graphics card the other day, or flashed it with a modified BIOS.

The truth lies somewhere in the middle: PC hardware components are just like any other electronics devices
— they can malfunction, or be damaged through abuse or overclocking, and eventually they will just plain
stop working. However at the same time software that is not configured correctly for your hardware will
mean your system will not function correctly. In terms of the actual balance between hardware-based and
software-based problems, I'd suggest that at least 80% of problems are software-based, and 20% are
hardware-based. In terms of the overall rankings of the common sources of problems, overclocking-related
issues are by far the number one cause, with incorrect Windows settings the number two cause, and
incorrect BIOS settings a distant third. Very rarely will the actual game or program settings or software be
the cause of any major problem, and even rarer are the instances where hardware is actually malfunctioning
due to physical faults.

To diagnose a problem on your machine I suggest you follow these general steps:

1. Remove any overclocking: 1 cannot stress this point enough - almost all of the problems which I see
reported on Internet forums and in emails to me are based at least in some part on some form of
overclocking and/or related heat issues. Crashes, memory errors, freezing, sudden reboots, garbled
graphics or unusual colors or dots on the screen — these are all the classic signs of a system which is
operating outside its specifications and being over-stressed by a particular game or application. Before
blaming any software of being at fault, you must first change all your hardware back to their default
speeds, including such things as RAM timings. Even if every single other game or program on your
system runs fine at a particular level of overclock, but one game or program doesn't, that does not mean
the program is at fault — you should still make sure your overclock is not the issue by running at stock
speeds for a while. If the problem is reduced or completely eradicated by running at stock speed then
the issue is without a doubt related to your overclock (See Step 6 to determine which component(s) are
the likely culprits). Note that if you have heavily overclocked and/or modified your components in the
past you may have already caused them permanent damage, so keep this in mind as you try to find the
source of the problem. For example, if you have heavily overclocked your graphics card for some time it
is quite likely that you have permanently damaged the Video RAM and this is the cause of any video
artifacts you may see in games, even at stock speeds.

2. Optimize your System: In order to rule out a software-based problem you must make sure your general
system settings are correctly configured. Clearly that is what this guide is designed to do, so follow it in
full and also make sure to check for application or game-specific tweak guides (such as those I write on
TweakGuides.com) to make sure the software's settings are configured correctly. Sub-optimal Windows
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and/or software settings and/or out-of-date drivers are a major cause of problems on most systems, and
even if they are not the primary cause they can certainly exacerbate any existing issues.

3. Optimize your BIOS: Along with any software optimization you must make sure your BIOS settings are
correct otherwise no amount of software optimization or reduction in overclocking will help. This is
another important area that is almost always overlooked because it is not easy to do. See the BIOS
Optimization section for details. For example, some game problems can be resolved by correctly setting
your AGP Aperture size - so make sure your BIOS is optimal.

4. Read the Manual & Help File(s): There are times when particular games have a known issue with a
particular hardware component or hardware combination. Usually these issues are addressed in future
patches for the program, or by new driver releases for the hardware. However you need to be aware of
these problems, and the best way to do that is to read the Readme.txt or similar help files which come
with the program. These are usually located somewhere in the program's directories and a link is
typically found for them under the program's install folder. You may even find mention of known issues
in the program's manual or on their website, so make sure you chase these up.

5. The Problem Occurs During Bootup or in the BIOS: If the problem you are experiencing occurs during your
PC's initial bootup and/or in the BIOS screen then this clearly indicates that it is unrelated to your
Windows settings or drivers, since neither has even loaded while the BIOS is loading up. Problems
which occur during initial bootup or when you are in the BIOS are always hardware-related faults
(including overclocking — see step 1 above) and/or a BIOS setting which is incorrect. They are never
related to your software settings.

6. Benchmark and Stress Test: By using the benchmarking and stress testing tools covered in the
Benchmarking & Stress Testing section, you can narrow down which particular component is likely to be
causing the problem. For example if your system is freezing during the playing of games, it could be the
graphics card, CPU, RAM or even the sound card which are at fault. Using a benchmarking or stress
testing program that is specialized in stressing a particular component more than others will tell you
which component is the likely candidate for further investigation.

7. Check your Cabling and Components: If you feel comfortable in doing so, turn off your system at the power
switch (but don't unplug it) and open up your case. Check the Hardware Handling Tips section below
first, then:

a. Check to ensure that all your component fans are not clogged with dust

b. Check to ensure all the cables to and from your components and to and from your case are
firmly plugged in and not damaged along their length

c.  Check your motherboard manual to make sure all the switches on the motherboard are set
correctly, and that all plugs are going into the right source;

d. Check for signs of extreme heat such as scorch marks or a burnt smell: these indicate heat
damage to particular components; and

e. Check to make sure metallic surfaces are not in contact with each other as this can short-
circuit components.

In fact if you need to handle your hardware components for any reason, follow the tips provided below to
minimize the potential for any damage:

HARDWARE HANDLING TIPS

If you have to physically handle the components in your system — such as remove or installing a component,
checking for component connections, or cleaning the components — you should make sure you always follow
these tips to prevent any permanent damage to the components through mishandling:

e Before opening your case and/or handling any of your components, always shut down Windows and
then turn off the power directly at the wall socket - the electricity in your PC can kill or injure you,
especially the dangerous voltages contained in your Power Supply. Even when switched off at the wall,
the PSU can retain a lethal charge for quite some time so on no account should you ever open your PSU
or insert any metal objects into its casing.
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e Make sure you regularly discharge any static electricity in your body by touching any 'earthed’ object —
that is any object that can harmlessly dissipate static electricity. Typically if you leave your Power
Supply Unit plugged into the wall socket (but switched off) then regularly touching the side of the metal
PSU case will harmlessly discharge any static electricity. You can also purchase an anti-static wrist strap
if you handle components regularly. If you are going to handle components try to minimize how much
artificial fabrics and materials you are wearing — these can help to build up a significant electrostatic
charge in your body. An electrostatic discharge from your body can instantly kill an electronic
component, so do not take this lightly as it happens far more often than you think. More details on Static
Electricity and its effects can be found in this Electrostatic Discharge Article.

e Do not use a vacuum cleaner to clean your computer and its components — precisely because vacuum
cleaners can discharge static electricity and zap your components. Use a clean barely damp lint-free cloth

to wipe dust from most surfaces, making sure you don't rub or scrape the Printed Circuit Board (PCB).
Don't use any detergents on the cloth and most certainly don't spray any onto the components. Ideally if
it is available to you, use a can of compressed air to blow dust from hard-to-reach or sensitive surfaces as
this is much safer and far more effective.

¢ Do not force any plugs or cables into sockets that do not appear to be accepting them. Even if the two
ends appear to be matched, the pin arrangements may be slightly different or out of alignment and
hence forcing a fit may actually bend some of the pins and make the connection useless or permanently
damaged. Computer plugs are designed to fit together with firm but not excessive force. This includes
hardware components like the CPU chip which fits into the appropriate socket on the motherboard -
align all the pins perfectly and press evenly but not too hard and they will mate safely. Force the fit and
you may just end up permanently ruining your CPU.

e Most devices in your PC require a source of power, however the voltage they require is very specific. If
you connect the wrong plug to the component (which is hard to do), or forget to attach a power
connector then the component will appear to be dead. You will have to check your component
documentation and especially the motherboard manual to ensure that all components are plugged in
correctly and firmly to receive sufficient power.

e Most hardware components are very sensitive to physical impact and strong vibrations — avoid
situations which result in the bumping or banging of these components, or for example the mounting of
heavy fans onto them which can pass vibrations to these components or warp them under the weight.

e Do not handle liquids around electronic components — any spillage can result in disastrous short-
circuiting and the demise of the components. This also includes any thermal or adhesive compounds
which can conduct electricity and hence cause a short-circuit — apply them cautiously and don't just
assume that any excess will dry up and disappear — remove all excess thermal compounds with a cloth.

e Do not place excessive weights on PCBs as this can crack or warp them such that they will be
permanently damaged. Don't even rest a large object temporarily on the motherboard or a component
for example — put them on another surface until you need to use them.

That covers what are for the most part fairly basic and perhaps obvious, but nonetheless essential tips for
handling electronic hardware components in your PC.

If you've followed the procedures above for diagnosing a problem and you are still without a solution, then
the next section will assist you in determining the best route to solving your problem.

B FINDING A SOLUTION

Most of the time you will find that a genuine effort to optimize your software and hardware will result in a
resolution of your problem. I can say from personal experience that I have very rarely if ever encountered a
problem where sheer persistence, some research and essential optimization hasn't resulted in a permanent
solution to my PC issues. However I realize that there are times when you don't have the time, patience,
knowledge or skills to resolve your problem. In those cases, you can try the various pathways below to
obtaining a solution:
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e  Search: The number one method I use to find a solution to my problem is the Google search engine.
Doing a search on Google using the right search filter can almost always give you all the information you
need to better understand the type of problem you are experiencing and the possible solutions which are
available for you to try. For example if you are having problems crashing in a particular game like Half
Life 2, a quick search on 'Half Life 2 crash' or 'Half Life 2 Problems' will give you dozens of valuable
leads on where to look for existing solutions.

o Internet Forums: Another fruitful method of getting a solution is to find a suitable Internet forum and
post your problems there. Often you can find a suitable forum by using Google — e.g. using the example
above, a search on 'Half Life 2 Forums' would tell you where you can find forums that discuss Half Life 2
issues. Alternatively if it is a hardware-related problem, a search on the name and model number of the
hardware — e.g. 'Radeon 9800 Pro Forums' will help you find the appropriate forum. Or you may already
have a favorite PC forum where you can post your question. Once you have found a good forum or two,

most forums to see if anyone else has already asked a similar sort of question. This is part of forum
‘netiquette’ whereby you have to show that you have made some sort of effort before posting, and in fact
most forums have a rule where you cannot post a new thread on the same topic as an existing thread.
Follow this netiquette and be sure to read the forum's rules first before posting otherwise you will find
that the members will be hostile towards you and you won't get any solutions no matter how hard you
try or how desperate you sound. Also, make sure that along with your problem you provide a full listing
of your system specifications (See Providing System Specifications below).

o Official Technical Support: You can send an email to the official Technical Support team for the hardware
or software company whose product you believe is the major cause of your problems. For example if you
have genuinely come to the conclusion that your problems are the result of a game bug, then email the
game's technical support area — usually their email details are provided at the back of the
software/hardware manual and also on their website. You will have to provide appropriate system
information (See Providing System Specifications below), however be aware that different companies
have different requirements for the format in which your specifications should be so check those first.
Most people don't want to email Tech Support because they don't believe they will get a useful answer —
if any answer at all. However it is always a good idea to email official Tech Support so that (a) they have
some indication of the level of a problem among their users; and (b) if no other avenue of help yields a
useful solution for you, the official techies just may come through with one.

e Seek Professional Help: If after all your searching, posting and emailing you cannot find a solution — and
this is rare indeed — then you will have to seek the help of a professional computer technician especially
if you believe the problem is hardware-based. This is a last resort, since typically most problems are not
hardware-based, and sometimes even if they are the issue involves permanent damage of some kind
which a technician cannot fix — he can only suggest you buy new hardware to replace the damaged
components — hardly advice worth paying for. However if you are genuinely concerned about your
system and don't have the time or ability to follow guides like this one in full, or just don't have the
patience, then you should be able to find a PC technician who can optimize your hardware and/or
software to some degree. The bottom line is if you don't know what you're doing you may end up
making things worse so it might be worth investing in a reputable service to resolve your issues.

Finally, if after every avenue of problem resolution you find your situation hasn't been resolved then you
may simply have to wait for a software update such as a game patch or driver update, or a hardware
solution such as buying more RAM, or replacing some of your components to resolve the issue. I must stress
though that most people who are honestly willing to look will find a solution to their problems within the
first few steps of the diagnosis procedures above.

PROVIDING SYSTEM SPECIFICATIONS

If at any point you have to provide your system specifications on an online forum or to a qualified Technical
Support person for example, and no format is provided for you to follow, you should try to use the format
below to ensure that you provide sufficient information to allow others to help you (the examples shown are
from my own system):

Sunooysayqnoaiy,

Copyright © 2005 Koroush Ghazi 1 61



http://www.google.com/

Pu=A~susess

THE WINDOWS XP TWEAKING COMPANION

CPU: List the brand, model number/speed and any overclocking.
E.g: Pentium 4 2.6GHz @ 3GHz
Graphics card: List the brand, model number and any overclocking
E.g: ATI Radeon 9800 Pro @ Stock speed
Sound Card: List the brand and model number
E.g: Creative SoundBlaster Audigy 1
Motherboard: List the brand, chipset type and model number
E.g. Asus P4G8X Deluxe, Intel E7205 chipset
RAM: List the no. of sticks, amount of memory, brand(s)/model(s), speed ratings, current speed and timings
E.g. 2 x 512MB Corsair TwinXMS PC3200 @ 400MHz, 2-2-2-5 (or CAS 2)
Hard Drive: List the brand, model, size, speed and interface
E.g. Seagate Barracuda 80GB 7200RPM SATA
Operating System, Major Driver Versions: List the version of Windows XP, graphics & sound card drivers
E.g: Windows XP Pro SP2 including all updates, latest Audigy drivers and 4.12 Catalysts

The information above is the bare minimum that is required to do a decent analysis of your system's
potential problem areas and you should provide as much of it as possible. You can gather all of this
information by using the utilities mentioned under the System Information Tools section of this guide. If you
are at a total loss as to how to provide full details of your system, use DXDiag to generate a report and attach
it (or cut and paste its rather lengthy contents) to an email or post on a forum. Neglecting to provide this
information can greatly increase the time taken to find a solution, and sometimes you may even be given the
wrong solution.

Note that certain information, such as the type of keyboard, mouse, network card, CD drive etc. are usually
excluded because they don't have any real impact on most general problems. However if your problem is
specifically related to a function which these items are involved in, e.g. if you are experiencing a laggy
mouse in games, or Internet connection problems, then quite obviously you will need to include full details
of these peripherals in your system specifications as well.

Generally when you ask for help in diagnosing a problem you have to understand that most of the time
there is no simple single fix to the problem — so don't expect one. Typically you won't be told to turn a single
setting on or off and suddenly all your problems disappear. A solution usually involves a range of
optimization steps, such as those I've tried to cover in this entire guide, to get your system performing
smoothly. Thus the more information you provide and the more help you give in reducing the number of
variables involved and solutions you may have already tried, the greater your chance of getting a working
solution or being steered onto the right path by someone more knowledgeable.

My firm belief is that you should make every effort to help yourself in the first instance, otherwise typically
others will be less willing to help you if you show no signs of self-help or having performed at least some
basic troubleshooting procedures. You should not expect to be spoon-fed answers every time you run into
problems. I often receive emails from people who give me a list of their system specifications and then just
say "Please help me...my system is crashing!!" While I can sympathize, they don't realize just how many
variables are involved in getting to a solution, and quite honestly if I see that the person has made no effort
to actually read my guides or attempt some basic troubleshooting, I put replying to their email at the bottom
of my To Do list. It is just a simple fact of life that a PC is not a machine which can be run without some
knowledge of how they work, and some effort on the part of the user to identify and rectify problems, and
maintain their machine in good working order. If this is too much commitment for you to handle, it is well
worth considering purchasing a console for gaming purposes for example, or paying someone to maintain
your PC for you. Otherwise you will keep running into 'mysterious’ problems time and time again until you
begin to make the effort to learn the basics and follow simple procedures.
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B COMMON WINDOWS PROBLEMS OR ERRORS

This section contains links to reputable sources of information (primarily Microsoft) on troubleshooting and
solving the most common errors people experience when using Windows XP:

CDR/DVD/CDROM DRIVES NOT FUNCTIONING/DISAPPEARED

Solutions: Microsoft Article

IRQL NOT_LESS_OR_EQUAL

Solutions: Microsoft Article

DRIVER_IRQL_NOT_LESS OR_EQUAL

Solutions: Microsoft Article

PAGE_FAULT_IN_NONPAGED_AREA

Solutions: Microsoft Article

LONG BLACK SCREEN ON BooTUP

Solutions: Microsoft Article

TROUBLESHOOTING WIRELESS NETWORKS

Solutions: Microsoft Article

UNMOUNTABLE BOOT VOLUME

Solutions: Microsoft Article

WINDOWS XP FIREWALL ISSUES

Solutions: Microsoft Article

WINDOWS DEVICE MANAGER ERROR CODES

Solutions: Device Manager Error Codes

WINDOWS XP Misc. ERROR MESSAGES

Solutions: Windows Support Center Misc. Errors Article

WINDOWS XP 'STOP' ERROR MESSAGES

Solutions: Windows Support Center Stop Messages Article

WINDOWS XP STARTUP PROBLEMS

Solutions: Labmice Windows XP Troubleshooting Article

WINDOWS XP SHUTDOWN PROBLEMS

Solutions: Windows Support Center Article

For more solutions to problems, you should check the Microsoft Knowledgebase and Microsoft Windows XP
Solutions Center. Both of these sites allow you to do searches on particular error codes, error strings or
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general error types. Although the answers they provide aren't always easy to understand, hopefully you will
see from the solutions offered which part of your system is likely to be causing the problem.

B SAFE MODE

Safe Mode is a Windows XP mode which only loads up the bare essentials required for Windows to
function. Most drivers, graphical enhancements, startup programs etc. are skipped and only the minimum
required to display and use Windows and access your drives is provided. Safe Mode is provided precisely
for troubleshooting purposes and not for general usage. The idea is that by reducing the number of variables
involved in Windows it is easier to identify the cause of a problem. You can read the full details on Safe
Mode options in this Microsoft Article.

To access Safe Mode do the following;:

1. Make sure there are no CDs in your CD/DVD ROM drives and Reboot your PC
As your PC starts booting up keep pressing the F8 key and you will soon reach the Windows Advanced
Options menu where you can see a range of options, each described in detail in the article linked above.

3. Select the safe mode option you prefer — for most troubleshooting purposes I recommend the default
'Safe Mode' option which loads the least number of device drivers.

4. You will reach the Windows Desktop which will be shown at low resolution, low color bit-depth. The
words 'Safe Mode' will appear around the edges of the screen to inform you that you are running a cut-
down version of Windows XP.

TROUBLESHOOTING USING SAFE MODE

The main use for Safe Mode is to determine whether your device drivers or installed software are the source
of a problem you are currently experiencing. Because Safe Mode does not load any of your installed device
drivers - instead it uses the default versions built into Windows XP - and because Safe Mode does not load
up any startup programs or services into the background, this gives you the opportunity to determine
whether your software or one (or more) of your startup programs is causing problems.

If you couldn't boot into Windows XP normally, but you can in Safe Mode for example that is a clear sign
that one of your recently installed driver(s) or software are the causes of the problem. You can choose to
remove the software or drivers completely by going to Control Panel>Add/Remove Programs and
uninstalling them from there. Alternatively you can experiment by using MSConfig (See the Microsoft
Configuration Utility section) to temporarily disable suspected startup items and/or services (by unticking
them) and reboot into normal Windows to see if this resolves your problem.

Finally, if you made a change to a system setting or the Windows Registry that would normally prevent you
from booting into Windows, you can undo the setting in Safe Mode, or revert to an earlier Restore Point, or
restore a Registry backup here.

If however you find that you are having similar problems in Safe Mode as you are in normal Windows — for
example your graphics are garbled or show glitches — then the problem is likely hardware-based such as
overclocking, excess heat, permanent damage to a component/faulty component(s).

VIRUS/SPYWARE REMOVAL

Another significant use for Safe Mode is the removal of Viruses, Trojans, Spyware, Browser Hijackers etc.
Many of these will load into the memory areas of Windows that cannot be unloaded during normal
Windows XP operation. However in Safe Mode there are no such protected memory areas, and no startup
programs or services are loaded with Windows, so this is the best way of removing such troublesome
software. Enter Safe Mode and either manually edit your startup items or Services to remove unusual or
harmful entries (See the Microsoft Configuration Utility and Services Utility sections to find out how to
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identify and disable them), or run a suitable Virus/Trojan/Spyware/Hijacker scanner in Safe Mode and it
should find and remove these malicious pieces of software where previously it may not have been able to.

B RECOVERY CONSOLE

The Recovery Console is a repair and recovery tool built into Windows XP that allows you to do such things
as check for faults on your drive and repair the Master Boot Records. You can read the full description of the
Recovery Console, as well as its available commands and options in this Microsoft Article.

The quickest way to access the Recovery Console is to do the following;:

1. Insert your Windows XP CD into your main CD/DVD ROM drive.

Reboot and go into your BIOS. Set the 'First Boot Device' (or similar) option in the BIOS to CDROM.
Reboot.

3. As your PC starts booting up from the CD, keep pressing the F8 key until you see the message 'Booting
from ATAPI CDROM. If this doesn't work, you can use the Windows XP Bootdisks instead (See
Formatting the Hard Drive & Installing Windows XP section).

4. The blue Windows Setup screen will eventually appear. Give it time to load all the files it needs, and
you'll see a set of options.

5. Press R from the Windows Setup screen to access the Recovery Console.

6. Press a number that corresponds with your Windows installation. The default is 1. Enter your Admin
password if required, or leave blank if you haven't set an Admin password for Windows XP, and press
ENTER.

7. Once the Recovery Console opens, there are a range of commands you can use. Just type "Help" (without
quotes) and a list of commands will be shown. To see the options for each command in more detail, type
the command followed by "/?" (without quotes).

Note that although the Recovery Console is quite a useful tool, it still may not resolve many hard drive
errors or problems. This is particularly true if your drive has experienced severe data corruption of the NTFS
security descriptors for example.

B SYSTEM FILE CHECKER

The System File Checker is another built-in function of Windows XP that allows the system to go through
and check all the major protected Windows XP system files against the original versions stored on a valid
Microsoft Windows XP CD. This is extremely handy if you suspect corrupted/tampered system files that are
leading to unusual Windows behavior. Full usage instructions for the System File Checker can found in this
Microsoft Article.

To access the System File Checker follow this procedure:

1. Go to Start>Run and type "SFC /scannow" (without quotes) then press Enter to start an immediate scan
of your system files.

2. The System File Checker will go through all your important system files and make sure they have not
been altered in any way. Where major system files are corrupted or shown to be different from original,
they will be replaced with the originals from your \Windows\ System32\ Dllcache\ directory and/or your
Windows XP CD.

3. If prompted to reboot your PC, reboot as required.

Note that you can use the switches /scanonce (to scan after the next reboot) or /scanboot (to scan on every
reboot) instead of /scannow. If you choose /scanboot and then want to stop a scan after every reboot at some
point, use the /revert switch.
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‘.Im.‘_ THE WINDOWS XP TWEAKING COMPANION

Well that brings the Windows XP Tweaking Companion, better known as the XPTC to a close. I sincerely
hope you find the information in this guide useful, not just now but in the future as you continually fine
tune and tweak your Windows XP installation. There's not much more to be said, so as I say at the end of all
my guides: Until next time, take care!

Cheers,
Koroush Ghazi
22 December 2004

Version | Release Date Pages Revised
1.00 22 December 2004 | Nil - First Release.

1.01 23 December 2004 | pp.55, 98 - RegCleaner links fixed.
pp-101 - Reference to /Windows/Prefetch fixed.

1.02 10 January 2005 All pages - Formatting altered (e.g. inserted section name on side of each page).
All pages - Numerous typographical /grammatical errors fixed.

pp-13 - XPTC problem reporting link changed.

pp-40 - Internet connection advice clarified in Driver Installation Order.
pp-42 - Added XCGI graphics card driver download link.

pp-49 - Added 2GB+ RAM example for Virtual Memory.

pp.54 - Prefetcher tweak clarified.

pp-56, 99 - Correct RegCleaner version clarified.

pp-86 - Mention how to re-enable User Names column in Task Manager.
pp-104 - Recycle Bin rename/delete tweak fixed.

pp-121 - Windows Update repair tweak fixed.

pp-145 - AMD CPU Thermal Limiting mentioned.

1.03 15 February 2005 All pages - Numerous typographical/grammatical errors fixed.
pp41, 62, 140 - Added Nvidia Forceware Tweak Guide link.

1.04 10 March 2005 pp-34 - Corrected IRQ Priority tweak.

pp-41 - Changed ATI Catalyst download link.

pp-50 - Clarified Position of Pagefile using Diskeeper tweak.

pp-53 - Clarified/corrected LargeSystemCache and IOPageLockLimit tweaks.
pp.54 - Clarified the Windows Prefetcher advice.

pp.102 - Instructions for Prefetch files in /Windows/Prefetch folder clarified.
pp-121 - Changed the Firefox Tweak Guide link.

1.05 10 April 2005 All pages - Several typographical/grammatical errors fixed.

pp-23 - Ad-Aware TweakSE plugin linked.

pp-29,87 - Erunt & NTRegOpt links fixed.

pp-56,100-101,157 - All WinOptimizer advice and links replaced by CCleaner.
pp-145 - Throttlewatch link fixed.

pp-148 - PSU Guide link fixed.

pp-160 - Electrostatic Discharge Article link fixed.

1.06 18 April 2005 pp.38 - Provided alternate links for XP Home and Pro Installation Guides.
pp.82-83 - Provide alternate links for XP Services Guide.

1.07 22 April 2005 pp-41 - Fixed Intel software download links.

[End of Guide]
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